
Cat.No. V053–E1–1

Support Tool for Windows 95/98 Ver. 3.0

NT-series

OPERATION MANUAL



iii

NT-series
Support Tool for Windows 95/98 Ver. 3.2
Operation Manual

Produced September 1999



v

Safety Precaution:
Read the safety precaution carefully and make sure you understand it before using the programmable
terminal so that you can use it safely and correctly.

CAUTION

Do not use input functions such as PT touch switches for applications

where danger to human life or serious property damage is possible or

for emergency switch applications.

CAUTION

Carefully check the operation of all screen data and host programs

before using them. If incorrect, the system may operate unpredictably.

Otherwise the system may operate unpredictably.

CAUTION

When the numeral values entered are confirmed, upper/lower limits

are checked. Otherwise the system may operate unpredictably.

CAUTION

When transferring the data in units of screens, if there are changes in

memory table and /or direct access, transfer such data along with the

screen data. 

Otherwise the system may operate unpredictably.
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OMRON Product References
All OMRON products are capitalized in this manual.  The word “Unit” is also capitalized when it refers to an
OMRON product, regardless of whether or not it appears in the proper name of the product.

The abbreviation “Ch,” which appears in some displays and on some OMRON products, often means
“word” and is abbreviated “Wd” in documentation in this sense.

The abbreviation “PC” means Programmable Controller and is not used as an abbreviation for anything
else.

[Numeral settings]

Each Support Tool screen displays options for functions to be set.  The example to the left shows
such an option, “Numeral settings”.

<Example screens>

The example screens that appear in this manual are mainly those of NT31C–V1.

Note that the contents of the screens of other models may differ somewhat from the examples.

Visual Aids
The following headings appear in the left column of the manual to help you locate different types of infor-
mation.

Note Indicates information of particular interest for efficient and convenient operation
of the product.

1, 2, 3... 1. Indicates lists of one sort or another, such as procedures, checklists, etc.

� OMRON, 1999
All rights reserved.  No part of this publication may be reproduced, stored in a retrieval system, or transmitted, in any
form, or by any means, mechanical, electronic, photocopying, recording, or otherwise, without the prior written permis-
sion of OMRON.

No patent liability is assumed with respect to the use of  the information contained herein.  Moreover, because OMRON
is constantly striving to improve its high-quality products, the information contained in this manual is subject to change
without notice.  Every precaution has been taken in the preparation of this manual.  Nevertheless, OMRON assumes no
responsibility  for errors or omissions.  Neither is any liability assumed  for damages resulting from the use of the infor-
mation contained in this publication.

Trademarks
Microsoft�, MS–DOS�, Windows� and Windows NT� are either registered trademarks or Trademarks of Microsoft
Corporation in the United States and/or other countries.
PLC names of MELSEC FX, A series and FX–2PIF of MELSEC F series are registered trademarks of Mitsubishi Elec-
tric Corporation.
Hewlett–Packard, HP, PCL and Laser Jet are registered trademarks of Hewlett–Packard Company.



vii

TABLE OF CONTENTS

SECTION  1
Introduction to the Support Tool 1. . . . . . . . . . . . . . . . . . . . 

1-1 What Is Support Tool? 2. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-2 Equipment Necessary for Using the Support Tool 7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-3 General Configuration of the Support Tool 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

1-3-1 Outline of Screen Data 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-3-2 Correspondence to PC (PLC) Data 11. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-3-3 Tables 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-3-4 Types of Screens 19. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

1-4 Basic Operation Flow 22. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-5 Menu Chart 23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-6 Usable Hardware Combinations 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

1-6-1 Applicable PT 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
1-6-2 Communication method for each PT type 29. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  2
Setting Up the Support Tool 31. . . . . . . . . . . . . . . . . . . . . . . . 

2-1 Before Installing the Software 32. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2-2 Installing the Support Tool 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

2-2-1 Basic Installation Operation 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2-2-2 Procedure 35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2-2-3 Uninstall 40. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  3
Support Tool Starting-up and Exiting Procedure
and File Operation 41. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

3-1 Starting-up and Exiting the Support Tool 42. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-1-1 Start-up Procedure 42. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-1-2 Exit Procedure 43. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

3-2 User Interface 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-2-1 Functions Provided in the Main Window 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-2-2 Major Functions of Dialog Boxes 48. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-2-3 Functions of Message Boxes 50. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

3-3 Operation of Screen Data (Application) File 51. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-3-1 Creating New Screen Data (Application) File 51. . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-3-2 Reading the Existing Screen Data (Application) File 59. . . . . . . . . . . . . . . . . . . . . 
3-3-3 Saving the Screen Data (Application) File 60. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-3-4 Closing the Screen Data (Application) File 62. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-3-5 Importing (Reading) the DOS Version Screen Data (Application) File 63. . . . . . . 
3-3-6 Importing Components from Different Screen Data File 

(Starting Up the Second Support Tool) 64. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
3-3-7 Using Method of Parts Collection 68. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  4
Application Manager 71. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

4-1 What Is the Application Manager? 72. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



viii

4-2 Operating the Application Manager 74. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-1 Opening a Data Creation Screen 74. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-2 Closing a Creation Screen 74. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-3 Creating a New Screen 74. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-4 Copying a Screen 75. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-5 Deleting a Screen 76. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-6 Displaying and Setting the PT configuration 76. . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-7 Displaying and Setting Screen Properties 76. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-8 Editing a Table 77. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-9 Copying the Whole Table 77. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-10 Saving the Screen Data (Application) to a File 78. . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-11 Error Check (Validation) 79. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-12 Sending (Downloading) the Data to a PT 81. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-13 [Window] Menu 83. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
4-2-14 [Help] Menu 85. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  5
Screen Types 87. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

5-1 Types of Screens, Common Dialog Box Settings and Operations 88. . . . . . . . . . . . . . . . . 
5-1-1 Setting the Screen Attributes 89. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-1-2 Grid Setting 91. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-1-3 Changing the Display Method on the Support Tool 92. . . . . . . . . . . . . . . . . . . . . . . 
5-1-4 Filter function 96. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-1-5 Switching Screens by Extended I/O Input at Each Screen 97. . . . . . . . . . . . . . . . . 
5-1-6 Saving the Screen Image 99. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

5-2 Standard Screen 100. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-3 Continuous/Overlapping Screens 101. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

5-3-1 Continuous Screens 101. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-3-2 Overlapping Screens 103. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-3-3 Editing a Parent Screen (Modification) 104. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

5-4 Window/Keyboard Screens 105. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-4-1 Window/Keyboard Screens 105. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-4-2 Improved input key–window/keyboard function 107. . . . . . . . . . . . . . . . . . . . . . . . . 

5-5 Extended Screen 111. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-6 Occurrence History Screen 112. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-7 Frequency History Screen 113. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-8 Host Connect Screen (System Initializing Screen) 114. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-9 Password Screen 115. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-10 Menu Screen 115. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
5-11 Print Format Screen 116. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  6
Element Operating Procedure 117. . . . . . . . . . . . . . . . . . . . . . 

6-1 Common Operation 119. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-1 Creating an Element 119. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-2 Pop-up Edit Menu 120. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-3 Selecting an Element 120. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-4 Modifying an Element 124. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-5 Copying, Cutting, Pasting, and Deleting Elements 126. . . . . . . . . . . . . . . . . . . . . . . 
6-1-6 Aligning Elements 129. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-7 Grouping Elements 130. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



ix

6-1-8 Associating Elements with the Touch Switch 131. . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-9 Centralizing the Label of Lamp and Touch Switch 132. . . . . . . . . . . . . . . . . . . . . . . 
6-1-10 Setting Properties 133. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-11 Relationships between Elements and Memory Tables 148. . . . . . . . . . . . . . . . . . . . . 

6-2 Fixed Display 149. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-1 Polyline 149. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-2 Arc 151. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-3 Rectangle 152. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-4 Circle 153. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-5 Polygon 155. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-6 Sector 157. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-7 Text 158. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-8 Tiling 161. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-9 Image Object (Data) 163. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-10 Mark 167. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-11 Library Object (Data) 169. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-3 Alarm 173. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-3-1 Alarm List 174. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-3-2 Alarm History 181. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-4 Data Input 187. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-4-1 Numeral Input 187. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-4-2 (Character) String Input 196. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-4-3 Thumbwheel Switch 205. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-5 Lamps 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-5-1 Standard Lamps 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-5-2 Image/library Lamps 212. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-6 Numeral Display 215. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-7 (Character) String Display 219. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8 Touch Switches 222. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-8-1 Input Notify Touch Switch 228. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-2 Switch Screen Touch Switch 228. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-3 (Character) String Input Touch Switch 229. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-4 Pop-up Window/Keyboard Function Touch Switch 229. . . . . . . . . . . . . . . . . . . . . . . 
6-8-5 Control Code Input Touch Switches 231. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-6 Copy Setting Touch Switch 233. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-7 Cursor Moving Touch Switch 235. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-8 Window Moving Touch Switch 236. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-9 Print Screen Touch Switch 237. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-9 Graphs 238. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-1 Bar Graph 238. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-2 Analogue Meter 243. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-3 Broken-line Graph 251. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-4 Trend Graph 257. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-10 Registering Created Elements (Symbol Manager Operation) 268. . . . . . . . . . . . . . . . . . . . . 
6-10-1 Screen Configuration of Symbol Manager 268. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-2 Basic Symbol Manager Operation 269. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-3 Operating the Symbol Manager 271. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-4 Pasting a Symbol to Screen 275. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-5 Operating Procedure of Color Palette Symbol 276. . . . . . . . . . . . . . . . . . . . . . . . . . . 



x

SECTION  7
Memory Table Setting 279. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

7-1 Common Operation 280. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-1-1 Reference Operation 280. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-1-2 Search Operation 282. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-1-3 Batch Address Change Operation 284. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-1-4 Edit Operation 286. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-1-5 Copy Increment Setting Operation 289. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-1-6 Table Display Operation by Specifying the Table Number 290. . . . . . . . . . . . . . . . . 

7-2 Numeral Memory Tables 291. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-2-1 Operation Procedure 291. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-2-2 Related Elements 292. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-2-3 Description of Numeral Memory Table Fields 292. . . . . . . . . . . . . . . . . . . . . . . . . . 

7-3 Character String Memory Tables (String Tables) 298. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-3-1 Operation Procedure 298. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-3-2 Related Elements 299. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-3-3 Description of Character String Memory Table (String Table) Fields 299. . . . . . . . 
7-3-4 Inserting Mark Data into a (Character) String 302. . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-3-5 Inserting Image Data into a (Character) String 303. . . . . . . . . . . . . . . . . . . . . . . . . . 
7-3-6 Inserting Library Data into a (Character) String 304. . . . . . . . . . . . . . . . . . . . . . . . . 

7-4 Bit Memory Tables 305. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-4-1 Operation Procedure 306. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-4-2 Related Elements 306. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-4-3 Description of Bit Memory Table Fields 306. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

7-5 Extended I/O Input Tables 310. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-5-1 Operation Procedure 311. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-5-2 Description of Extended I/O Input Table Fields 312. . . . . . . . . . . . . . . . . . . . . . . . . 

7-6 Extended I/O Output Table 315. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-6-1 Operation Procedure 315. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-6-2 Description of Extended I/O Output Table Fields 316. . . . . . . . . . . . . . . . . . . . . . . . 

7-7 I/O Comment Tables 317. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-7-1 Operation Procedure 317. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-7-2 Description of I/O Comment Table Fields 318. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-7-3 Importing I/O Comment from Ladder Program 320. . . . . . . . . . . . . . . . . . . . . . . . . . 

7-8 F-Key Input Notify Table 324. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-8-1 Operation Procedure 324. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
7-8-2 Description of F-Key Input Notify Table 324. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  8
Editing Graphic Data 325. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

8-1 Image Editor 326. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-1-1 Operating the image table 326. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-1-2 Creating Image Data Using Image Editor 329. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

8-2 Library Editor 339. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-2-1 Operating the library table 339. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-2-2 Creating Library Data Using Library Editor 342. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

8-3 Mark Editor 347. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-3-1 Screen Configuration 347. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-3-2 Creating Marks Using the Mark Editor 348. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



xi

SECTION  9
Example Screens 355. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

9-1 Example Screen Configuration 356. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-1-1 Screen Configuration 356. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-1-2 Screen Transfer among Example Screens 357. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

9-2 Operation Flow 363. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3 Creating the Sample Data 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

9-3-1 Starting up the Support Tool 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-2 [File] – [New] 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-3 Setting the PT Configuration 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-4 Setting Memory Tables 368. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-5 Creating the Menu Screen 371. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-6 Creating the Monitor Screen (Child Screen 1) 375. . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-7 Creating the Monitor Screen (Child Screen 2) 381. . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-8 Creating the Monitor Screen (Parent Screen) 392. . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-9 Creating the Set Screen 393. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-10 Creating the Alarm Screen 405. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-11 Creating the Alarm List Library Data 411. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-12 Creating the Pop-up Display Numeric Keys 413. . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-13 Saving the Created Data 417. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-14 Downloading to the PT 418. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  10
Quick Reference 419. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
SECTION  11
Data Communications with a PT 437. . . . . . . . . . . . . . . . . . . . 

11-1 Preparation for Data Communications with a PT and Data Communication Procedure 438
11-1-1 Connection to PT 438. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-1-2 Available Data Communication Methods by PT Models 439. . . . . . . . . . . . . . . . . . 
11-1-3 Data Communication Procedure 440. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

11-2 Communication Setting at the Support Tool 441. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-3 Sending (Downloading) the Data 442. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-4 Receiving (Uploading) Data 445. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-5 Receiving (Uploading) the History Record 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-6 Setting and Reading the Date and Time 449. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

SECTION  12
Making Reports 451. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

12-1 Report Types 452. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-1 Cross-Reference 453. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-2 Direct Connection Information 454. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-3 History Report 455. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-4 Image/Library Report 455. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-5 Mark List 456. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-6 Screen Image 457. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-7 Screen List 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-8 Table Report 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-9 Validation Report 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

12-2 Printing Reports 459. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



xii

12-2-1 Printer Setting 459. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-2-2 Output to a Printer 460. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-2-3 Output to a File (RTF) 465. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

12-3 Displaying the Print Image (Preview) 467. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-4 Outputting the Screen Image 468. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDICES 469. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
APPENDIX  A Data Conversion 470. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Direct Access Types 470. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Data Conversion Procedure 471. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Correcting the Screen Data Conversion 473. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDIX  B System Installer Operation 490. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Applicable PT Models 490. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Starting and Exiting the System Installer 491. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Functions of the Main Window 492. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Installing the System Program 494. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDIX  C NT Transfer Utility 495. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Equipment necessary for using the NT Transfer Utility 495. . . . . . . . . . . . . . . . . . . . . . . . . 
Installing the NT Transfer Utility 496. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
How to use the NT Transfer Utility 499. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDIX  D Table of Functions of Each PT Model 503. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
PLC Vendor (PT Configuration–PT Type) 503. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
System Setting (PT Configuration) 504. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Report 505. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Data Transmission (Download/Upload) 505. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Image Data, Library Data, and Marks 506. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Memory Tables 506. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Screens 508. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Screen Properties 508. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Elements 509. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDIX  E Limits on Numbers of Elements 522. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Limits with Conventional Models 522. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
New Models 523. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDIX  F New Functions of Support Tool Ver.3.2 526. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
APPENDIX  G Error Messages 530. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
APPENDIX  H Short Cut Keys 535. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
APPENDIX  I Connecting Cable Specifications 536. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Tool Interface Connector Specifications 536. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Assembly of Connecting Cables 536. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

APPENDIX  J 538. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Keycode Tables and Conversion Rule 538. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
ISO 8859/1 538. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
MS–DOS CP437 539. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
Keycode Conversion Rule 540. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 



xiii

About this Manual:

This manual describes the basic functions and operation procedures of the NT-series Support Tool for
Windows 95/98 and includes the sections described below.

Please read this manual carefully and be sure you understand the information provided before attempting
to install and operate the NT-series Support Tool for Windows 95/98.

WARNING Failure to read and understand the information provided in this manual may result in personal
injury or death, damage to the product, or product failure.  Please read each section in its
entirety and be sure you understand the information provided in the section and related
sections before attempting any of the procedures or operations given.

SECTION 1 Introduction to the Support Tool

This section outlines the functions of the Support Tool and describes the operating
environment of the Support Tool.

SECTION 2 Setting Up the Support Tool

This section describes how to install the Support Tool at a personal computer.

SECTION 3 Support Tool Starting-up and Exiting Procedure and File Operation

This section describes how to start and exit the Support Tool, and explains the basic file
operations.

SECTION 4 Application Manager

This section describes the basic operations of the “application manager”, which includes
the principle functions of the Support Tool.

SECTION 5 Screen Types

This section describes the types and functions of the screens that can be created with the
Support Tool and displayed at a PT.

SECTION 6 Element Operating Procedure

This section describes the settings and functions of the elements that can be registered
for screens.

SECTION 7 Memory Table Setting

This section describes how to set and use “memory tables”; internal memory areas in the
PT used to record numeric values, character strings, and bit statuses.

SECTION 8 Editing Graphic Data

This section describes how to edit graphic symbol and bit map data, and data which
combines a number of elements but is handled as a single element.

SECTION 9 Example Screens

This section describes how to create screens by reference to actual examples,
enabling you to gain practical experience of using the Support Tool and creating
screens.
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SECTION 10 Quick Reference

This section gives suggestions on how to use the functions of the Support Tool
according to the intended use of the PT.  Refer to this section to make the best use of
the PT.

SECTION 11 Data Communications with a PT

This section describes how to transmit created data to a PT and how to register it.  It
also describes how the various data other than screen data that can also be sent and
received between the Support Tool and PT, is handled.

SECTION 12 Making Reports

This section describes how to print, and output to files, the various data that the Sup-
port Tool allows to be printed or stored in files.

Appendix This section gives details on the system installer supplied as an accessory, lists the
functions of each PT, describes the methods for data conversion between PTs, gives
the specifications of connection cables, and lists error messages, etc.
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Organization of the Manual, and How to Use It:

The related manuals are listed below.

* The final digit of the manual number is the revision code.

[For operating the support tool]

� NT-series Support Tool for Windows 95/98  Operation Manual
(V053-E1-2) This manual. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Details on the operating procedure, settings, etc., of the Support Tool can be
displayed on the screen in the form of online help information.  Normal operation
can be carried out by following this help information.

When you are unsure of the operating procedure while using the Support Tool, or
you need to check detailed settings, refer to this manual.

The explanations in this manual center on the Support Tool itself.  It does not
include detailed explanations on the operation of the PT.  Therefore, refer to the
following manuals also.

This manual also explains the operation of NT Transfer Utility which is exclusively
used for downloading, uploading the screen data.

The NT-series Support Tool for Windows 95/98 can be used with the latest direct
access versions of the following PT models.  Details are given in this manual.

NT11S, NT20S, NT30, NT30C, NT31, NT31C, NT600S, NT620S, NT620C,
NT625C, NT631, NT631C

[For information on PT functions, operations, and restrictions]

� NT11S Programmable Terminal Operation Manual (V029-E1-�)

� NT20S Programmable Terminal Operation Manual (V020-E1-�)

� NT600S Programmable Terminal Operation Manual (V022-E1-�)

� NT30/NT30C Programmable Terminal Operation Manual (V034-E1-�)

� NT620S/NT620C Programmable Terminal Operation Manual (V033-E1-�)

� NT31/31C Programmable Terminal Operation Manual (V043-E1-�)

� NT631/631C Programmable Terminal Operation Manual (V044-E1-�)

These manuals contain full descriptions of PT functions, operations, and
restrictions.

[For information on the functions and operations of the PC]

� User’s manual for each PC

When you need information about the operations, functions, etc.,  of the PC, refer
to the operation manual for the PC, advanced function unit, or communication
unit being used.
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[Description of NT31, NT31C, NT631 and NT631C]

There are two types of NT31, NT31C, NT631 and NT631C, the models with the
suffix “–V1” and the models without the suffix “–V1”. Moreover, there are more
than one system program versions for “–V1” type. 
In this manual, they are written as “NT31, NT31C, NT631 and NT631C” collec-
tively when it is not necessary to classify them. However, they are written sepa-
rately like “NT31, NT31C, NT631 and NT631C with –V1” and “NT31, NT31C,
NT631 and NT631C without –V1” when it is necessary to classify them. (System
program version will be indicated like ”NT31, NT31C, NT631 and NT631C with
(System Ver.2.1), if required.)
The system programs of NT31, NT31C, NT631 and NT631C with “–V1” (System
Ver.2.1) are supplied with NT–series Support Tool for Windows 95/98 (Ver.3.2).
By installing this new system to NT31, NT31C, NT631 and NT631C without
“–V1”, it is possible to make them version up.
In this case, however, the functions indicated below can not be used even though
other functions can be used in the same way as the models with “–V1”.

� 32 dot font

� Font type ISO 8859–1

For details of 32–dot font, refer to section 6–1 “Settings for text display”. Note that
smoothing is not performed for 32–dot font.
For details of font types, refer to 3–3 “Font Type” and Appendix J.
With the system program version 2.1 for NT31, NT31C, NT631 and NT631C, the
following functions are available (Refer to Appendix F).

� Indirect reference of image/library

� Number of fixed–display which can be registered for a library has increased

� Up to 40 characters can be used for alarm list/history message of
NT631/NT631C regardless of the display method
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Introduction to the Support Tool
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1-1 What Is Support Tool?
“NT-series Support Tool for Windows 95/98 (Ver. 3.2)” (hereafter referred to as the
“Support Tool”) is the application software, which runs on Windows 95/98, devel-
oped to create the screen data for the programmable terminal (PT).

Since the Support Tool has been developed to use the graphical interface and run
under the operation environment of Windows 95/98, persons not familiar with the
Support Tool can create the screen data of the programmable terminal without dif-
ficulties.

The Support Tool can create the screen data for the following models of PT.

Conventional models: NT11S, NT20S, NT30, NT30C, NT600S, NT620S, 
NT620C/NT625C

New models: NT31, NT31C, NT631, NT631C

The screen data created using the Support Tool consists of the objects shown in
the following page.



Screen DataData created 
by the Support Tool

Screen 1 Screen Properties

Display
Object

Arc

Circle

Sector

Polyline

Polygon

Rectangle

Text

Tiling

Image Object

Library Object

Mark

Lamp

Numeral Display

String Display

Graph

Alarm List/Alarm History

Standard Lamp

Image Lamp

Bar Graph

Broken-line Graph

Trend Graph

Touch Switch

Input
Setting

Input 
Object

Numeral Input

String Input

Thumbwheel Switch

Screen 2

Screen 3

Table Numeral Table

String Table

Bit Memory Table

Extended I/O Input Table

Extended I/O Output Table

I/O Comment Table

System Memory

Direct AccessSymbol Data

F–key input Notify Table

Analogue Meter

.............
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Temp.Alarm  11:01

Temp.Alarm  10:00

Screen N

SP  0  CR

Data input (numeral input)

Menu
PV
SV

7   8   9
4   5   6
1   2   3

Alarm display

Graph display

String Display

Numeral
display

Fixed
display–text

Touch switch

Screen 1

Screen 2

Lamp
display

Fixed
display

ABCD
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Variations of Support Tool

NT-series Support Tool for Windows 95/98 (Ver. 3.2) is available in the following
types.

Type Specifications

NT-ZJ3AT1-EV3 For IBM PC/AT compatibles,
media: FD (3.5-inch, 1.44 Mbyte)

NT-ZJCAT1-EV3 For IBM PC/AT compatibles, media: CD-ROM

All types of the Support Tool come with the following program data.

� Support Tool

� Supplement Symbols (keyboard/keypad Collection)

� Colour Palette Symbol (Tilling Collection for color–type PT.)

� System installer (for replacing the PT system program)

� System program for NT31/NT31C with “-V1”

� System program for NT631/NT631C with “-V1”

� System program for NT11S

The following data is available only for the Support Tool on CD–ROM.

� Transfer Utility

This utility is used to upload/download screen data file from/to PT using MMI for-
mat. For details, refer to “Appendix C NT Transfer Utility”.

� Symbol manager – ISO symbol data

For details of ISO symbol data, refer to “6–10 Registering Created Elements (Sym-
bol Manager Operation)”.

� Sample

Parts Collection
Lamps and touch switches combined with image/library data are registered in
the Parts Collection (This is a screen data file in MMI format). For details, refer
to “3–3–7 Using Method of Parts Collection”.

Image/library Sample Collection
Expressive image lamps or other objects can be created easily using this sam-
ple collection. Graphical touch switches can be also created by overlapping
touch switches on these lamps. For details, refer to “read me(E).rtf” file con-
tained in “Sample” folder in program folder. In the same folder, “Parts List E.rtf”
which shows the list of image/library data is provided. “read me.rtf” and “list.rtf”
can be printed using “WordPad” supplied with Windows or other word proces-
sor software.

Sample Screen Data
This data is provided just as sample screen data. It is not created for the pur-
pose of actual operation on PT after downloading it to PT.

Reference: If you need system programs of PT other than NT31, NT31C, NT631, NT631C with
“-V1” and NT11S, please purchase the system installer for DOS Version. For de-
tails of system programs supplied with system installer of DOS Version, refer to
“Appendix B Applicable PT Models”.
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Main Differences of V3.2

Following changes are made for NT–series Support Tool for Windows 95/98 to im-
prove operational efficiency and to support new functions added for NT31, NT31C,
NT631 and NT631C with “–V1”. 
Here, outlines of the changed points are written. For details, refer to the stated
page or “Appendix F New Functions of Support Tool Ver.3.2”.

NT31, NT31C, NT631, NT631C new system program support

System program for NT31, NT31C, NT631, NT631C with “–V1” is version upped to
Ver.2.1. Corresponding to this new system program, indirect reference of image/li-
brary is newly supported with Support Tool. New system program is supplied with
Support Tool Ver.3.2.

Importing data from different screen data file

Up to two screen data files can be opened by starting up the second Support Tool.
By using this method, various data can be copied/pasted between the application
managers etc. For details, refer to “3–3–6 Importing Component from Different
Screen Data File (Starting Up the Second Support Tool) “.

Addition of Parts Collection (CD–ROM version only)

Various lamps and touch switches combined with graphical image/library data are
registered in the Parts Collection. These data can be imported easily using “Import
Component” function above (Desired image/library code should be copied before-
hand). For details, refer to “3–3–7 Using Method of Parts Collection”.

Easier selection of an element

Element overlapped by other elements can be directly selected by a mouse click.
In addition, pressing TAB key can traverse through the screen elements.

Improvement of image/library editing function

Image/library data can be copied/pasted between codes, and previewed before
selection. Two or more image/library editor screens can be opened collectively.
Display speed of image/library table is improved. For details, refer to “8–1 Image
Editor” and “8–2 Library Editor”.

Change of status bar, title bar, toolbar

Display contents of status bar, title bar, toolbar are changed to improve operational
efficiency. Detailed information of the selected object is displayed on the status
bar. For details, refer to “3–2–1 Functions Provided in the Main Window”.

Simulation of inverse/flash attribute

Inverse/flash attribute can be simulated on the editing screen. For details, refer to
“5–1–3 Changing the Display Method on the Support Tool”.

Addition of filter function

Filter function displays only the objects of the specified type on the editing screen
to facilitate the operation with the objects. For details, refer to “5–1–4 Filter Func-
tion”.
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Easier label editing operation

Property of lamp/touch switch label can be edited from the property dialog of lamp/
touch switch. In addition, “Copy I/O Comments” button used to copy the I/O com-
ment of the allocated bit as a label, and “Centralize Label” function are provided.
For details, refer to “6–8 Touch Switches” and “6–1–8 Centralizing Lamp/Touch
Switch Label”.

Addition of NT Transfer Utility (CD–ROM version only)

The function of NT Transfer Utility is limited only to execute downloading/upload-
ing of screen data to/from PT. Since the operation is simple, persons not familiar
with the Support Tool can download/upload screen data without difficulties. It can
also prevent unexpected change in screen data by a miss operation. Please save
the screen data to be downloaded in MMI format since the NT Transfer Utility can
handle only the MMI file. MMI file uploaded by NT Transfer Utility can be read/
edited with the Support Tool. For details, refer to “Appendix C NT Transfer Utility”

Improvement of printing function

For “Screen Image” printing, options such as “Inverse Print” (inverse screen
image) and “Hide Screen Grid (selection of display/no–display grid)” are added.
Printing of screen image corresponding to the purposes is available.
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1-2 Equipment Necessary for Using the Support Tool
The following indicates the equipment necessary for using the Support Tool.

Hardware

� Recommended CPU

Pentium 100 MHz or faster CPU

� Personal Computer

Use an IBM personal computer or 100% compatible.

� Recommended Memory

32 Mbytes minimum

� Free area in hard disk

At least 23 Mbytes. (for installing Support Tool, System Program, System Install-
er and Supplement Symbols)

To install other data such as Image/Library Sample Collection for Support Tool
on CD-ROM, more 17MB is required.

� Floppy disk drive

At least one drive is required if the Support Tool is provided on FD.

The drive must be able to read/write 1.44 Mbytes, 3.5-inch, 2HD type FDs.

� CD-ROM drive

At least one drive is required if the Support Tool is provided on CD-ROM.

� Display

VGA compatible display

When creating screen data for a PT which has a color display, a color display is
required.

When the resolution setting of desktop area is low (lower than 640�480), part of
the window of Support Tool may stick out of the screen. In this case, change the
resolution setting of desktop area  to the higher one with the control panel proper-
ty of Windows 95/98.

� Mouse

Serial mouse or bus mouse

Operating system

Microsoft Windows 95/98 and Windows NT (Windows NT is only available with
NT–series Support Tool Ver.3.3 onward.)

Device necessary for Transmitting screen data

� RS-232C cable

For cable specifications, refer to Appendix I “Connecting Cable Specifications”.
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1-3 General Configuration of the Support Tool

1-3-1 Outline of Screen Data
The screen data of the Support Tool consists of multiple screens which are linked
with each other.

Screens are managed by screen numbers.  The range of usable screen numbers
varies according to the type of the PT connected to the Support Tool.

The screen display is switched by pressing a touch switch or giving an instruction
from the PC (PLC).

PT Model Range of Screen Numbers

NT11S 1 to 250

NT20S 1 to 250, 256 to 500

NT600S 1 to 1000

NT30/NT30C
NT620S/NT620C/NT625C 1 to 1899, 1900 to 1979 1980 to 1999, 2000

NT31/NT31C/
NT631/NT631C 1 to 3999, 9000

On a screen, a variety of objects can be arranged as desired.

The following objects are used to create a screen.

Display objects

Display objects are drawn on a screen and do not have an input function.

Display objects are classified into two kinds:  objects which are always displayed in
the same status, and those which change according to the status of the PT or the
PC (PLC).

Input objects

Input objects are objects which allow input by operation at the PT.  Touch switches
and input fields for numerals and strings are examples of input objects.

Objects having code numbers

These objects are created using an exclusive editor.

They are registered with a code number so that they can be used in different posi-
tions and different screens.

� Library data

A drawing created as a fixed display is registered as library data so that it can be
used multiple positions and screens.

The library editor is used to create library data.
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� Image data

Image data are objects used to display bit map data on the screen.

An image editor or bit map editor (running on Windows 95/98) available on the
market is used to create image data.

For image data, scanned illustrations and drawings can be embedded.

� Marks

Marks are used to display special characters and symbols.  These objects can
be handled as characters.

The mark editor is used to create marks.

Registering created objects (symbol manager)

The efficiency of use of created objects can be increased by reusing them in other
screen data or by registering objects which will be used frequently.

The symbol manager is provided to register created objects.

Objects which can be used

The table below shows which objects can be used with particular PT types.

NT11S NT20
NT600S

NT30
NT30C
NT620S
NT620C
NT625C

NT31
NT31C
NT631

NT631C

Objects Display Object Arc – – � �

Circle – � � �

Sector – – � �

Polyline – � � �

Polygon – – � �

Rectangle – – � �

Text � � � �

Tiling – � �

Standard Lamp – � � �

Image/Library
Lamp

– – � �

Numeral 
Display

� � � �

String Display � � � �

Bar Graph � � � �

Broken-line
Graph

– – � �

Analogue Me-
ter

– – – �*1

Trend Graph – – � �

Alarm List – – � �

Alarm History – – � �

�:  Can be used. �*1:  Can be used only with models with “-V1”.

�*2:  Only use is insertion into character strings.
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NT11S NT20
NT600S

NT30
NT30C
NT620S
NT620C
NT625C

NT31
NT31C
NT631

NT631C

Objects Input Objects Touch Switch – � � �

Numeral 
Input

� � � �

String Input – – � �

Thumbwheel
Switch

– � � �

Library Image Display – – � �
Type
Object Library Display – – � �Object

Mark �*2 �*2 � �

�:  Can be used. �*1:  Can be used only with models with “-V1”.

�*2:  Only use is insertion into strings.



11

General Configuration of the Support Tool Section 1-3

1-3-2 Correspondence to PC (PLC) Data
The following table shows objects which are capable of transmitting data with PC
(PLC) to execute processing such as updating the screen display.

Object Input Output

Standard Lamp PC (PLC) (bit address) –

Image/Library Lamp

Touch Switch PC (PLC)
(lamp display, bit address)

Notify Bit (bit address)

Switch Screen

Input key-Window/Keyboard

Window Move
(Can be used only on Win-
dow Screen)

Copy Setting
(Numeral, String table)

Input key - Control

Input key - String

Cursor Move

Print Screen

Thumbwheel Switch – PT (Numeral table)

Numeral Display PT (Numeral table) –

String Display PT (String table) –

Bar Graph

Analogue Meter

Broken-line Graph

Trend Graph

PT (Numeral table) –

Numeral Input – PT (Numeral table)

String Input – PT (String table)

Alarm History PT (Bit Memory table) PT (Alarm History)

Alarm List PT (Bit Memory table) String Display
Image/Library Display

Operation of changing display objects

� Lamp display

The lamp is turned ON (OFF) when the specified PC (PLC) bit goes ON (OFF).

Screen PC (PLC)
Bit address

Lamp lights when
bit comes ON
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� Touch switch – Notify Bit

The specified PC (PLC) bit goes ON (OFF) when the switch area is pressed.

Screen

Notification

PC (PLC)

Bit address

� Touch switch – Switch Screen

The display screen is switched to another when the switch area is pressed.

Screen A Screen B

� Touch switch – Input Key - Window/Keyboard

A window (Keyboard Screen) pops up in the screen when the switch area is
pressed.

Screen Screen

Window (Keyboard)

� Touch switch – Window Move

The window is moved by touch panel operation when the switch area is pressed.

Window Window in a moving status

Screen Screen Screen
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� Touch switch – Input key - Control

When the switch area is pressed, the processing assigned to the specified con-
trol code is executed.

Screen

� Touch switch – Input Key - String

When the switch area is pressed, the characters of the label set for the switch are
displayed in the string input field and stored in the string table.

ScreenScreen

String input field

� Touch switch – Copy Setting

When the switch area is pressed, data is copied.  The following types of copying
can be designated.

Data in Numeral table Numeral table

Data in Numeral table Numeral Input field

Data in String table String table

Data in String table String Input field

Constant Numeral table

Constant Numeral Input field

Input box

Screen
Data Data
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� Touch switch – Cursor Move

The cursor moves from Numeral Input to Numeral Input fields when the switch
area is pressed.

ScreenScreen

� Touch switch – Print Screen

A hard copy of the screen will be printed when the switch area is pressed.

Screen

� Numeral display

The data in a Numeral table will be displayed.

1234
Reference

Display

Screen

Numeral display

1 2 3 4

Numeral
table

� String display

The string display object displays the data in a string entry.

String
table

 A B C ABC

String display

Screen

Display

Reference
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� Graph display

The graph display object displays the data in a numeral table entry.

100
60

Numeral
tableScreen

Bar graph display

  0
Display

Reference

� Data Input – numeral input and string input

These input objects write data into a table.

Numeral Input field Numeral Table
String Input field String Table

Screen
Numeral

table

Numeral data input

Input field

Writing
50

50

� Data Input – Thumbwheel switch

The Thumbwheel Switch object stores the numeric values to a numeral table
entry through transaction of Thumbwheel Switch.

Screen
Numeral

table

1234
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� Alarm

When a bit in a bit memory table is ON (OFF), the object displays the data in a
string table entry and stores it in the alarm history.

When the displayed data of the string table is touched, the object displays image/
library data, switches the screen to the specified screen.

Alarm history display

Temp.Alarm

Temp.Alarm

Library
data

Image/Library table

Temp.Alarm 96/11/06 16:02
Pres Alarm 97/01/06 18:25

Touch display

String tableAlarm list display
Bit memory table

Reference: If “Indirect Reference” is used with image/library data, data to be displayed can be
changed according to the change in the contents of numeral table. (NT31, NT31C,
NT631, NT631C with “(System Ver. 2.1)” only.)
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1-3-3 Tables
Tables are areas secured in the PT to store data such as numeral data and string
data.  They are used to share data for the functions assigned to objects and com-
municate with a PC (PLC).

If a channel address of a PC (PLC) is set in a table, data communication process-
ing between the PT and PC (PLC) is executed automatically in predetermined
cycles.

The following types of tables are provided.

� Numeral table

� String table

� Bit memory table

� Extended I/O Input table

� Extended I/O Output table

� I/O Comment table

� F-key Input Notify Table

The number of memory tables varies according to the model of PT connected.

NT11S NT20S NT600S NT30
NT30C

NT620S
NT620C
NT625C

NT31
NT31C
NT631

NT631C

Numeral table

128 128 512
512 
or

 1000

512 
or 

1000

512,
1000, 

or 
2000

String table

128 128 256
256 
or 

1000

256 
or 

1000

256,
1000 

or 
2000

Bit Memory table
– – – 256 256

256 
or 

1000

Extended I/O 
Input table

– – – 64 – –

Extended I/O
Output table

– – – 64 – –

F-key Input
Notify table

4 – – – – –

Numeral table

A numeral table stores numeral data.

This type of table is set when using Numeral Display objects, Graph objects, and
Numeral Data Input.

For details of table setting, refer to 7–2 “Numeral  Memory Tables”.
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String table

A String table stores text data.

This type of table is set when String Display object and String Input object are
used.

For details of table setting, refer to 7–3 “Character String Memory Tables (String
Tables)”.

Bit Memory table

A bit memory table stores status of a PC (PLC) memory bit.

This type of table is set when using the alarm list/history function.

It is also used when switching the screen by the operation at the PC (PLC).

For details of table setting, refer to 7–4 “Bit Memory Tables”.

Extended I/O Input table

An extended I/O input table sets the usage of input terminals of an extended I/O
unit.

For the individual input terminals, a function is set or a PC (PLC) bit to be refer-
enced is allocated.

For details of table setting, refer to 7–5 “Extended I/O Input Tables”.

Extended I/O Output table

An extended I/O output table is used to allocate the PC (PLC) bits which control
the output terminals of an extended I/O unit.

The output terminals of the extended I/O unit are controlled according to the sta-
tuses (ON/OFF) of PC (PLC) bits.

For details of table setting, refer to 7–6 “Extended I/O Output Table”.

I/O Comment Table

I/O Comment Table are areas provided in a PT to manage the comment data of
all words and bits in a PC (PLC) that are set by the Support Tool.

It displays comments on PC (PLC) words and bits specified by numeral memory
tables, character string memory tables (string tables) bit memory tables, ex-
tended I/O input tables, extended I/O output tables, and elements, in the form of
list.

The displayed comments can be edited.  For details, refer to section 7–7 “I/O
Comment Tables”.

F-Key Input Notify table

F-Key Input Notify table assigns to a function key in a PT device.  Host bits are
allocated to the function keys.  By switching the function key on and off, the corre-
sponding bit is turned on and off.  For details of table setting, refer to 7–8 “F-Key
Input Notify Table”.
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1-3-4 Types of Screens
A PT displays two types of screens — user screens which are created by arranging
objects as desired and system screens for which a specific function is preset.

The types of screens displayed on a PT, and screen numbers assigned to the each
screen are shown below.

Screen Types NT11S NT20S NT600S

NT30
NT30C
NT620S
NT620C
NT625C

NT31
NT31C
NT631

NT631C

User
Screens Standard screen 1 to 250 1 to 250 1 to

1000

1 to
1899,
2000

1 to
3999

Overlapping screen – 1 to 250 1 to
1000

1 to
1899,
2000

1 to
3999

Continuous screen – 1 to 250 1 to
1000

1 to
1899

–

Window/Keyboard
screen

– – – 1900 to
1979

1 to
3999

Host connect screen – – – 1999 –

System initializing
screen

– – – – 9000

Password screen 1 to 250 – – – –

Menu screen 1 to 250 – – – –

Print format screen 255 – – – –

System Screen display OFF 0 0 0 0 0
Screens

Extended screen – – – 1980 to
1996

–

Occurrence history
screen

– – – 1997 9001

Frequency history
screen

– – – 1998 9002

Return to the previous
screen

– – – – 9999

Standard screen

Standard screens are the fundamental screens of the PT.  Specify a “Standard
Screen” to create a screen.
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Overlapping screens

Overlapping screens are grouped screens; a maximum of eight screens can be
overlapped to display information on one screen.  The screen used as the base
for the overlapping screens is called the “Parent Screen” and the multiple stan-
dard screens which configure the overlapping screen are called “Child Screens”.

This is an 
example of an
Overlapping
Screen.

This is an

Screen No. 10
(Child Screen)Screen No. 8 

(Parent Screen)

example of an
Screen No. 7
(Child Screen)

Overlapping
Screen.

Screen No. 25
(Child Screen)

When screen No. 8 (parent screen) is specified, objects set on the individual
child screens (screens No. 10, No. 7, No. 25) are displayed in this order.

Since screen No. 8 is set as an overlapping screen, it cannot be displayed inde-
pendently.  Note that a child screen can be displayed independently.

Continuous screens

Continuous screens are grouped screen: a maximum of eight screens can be
displayed in series.  The base screen where continuous screens are registered
is called the “Parent Screen” and the registered screens are called “Child
Screens”.

[ ] [ ] Screen No. 1Screen No. 15Screen No. 20Screen No. 10

Parent
screen

Continuous
screen 1

Continuous
screen 2

Continuous
screen 3

[ ] [ ]

When screen No. 10 is specified, screen No. 20 – which is the first of the continu-
ous screens – is displayed.  After that, screens are displayed in the order of
screen No. 20, screen No. 15, and screen No. 1 by the operation of touch switch 
[ � ].

Since screen No. 10 is set for a continuous screen, it cannot be displayed inde-
pendently.

Continuous screens are switched by pressing touch switches [ � ] and [ � ], to
which system keypad is assigned.

Continuous screens cannot be used for NT31/NT31C and NT631/NT631C.  For
these models, Switch Screen function of touch switch is recommended to obtain
the indentical function.
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Window/Keyboard Screen

Window/Keyboard Screen is used as a window screen. This is a partial screen
used to display a keyboard such as a keypad for inputting numeral/string or an
operational help etc. overlapping a display screen.

For NT30, NT30C, NT620S, NT620C, and NT625C, this screen can also be
used as a standard screen if it is not used as a keyboard screen.  (For NT31,
NT31C, NT631, and NT631C, a keyboard screen cannot be displayed
independently.)

With NT31, NT31C, NT631 and NT631C with “-V1”, all objects other than
thumbwheel SW can be registered. With other models, only fixed display, and
touch switch used to input numeral/string and temporary input field can be
registered. (This type of window is called “Keyboard Screen”)

With NT31, NT31C, NT631C with “-V1”, up to 3 window/keyboard screens can
be opened at the same time. (With other models, only 1 window/keyboard can be
opened.) For details, refer to “5-4 Window/Keyboard Screen”.

Host connect screen (System initializing screen)

This screen is displayed at the start of PT operation until the connection to a PC
(PLC) is completed.

If a “Host Connect” screen is not registered, the default screen that shows the
host connection message is automatically displayed when the PT power is
switched on or when the PT mode transfers to the run mode.

Display OFF screen (no-display screen)

This screen is used when nothing is to be displayed on the screen.  Since this
screen is reserved by the system as a Display OFF screen, it cannot be edited.

Extended screen

Screens reserved for future extension of PT functions.  Screens should not be
registered to the screen numbers of these reserve screens.

Occurrence history screen

An occurrence history screen displays the numbers of screens displayed by
Switch screen operations in the order of occurrence.

Frequency history screen

A frequency history screen displays the numbers of screens displayed by Switch
screen operations in the order of frequency.

Password screen

This screen exists for the secure protection of a designated screen so that users
can switch the screen only when the accurate password is input.

Menu screen

Menu screen serves as a control screen which switches to a designated screen
through the operation of numeric key.

Print Format screen

If this screen is assigned, printing can be done by simple operation.
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1-4 Basic Operation Flow
The procedure for creating a screen using the Support Tool is shown below.

Setting Table
(Table Dialog Box Setting)

Starting up the Support Tool

Initial Setting (PT Configuration)
[File] – [New]
(or [File] – [Open] – [Tools] –
[PT Configuration])

[Tools] – [Table]

[Tools] – [Image Editor]
[Library Editor]
[Mark Editor]

Creating Objects with a Code Number

Opening a Screen [Screen] – [New]

Setting Properties on a Screen [Screen] – [Properties]

Arranging and Setting Objects

Registering Created Data to a File [File] – [Save] or [Save As]

Printing the Created Data to Confirm [File] – [Print]

Downloading the Data to the PT [Connect] – [Download]

[Operation]

CAUTION

Carefully check the operation of all screen data and host programs

before using them. If incorrect, the system may operate unpredictably.

Otherwise the system may operate unpredictably.



File New Creating new screen data. . . . . . . . . . . . . . . . . . . 

Open Reading created screen data. . . . . . . . . . . . . . . . . . 

Close Ending creation of screen data. . . . . . . . . . . . . . . . . . 

Save Saving screen data being created to a file. . . . . . . . . . . . . . . . . . . 

Save As Registering screen data being created under a new file name. . . . . . . . . . . . . . . . 

Import Reading the data created by DOS version Support Tool. . . . . . . . . . . . . . . . . . 

Print Printing screen data. . . . . . . . . . . . . . . . . . . 

Print Preview Displaying print format of screen data. . . . . . . . . . . . 

Print Setup Setting the printer. . . . . . . . . . . . . . 

Recent File(s) Recently used files. . . . . . . . . . . 

Exit Exiting the Support Tool. . . . . . . . . . . . . . . . . . . . 

Import Component Importing data from different screen data file. . . . . . . 

Edit Undo Canceling the last operation. . . . . . . . . . . . . . . . . . 

Redo Returning the screen status to the status before “Undo”. . . . . . . . . . . . . . . . . . 

Cut Cutting an object (to the clip board). . . . . . . . . . . . . . . . . . . . 

Copy Copying an object (to the clip board). . . . . . . . . . . . . . . . . . . 

Paste Pasting an object (from the clip board). . . . . . . . . . . . . . . . . . 

Delete Deleting an object. . . . . . . . . . . . . . . . . . 

Select All Specifying objects collectively. . . . . . . . . . . . . . . 

Edit Object Specifying “editing an object”. . . . . . . . . . . . . . 

Select Object Selecting an object. . . . . . . . . . . . 

Align Align Top Aligning objects to the top. . . . . . . . . . . . . . . . . . . . . . 

Align Bottom Aligning objects to the bottom. . . . . . . . . . . . . . . . . . . 

Align Left Aligning objects to the left. . . . . . . . . . . . . . . . . . . . . . 

Align Right Aligning objects to the right. . . . . . . . . . . . . . . . . . . . . 

Centre in a Row Aligning objects to vertically center. . . . . . . . . . . . . . . . 

Centre in a Column Aligning objects to horizontally center. . . . . . . . . . . . . . 
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1-5 Menu Chart
The pull down menu commands provided by the Support Tool and the function of
each menu item are shown below.



View Full Tiling Switching tiling display for object to be tiled. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Show Tag

Refresh Redrawing the current screen. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Toolbars

Full Screen Changing over entire screen display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

PC (PLC) Address Changing over the display to “with word number”. . . . . . . . . . . . . . 

Table No. Changing over the display to “with table number”. . . . . . . . . . . . . . . . . . . . . . 

Image and Library Code Changing over the display to “with code number”. . . . . . . . . . 

Standard Bar Displaying/not displaying standard tool bar. . . . . . . . . . . . . . . . . . . 

Draw Bar Displaying/not displaying drawing tool bar. . . . . . . . . . . . . . . . . . . . . . 

Status Bar Displaying/not displaying status bar. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Zoom 100% Changing display enlargement scale (100%). . . . . . . . . . . . . . . . . . . . . . . . . 

200% Changing display enlargement scale (200%). . . . . . . . . . . . . . . . . . . . . . . . . 

400% Changing display enlargement scale (400%). . . . . . . . . . . . . . . . . . . . . . . . . 

800% Changing display enlargement scale (800%). . . . . . . . . . . . . . . . . . . . . . . . . 

Simulate ON/OFF Displaying lamp ON/OFF status. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Show 

Window/

Local 1 (keyboard) Displaying/not displaying local window 1 (keyboard screen). . . . . . . . . . . . . . 

Local  2 Displaying/not displaying local window 2. . . . . . . . . . . . . . . . . . . . . . . Keyboard

Simulate Flash Displaying flash status of an object. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Error Log Displaying the error log. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Utility Bar Displaying/not displaying utility bar. . . . . . . . . . . . . . . . . . . . . . 

Alignment Bar Displaying/not displaying alignment bar. . . . . . . . . . . . . . . . . . 

Draw Selector Selecting object. . . . . . . . . . . . . . . . 

Group Grouping objects. . . . . . . . . . . . . . . . . . 

Ungroup Ungrouping objects. . . . . . . . . . . . . . . . 

Bring to Front Bringing object to the front. . . . . . . . . . . 

Send to Back Sending object to the back. . . . . . . . . . . . 

Associate with Associating touch switch with object. . . . . . . . . . . 

Disassociate Canceling association of touch switch with object. . . . . . . . . . . . 

Set Order Specifying moving order among numeral/character-string input fields. . . . . . . . . . . . . . . 

Properties Setting attributes of selected object. . . . . . . . . . . . . . 

Use as Default Registering the status of the selected object as the default . . . . . . . . . . 

for the object

Centralize Label Centralizing label of lamp/touch switch. . . . . . . . . 
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Objects Fixed

Display
Text Specifying text. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Circle Specifying a circle. . . . . . . . . . . . . . . . . . . . . . . . . 

Arc Specifying an arc. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Sector Specifying a sector. . . . . . . . . . . . . . . . . . . . . . . . 

Polyline Specifying a polyline. . . . . . . . . . . . . . . . . . . . . . . 

Polygon Specifying a polygon. . . . . . . . . . . . . . . . . . . . . . . 

Rectangle Specifying a rectangle. . . . . . . . . . . . . . . . . . . . . 

Tiling Specifying tiling. . . . . . . . . . . . . . . . . . . . . . . . . . 

Image Display Specifying image data display. . . . . . . . . . . . . . . . . . 

Library Display Specifying library data display. . . . . . . . . . . . . . . . . 

Mark Specifying a mark. . . . . . . . . . . . . . . . . . . . . . . . . . 

Touch Switch Specifying a touch switch. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Lamp Standard Specifying a standard lamp. . . . . . . . . . . . . . . . . . . . . . 

Image Specifying an image/library lamp. . . . . . . . . . . . . . . . . . . . . . . . . 

Data Input Numeral Specifying a numeral setting input field. . . . . . . . . . . . . . . . . . . . . . . 

String Specifying a character-string input field. . . . . . . . . . . . . . . . . . . . . . . . . 

Thumbwheel Switch Specifying a thumbwheel switch. . . . . . . . . . . . . 

Numeral Display Specifying a numeral display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

String Display Specifying a character-string display. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Graph Bar Graph Specifying a bar graph. . . . . . . . . . . . . . . . . . . . . 

Broken-line Graph Specifying a broken-line graph. . . . . . . . . . . . . . 

Trend Graph Specifying a trend graph. . . . . . . . . . . . . . . . . . . 

Alarm List Specifying alarm list. . . . . . . . . . . . . . . . . . . . . . . . . . . 

History Specifying alarm history. . . . . . . . . . . . . . . . . . . . . . . . 

Analogue Meter Specifying an analogue meter. . . . . . . . . . . . . . . . . 

Screen New Adding a new screen. . . . . . . . . . . . . . . . . . . 

Delete Deleting a screen. . . . . . . . . . . . . . . . . . 

Modify Parent Setting continuous/overlapping screens. . . . . . . . . . . 

Copy to Image Saving screen data in image (BMP format) file. . . . . . . . . . . 

Extended I/O Setting an extended I/O table (setting a table common to all screens). . . . . . . . . . . . 

Grid Setting grid. . . . . . . . . . . . . . . . . . . 

Properties Setting screen attributes. . . . . . . . . . . . . . 
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Tools Table Setting memory tables. . . . . . . . . . . . . . . . . . . 

Image Editor Editing image. . . . . . . . . . . . 

Library Editor Editing library. . . . . . . . . . . . 

Mark Editor Editing marks. . . . . . . . . . . . . 

Change Address Changing PC (PLC) addresses set for objects and memory tables collectively. . . . . . . . . 

Validate Checking errors. . . . . . . . . . . . . . . . 

PT Configuration Setting PT type, system setting, PT status control area/PT status notify area setting, changing. . . . . . . . . 

PT type (data conversion)

Import I/O comments Importing I/O comments from ladder program. . . . . 

Upload 

(PT

Support Tool)

Download

(Support Tool

 PT)

Application Sending (downloading) all screen data to the PT. . . . . . . . . . . . . . . . . . . . . 

Screen Sending (downloading) screen data to the PT . . . . . . . . . . . . . . . . . . . . . . . . 

in units of screens

Direct Access Information Sending (downloading) direct connection setting data. . . . . . . . 

to the PT

System Memory Sending (downloading) system memory data to the PT. . . . . . . . . . . . . . . . 

Table Sending (downloading) memory table data to the PT. . . . . . . . . . . . . . . . . . . . . . . . . . 

Connect Comms. Setting Setting methods for communicating with the PT. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Application Reading (uploading) all screen data from the PT. . . . . . . . . . . . . . . . . . . . . 

Screen Reading (uploading) screen data to the PT in units. . . . . . . . . . . . . . . . . . . . . . . . 

from the screen

Direct Access Information Reading (uploading) direct connection setting data . . . . . . . . 

from the PT

System Memory Reading (uploading) system memory data to the PT. . . . . . . . . . . . . . . . 

Table Reading (uploading) memory table data to the PT. . . . . . . . . . . . . . . . . . . . . . . . . . 

Get History Log Screen History Reading (uploading) screen history data from the PT. . . . . . . . . . . . . . . . . 

Alarm History Reading (uploading) alarm history data from the PT. . . . . . . . . . . . . . . . . . 

Date and Time Reading/setting (uploading/downloading) clock . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

data in the PT

Window New Window Opening another window on the same screen. . . . . . . . . . . . . . . . . . . 

Cascade Displaying cascaded windows. . . . . . . . . . . . . . . . . . . . . . 

Tile Displaying tiled windows. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Arrange Icons Arranging icons. . . . . . . . . . . . . . . . . . 

Symbol Manager Starting symbol manager. . . . . . . . . . . . . . . . 

(Opened Window) Selecting window. . . . . . . . . . . . . . . 
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Help Contents Displaying table of contents of online help. . . . . . . . . . . . . . . . . . . . . . 

Search for Help on Displaying help by search operation. . . . . . . . . . . . . . 

What’s This? Displaying help by a click. . . . . . . . . . . . . . . . . . . 

PLC Address Help Displaying PLC Address help of the specified PLC vendor. . . . . . . . . . . . . . 

About NT-series Support Tool Product information. . . . . 
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1-6 Usable Hardware Combinations
The combinations of hardware that can be used are shown below.

The table shows the basic combinations. Depending on the PT display method
and system configuration, they may not be usable.

1-6-1 Applicable PT
NT-series Support Tool for Windows 95/98 (Ver. 3.2) can create screen data for the
following PT models.

PT Model Type

NT11S NT11S-SF121�

NT20S*1 NT20S-ST121�-V1 NT20S-ST121�-EV3
NT20S-ST122�-V1 NT20S-ST161�-EV3

NT30 NT30-ST131�-E

NT30C NT30C-ST141�-E

NT600S*1 NT600S-ST121�-V1 NT600S-ST121�-EV3
NT600S-ST211�-V1 NT600S-ST211�-EV3

NT620S NT620S-ST211�-E NT620S-ST212�-E

NT620C NT620C-ST141�-E

NT625C NT625C-ST152�

NT31 NT31-ST121�-E NT31-ST121�-EV1

NT31C NT31C-ST141�-E NT31C-ST141�-EV1

NT631 NT631-ST211�-E NT631-ST211�-EV1

NT631C NT631C-ST141�-E NT631C-ST141�-EV1
NT631C-ST151�-E NT631C-ST151�-EV1

*1: NT20S and NT600S have direct access Ver.4 and Ver.5.
NT-series Support Tool for Windows 95/98 (Ver.3.2) supports only Ver.5.
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1-6-2 Communication method for each PT type
Usable communication method differs depending on the PT types.

Also, some PT can use communication method which is not supported in their ini-
tial state by installing the exclusive system programs. (For details, refer to Appen-
dix B “System Installer Operation”.)

Communication Method
PT
Model

Type Host
Link

NT  Link
(1:1,1:N)

C200H
Memory
Link

Mitsu-
bishi A

Mitsu-
bishi FX

NT11S NT11S-
SF121� � � � � � �

NT20S NT20S-ST
121�-V1 � � � � � �

NT20S-ST
121�-EV3 � � � � � �

NT20S-ST
122�-V1 � � � � � �

NT20S-ST
161�-EV3 � � � � � �

NT30 NT30-ST131
�-E � � � � � �

NT30C NT30C-ST14
1�-E � � � � � �

NT600S NT600S-ST
121�-V1 � � � � � �

NT600S-ST
121�-EV3 � � � � � �

NT600S-ST
211�-V1 � � � � � �

NT600S-ST
211�-EV3 � � � � � �

NT620S NT620S-ST2
11�-E � � � � � �

NT620S-ST2
12�-E � � � � � �

NT620C NT620C-ST1
41�-E � � � � � �
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Communication Method
PT
Model

Type Host
Link

NT  Link
(1:1,1:N)

C200H
Memory
Link

Mitsu-
bishi A

Mitsu-
bishi FX

NT625C NT625C-ST1
52� � � � � � �

NT31 NT31-ST121
�-E � � � � � �

NT31-ST121
�-EV1 � � � � � �

NT31C NT31C-ST14
1�-E � � � � � �

NT31C-ST14
1�-EV1 � � � � � �

NT631 NT631-ST21
1�-E � � � � � �

NT631-ST21
1�
-EV1

� � � � � �

NT631C NT631C-ST1
41�-E � � � � � �

NT631C-ST1
41�-
EV1

� � � � � �

NT631C-ST1
51�-E � � � � � �

NT631C-ST1
51�-
EV1

� � � � � �

�: Usable in the default state.
�: Exclusive system program should be installed.
�: Exclusive communication I/F unit is needed. (C200H I/F unit: NT-LB122)
�: Not usable

Note There is no version number for the direct access of NT11S at the present moment.
Communication methods are indicated in the table above using the following ab-
breviations:

C200H :C200H I/F
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SECTION  2
Setting Up the Support Tool

When you are going to use the Support Tool for the first time, the Support Tool software must be installed at your personal
computer.

The Support Tool is an application software which runs on Windows 95/98 of Microsoft Corporation.

The procedure described in the following pages assumes that your personal computer already has Windows 95/98 installed.

2-1 Before Installing the Software 32. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2-2 Installing the Support Tool 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

2-2-1 Basic Installation Operation 34. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2-2-2 Procedure 35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
2-2-3 Uninstall 40. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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2-1 Before Installing the Software
If the Support Tool is delivered in an FD, make a backup disk and keep the original
in a safe place.

When making the backup disk, place the write-protect tag of the original disk in the
write-protect position.

Write-protection tag

According to the media, following two types of NT-series Support Tool for Windows
95/98 (Ver. 3.2) are available.

Type Specifications

NT-ZJ3AT1-EV3 For IBM PC/AT compatibles,
media: FD (3.5-inch, 1.44 Mbyte)

NT-ZJCAT1-EV3 For IBM PC/AT compatibles, media: CD-ROM

All types of the Support Tool come with the following program data.

� Support Tool

� Supplement Symbols (keyboard/keypad collection)

� Colour Pallette Symbol (Tilling collection for colour-type PT)

� System installer (for replacing the PT system program)

� System program for NT31/NT31C with “-V1” (Ver. 2.1)

� System program for NT631/NT631C with “-V1” (Ver. 2.1)

� System program for NT11S

The data indicated below is available only for the Support Tool on CD-ROM.  

The following software should be installed separately.

� NT Transfer Utility

This utility uploads/downloads screen data file from/to PT using MMI format.
For details, refer to Appendix C “NT Transfer Utility”.

The follwing data is copied to the folder if it is selected when installation.
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� Parts Collection

Lamps and touch switches combined with image/library data are registered in
the Parts Collection (This is a screen data file in MMI format). For details, refer to
3–3–7 “Using Method of Parts Collection”.

� Image/library Sample Collection

Expressive image lamps or other objects can be created easily using this sample
collection. Graphical touch switches can be also created by overlapping touch
switches on these lamps. For details, refer to “read me(E).rtf” file contained in
“Sample” folder in program folder. In the same folder, “Parts List E.rtf” which
shows the list of image/library data is provided. “read me.rtf” and “list.rtf” can be
printed using “WordPad” supplied with Windows or other word processor soft-
ware.

� Sample Screen Data

This data is provided just as sample screen data. It is not created for the purpose
of actual operation on PT after downloading it to PT.

� Symbol manager – ISO symbol data

For details, refer to 6–10 “Registering Created Elements (Symbol Manager Op-
eration)”.

Reference: � The system installer is an application software that sends the system 
program from a personal computer to PT to update the system program. 
Updating the system program allows communication using a new method or 
upgrades the PT software. However, since the system program is specific to
each PT model, the system program that matches the PT model must be 
downloaded.

� If you need system programs of PT other than NT31, NT31C, NT631 and
NT631C with “-V1” and NT11S, please purchase the system installer for Dos
Version. For detail of system programs supplied with system installer of Dos
Version, refer to Appendix B “Applicatable PT Models”.
System program for NT31, NT31C, NT631, NT631C with “–V1” (Ver. 2.1) is sup-
plied with the Support Tool.
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2-2 Installing the Support Tool
To install the Support Tool, execute the install program which has been ready in
your software package.

Reference: The following data is selectable for installation.

� NT-series Support Tool Ver. 3.2

� System Installer

� Sample Collection (For CD-ROM Version only)

If you select “Sample Collection”, data such as “Parts Collection”, “Image/Library
Sample Collection”, “ISO symbol data” and “Sample Screen Data” are installed.

� NT Transfer Utility (CD–ROM version only) should be installed separately.
Please refer to Appendix C “NT Transfer Utility”.

� Data can be added afterward by executing the installation program again. In this
case, when the item which is already installed is specified, it will not be overwrit-
ten. Also, the data will not be uninstalled even if its check mark was set to OFF
when the data is already installed.

To delete the data which is already installed, delete all data by uninstalling it and
then perform installation again.

2-2-1 Basic Installation Operation
Buttons which are displayed during the course of installation are shown below.

Clicking on this button confirms the settings in the displayed window and displays
the next window.

Clicking on this button cancels the settings in the displayed window and displays
the previous window.

Clicking on this button causes the window to close.  The status set in the window is
canceled.

This button stops Support Tool installation if it is clicked at the program install win-
dow.  In this case, a message is displayed requesting confirmation that installation
is to be stopped.

Clicking on this button displays the actual folder configuration in tree form.  You can
select the folder in this display to install the Support Tool.
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2-2-2 Procedure
1. Start up Windows 95/98.

2. If your media is FD, set the first FD of the system disks in drive A (or other
3.5-inch FD drive).

If you are using CD-ROM, set the Support Tool CD-ROM in the CD-ROM drive.
The setup program automatically starts.  Follow step 6 onward.  If the setup
program does not start automatically, execute the setup program according to
the steps shown below.

Reference: You can execute the setup program by double clicking “Setup.exe” in the Support
Tool system disk by displaying the “Explorer” of Windows 95/98.  In this case, steps
3, 4, and 5 below can be skipped.

3. Click on the Start button of Windows 95/98 and select “Run ...”.

4. Input “a:\setup” in the input field in the displayed window.

Note that drive designation must agree with the name of the drive where you
set the system disk (or CD-ROM).  If you set the disk (CD-ROM) in drive B,
input “b:\setup”.

5. Click on .

The installation is started.
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6. When the setup screen of the Support Tool is displayed, click on .

The screen to prompt you to input User Information (Name and Company) is
displayed.

7. Input your name and company. In the initial state, the name and company
which are registered for the computer are displayed.

After inputting, click on .

The screen for specifying the destination of program installation is displayed.
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8. Select the directory for installation.

In the initial state, the directory shown below is set as the destination directory.

C:\Program Files\Omron\NTST3.2

If you want to change the directory, click on  and input the drive and
directory.  (If a directory that does not exist in the hard disk is specified, the
directory is automatically made.)

After specifying the destination, click on .

The program selection screen is displayed to allow you to select the programs
to be installed.
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9. Click on the check box, displayed to the left of the program to be selected to
enter a check mark.

ex. With CD-ROM version

When the system installer is installed, the system program for NT31, NT31C,
NT631, NT631C with “-V1” (Ver. 2.1) and NT11S is also automatically
installed.

Click on after specifying.

The screen for specifying the destination for registering the start menu is
displayed.

Reference: With Support Tool on FD version, “Sample Collection” is not displayed in programs
to be installed.
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10. In the start menu of Windows 95/98, specify the folder where the short-cut to
the Support Tool is created.

In the initial state, the following folder is selected.

Start\Program\Omron\NTST3.2

If you want to change the folder, select the desired folder from the “Existing
Folders” or directly input the folder name.  (If a folder that does not exist in the
hard disk is specified, the specified folder is automatically made.)

After specifying the folder, click on .

Installation of the specified programs is implemented; files are copied.

During program installation, the progress of the processing is indicated as a
percentage.

11. After the completion of installation, the folder specified in step (10) is displayed
along with the installation completion message.

Click on  and the installation operation is completed.

Then a dialog to select restart/non–restart will come out.  Restarting your ma-
chine is recommended.
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2-2-3 Uninstall
An uninstaller (uninstall software) is supplied with the Support Tool.

If you want to remove the Support Tool from your personal computer, run the unins-
taller to delete the Support Tool program files and installation information.  Note
that the data created by the Support Tool is not deleted.

� Starting the uninstaller from the Windows 95/98 start menu

Select “Uninstall NTST” in the same folder where the short-cut to the Support
Tool is stored.

Example: Assuming the short-cut to the Support Tool exists in the Start\
Program\Omron\NTST3.2

Select the uninstaller by the following operation.

[Start] → [Program] → [Omron] → [Ntst3.2] →[Uninstall NTST]

After the start up of the uninstaller, follow the instructions displayed on the screen.
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3-1 Starting-up and Exiting the Support Tool
The procedure for starting up the Support Tool installed in your personal computer
and exiting it is shown below.

3-1-1 Start-up Procedure
To start up the Support Tool, select [Programs] → [Omron] → [Ntst3.2] → [NT–Se-
ries Support Tool] beginning with the Windows start button.

After the start-up of the Support Tool, the main window, shown below, is displayed.

Reference: Up to two Support Tools can be started up at the same time.
You can copy and paste the screen data or table data between them by opening
the two different screen data files. To start up the second Support Tool, select [Im-
port Component] from [File] menu in the main window of the first Support Tool (It is
not possible to start up the second Support Tool from [Start] menu of Windows).
For details, refer to 3–3–6 “Importing Components from Different Screen Data File
(Starting Up the Second Support Tool)”.
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3-1-2 Exit Procedure
To exit the Support Tool, use any of the operations shown below.

� In the menu, select [File] → [Exit].

� Click on  button at the upper right corner in the main window.

� Double click the Support Tool icon displayed at the upper left section in the main
window.

� Click the Support Tool icon displayed at the upper left section in the main window,
then select in the control menu box.

� Press F4 key while pressing down the Alt key.

If you are going to exit the Support Tool before saving the data of the opened
screen, a confirmation message is displayed.

After you exit the Support Tool, the screen returns to the Windows screen.
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3-2 User Interface

3-2-1 Functions Provided in the Main Window
The configuration of the Support Tool operation screen, name of each parts, and
the available functions are described below.

Title bar

Control Menu box
Menu bar

Standard toolbar

Draw bar

Application manager screen

Data creation screen

Status bar

Application manager screen

The directory of screens and tables is displayed as a tree list which allows opening,
copying and other operations.

Data creation screen

On this screen, the screen to be displayed by the PT is created.

Control menu box

The control menu box displayed at the upper left corner of the operation screen
and windows allows you to select how a window is displayed.

Title bar

The titles of windows are displayed here on each window respectively.

Status bar

The status bar displays a simple explanation about  the selected function, selected
object, cursor position, object position, the model type of the objective PT, PLC
Vendor, the maximum memory size, and the remaining application size.

Selected PT model
Selected PLC 
Vendor

Application Memory (Remaining
memory/Total memory
In case user application exceeds
the total memory, remaining
memory will be shown as nega-
tive value in red color.)

Status/Help message
or 
information of object

Cursor  Position

Top–left coordinate of
selected objects
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Menu bar

The functions provided by the Support Tool are divided into several groups.

The menu bar shows the names of these function groups and the functions in each
group are displayed in pull-down menus.

� Standard Toolbar

Functions which are used frequently — such as file reading/writing, copy and
paste, undo/redo, and print — are assigned to the buttons in the standard tool-
bar.

These functions can be called easily without selecting the function item from the
menu bar.

New

Open

Save

Print

Print
preview

New
Screen

Cut

Copy

Paste

Undo

Redo

What’s This?

� Draw Bar

Functions to draw objects are assigned to buttons in the draw bar.

These functions can be called easily without accessing the commands from the
menu bar.

Selector

Polyline

Arc

Rectangle

Circle

Polygon

Sector

Text

Tiling

Image
object

Mark

Library
object

Standard
lamp

Image
lamp

Touch
switch

Thumbwheel
switch

Numeral
input

String
input

Numeral
display

String
display

Bar
graph

Trend
graph

Broken
line
graph

Alarm
history

Alarm
list

Ana-
logue
Meter
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� Utility Bar

Buttons for centralizing label of touch switch or lamp (refer to 5–1–3), simulation
for flash attribute in fixed display objects (refer to 5–1–3), lamp ON facility (refer
to 5–1–3), and a combo–box for selecting to display certain screen object type
(refer to 5–1–4) are provided.

Centralize
Label

Filter Screen
Element

Simulate
ON/OFF

Simulate
Flash

� Alignment Bar

This toolbar provides the object alignment to the top, bottom, left, right and also
centre in a row and centre in a colmn. (refer to 6–1–6)

Align
Top

Align
Left

Centre in
a Column

Centre
in
a Row

Align
Right

Align
Bottom

Reference: Whether or not Status Bar, Standard Toolbar, Draw Bar, Utility Bar and Alinment
Bar are displayed can be selected, respectively, by the following operation.

Status Bar: [View] (menu bar) → [Status Bar]

Standard Toolbar: [View] (menu bar) → [Toolbars] → [Standard Bar]

Draw Bar: [View] (menu bar) → [Toolbars] → [Draw Bar]

Utility Bar: [View] (menu bar) → [Toolbars] → [Utility Bar]

Alignment Bar: [View] (menu bar) → [Toolbars] → [Alignment Bar]

Each time you select the item, display/no-display selection changes alternately.
The check mark, if displayed, indicates that the selection of the corresponding item
is “to display”.

If [Auto hide] invoked by selecting [Start] button (Windows) → [Settings] →
[Taskbar] → [Taskbar Options] is checked, status bar may not be displayed cor-
rectly when the window of the Support Tool is maximized. In this case, clear the
checkmark for [Always on top] at [Taskbar Options].
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Floating palette

The standard toolbar, draw bar, utility bar and alignment bar can be moved as a
floating palette to a convenient place for your operation.

� Object information on the status bar

The information for the selected object that will be displayed on the status bar is
indicated in the following table. (No information will be displayed when multiple ob-
jects are selected) Information to be displayed may be cut depending on the reso-
lution of the screen or the selected object.

Screen Element
(Selected item)

Information to be displayed

Fixed Display Object Fixed Display {Object Name: Attribute}

Fixed Display–Mark Mark Object {Code}

Fixed Display–Image Image Object {Reference Type: Code: Comment: Size: Compression}

Fixed Display–Library Library Object {Reference Type: Code: Comment}

Image Lamp Image Lamp {PLC Address: ON code: OFF code: ON comment if check else OFF comment}

Standard Lamp Standard Lamp {PLC Address: Label}

Touch Switch Touch Switch {Function: PLC Address: Label} (If function type is Notify Bit, display Notify Ad-
dress, else display Lamp Address)

Thumbwheel Thumbwheel {PLC Address: Table Entry}

Numeral Input Numeral Input {PLC Address: Table Entry: Reference Type}

String Input String Input {PLC Address: Table Entry: Reference Type}

Numeral Display Numeral Display {PLC Address: Table Entry: Reference Type}

String Display String Display {PLC Address: Table Entry: Reference Type}

Bar Graph Bar Graph {PLC Address: Table Entry: Direction}

Trend Graph Trend Graph {Type: Drawing Width: Direction}

Broken–line Graph Broken–line Graph {Direction}

Alarm History Alarm History {Display Image/Library or not}

Alarm List Alarm List {Table Entry: Display Image/Library or not}

Analogue Meter Analogue Meter {PLC Address: Table Entry}
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3-2-2 Major Functions of Dialog Boxes
A dialog box is a window which is displayed in a fixed size.  The purpose of dialog
box is to set the data which is required to execute the functions of the Support Tool.

The following types of dialog boxes are used and the procedure for setting the data
differs according to the type of dialog box.

� Option button

This represents a selection item, with “ � ” displayed to the left of the item name.

Only one of the displayed items can be chosen.  The item is identified by a black
circle.

� Check box

This represents a selection item, with “ � ” displayed to the left of item name.

Items can be selected by giving a check mark in this box.

� Text box

This text box is an input field to set characters.

� List box

A list box displays a list of data: the data to be set is selected from the list.



49

User Interface Section 3-2

� Combo box

A list of selection items appears in the dropdown list box format.  The data to be
set is selected from the list.
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3-2-3 Functions of Message Boxes
Message boxes display details of errors which occur during Support Tool operation
and messages which request your confirmation of attempted operations.

When a message box shows up, operation can be continued or cancelled by
pressing the corresponding button in the message box.
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3-3 Operation of Screen Data (Application) File
The procedure for operating the screen data file, where the PT screen data is
stored, is described below.  “PT Configuration”, which determines the basic PT op-
eration, is also discussed.

3-3-1 Creating New Screen Data (Application) File
To create new screen data, select [New] in the [File] Menu of the main window.

PT configuration dialog box appears so that users can set information of the ap-
plication environment and type of PT device.

Click on  after completing the setting at the PT configuration dialog box.
For details of the setting at the PT configuration dialog box, refer to “Dialog Box
Settings in the PT Configuration” below.

The application manager and the data creation screen (1 Standard Screen) are
displayed.

PT screen data is created by arranging objects on this data creation screen.

The application manager is the tool to manage the screen data created by a user.
For operation procedure, refer to Section 4 “Application Manager”.
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Dialog Box Settings in the PT Configuration

Before creating screen data, it is necessary to set the PT configuration and the
control/notify area which is shared by the PC (PLC).

The operation steps shown below display the PT configuration dialog box.

� Menu Bar →  [File] → [New] (creating new application)

� Menu Bar → [Tools] → [PT Configuration] (for modifying)

The PT configuration dialog box has a variety of setting items provided in three
pages.

� PT Type page

� System page

� Control/Notify Area page

� PT Type page

The PT Type page is displayed when you click on the [PT Type] tab.

The PT Type page is used to set the hardware configuration of the PT to be con-
nected.

[PT Model]

Specify the type of PT to be connected. When you are using the NT31, NT31C,
NT631 or NT631C, refer to the table below to select the correct model according to
the system program being installed.

PT Model System Program

Ver.1.01 Ver.2.0 Ver.2.1

NT31 ”NT31” ”NT31–V1” ”NT31–V1(System Ver.2.1)”

NT31C ”NT31C” ”NT31C–V1” ”NT31C–V1(System Ver.2.1)”

NT631 ”NT631” ”NT631–V1” ”NT631–V1(System Ver.2.1)”

NT631C ”NT631C” ”NT631C–V1” ”NT631C–V1(System Ver.2.1)”
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[PLC Vendor]

Specify the usable direct access type from either of the following.  
MEMLINK, Mitsubishi_A and Mitsubishi_Fx can be set only with NT31, NT31C,
NT631and NT631C with “–V1”.  (Refer to 29).

� OMRON

� Mitsubishi_A

� Mitsubishi_Fx

� MEMLINK

[Font Type]

If you are using NT31–V1, NT31C–V1, NT631–V1, NT631C–V1 hardware or had
NT31, NT31C, NT631and NT631C and been updated the system program to the
–V1 system program which is attached to this Support Tool, it is possible to select
the Font Type ISO8859–1 or CP437. 
If you are using the European Keyboards, please refer to Appendix J for more de-
tails.

[Comment]

Set a comment which is appended to the screen data file.

An arbitrary character of up to 28 characters can be set.

Reference: The PT model of the screen data which is opened can be changed.  If it is changed,
the data is converted automatically.  Note that changing of PT models is allowed
only for the restricted combinations shown in Appendix A “Data Conversion”.

� System page

The System page is displayed when users click on the [System] tab.
Fundamental operating functions can be set in this System page.

[Initial Screen]
Screen number, which appears when the wrong data is set for PT control area
when PT is driven, is selected from the drop–down list box or keyboard input.  Nor-
mally, this setting is invalid since PT references PT control area for the initial
screen number when starting up.

The screen numbers of existing screen data are listed in the list box or only screen
number 1 is displayed if the screen data is newly created.
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[Backlight OFF]
Specify whether or not the backlight OFF function is used.

This option can be selected from System of PT Configuration in the Support Tool.
The Backlight OFF function automatically turns off the screen if the Support Tool is
not operated for a certain time period to save the backlight of PT.

If the check box is clicked to utilize the option, the time interval will be displayed in
the drop-down list box to set it. 
For details of the PT models which can use this function, refer to Appendix D “Sys-
tem Setting (PT Configuration)”.

[Resume Function]

The resume function holds the data in the tables when the PT is off or reset.

For details of the PT models which can use this function, refer to Appendix C “Sys-
tem setting (PT Configuration)”.

[History Setting]

This item specifies the method for processing when the Log memory of the alarm
history function and History screen function becomes full.

- Alarm (Use Ring Buffer):

Same meaning with FIFO (First In First Out)
Alarm FIFO system is applied for this function if the log memory area is full.
When new alarm occurs, the oldest record data will be deleted so that the new
data can be stored there.

If the Alarm function is not chosen, newly coming data is not acceptable to record
when the memory space is full.

- Screen (Use Ring Buffer):

Same meaning with FIFO (First In First Out).

When the new screen history occurred, the oldest record data will be deleted so
that new data can be stored there.  This is so called FIFO.  If this check box is not
ON, newly coming data is not acceptable to record when the memory space is
full.

Either the Alarm and the Screen data is available for the following PT models.

NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C, NT631, NT631C.
(For NT31, NT31C, NT631, NT631C, both Alarm and Screen settings are avail-
able.)

[Number of Table Entries]

Specify the number of numeral memory tables, character string memory tables
(String Table), and bit memory tables.

Setting of the Number of Table Entries is valid for the following PT models.

NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C, NT631, NT631C

[Buzzer] –[Enable]

Specify whether or not the buzzer function is used.

To use the buzzer function, click the check box to enter the check mark.  To set the
buzzer function to be unused, click the check box to clear the check mark.
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To sound the buzzer only at the occurrence of an alarm, specify [On Error] at the
drop-down list box.

If [Always] is selected for the buzzer function, the buzzer sounds at following
events.

� Occurrence of an error at PT

� Reception of a command from the host

� Screen switching

Setting of the buzzer function is valid for the following PT models.

NT30, NT30C, NT620S, NT620C, NT625C

Reference: With the NT31, NT31C, NT631, and NT631C, buzzer function settings are made
by system menu operation at the PT and setting from the Support Tool is not al-
lowed.

[Buzzer] – [Key Input]

Click the check box of [Key Input] to enter the check mark if you want to sound the
buzzer in response to the input from a touch switch or the extended I/O unit.  Clear
the check mark if the key input sound is not to be used.

[Printer for PT]

A printer can be connected to PT device for printing screen data if required.  You
have to specify the type of printer being used by the application for the following
PT models:

NT30, NT30C, NT620S, NT620C, NT625C

� Printer

Select one of the Supported printers from the printer drop-down list box.

Although this setting is possible for NT31, NT31C, NT631, NT631C, it is not valid
from Support Tool.

Please set from the Maintenance Mode of PT.

� Mode

Colour:

Specify “Colour” for color printing.

Designation of “Colour” is valid for the following PT models.

NT30C, NT620C, NT625C

� Tone:

Specify “Tone” for monochrome printing.

If a color type PT is used with “Tone” set for [Mode], color data is expressed using
a gray scale, printed in monochrome.

These setting are available for the following PT models.

NT30, NT30C, NT620S (Printer only), NT620C, NT625C

For NT31, NT31C, NT631, NT631C, this setting has to be selected from PT.
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[Numeral Storage Type]

BCD or Binary can be selected for the storage type of the Numeral memory table.
This setting is available only when the time the “Storage Type” in the Numeral
memory table has [System] setting.  When “BCD” or “Binary” is set for Numeral
memory table “Storage Type”, this setting in the PT Configuration will be ignored
and follows the storage type in the Numeral Table.

This setting is available for the following PT Model.

NT31, NT31C, NT631, NT631C

� Control/Notify Area page

The Control/Notify Area page is displayed when you click on the [Control/Notify
Area] tab.

The Control/Notify Area page is prepared to set the PT Control area, controlling
PT from PC (PLC) and for PT Notify Area, notifying PT information to a PC (PLC
and for window control area, controlling a window (NT31, NT31C, NT631,
NT631C with “–V1” only).

[PT Control Area]

[PC (PLC) Address]

Set the type of words at the PC (PLC) and the first address (word number) of the
area used as the PT status control area.

The PT status control area differs depending on the PT model and it occupies the
following number of words.

NT31, NT31C, NT631, NT631C: 5 words
Other models: 4 words

[Comments]

Set a comment concerning this area.

As a comment, up to 16 character can be set.
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[PT Notify Area]

[PC (PLC) Address]

Set the type of words at the PC (PLC) and the first address (word number) of the
area used as the PT status notify area.

The PT status notify area differs depending on the PT model and it occupies the
following number of words.

NT31, NT31C, NT631, NT631C: 2 words

Other models: 3 words

[Comments]

Set a comment concerning the area set as the PT status notify area.

As a comment, a character string of up to 16 characters can be set.

[Window Control Area]

[PC (PLC) Address]

Set the type of words at the PC (PLC) and the first address (word number) of the
area used as the window control area.

Window control area differs depending on the PT model and it occupies the fol-
lowing number of words.

NT31, NT31C, NT631, NT631C with “–V1”: 9 words

Other models: can not be used

[Comments]

Set a comment concerning the area set as the window control area.

As a comment, a character string of up to 16 characters can be set.

Note Set memory addresses so that the PT Control Area, PT Notify Area and Window
Control Area do not overlap.

� PC (PLC) Address dialog box

Clicking on the [Set] button in the [PT Control Area], [PT Notify Area] or [Window
Control Area] displays the PC (PLC) Address dialog box.

In the PC (PLC) Address dialog box, the PC (PLC) address of the PT status con-
trol area, the PT status notify area and the window control area can be set by
specifying the area type and address individually.  The setting made in the PC
(PLC) Address dialog box will be reflected on the setting made in the [PC (PLC)
Control Area], [PT Notify Area] or [Window Control Area].
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Use the PC (PLC) Address dialog box only when the area type and address are
input individually.  If the PC (PLC) address is directly input in the Control/Notify
Area page, it is not necessary to call this dialog box.
Example PLC Vendor : OMRON

[Channel]

Specify the type of PC (PLC) area which is used as a PT status control area, a PT
status notify area or a window control area by selecting an item from the drop-
down list box.

[Address]

Specify the first address (word number) of the PC (PLC) area which is to be used
as the PT status control area, PT status notify area and window control area.

[I/O Comments]

Set a comment concerning the area set as the PT status control area, a PT status
notify area or a window control area.

As a comment, a character string of up to 16 characters can be set.
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3-3-2 Reading the Existing Screen Data (Application) File
To read the screen data which is saved in a file, select [File] → [Open] from the
main window menu.

The dialog box which applicable folder, file name and files of type exist appears to
specify them.

NTST Application (*.onw)

After specifying the folder, file name, and file type click on the [Open] button.

The application manager of the read out screen data is displayed.

With NT–series Support Tool for Windows 95/98 (Ver. 3.2), following screen data
files can be handled.

onw

mmi

For details, refer to “File Types” in page 61

Reference:� Recent used files will be shown at the bottom of [File] menu.  Recent four files 
can be opened from this command.

� NT–series Support Tool for Windows 95/98 (Ver. 3) can read the screen data
which is created using NT–series Support Tool for Windows 95 (Ver. 2). Howev-
er, NT–series Support Tool for Windows 95 (Ver. 2) can not read the data created
using NT–series Support Tool for Windows 95/98 (Ver. 3.).

� With the Support Tool Ver.3.0, it is not possible to read out the files which were
saved in ONW format with the Support Tool Ver.3.11/Ver.3.12/Ver.3.2. If you
want to edit these files with the Support Tool Ver.3.0, save them in MMI format.
However, grid setting and group information will be lost with MMI format. 
Compatibility between ONW files of each Support Tool version is as follows.

ONW file saved with the Support Tool Ver.3.0 can be read with Ver.3.11 onward.
ONW file saved with the Support Tool Ver.3.11 onward can not be read with Ver.3.0
regardless of the PT models.
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3-3-3 Saving the Screen Data (Application) File
After creating the screen data, save it to a file.

The procedure for saving the screen data to a file is: [File] (main window menu) →
[Save], or [File] (main window menu) → [Save As].

[Save]:

The existing screen data of the opened file is overwritten by the new screen data.

If the file was opened using [New], the operation to be followed is the same as for
saving a file by selecting [Save As].

[Save As]:

The created or edited screen data is saved by specifying the folder and the file
name.

� File name setting dialog

If you select [Save] when creating new screen data or [Save As], the file name
setting window (Save As) opens.

NTST Application (*.onw)
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After inputting the folder and file name, click on : the screen data is
saved to the specified file.

If the file name of an existing file is specified, a message requesting confirmation
that the file is to be overwritten is displayed.

� File types

When saving files in file name setting dialog, either of following two file types can
be selected.

� NTST screen data (*.onw) format (onw format)
This is a standard file format for Support Tool.
Use this format to save screen data normally.

� Memory map image file (*.mmi) format (mmi format)
This is a file format to which screen data is compressed after deleting information
used only for Support Tool. (Data to be lost are grid setting and grouping informa-
tion.)
Use this format for purposes such as transferring screen data using FD.
It is advisable to save the same data with onw format also, since part of informa-
tion are lost with this format as mentioned above.

Once you saved data, specified file types will not be changed until you exit the Sup-
port Tool or perform saving/reading the onw file. (Data will be saved in the format
same as before when you select “Save” to save it.) If you want to change the file
type, select “Save As”.

Reference: � It is not possible to save data in DOS format.
However, with PT models other than NT31, NT31C, NT631, and NT631C,
uploading with DOS tool is possible after downloading it with Support Tool.

� With mmi file format, error check is executed before saving. By this error check,
data which can not be downloaded to PT will not be stored.

� With the Support Tool on CD–ROM, “NT Transfer Utility” which transmits mmi file
to the PT is supplied.
For details, refer to Appendix C “NT Transfer Utility”.
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3-3-4 Closing the Screen Data (Application) File
It is not possible to open two or more screen data files with one Support Tool. So
when you want to edit different screen data file, you need to close the currently
opened file, or start up the second Support Tool by [Import Component] command
from [file] menu. For details of “Import Component”, refer to 3–3–6 “Importing
Components from Different Screen Data File (Starting Up the Second Support
Tool)”.

To close application, select [Close] from [File] in the main window menu.

If the screen data (application) has not been saved, a message requesting con-
firmation of saving it is indicated/displayed.

If the file name is not set, the name setting dialog appears.  If
the file name has been already determined, the data will be
overwritten.

The screen data file closes without saving the screen data.

The file close operation is canceled.
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3-3-5 Importing (Reading) the DOS Version Screen Data (Application)
File

The Support Tool has a function for reading screen data files created using the pre-
vious DOS version Support Tool.  Note that although the DOS version screen data
files can be read, files cannot be saved in DOS format.

The procedure for reading a DOS version screen data file is: 
[File] (main window menu) → [Import].

For “Files of type”, select any of the following items according to the model of Sup-
port Tool used to create the screen data you are going to read.

� M1S: Screen data for NT11S

� M2S: Screen data for NT20S

� M6S: Screen data for NT600S

� G6S: Screen data for NT30, NT30C, NT620S, NT620C, and
NT625C

Click on  after selecting the folder and specifying the file name.

The application manager of the read screen data will be displayed.

Reference: For details of the PT models and types, the Support Tool can create screen data
for, refer to 1–6 “Usable Hardware Combinations”.
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3-3-6 Importing Components from Different Screen Data File (Starting
Up the Second Support Tool)

Select [Import Component] from [File] menu and you can start up the second Sup-
port Tool and open a different screen data file. By reading out the different screen
data files with the two Support Tools, data copying/pasting can be performed easily
between the files.

When you select [Import Component], dialog box to specify the file to be read is
displayed. (For details of this dialog, refer to “3–3–2 Reading the Existing Screen
Data (Application) File”.) 

After specifying the folder, file name and file type, click on . The sec-
ond Support Tool starts up and the application manager of the read out screen data
is displayed.

Reference: � It is not possible to start up the second Support Tool from the [Start] button of
Windows (Error message will be displayed). Be sure to select [Import Compo-
nent] from [File] menu in the main window of the first Support Tool.

� Copy/paste operation can not be performed between the two files if the PT model
of the two files is different. In this case, perform data conversion beforehand so
that the PT model setting of the copy source screen data matches to the setting
of the copy destination screen data. (Selected PT model can be checked on the
status bar.)

� It is not possible to edit the same screen data file by two Support Tools. If you try
to read out the file which is already opened by the other Support Tool, error mes-
sage will be displayed.

� The second Support Tool can read out the screen data file regardless of the file
types (onw, mmi).

� When the second Support Tool is started, the windows of both Support Tools are
automatically resized into normal windows which overlap each other to facilitate
the copy operation between the files.

� It is not possible to open one more Support Tool when two Support Tools are al-
ready started.
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� [Import Component] will not be displayed in [File] menu when no screen data is
opened with the Support Tool.

� Conversion of PLC address is executed when the PLC vendor (direct access) is
different between the copy source/destination screen data.

� Conversion of key code is executed when the key code (font type) is different
between the copy source/destination screen data.

� In case of numeral/string table and bit memory table, if the table size of copy des-
tination is smaller than the size of copy source, excessive entries will be dis-
carded.

� To achieve higher performance , close the second Support Tool after you com-
pleted import operation.

� It may take time to read out MMI file since data checking is performed before
opening the file.

Possible Operation between Two Support Tools

While screen data files of the same PT model are opened with the two Support
Tools, following operations are possible.

a. Copying, cutting, pasting and drag&drop of a screen between application man-
agers (multiple screens can be also handled). (Refer to 4–2–4) 

b. Copying, cutting, pasting and drag&drop of a table data between application
managers (All the data in a table is handled, it is possible to handle a table indi-
vidually or to handle multiple tables collectively.) (Refer to 4–2–9)
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c. Copying, cutting, pasting of a number/code between the following tables
(Drag&drop is not possible).
Between image tables (Refer to 8–1–1)
Between library tables (Refer to 8–2–1)
Between bit memory tables (Refer to 7–1–4)
Between numeral tables (Refer to 7–1–4)
Between string tables (Refer to 7–1–4)
Between extended I/O output tables (Refer to 7–1–4)
Between extended I/O input tables (Refer to 7–1–4)

d. Copying, cutting, pasting and drag&drop of objects between editing screens or
library editors. (Drag&drop can not be performed if the copy destination window
is hidden under other windows.) (Refer to 6–1–5)

e. Copying, cutting, pasting of the specified area between image editors or mark
editors (Drag&drop is not possible). (Refer to 8–1–2, 8–3–2)
 

These operating procedures are same as normal operations of copy, cut, paste
and drag&drop on one Support Tool.



67

Operation of Screen Data (Application) File Section 3-3

Copying/Pasting an Object Which Contains Image/Library Data

Even if a screen or an object which contains image/library data is pasted onto a
different screen data file, image/library data itself is not copied.
If you want to copy/paste an object which contains image/library data between
screen data files, you need to copy the image/library data referenced by the object
beforehand.

Ex: Copying/pasting a fixed–display image which references image code 0001
while the contents of the code are different between the screen data files

As shown above, image data to be displayed will vary even if both objects are refer-
encing the same code, when the contents of the referenced image code are differ-
ent between the screen data files. (When no data is registered to the referenced
code,   is displayed. )
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3-3-7 Using Method of Parts Collection
With the Support Tool on CD–ROM, Parts Collection is supplied. 
In this section, using method of Parts Collection is described.

Parts Collection

Lamps and touch switches will be graphical and expressive parts when they are
combined with image/library data or image lamps. These graphical lamps and
touch switches are registered to the Parts Collection (Parts Collection for each PT
model is provided). 
Using [Import Component] command, desired data can be copied/pasted from
Parts Collection to the editing screen easily.

Reference: � Parts Collection is supplied only for the Support Tool on CD–ROM. It can be
installed by specifying “Sample Collection” when installing the Support Tool.

� Parts Collection for NT11S, NT20S and NT600S is not supplied.

� Parts Collection is created in MMI format. It may take time to read out/save MMI
file.

Operation Procedure

To use the Parts Collection, follow the procedure below.
Here, operations such as copying, pasting, drag&drop are not described in details.
Please refer to 8–1, 8–2 and 6–1–5.

(1) Open the screen data file to which you want to paste data from Parts Collection.

(2) Select [Import Component] from [File] menu.

(3) Dialog box to specify the file to be opened is displayed. Open the “Sample
Collection” folder in a folder which Support Tool has been installed into. Then,
open the folder of the required PT model (see below). Select “Memory Map
Image File (*.mmi)” as a file type.
Parts Collection for each PT model is displayed. Specify the Parts Collection of
the PT model same as the currently opened screen data file and click on

. 

Second Support Tool starts up and the selected Parts Collection opens.

(4) In the screen data file of Parts Collection, decide an object which you want to
import.
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(5) If the object contains image/library data, the image/library data should be cop-
ied between image/library tables beforehand by copy/paste operation. Follow
the procedure below. 
Code number to be copied can be checked in the property of an object. (Refer-
enced image/library code is also displayed on the status bar for some object
when they are selected.) 
If image/library copying is not performed beforehand, display will not be as in-
tended since the image/library allocated to the code is not copied even if the
object itself is copied.

[Procedure]

a. Open the property of an image lamp or image/library data to be imported and
check the referenced image/library code.

b. Select [Image Editor] or [Library Editor] from [Tools] menu and copy ([Edit] –
[Copy]) the code to be imported on the image/library table.

c. Open the image/library table of the screen data file of copy destination and
paste the image/library data which has been copied.
This time, if the copy destination code number is different from the copy source
code number, display will not be correct when the object is pasted. Register the
same code number as copy source by pressing  button.

(6) Drag&drop the object which you want to import from the screen data file of Parts
Collection to the screen data file of copy destination ([Copy], [Paste] in [Edit]
menu can be used also).
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SECTION  4
Application Manager

This section shows how the application manager is used when checking the created data, copying screen data, setting a memory
table, operating a window.
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4-1 What Is the Application Manager?
A screen data (application) file holds a variety of data.  The application manager is
a data management tool used for managing the various types of screen data.

Since the application manager displays the data in tree style, you can check the
created data or read the necessary data easily.

(The number and type of screens and tables displayed in the application manager
vary according to the setting made for [PT Model] of [PT Type] in the PT configura-
tion.  Bit map shown above is in case of NT31, NT31C, NT631 and NT631C.)

The application manager provides following operations:

� Opening a data creation screen

� Creation of new application

� Copying a screen

� Deleting a screen

� Displaying and setting PT configuration

� Displaying and setting screen properties

� Editing tables

� Saving the created data to a file

� Sending (downloading) the created data to a PT

Icons used by the application manager

 App 1: Name of application folder

When a file name has been specified, the file name specified by App 1 is used.

Double clicking of this icon opens a set of sub-data box by screen type.

 screen: Screen data box

Double clicking of this icon displays the screen data boxes classified by group.

 table: Table data box

Double clicking of this icon shows memory tables classified by icon.
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 1-1899.2000 (Standard): Screen data boxes classified by screen type

1-1899.2000: Indicates a screen number.

Standard: Indicates screen type.

Double-clicking of this icon displays the screen icons in a group.

The screen number and screen type displayed here differ from PT models.

: Screen icon

1: Indicates a screen number.

Double clicking of this icon opens a data creation screen.

 numeral memory table: Table data icon

Numeral memory table: Indicates a table type.

Double clicking of this icon opens a memory table dialog box setting.

The type of table to be displayed differs depending on the PT model.

When you click on [�], displayed to the left of a  icon, icons existing under the
clicked icon are displayed.  Clicking on [−] hides these icons.
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4-2 Operating the Application Manager
The procedure for operating and setting the data using the application manager is
shown below.

Two types of operations - mouse operation and menu operation - are possible.  For
the menu driven operation, short-cut keys (keys used to call menu functions) may
be used instead of displaying the menu.

4-2-1 Opening a Data Creation Screen
The procedure for opening a creation screen of existing data is shown below.

Operation using the mouse (1)

(1) Double click the screen icon.

Operation using the mouse (2)

(1) Click the right mouse button at the screen icon.

(2) Select [Open].

4-2-2 Closing a Creation Screen
The procedure for closing a creation screen is shown below.

Operation using the mouse

(1) Click  at the upper right corner in the data creation screen.

4-2-3 Creating a New Screen
The procedure for opening a new screen is shown below.

Operation using the mouse

(1) Click the screen data box icon, or right click the mouse on the screen data box
(classified by group).

(2) Select [New], choose the screen type, then click on .

(3) Input a screen number and a comment, then click on .

Operation using the menu

(1) Select [New] from [Screen] in the menu bar.

(2) Select the screen type, then click on .

(3) Input a screen number and a comment, then click on .
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4-2-4 Copying a Screen
The procedure for copying an existing screen to another screen number is shown
below.

Reference: The operations shown below can be performed between different screen data files
of the same PT model by starting up two Support Tools. For details, refer to 3–3–6.

Operation using the mouse (1)

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected screen icon, then select
[Copy].

(3) Click right button of the mouse on one of the screen icon, then select [Paste].

(4) Input a screen number, then click on .

The screen number of the copy source screen is displayed as a duplicated
number, and in the new screen number field, the smallest number of the avail-
able screen numbers is displayed.

If you input an existing screen number, a confirmation message is displayed to
overwrite it.

Operation using the mouse (2)

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Drag the selected screen icon in the screen icon display area.

(3) Input a screen number, then click on .

The screen number of the copy source screen is displayed as a duplicated
number, and in the new screen number field, the smallest number of the avail-
able screen numbers is displayed.

If you input an existing screen number, a confirmation message is displayed to
overwrite it.

Operation using the menu

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Select [Copy] from [Edit] in the menu bar.

(3) Then select [Paste] from [Edit] in the menu bar.

(4) Input a screen number, then click on .

The screen number of the copy source screen is displayed as a duplicated
number, and in the new screen number field, the smallest number of the avail-
able screen numbers is displayed.

If you input an existing screen number, a confirmation message is displayed to
overwrite it.
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4-2-5 Deleting a Screen
The procedure for deleting a created screen is shown below.

Operation using the mouse

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected screen icon, then choose
[Delete].

The message requesting your confirmation is displayed.

Operation using the menu

(1) Specify the screen icon.

Multiple screen icons can be selected by dragging the mouse cursor while
pressing the Shift key or Ctrl key.

(2) Select [Delete] from [Edit] in the menu bar.

A message requesting your confirmation is displayed.

4-2-6 Displaying and Setting the PT configuration
The procedure for displaying the PT configuration dialog box is shown below.

For details, refer to “Dialog Box Setting in the PT Configuration. (P52).

Operation using the mouse

(1) Click right button of the mouse on the screen data (application) file icon, then
select [Setup].

Operation using the menu

(1) Select [PT Configuration] from [Tools] in the menu bar.

4-2-7 Displaying and Setting Screen Properties
The procedure for displaying the property setting dialog box is shown below.

For details, refer to 5–1 “Types of Screens, Common Dialog Box Settings and Op-
erations”.

Operation using the mouse

(1) Click right button of the mouse on the screen data file icon, then select
[Properties].

Operation using the menu

(1) Select the screen icon.

(2) Select [Properties] from [Screen] in the menu bar.

Reference: The following operations can also display the screen property setting dialog box.

� Click right button of the mouse on the editing screen where no objects are regis-
tered, then select [Properties].

� Double click on the editing screen where no objects are registered.
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4-2-8 Editing a Table
The procedure for displaying the table setting dialog box is shown below.

For details, refer to Section 7 “Memory Table Setting” or section 8 “Editing Graphic
Data”.

Operation using the mouse (1)

(1) Double click the icon of the table data to be edited.

Operation using the mouse (2)

(1) Make a right click on the icon of the table data to be edited, then select
[Modify].

Operation using the menu

(1) Select [Tools] in the menu bar, then choose [Table], [Image Editor], [Library
Editor] or [Mark Editor].

(2) If [Table] is chosen, select the tab of the table to be edited.

4-2-9 Copying the Whole Table
The whole table can be copied between the screen data files of the same PT model
by starting up two Support Tools.

Caution: Copying of tables, screens and objects between two screen data files involves
addition or overwriting of PLC address. Please check the movement sufficiently
before shifting to actual operation.

Reference: � To start up second Support Tool, select [Import Component] from [File] menu,
For details, refer to 3–3–6.

� If the whole table is copied, all the contents in the specified table are copied col-
lectively. For method to copy the individual data in a table, refer to section 7
“Memory Table Setting” or section 8 “Editing Graphic Data”.

� Check box for “Overwrite PLC Address” appears when copying the whole table
indicated below. If this check box is checked, PLC address setting is overwritten.
If not checked, settings such as initial value will be overwritten but the PLC ad-
dress setting remains the same. Note that I/O comments are not copied even if
the PLC address is overwritten. If you need the same I/O comment, copy the I/O
comment.
Bit memory table, Extended I/O output table, Numeral table, String table, F–Key
input notify table

Operation using the mouse (1)

(1) Specify the table data icon.
Multiple tables can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Click right button of the mouse on the selected table data icon, then select
[Copy].

(3) Click right button of the mouse on the desired table in the table data icon dis-
play area of another Support Tool, then select [Paste].
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(4) In the confirmation dialog box, click on . If check box for “Overwrite
PLC Address” appeared in the dialog box, make the setting as required.

Operation using the mouse (2)

(1) Specify the table data icon.
Multiple tables can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Drag the selected table data icon to the table data icon display area of another
Support Tool.

(3) In the confirmation dialog box, click on . If check box for “Overwrite
PLC Address” appeared in the dialog box, make the setting as required.

Operation using the menu

(1) Specify the table data icon.
Multiple tables can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Select [Copy] from [Edit] in the menu bar.

(3) Then select [Paste] from [Edit] in the menu bar of another Support Tool.

(4) In the confirmation dialog box, click on . If check box for “Overwrite
PLC Address” appeared in the dialog box, make the setting as required.

4-2-10 Saving the Screen Data (Application) to a File
The procedure for saving the screen data to a file is shown below.

For details, refer to 3–3–3 “Saving the Screen Data (Application ) File.”

Please save frequently.  Support Tool will not save automatically.

Operation using the mouse

(1) Click right button of the mouse on the screen data file icon, then select [Save]
or [Save As].

If you select [Save] for a file other than a new file, the saving operation starts
immediately without prompting dialog box.

(2) Specify the folder and file name of the destination and click on .

If you specify an existing file, a message requesting your confirmation is dis-
played if it is overwritten.

Operation using the menu

(1) Select [File] in the menu bar, then choose [Save] or [Save As].

If you select [Save] for a file other than a new file, the saving operation starts
immediately without prompting dialog box.

(2) Specify the folder and file name of the destination and click on .

If you specify an existing file, a message requesting your confirmation is dis-
played if overwriting should be done.
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4-2-11 Error Check (Validation)
The Support Tool has a function to check the data such as limitations of screen
elements, PC (PLC) address assignments in order to forbid the mistook data to be
downloaded.  This is called “Validation”.

The following three validation functions are provided:

� Validation performed on real time

The Support Tool provides real time validation while users are creating data.
This function mainly checks the elements one by one.  Moreover, maximum
number of elements and memory size will be also watched.

� Validation performed from [Tools] menu → [Validate]

It is also possible to perform the Validation by [Tools] menu → [Validate].

By the check, Support Tool will detect the contradiction in the screen (applica-
tion) data including association between touch switches and the elements and
so on.

This check will be also performed at the beginning of the download process to
prohibit the wrong data to be downloaded.

� Validation during the data conversion and importing DOS data file

Validation will be also performed when converting the screen data (application)
from a current model to another model and when importing the DOS data file.
Data conversion will be also performed when the registered symbol data from
the Symbol Manager which was created by a certain PT model, has been
dragged and dropped to the another PT model screen.  So at this time validation
will be also performed.

Reference: Validation will be also performed when saving the screen data in mmi format.

Executing the Validation

� Validating the current focused screen

Under condition which the screen you want to validate is opened and select [Vali-
date] from [Tools] menu.

� Validating the whole screen data (application) file

(1) Right after performing the screen validation mentioned above, choose [Vali-
date] from [Tools] menu again.  Confirmation dialog box arrives.

(2) Click .  Then the validation will start.

During the validation, it is not possible to perform other operation.

After the validation has been completed the result message arrives.

Reference: � Please execute the validation after the creation of screen data (application).

� Validation might need a sufficient time period in case the screen data (applica-
tion) itself has large size and validation for the whole data has been executed.
So when the time “Validating for the whole data” has been performed, the con-
firmation dialog box appears asking whether you want to perform the validation
or not.  Click  to start the validation.
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Displaying the error log and its location

If the error check function detects an error, a brief error message is displayed and
you are requested to confirm the “error log”.

Reference: � The messages contents of the error log are cleared when an element or a screen
is operated.  Therefore, if an error is detected, display the error log window im-
mediately to determine the details of the error.  Since errors occurring during
data conversion, in particular, may not reoccur if you try to check them later, they
must be checked at their occurrence.

� The results of the error check can be printed or saved in a file.  For details, refer to
Section 12 “Making Reports”.

The procedure for displaying the error log window is shown below.

(1) Select [View] in the menu bar, then choose [Error Log].

The error log window opens.

With some types of errors, double-clicking on the error message will display the
screen(s) where the error has occurred.

For the meaning of error message and the solution to be taken to correct the error,
refer to Appendix A “Data Conversion” and Appendix G “Error Messages”.
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4-2-12 Sending (Downloading) the Data to a PT
The data created using the Support Tool can be sent (downloaded) to a PT.  It is
possible to send the screen data collectively or only the data of the specified
screens or memory tables.  Here, only the procedure is described.  For details, re-
fer to 11–3 “Sending (Downloading) the Data”.

Before sending the data, set the communication conditions (communication port
and communication speed [Baud Rate]) by selecting [Connect] (menu bar) and
[Comms. Setting].

Operation using the mouse

� Sending (Downloading) the whole data file

(1) Right click the mouse on the screen data file icon, then select [Download].

If the screen data is free of errors, sending of the data starts immediately.  
A message is displayed if the data has an error.

� Sending (Downloading) specified screen

(1) Specify the screen icon.

Multiple files can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Make a right click on the selected screen icon, then choose [Download].

(3) Specify if child screens of continuous/overlapping screens are also to be
sent, then click on .

If the screen data is free of errors, transmitting of the data starts immediate-
ly.  
A message will be displayed if the data has an error.

� Sending (Downloading) specified Table

(1) Right click the mouse on the table data box icon, then select [Download].

The dialog box used for specifying the table to be sent (downloaded) is dis-
played for PTs which allow table data to be sent in table individually.  With
PTs which do not allow table data to be sent table by table, sending of the
data starts immediately.

(2) Specify the table to be sent (downloaded), then click on .

Reference: It is not possible to send (download) the direct access information or system
memory individually.  Please use the menu operation.
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Operation using the menu

� Sending (Downloading) the whole data file

(1) Select [Connect] in the menu bar, then choose [Download (NT-series Sup-
port Tool → PT)] → [Application].

If the screen data is free of errors, sending of the data starts immediately.  
A message is displayed if the data has an error.

� Sending (Downloading) specified screen

(1) Specify the screen icon.

Multiple files can be selected by dragging the mouse cursor while pressing
the Shift key or Ctrl key.

(2) Select [Connect] in the menu bar, then choose [Download (NT-series
Support Tool → PT)] → [Screen].

(3) Specify if child screens of continuous/overlapping screen are also to be
sent, then click on .

If the screen data is free of errors, sending of the data starts immediately.  
A message is displayed if the data has an error.

� Sending (Downloading) specified Tables

(1) Select [Connect] in the menu bar, then choose [Download (NT-series
Support Tool → PT)] → [Table].

The dialog box used for specifying the table to be sent is displayed for PTs
which allow table data to be sent in table units.  With PTs which do not allow
table data to be sent table by table, sending of the data starts immediately.

(2) Specify the table to be sent, then click on .

� Sending the Direct Access Information and system memory

(1) Select [Connect] in the menu bar, then choose [Download (NT-series
Support Tool → PT)] → [Direct Access Information] or [System Memory].

If the setting is free of errors, sending of the data starts immediately.  A mes-
sage is displayed if the data has an error.
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4-2-13 [Window] Menu
The following Support Tool operations are possible using the [Window] menu.

� Opening a new window for the data creation screen which is active

� Arranging windows

� Switching windows

Reference: The Support Tool can operate windows in the same manner as other Windows
95/98 applications.  Here, only the functions which can be selected from the Sup-
port Tool menu are explained.

Opening a new window

To open a new window for the data creation screen which is active, follow the pro-
cedure described below.

Reference 1. Windows with the same screen number display the same contents.

2. When the same screen is displayed in two windows, elements can be copied
between the windows by dragging them while pressing the Ctrl key.  Usually,
copying an element to a desired position in the same screen is not possible.
However, if two same windows are opened, it is possible to copy an element to
a desired position although they are on the same screen.
(Similarly, if different screen data files of the same PT model are opened by two
Support Tools, it is possible to copy screen data between the files.)

3. When multiple windows which have the same screen number exist, the follow-
ing information is displayed in the window title area (for standard screens).

x Standard Screen: y

(x: Screen number, y: Serial number)

Serial numbers will be assigned in the order the windows are opened.  If any
window presently opened is closed, the serial numbers are renumbered auto-
matically.

4. The Support Tool can open up to ten windows at the same time in addition to
the application manager window.

� Operation

(1) Specify the screen.

Click on the screen or double-click on the screen icon to open multi-
windows.

(2) Select [New Window] from [Window] in the menu bar.

An additional window opens for the screen specified in step (1).
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Arranging windows

Windows can be arranged in any of the following three ways.

Cascade:

All windows are cascaded in such a way that window titles are visible.  All win-
dows are displayed at the same size.

The order of cascading differs depending on the display position of the win-
dows before the cascading operation is attempted.

Tile:

All windows are arranged over the entire main window area at the same size.
However, the sizes may differ slightly, depending on the number of windows.

The order of tiling differs depending on the display position of windows before
tiling operation is attempted.

Arrange Icons:

The application manager and creation screens shown in icon form are ar-
ranged in the lower left part of the main window.

The order in which the icons are displayed differs depending on the display
position of the icons before the “arrange icons” operation was attempted.

� Operation

(1) Select [Window] in the menu bar, then choose [Cascade], [Tile], or [Arrange
Icons].

The windows are arranged according to the selected item.

Switching windows

Under the [Window] menu, up to nine windows which are open are displayed in a
list.

If the number of windows is ten or more, the [More windows...] item is displayed.
The window selection dialog box opens when this item is selected.

Users can activate the particular screen to edit from [Window] in the main menu or
selecting from window selection dialog box of [More windows...].

This feature brings simple operation to edit data of veiled screen.
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4-2-14 [Help] Menu
The [Help] menu includes the following items.

� Contents

� Search for Help on

� What’s This?

� PLC Address Help

� About NT-series Support Tool

Displaying help information using the table of contents

The help information of the Support Tool is constructed so that the functions can be
tracked according to the menu configuration.  To display help on a specific func-
tion, display the table of contents of the help information and find help on the rele-
vant function.

� Operation

(1) Select [Help] in the menu bar, then select [Contents].

The table of contents of help is displayed.

(2) Select an item to display the corresponding help contents.

In the information displayed in the help screen, items which have a link to
detailed help information are underlined; click on such an item to access the
detailed information.

The necessary information will be reached by tracking the items in this way.

Reference: The  button or F1 key is also used to display the table of contents for help

information.

Displaying help information by searching for a keyword

Help information on a specific topic can be displayed by inputting the related key-
word.

� Operation

(1) Select [Help] in the menu bar, then select [Search for Help on].

The topic search dialog box is displayed.

(2) Input a keyword.

When the keyword is input, the corresponding help item is highlighted.

(3) If you find the specified help item, click on .

The help information relating to the specified item is displayed.
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Displaying help information by clicking on a screen

The Support Tool provides the [What’s This?] item which allows you to get help
when an item for which you need help is displayed.

Using this feature, you can display the help information in a simple operation with-
out tracking the table of contents or inputting a keyword.

� Operation

(1) Select [Help] in the menu bar, then select [What’s This?].

A question mark “?” is appended to the mouse cursor.

Clicking on  in the standard tool bar, also displays a question mark at the

mouse cursor.

(2) Click on the item (place) for which you need help.

The corresponding help information is displayed.

Checking the input method of PLC address

PLC address dialog box is displayed when an address or channel is allocated to an
object.
If [PLC Address Help] is selected in the [Help] menu, the help about the PLC ad-
dress dialog box that shows the input method of PLC address is displayed.

Checking the Support Tool version

If [About NT-series Support Tool] is selected in the [Help] menu, the dialog box that
shows the version of the Support Tool is displayed.

If you have questions on the Support Tool, please check the version of your Sup-
port Tool before contacting.



87
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Screen Types

This section deals with the types of screens which can be created by the Support Tool.
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5-1 Types of Screens, Common Dialog Box Settings and 
Operations

The Support Tool provides various types of screen.

The screens which can be created using the Support Tool are shown below.  The
screens that can be used differ depending on the PT model.

� Standard screen

� Continuous/overlapping screen

� Window/Keyboard screen

� Extended screen

� Occurrence history screen

� Frequency history screen

� Host connect screen (system initializing screen)

The screen attributes and grid can be set for each screen, individually.

� Password screen

� Menu screen

� Print format screen
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5-1-1 Setting the Screen Attributes
All screens have screen attributes used for setting the screen display specifica-
tions.

The information to be set as attributes, specific to the individual screens, includes
screen number, screen comment, recording in display history, backlight, and buzz-
er control.

To display the attributes, follow any of the operations indicated below.

� [Screen] (menu bar) → [Properties]

� Right click on a screen data icon in the application manager → [Properties]

� Right click at an arbitrary position on the screen → [Properties]

� Double click at an arbitrary position on the screen

Screen No.

Specify a screen number.  The screen number of an existing screen may be
changed.

History (other than NT20S)

Specify whether or not the event of screen display is to be recorded in the display
history record (Screen history Log).  The display history function records the date/
time and frequency of screen display for screens for which the [History] attribute
check box is ticked.  The recorded display history can be checked on the occur-
rence history screen and the frequency history screen.

The event of screen display is recorded in the display history if the check box of the
history attribute is ticked; if it is not ticked, the event is not recorded.

Title (other than NT20S)

Specify the title of screens which are displayed in the display history.

Setting of the title is possible only when the history attribute is selected.
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Comment

Set the comment for a screen.  For the comment, characters of up to 24 characters
can be set.

Backlight - Type

Set if the backlight is to light continuously or flash when the screen is turned on.

Light: When the screen is turned on, the backlight lights.

Flash: When the screen is turned on, the backlight flashes.

This attributes cannot be set for NT600S, NT620S, NT620C, NT625C.

Backlight - Colour (only for NT30)

Specify the backlight color, white or red.

Buzzer (other than NT11S)

Specify whether or not the buzzer should sound when a screen is displayed and
also the type of buzzer sound.

If this attribute is selected, the buzzer sounds when a screen is displayed.

The buzzer type can be selected from the following.

Continuous: The buzzer sounds continuously.

Short: The buzzer sounds in cycles of 0.5-second beep and 
0.5-second stop.  (Setting is not possible for NT20S and
NT600S.)

Long: The buzzer sounds in cycles of 1-second beep and 1-second
stop.  (Setting is not possible for NT20S and NT600S.)

Beep: The buzzer sounds in cycles of 0.5-second beep and 
0.5-second stop.  (Only for NT20S and NT600S)

Buzzer type setting is possible only when the buzzer attribute is selected.

Load Local 1 (Keyboard) (other than NT11S, NT20S and NT600S)

Select whether or not a local window 1 (Keyboard) pops up on the screen when
standard screen is opened.

If the attribute is checked, a window (keyboard) pops up when the screen is dis-
played.  Window (keyboard) does not pop up if the attribute is not selected.  If the
attribute is not set when the standard screen is created, it can be selected later to
display.

Specify the screen number of window/keyboard screen to be displayed as a pop-
up window/keyboard.

Window (Keyboard) will be displayed at the position specified when window/key-
board screen was created.

With NT30, NT30C, NT620S, NT620C, NT625C, and NT31, NT31C, NT631,
NT631C without “-V1”, window is called “keyboard window” since it is used to place
keypad (touch switch) for inputting numeral/string.
With NT31, NT31C, NT631 and NT631C with “-V1”, it is simply called “window”
since all kinds of objects other than thumbwheel can be registered on it.  For details
of window/keyboard screen, refer to 5-4 “ Window/Keyboard Screen”.



91

Types of Screens, Common Dialog Box Settings and Operations Section 5-1

Load Local 2 (NT31, NT31C, NT631, NT631C with “-V1” only)

Select whether or not a local window 2 pops up on the screen when standard
screen is opened.

If the attribute is checked, window pops up when the screen is displayed.  Window
does not pop up if the attribute is not selected.  If the attribute is not set when the
standard screen is created, it can be selected later to display.

Specify the screen number of window screen to be displayed as a pop–up window.

Window is displayed at the position specified when window/keyboard screen was
created.
For details of window/keyboard screen refer to 5-4 “Window/Keyboard Screen”.

System Keypad (other than NT11S, NT31, NT31C, NT631 and NT631C)

Specify whether or not the keypad which is automatically created by the system is
used for setting numerals or strings.

If the attribute is selected, the system keypad is used and it is not used if the attrib-
ute is not selected.

Colour - Background (NT30, NT30C, NT31C, NT620C, NT625C, NT631C)

Set the background color.

5-1-2 Grid Setting
Specify the grid used for drawing.

The grid is used as the guide when drawing an element.  When the grid is selected,
dots are set in the specified spacing.

The grid can be set so that the specified points of an element being drawn are posi-
tioned at grid points.

To display the attributes, follow any of the operations indicated below.

� [Attributes] of screen property → 

� [Screen] (menu bar) → 

Grid Size - Custom

Set the grid spacing in the horizontal and vertical directions to create the grid of the
desired spacing, respectively.

Horizontal Spacing: Specify the grid spacing in the horizontal direction as a
number of dots.

Vertical Spacing: Specify the grid spacing in the vertical direction as a
number of dots.
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Grid Size - Touch Switch Grid

If this attribute is selected, grid spacing equivalent to the size of a touch switch is
set.  The actual size differs depending on the PT model.

Display Grid

Specify whether or not the grid is displayed.

To display the grid, tick the check box of this attribute.  If you want not to display the
grid, cancel the tick in the check box.

Snap to Grid

Specify if the specified position of an element being drawn is automatically ad-
justed so that it coincides with a grid position.

To adjust the element position, tick the check box of this attribute.  If adjustment is
not necessary, cancel the tick in the check box.

Reference: � When saving screen data using mmi format, grid setting information and group-
ing information will not be stored.
(Refer to 3–3–3 “Saving the Screen Data (Application) File”.)

� It is possible to select whether to print screen grid or not when printing screen
image. (Refer to 12–2–2)
If grid is to be printed, the grid setting of each screen will be included in the screen
image.

5-1-3 Changing the Display Method on the Support Tool
The procedures for changing the screen display method and displaying the infor-
mation on elements are indicated below.

Reference: In addition to the display methods indicated below, Support Tool has a “filter func-
tion” which displays only the elements of the selected type. (Refer to 5–1–4)

Confirming full tiling status

When [Full Tiling] is selected in the [View] menu with a tick mark entered on the left
side of the menu item, the element is displayed on the Support Tool screen in the
tiled status.

Reference: � There may be differences in element display order and details in display be-
tween the Support Tool and a PT.  Therefore, results of tiling may be different in
the display obtained at a PT and that confirmed by the Support Tool.

� When a filter function is used for “fixed display”, Full Tiling will be automatically
cancelled (comfirmation message will be displayed) since the tiled status may
not be displayed correctly if the object used as a border is hidden by a filter func-
tion.
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Displaying element information (Show Tag)

The Support Tool can display the following element information on the screen at
the same time.

Information Displayed
on the Screen Description

PC (PLC) address PC (PLC) bit addresses of lamp settings (light func-
tion) for lamps, PC (PLC) addresses of lamp set-
tings for touch switches, or PC (PLC) addresses of
notification (notify) bits are displayed.

For a touch switch with the notification bit function,
both PC (PLC) address of the notification (notify) bit
and lamp setting are displayed (upper: notify bit,
lower: lamp bit), and for touch switches with other
functions, the PC (PLC) addresses of lamp settings
(light function) are displayed.

The first character represents the type of element
as shown below. (In case of touch switch, the first
character for lamp bit is also represented by “T”.)

L: Lamp

T: Touch switch

The second character represents the area type of
PC (PLC) addresses.

Example (PLC Vendor: OMRON)

Blank: CIO area (relay)

H: Holding relay

A: Special auxiliary relay (auxiliary relay)

L: Link relay

D: DM (Data Memory) area

E: EM Current Bank

For characters which indicates area type of Mitsu-
bishi, refer to page 134.

Table No. The table number of the numeral or Character
String Memory Table (String Table) which is refer-
enced for a numeral display, (character-)string dis-
play, bar graph, numeral setting input, (charac-
ter-)string input, or thumbwheel switch is displayed.

The first character represents the type of table as
shown below.

N: Numeral memory table

S: Character  String Memory Table 
(String Table)

Image and library code The code of image and library data of fixed displays
is displayed as a hexadecimal number.
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Multiple sets of the element information described above can be displayed at the
same time.  If they are set for a single element, the information is displayed accord-
ing to the priority shown below.

PC (PLC) address � Table number � Image and library data code

Setting for the display of element information is possible for all the editing screens.

The display method for element information is set in the manner shown below.

(1) Select [View] in the menu bar, then choose [Show Tag].

The menu shows the items which can be set.

The items for which “display” is presently set are identified by a tick.

(2) Select any of [PLC Address], [Table No.], and [Image and Library Code] to
change whether element information should be displayed or not.

Each time a menu item is selected, the tick mark is set, or canceled, alternate-
ly.  When a tick mark is displayed, the specified element information is dis-
played.

Inversing and flashing the objects

Some of the objects have “Inverse”, “Flash” and “Inverse Flash” attribute.
”Inverse” status is always reflected on the screen.
”Flash” display can be checked by specifying the “Simulate Flash” command. (It is
possible to view “Inverse Flash” state also.)
”Simulate Flash” is applied to each screen individually.
To activate this setting, follow the procedure below.

(1) Select “Simulate Flash” from “View” menu. (or click on the  /  button.)

In the [View] menu, the check mark is set to ON and OFF each time it is se-
lected.
When the check mark is displayed, the objects which have “Flash” or “Inverse
Flash” attribute show their flashing statuses.
Each time the “Simulate Flash” button is clicked, it changes as follows.

 : Flash status being showed

 : Flash status not showed
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Lighting and flashing the lamps/touch switches

For lamps and touch switches, it is possible to specify PLC address for lamp set-
ting. Lamps and touch switches light (flash) according to the status of the host bit.
When the PLC address for lamp setting goes to 1 (ON), they light or flash. (Wheth-
er they light or flash is determined by the “lamp attribute” set to the object.) 
With the Support Tool, ON status of lamps and touch switches can be checked on
the screen. 
“Simulate ON/OFF” setting is applied to all the screens being displayed.

Reference: � In case of image lamp, ON state image and dotted line indicating the position of
OFF state image is shown when the state is ON, and OFF state image and dotted
line indicating the position of ON state image is shown when the state is OFF.

� Display of lamp ON/OFF status may differs between the Support Tool and PT for
the following cases.

� ON color when lamps/touch switches are overlapped.
� ON color of lamp/touch switch label when using NT30C, NT620C/NT625C.
� ON status of lamp/touch switch when overlapping with other object (other than 
   fixed display)

To activate this setting, follow the procedure below.

(1) Select [Simulate ON/OFF] from [View] menu. (or click on the  /  button)

In the [View] menu, the check mark is set to ON and OFF each time it is se-
lected.
When the check mark is displayed, the lamps and touch switches show their
ON statuses.
Each time the “Simulate ON/OFF” button is clicked, it changes as follows.

 : Lamp ON status being showed

 : Lamp ON status not showed

Redrawing the editing Screen (Refresh)

In case the screen has disrupted during the edition of the screen, “Refresh” func-
tion will help you redrawing the screen.

Redrawing can be performed as follows.

(1) Select [Refresh] from the [View] menu.  The screen will be updated.

Displaying Full Screen (Full Screen)

 This is available in case if you want to view the screen in wide range.  (But is impos-
sible to edit while displaying in full screen.)

Full Screen can be performed as follows.

(1) Select [Full Screen] from [View] menu.  The current editing screen will be dis-
played in wide range.

To recover from this condition, click at any place on the screen.
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Zoom

Zooms the screen to 100% view (Normal), 200%, 400% or 800%.  If the grid is set ,
it will also be zoomed to the respective size.

It will help you to operate small elements.  Zoom can be performed as follows.

(1) Select [Zoom] from [View] menu.  On this menu, current zoom percentage is
displayed using check mark.

Displaying window/keyboard (Show Window/Keyboard)

Local window (Keyboard) set for attribute of currently displayed screen can be dis-
played overlapping on the screen to check the actual status to be displayed on PT.
Local window 2 is available only with NT31, NT31C, NT631 and NT631C with
“-V1”.

Show Window/Keyboard command can be performed as follows.

(1) Open a property sheet of the screen and set a check mark for the window type
to be displayed and specify the screen number.

(2) Select [Show Window/Keyboard] from [View] menu and specify the window/
keyboard type to be displayed (Local 1 (Keyboard) or Local 2).
Check mark will be set on menu next to the name of the displayed window
type.
Each time you select window, the check mark switches to the objective one
and according to it, window/keyboard display will be changed.

5-1-4 Filter function
Support Tool has a “filter function” which can show only the specified object on the
screen. 
It is possible to edit/select objects while this function is executed. So it will be useful
when you correct or edit complicated screen. In addition, it is possible to display
the list of each object by types if this function is used with “Select Object” function
(for details, refer to the “Reference”). 
Filter function is applied to individual screen.
To activate this setting, follow the procedure below.

(1) Select the object to be displayed from the combo box on the utility bar. 
To display all the objects (cancel filter function), select “All”.
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Reference: � While a filter function is used, you can edit only the objects being displayed.

� If “Select Object” dialog box (refer to P121) is displayed by right–clicking the ob-
ject while a filter function is used, only the type of object being displayed is shown
in the list. In this case, the type name of the object will not be displayed in the
“Select Object” dialog box and detailed information of objects is shown.

� If a filter function is used for “Fixed Display”, “Full Tiling” ([View] menu) will be
cancelled automatically since the tiled status may not be displayed correctly if
the element used as a border is hidden by a filter function. (Confirmation mes-
sage is displayed.)

� With a filter function, only one type of object can be specified. It is not possible to
select two or more objects, like “Touch Switch and Bar Graph”.

Reference: When the operations indicated below are performed while a filter function is being
used, the filter function will be reset and returned to “All”.

Operation Remark

File→Print When the user performs this opera-

File→Print Preview tion, the screen will refresh and then
the operation will be performed.

Edit→Paste
the operation will be performed.

Edit→Align

Draw→Associate With

Draw→Disassociate

Draw→Set Order

Draw→Group

Draw→Ungroup

All menu items under “Object” This includes all creation of screen
elements using menu and toolbar ex-
cept the object specified on the filter.

Connect→Download When the user performs this opera-

Connect→Upload
tion, the screen will refresh and then
the operation will be performed.

All the references from the table When the user chooses the reference
from the tables, the filter will be reset
to ALL.

5-1-5 Switching Screens by Extended I/O Input at Each Screen
It is possible to make a setting so that the specified screen is displayed when the
input of the extended I/O which is connected to the PT is turned ON.  The following
two setting methods are provided to switch the screen by extended I/O input.

Note that this setting is possible only for NT30 and NT30C.

Common setting for all screens:

Regardless of the screen presently displayed, the specified screen is always dis-
played when the extended I/O input is turned ON.

Select [Table] from [Tools] in the menu.  Then click the tab of Extended I/O Input
to set the Switch screen.
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Setting for the individual screens:

It is possible to set the screen to be displayed in response to turning ON of the
extended I/O input for each screen.

For this setting, select [Extended I/O] from [Screen] in the menu bar.

For example, this setting allows the display screen to change sequentially from
screen No. 1 to screen No. 2, then to screen No. 3 in response to turning ON of
the extended I/O input.  If the extended I/O input 0 goes ON while screen No. 1
displayed, the screen switches to screen No. 2, then if the extended I/O input 0
goes ON while screen No. 2 displayed, the screen switches to screen No. 3.  To
allow screens to be changed in this way, set [Switch Screen No. 2] for [Extended
I/O] at screen No. 1, and [Switch Screen No. 3] for [Extended I/O] at screen No. 2.

Here, only the setting for screen switching at the individual screens is described.
Operations of the extended I/O input table and the common setting to all screens
are described in 7-5 “Extended I/O Input Tables”.

The procedure for setting the screen to be displayed on turning ON of the extended
I/O input at each screen is shown below.

(1) Select the screen for which [Extended I/O] is to be set to place the screen in
edit enabled state.

(2) Select [Screen] in the menu bar, then select [Extended I/O].

An extended I/O input table dialog box is displayed.
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(3) Select the extended I/O input row where setting is to be done, and click on
.

An extended I/O input setting dialog box is displayed.

(4) Set [Switch Screen] for [Function] and the screen number of the screen to be
displayed for [Screen No.].

5-1-6 Saving the Screen Image
The Support Tool provides a function to save the displayed screen image in a bit
map file as it is.

The grid display status and Show Tag can be also saved.

The following describes the procedure for saving the screen image.

(1) Select the screen which is going to be saved in a file so that it can be edited.

(2) Select [Screen] in the menu bar, then select [Copy to Image].

A dialog box is displayed to set a file name.

(3) Set the folder and file name, then click on .

The screen image is saved to the specified file.
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5-2 Standard Screen
A standard screen is the base screen for the display at a PT.

Screen numbers of standard screens differ depending on the PT model.  The table
below shows the screen numbers which can be used for a standard screen.

PT Model Screen Nos.

NT11S 1 to 250

NT20S 1 to 250, 256 to 500

NT600S 1 to 1000

NT30, NT30C, NT620S, NT620C, NT625C 1 to 1899, 2000

NT31, NT31C, NT631, NT631C 1 to 3999

Screen No.

In a standard screen, all elements can be used.

However, the usable elements depend on the PT models.

Standard screens are also used for creating child screens of continuous/overlap-
ping screens.
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5-3 Continuous/Overlapping Screens
A continuous/overlapping screen is a group of multiple screens which are switched
consecutively or overlapped for display.

A group of screens which are switched consecutively is called a “continuous
screen” and one screen which overlaps multiple screens is called an “overlapping
screen.”

Screen numbers which can be used for continuous/overlapping screen are same
as standard screen.  Note that continuous screens cannot be used with NT31,
NT31C, NT631, and NT631C.  To obtain the same effect as a continuous screen
with these PT models, use the touch switch which is assigned the switch screen
function.

Reference: The application manager displays a parent screen as a folder as shown below and
child screens are displayed when the folder is opened.

For NT11S, parent screen setting is not possible.

5-3-1 Continuous Screens
Two to eight screens can be registered for one continuous screen.  The base
screen where multiple screens are registered is called a “parent screen” and multi-
ple screens registered to the parent screen are called “child screens.”

[ ] [ ] Screen No. 1Screen No. 15Screen No. 20Screen No. 10

Parent
screen

Continuous
screen 1

Continuous
screen 2

Continuous
screen 3

[ ] [ ]

When screen No. 10 is specified, the first continuous screen, screen No. 20, is dis-
played.  Pressing touch switch [ ↓ ] changes the screen to screen No. 15.  Pressing
the touch switch again changes the screen to screen No. 1.

Since the screen of screen No. 10 is set for continuous screen, it cannot be dis-
played independently.

Screens set as continuous screens are switched by the pressing of the touch
switches [ ↓ ] and [ ↑ ], for which system key functions are allocated.

In the parent screen setting dialog, show page number can be set or reset to indi-
cate currently activated child screen number out of total pages on the upper right
corner of the parent screen.

Child screens should be created on standard screens in advance.
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Continuous screens are set in the procedure described below.

(1) Create child screens using standard screens.

(2) Specify [Parent Screen] from [New] command in [Screen] menu.

(3) In the parent screen setting dialog box, set a parent screen number, child
screen numbers, and whether or not a page number is displayed.

a. Set the number of the parent screen for [Screen No.] in [Parent].

If the number of screen data has been already created, it cannot be regis-
tered as a parent screen.

b. Select [Continuous].

c. If necessary, tick [Show Page Number].

d. Specify child screens.

Select screens which are specified as child screens by selecting them
from the [Standard] field, then click on .

The selected screen moves to the [Child] field.  If a wrong number is
moved, click on :  the screen returns from the [Child] field to the
[Standard] field.

Two to eight screens can be registered as child screens.

e. Modify the screen switching order.

Child screens are displayed in the order they are set in the [Child] field.

The setting order of the child screens can be modified using  and
.

f. Click on  after the completion of child screen setting.

When creating continuous screens with NT20S and NT600S, it is recom-
mended to create “Switch Screen” touch switch.
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5-3-2 Overlapping Screens
Overlapping screen allows two to eight screens to be displayed in one screen.  (For
NT31, NT31C, NT631, NT631C, one to eight screen can be set.)  The base screen
of an overlapping screen is called a parent screen and multiple screens which are
the constituents of an overlapping screen are called child screens.

This is an 
example of an
overlapping
screen.

This is an

Screen No. 10
(child screen)Screen No. 8 

(parent screen)

example of an
Screen No. 7
(child screen)

overlapping
screen.

Screen No. 25
(child screen)

When screen No. 8 (parent screen) is specified, the elements set on the screens
No. 10, No. 7, and No. 25 are overlapped for display on the parent screen.

Since the screen of screen No. 8 is set for an overlapping screen, it cannot be dis-
played independently.

In the setting for a parent screen, screen numbers of a parent and child screens are
set.

Child screens should be created on standard screens in advance.

An overlapping screen is set in the procedure indicated below.

(1) Create the child screens on standard screens.

(2) Specify [Parent Screen] from [New] command in [Screen].

(3) In the parent screen setting dialog box, set a parent screen number and child
screen numbers.
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a. Set the screen number of a parent screen for [Screen No.] in [Parent].

If the screen number has already existed, it cannot be registered as a parent
screen.

b. Select [Overlapping].

c. Specify child screens.

Select a screen which is specified as a child screen by selecting it from the
[Standard] field, then click on .

The selected screen moves to the [Child] field.  If a wrong number is moved,
click on : the screen returns from the [Child] field to the [Standard]
field.

Two to eight screens can be registered as child screens.

For NT31, NT31C, NT631, NT631C, one to eight screen can be registered as
child screen.

d. Modify the screen switching order.

Child screens are overlapped in the order they are set in the [Child] field.

The setting order of the child screens can be modified using  and
.

e. Click on  after the completion of child screen setting.

5-3-3 Editing a Parent Screen (Modification)
The type (continuous/overlapping) and configuration of a created parent screen
can be modified.

The procedure for modifying a parent screen is indicated below.

(1) Specify the parent screen which you want to modify from the application man-
ager, or display the pop-up menu by right clicking the mouse on the parent
screen.

(2) Select [Screen] in the menu bar, then choose [Modify Parent], or select
[Modify] in the pop-up menu.

The parent screen modify dialog box is displayed.

The procedure for modifying the setting is the same as setting for new parent
screen information.  Refer to 5-3-1 “Continuous Screens” or 5-3-2 “Overlap-
ping Screens”.

Reference: If a parent screen is copied on the application manager, child screens are also cop-
ied. (When two Support Tools are started up, the same operation is posible be-
tween the Support Tools.)
For details of screen copying, refer to 4–2–4 “Copying a Screen”.
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5-4 Window/Keyboard Screens

5-4-1 Window/Keyboard Screens
A window/keyboard screen is used as a window screen for the pop-up window/
keyboard function.  It means a partially display window which contains a keypad or
other elements to overlap on the base screen.

Note that window/keyboard screen cannot be used with NT11S, NT20S, and
NT600S.

With NT30, NT30C, NT620S, NT625C and NT31, NT31C, NT631, NT631C with-
out “-V1”, only one window can be opened at a time and objects which can be regis-
tered are limited mainly to those used for inputting numeral/string as follows.  (With
these PT, window is called “keyboard screen”.)

Fixed displays
Touch switches (Notify bit, cursor move and print screen functions are not per-
mitted.)
Numeral/string setting input filed (Only one input field can be set.)

Other elements are not displayed when the window/keyboard screen is opened as
a window although they can be registered for the window/keyboard screen.

With NT31, NT31C, NT631, NT631C with “-V1”, up to three windows can be
opened at the same time and all objects other than thumbwheel can be registered.
(However, only one input field of numeral/string input can be registered.)

Pop-up display frame

The pop–up display frame specifies the display range and display position of a
pop–up window/keyboard, the size and position of the frame can be specified as
follows:

NT30, NT30C, NT620S, NT620C, NT625C: Specify by 1 dot unit

NT31, NT31C, NT631, NT631C: Specify by 20 dot

The pop–up function displays only the area enclosed by the pop–up display frame.
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Reference: � Since the same memory area is shared by a pop-up window/keyboard and print
screen function, it is not possible to open the window during the printing process.
Moreover, it is also not possible to print from PT during the window is opened.

� With PT models other than NT31, NT31C, NT631, NT631C with “-V1” commu-
nication with a PC (PLC) is not possible for elements which are displayed in a
keyboard/window.  Therefore, the lamp bit of a touch switch in a window cannot
be controlled.

� While a window is open, display processing may be slowed a little.

Touch Switch functions which can be set on Window/Keyboard screen;

NT30, NT30C, NT620S, NT620C, NT625C:

� Notify Bit

� Switch Screen

� Input Key–Control

� Input Key–Window/Keyboard

� Input Key–String

� Copy setting

� Cursor Move

� Print Screen

With NT30, NT30C, NT620S, NT620C, and NT625C, keyboard screen can be
used as a standard screen.  If it is used as a keyboard screen (called from other
screen), Notify Bit, Cursor Move and Print Screen functions are not available.

NT31, NT31C, NT631, NT631C without “-V1”:

� Switch Screen

� Input Key–Control

� Input Key–Window/Keyboard

� Input Key–String

� Copy setting

NT31, NT31C, NT631, NT631C with “-V1”:

� Notify Bit

� Switch Screen

� Input Key–Control

� Input Key–Window/Keyboard

� Input Key–String

� Copy setting

� Window Move

� Print Screen



Up-down handleRight-left handle Apex handle
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Changing the size and the position of pop-up display frame

The procedure for changing the size and the position of a pop-up display frame is
shown below.

(1) Click the mouse on a dotted line of the pop-up display frame.

Green � (handles) appear around the pop-up display frame.
(Arrows in the handle indicates the direction to be resized.)

(2) The frame size can be changed by dragging a handle.

When the mouse cursor is positioned on a handle, the shape of the mouse
cursor changes as shown below according to the handle position.  When the
mouse cursor is dragged in this state, the pop-up display frame size changes
in the direction the arrow symbol of the mouse cursor indicates.

(3) To move the pop-up frame, drag any position in the dotted lines other than
handles.

When the mouse cursor is positioned on dotted lines other than at handles,
the shape of mouse cursor changes as shown below.  The pop-up display
frame moves when the mouse cursor is dragged in this state.

(4) After the size and the position of the pop-up display frame are determined,
click on an arbitrary point in the screen other than the pop-up display frame.

The size and the position of the pop-up display frame are set and the handles
are cleared.

To change the size and the position of the pop-up display frame, repeat the
procedure shown above from step (1).

Reference: The size and position of the pop–up display frame can be specified as follows.

� NT30, NT30C, NT620S, NT620C, NT625C: Specify by 1 dot unit

� NT31, NT31C, NT631, NT631C: Specify by 20 dot

5-4-2 Improved input key–window/keyboard function
This section describes input key–window/keyboard function which was improved
for NT31, NT31C, NT631 and NT631C with “-V1”.

Types of windows

Following two types of windows are available.
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Global window

This window can be kept displaying all the time regardless of the screen displayed
on PT.  Global window stays at the same position even when the displayed screen
is switched.  (Global window will be closed automatically when the screen other
than user screen was displayed, and will be re–displayed when the screen was
switched back to user screen.)

Only one global window can be displayed at a time.

It can be opened, closed or moved only by the operation of window control area
from the host.  For details of window control area, please refer to the operation
manual of PT.

Local window

This window will be closed when the screen displayed on PT is switched.

By setting local window for attribute of each screen, specified window can be
opened at the same time the screen is opened.

Up to two local windows can be opened at the same time.  (Local window 1, Local
window 2)

Local window can be opened, closed or moved by following operations.

Setting screen attribute (Opens when the screen is displayed.)

Touch switch operation (By Input key–window/keyboard touch switch and win-
dow move touch switch)

Operation of window control area from the host

Types of windows can be specified when opening the window.

It is possible to open same window as “Global window” or as “Local window”.

(However, multiple display of the same window is not possible.)

Opening/Closing and moving a window

Window can be controlled by the following operations.

Opening windows by setting screen attribute

When creating screen using Support Tool, up to two windows can be selected to be
displayed when opening the screen.

By this method, window is displayed at the position which was specified when win-
dow screen was created.  This type of window will be local window.  For details of
the setting, refer to 5-1-1 “Setting the screen attributes”.

Screen 5 Screen 23

Window
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Opening/Closing and moving a window by touch switch operation

To create input key–window/keyboard touch switch on a screen or a window en-
ables to open/close specified window.

By this method, window is displayed at the position set for touch switch property.

This type of window will be local window.

 

Screen Screen
Local

Window

Also, by creating window move touch switch on window, it is possible to move win-
dow by touch panel operation at PT.

 

Screen Screen

Window Window in a moving status

Screen

For details of touch switch settings, refer to 6-8 “Touch Switches”.

It is not possible to control global window by touch panel operation.

Opening/ Closing and moving a window by the operation of window control area

Window control area is added for NT31, NT31C, NT631 and NT631C with “-V1” as
a direct access area.

While running PT, by writing window screen number or x, y co-ordinate of window
position (bottom left) at window control area from the host, opening/closing, mov-
ing a window are possible.

Window control area can control global window and local window.  For details, re-
fer to the operation manual of PT.

 

Screen

Window

The selected 
window opens

PLC

Window 
screen number

Window

Window

The window shifts

PLC

The co–ordinates 
of the window
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Size and display position of window (NT31, NT31C, NT631, NT631C with “-V1”)

With NT31, NT31C, NT631, NT631C with “-V1”, size of window can be specified
freely by 20 dot unit.  (Minimum window size: 20

It is possible to display a window at a different position from where it was created,
or to move a window.

However, the distance between the position where window was created and where
it is displayed have to be always multiple of 20 dot.

 

Display

Co–ordinates at the bottom 
left corner (20,179)

Window

Display

Co–ordinates at the bottom 
left corner (180,219)

Window

Reference: Specify the bottom left co-ordinate of window when specifying the window position
at window control area.

Checking the display status of a window

Whether window is opened or closed will be written to PT status of PT notify area.

Window screen number and window position (bottom left co-ordinate) of currently
displayed screen will be written to window control area.

Checking these areas from the host enables to know the display status of window.
For details, refer to the operation manual of PT.
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5-5 Extended Screen
An extended screen is used by the expansion function of a PT.

Although an extended screen can be used in the same manner as a standard
screen, it should not be used unless absolutely necessary since it is used by the
expansion function.

If data is registered as a standard screen, the registered data is given priority.

The screen numbers used for an extended screen are indicated below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1980 to 1996

NT31, NT31C, NT631, NT631C None
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5-6 Occurrence History Screen
An occurrence history screen displays the screen numbers recorded by the dis-
play history (Screen History) function in the order of displayed date and time.  This
function records the date/time of display and the number of times the screen was
displayed for the screens for which the [History] attribute is ticked in the screen
property.

The occurrence history screen, provided with NT30, NT30C, NT620S, NT620C,
and NT625C, has a blank area at the right side in the screen so that scroll and
screen switching touch switches can be created.  Other area of the screen must
not be changed.

The screen number of the occurrence history screen is indicated below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1997

NT31, NT31C, NT631, NT631C 9001*

*: Cannot edit (Only display is possible.)

The screen to be displayed differs according to the PT model.

Example: For NT30, NT30C

[No.] (NT30/NT30C), [Screen No.] (NT620S/NT620C/NT625C)

Indicates a screen number.

[Date] (NT30/NT30C), [Time] (NT30/NT30C)
[(YY/MM/DD HH:MM)] (NT620S/NT620C/NT625C)

Indicates the date and time the screen was displayed.

[Cnt.] (NT30/NT30C), [Frequency] (NT620S/NT620C/NT625C)

Indicates the number of times the screen has been displayed.

[Message]

Indicates the [Title] of the screen attribute.
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5-7 Frequency History Screen
A frequency history screen displays the screen numbers recorded by the display
history (Screen History) function in the order of frequency of screen display.  This
function records the date/time of display and the number of times the screen has
been displayed for screens for which the [History] attribute is ticked in the screen
property.

The frequency history screen, provided with NT30, NT30C, NT620S, NT620C,
and NT625C, has a blank area at the right side in the screen so that scroll and
screen switching touch switches can be created.  Other area of the screen must
not be changed.

The screen number of the frequency history screen is shown below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1998

NT31, NT31C, NT631, NT631C 9002*

*: Cannot edit (Only display is possible.)

The screen to be displayed differs according to the PT model.

Example: For NT30, NT30C

[No.] (NT30/NT30C), [Screen No.] (NT620S/NT620C/NT625C)

Indicates a screen number.

[Date] (NT30/NT30C), [Time] (NT30/NT30C)
[(YY/MM/DD HH:MM)] (NT620S/NT620C/NT625C)

Indicates the date and time the screen was displayed.

[Cnt.] (NT30/NT30C), [Frequency] (NT620S/NT620C/NT625C)

Indicates the number of times the screen has been displayed.

[Message]

Indicates the [Title] of the screen attribute.
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5-8 Host Connect Screen (System Initializing Screen)
The host connect screen is displayed for the start of PT operation until communica-
tion with the PC (PLC) is established.

This screen can be created freely using only fixed display.

In case host connect screen is not registered, a default screen indicating that PT is
trying to connect to the host will be automatically displayed at the time  PT power is
switched on or when the mode is changed to the RUN mode.

The screen number of the host connect screen is shown below.

PT Model Screen No.

NT11S, NT20S, NT600S None

NT30, NT30C, NT620S, NT620C, NT625C 1999

NT31, NT31C, NT631, NT631C 9000

Reference: For NT31, NT31C, TN631, NT631C, it is called “System Initializing Screen”.
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5-9 Password Screen
A Password screen is treated as one of the 250 Standard screen in NT11S.

It is used to protect another screen by password.  When a password screen is dis-
played on the NT11S PT, it forces the user to enter the correct password before
bringing up the designated screen.

The figure above shows a new password screen created.  It has a text element with
“password” as labeled.  Next to the text element is the password element which
indicates the current password for this password screen.  In the password property
page, you can set the password and the designated screen number to be dis-
played next.

5-10 Menu Screen
A Menu Screen is treated as one of the 250 Standard screens in NT11S.  It serves
as a control screen which maps a numeric key inputs onto a designated screen.  A
maximum of 4 designated screens for each of the numeric keys 1 to 4 can be speci-
fied in the menu screen property page.
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5-11 Print Format Screen
The Print Format Screen has the screen number 255 in NT11S.  It creates a format
for PT printing function mainly for the daily printing.  You can only use Numeral and
String display to create the format.
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SECTION  6
Element Operating Procedure

Screen data for a PT is created by arranging elements on a screen.
Elements are classified into two groups, elements for display and those used for inputting data at a PT.

6-1 Common Operation 119. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-1 Creating an Element 119. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-2 Pop-up Edit Menu 120. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-3 Selecting an Element 120. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-4 Modifying an Element 124. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-5 Copying, Cutting, Pasting, and Deleting Elements 126. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-6 Aligning Elements 129. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-7 Grouping Elements 130. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-8 Associating Elements with the Touch Switch 131. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-9 Centralizing the Label of Lamp and Touch Switch 132. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-10 Setting Properties 133. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-1-11 Relationships between Elements and Memory Tables 148. . . . . . . . . . . . . . . . . . . . . . . . . . 

6-2 Fixed Display 149. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-1 Polyline 149. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-2 Arc 151. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-3 Rectangle 152. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-4 Circle 153. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-5 Polygon 155. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-6 Sector 157. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-7 Text 158. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-8 Tiling 161. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-9 Image Object (Data) 163. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-10 Mark 167. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-2-11 Library Object (Data) 169. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-3 Alarm 173. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-3-1 Alarm List 174. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-3-2 Alarm History 181. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-4 Data Input 187. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-4-1 Numeral Input 187. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-4-2 (Character) String Input 196. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-4-3 Thumbwheel Switch 195. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-5 Lamps 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-5-1 Standard Lamps 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-5-2 Image/library Lamps 212. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-6 Numeral Display 215. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-7 (Character) String Display 219. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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6-8 Touch Switches 222. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-1 Input Notify Touch Switch 228. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-2 Switch Screen Touch Switch 228. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-3 (Character) String Input Touch Switch 229. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-4 Pop-up Window/Keyboard Function Touch Switch 229. . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-5 Control Code Input Touch Switches 231. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-6 Copy Setting Touch Switch 233. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-7 Cursor Moving Touch Switch 235. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-8 Window Moving Touch Switch 236. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-8-9 Print Screen Touch Switch 237. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-9 Graphs 238. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-1 Bar Graph 238. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-2 Analogue Meter 243. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-3 Broken-line Graph 251. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-9-4 Trend Graph 257. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

6-10 Registering Created Elements (Symbol Manager Operation) 268. . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-1 Screen Configuration of Symbol Manager 268. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-2 Basic Symbol Manager Operation 269. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-3 Operating the Symbol Manager 271. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-4 Pasting a Symbol to Screen 275. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
6-10-5 Operating Procedure of Color Palette Symbol 276. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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6-1 Common Operation
Operations common to all element creation steps are shown below.

6-1-1 Creating an Element
To create an element, specify the element to be created and click the mouse at the
position where the element is to be placed.

(1) Specify an element.

Menu bar: [Objects] → Select the objects to be created.

Drawing toolbar: Click on the icon of the object to be created.

(2) Click the mouse after placing the mouse cursor at the position where you want
to  create the specified element.

The elements shown below can be dragged to change the size of the ele-
ments instead of clicking the mouse when the element is positioned.

Circle, Arc, Sector, Polyline, Polygon, Rectangle, Touch switch, Standard
lamp, Bar graph, Analogue meter, Broken–line graph, Trend graph

After placing the element by clicking or dragging, the dialog box for setting the
property of the element is automatically displayed. (The procedure to open
the property setting dialog box is omitted.)

(3) In the displayed dialog box, set the property of the element. 
Change the size and the shape as required.

The selection of an element, the object to be created, is canceled on completion of
the drawing of a graphic.

To draw graphics with the same element continuously, you can maintain the ele-
ment’s selected status by pressing the Shift key when releasing the left mouse but-
ton after the clicking or dragging.

Reference: The dialog will be displayed each time the element is created even when the Shift
key is being pressed to draw the same element continuously. In case of Polyline
however, the dialog will be displayed only for the last element which was created
immediately after the Shift key is released.
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6-1-2 Pop-up Edit Menu
The Support Tool provides a pop-up menu where functions used for editing are col-
lected.

The pop-up edit menu is displayed by clicking the right button of the mouse.

Items displayed in the pop-up edit menu are common to most of all elements.

(1) Select an element.

(2) Right click the mouse.

6-1-3 Selecting an Element
To edit or move an element, select the created element.

When an element is selected, � marks (handles) are displayed to enclose the se-
lected element.

Selection mark (handle)

Reference: Arrows in the handle indicate the direction to which the size of the element can be
changed. When the mouse cursor is set on the handle, the shape of the cursor is
changed to an arrow of the same direction.

� Selecting an element using a mouse

Click the element you want to select.

� Selecting an element using a Tab key

Each time the Tab key is pressed, elements are selected one by one according to
the display order. (If no elements are selected, the element of the highest display
order will be in selected status when the Tab key is pressed.)
When the Shift + Tab keys are pressed together, the selection order will be re-
versed.
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Selecting an element from among overlapped elements

When elements are overlapped complicatedly, use the element selection function
below.

Reference: When you click on the overlapped elements, the element with the smallest area
enclosing the point of selection will be selected. However, if you want to select “ele-
ment A” which is enclosed by other element, like in the figure below, it is not pos-
sible to select “element A” if the element enclosing it is already selected. In this
case, click any position on the screen where no element is registered to cancel the
selected status and then select “element A”.

For a complicated screen, element select operation will be easier if a filter function
(refer to 5–1–4) is used to limit the display objects.

(1) Select the element at the foremost position.

(2) Select [Edit] (menu bar), then select [Select Object].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse and choose [Select Object] in the menu.

The list of elements behind the element selected first is displayed.
(Detailed information of the objects are displayed in the list. However, part of
the information may not be displayed for some objects such as lamps/touch
switches with long label.)

(3) Select the desired element from the list.

(4) Click on .

(1) (2) (3) (4)

Reference: � The element selected in the “Select Object” dialog box is also selected on the
screen so that you can confirm which element is being selected before you click
the  button.

� In the “Select Object” dialog box, object information same as the one displayed
on the status bar is shown.
For details, refer to P47.
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Batch selection of multiple elements

It is possible to select multiple elements collectively.

� Using the Shift key

Click an element while holding down the Shift key, and it is added to the previous-
ly selected elements.  If you click a selected element while holding down the Shift
key, the element is deselected.

+ Shift

� Specifying a range

Drag the mouse cursor so that all elements will be enclosed by the range specify-
ing frame.

�

Range specifying frame

� Selecting all elements in a screen

To select all the elements arranged in a screen, use the select all function.

Select [Select All] from [Edit] menu.
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Specifying an element consisting of multiple elements

To edit an element which consists of multiple elements as shown below, use the
edit element function.

� Position of a “label” in a touch switch

� Position of a “label” in a standard lamp

� Position of a “Display %” in a bar graph

� Position of a “Display %” in an analogue meter

� Position of a “Display %” in a trend graph and touch switches for controlling func-
tion

� Display position of image/library data and position of touch switches in an alarm
list/alarm history

(1) Select the element to be edited.

Select only one element, if multiple elements are selected, edit object function
can not be used.

(2) Select [Edit] (menu bar), then select [Edit Object].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse on the elements and select [Edit Object]
in the menu.

It is also possible to enter “Edit Object” mode by simply pressing the [Insert]
button on a keyboard.
(To cancel “Edit Object” mode, press [Insert] button again.)

The green � marks (handles) change into red.

(3) Select an element.

[Example: Changing the position of “label” in a touch switch]

(1)

Green Red

(2) (3)

Reference: The following operation is also possible.

(1) Confirm that no element (or element other than objective one) is selected.

(2) While holding down the Shift key and Ctrl key, click on the objective part of the
element which consists of multiple elements.

(3) The element automatically enters into “Edit Object” mode so that the element
selected at (2) can be edited.
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6-1-4 Modifying an Element
The size, shape, and/or position of a created element can be modified.

Modifying the size and shape of an element

To modify the size or the shape of an element, drag one of green � marks (han-
dles) that enclose the objective element.

Position the mouse cursor on a green handle, and the shape of mouse cursor
changes as shown below. (Same direction as arrows in the handles)

Drag the mouse cursor in the indicated direction to modify the size and the shape
of the element.

Note If a green mark is shown as  when an element is selected, the size of this ele-

ment cannot be changed.

Moving an element

Moving an element by dragging operation

To move an element, position the mouse cursor on the selected element and con-
firm that the mouse cursor changes as shown below.  Then, drag the element as
desired.

If multiple data creation screens are displayed, an element can be moved over to
another data creation screen by dragging it.



125

Common Operation Section 6-1

Moving an element by keyboard operation

The screen element can be moved by pressing cursor key (�, �, �, �) on key-
board after selection.

The size of movement depends on the setting of “Snap to Grid” as follows.

[When “Snap to Grid” is OFF]

Cursor key: move by 1 dot

Shift key + Cursor key: move by 16 dots

[When “Snap to Grid” is ON]

Cursor key: move by 1 dot

Shift key + Cursor key: move by set grid size

However, if the selected elements include touch switch, elements always move by
the size of the touch switch grid regardless of whether Shift key is pressed or not.

To move a part of an element such as “% Display” for a bar graph or “Label” for a
lamp/touch switch, click on the objective part while holding down the Shift key and
Ctrl key (or after selecting “Edit Object”), then perform move operation.

In case of NT11S, there is a special requirement i.e. The selected objects will move
by one system grid size (8,16) in all cases. The snap to grid option value is not con-
sidered.

Reference: “Snap to Grid” setting can be made by the procedures below.

[Screen] menu - [Property] - [Grid] button

[Screen] menu - [Grid]

Double clicking on a screen – [Grid]

Right-clicking on a screen – [Property] – [Grid] button
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6-1-5 Copying, Cutting, Pasting, and Deleting Elements
The operations for copying, cutting, and pasting elements using the clip board, and
also the operation for delete an element, are described below.

Copying and pasting elements

The procedure for copying an arranged element to the clip board then pasting it at
another position in the screen is shown below.

The attributes set for the copy source element are also copied.

The pasted element is displayed at the upper left section of the screen.

The element copied to the clip board can be used for pasting as many times as
desired until another element is copied or cut.  Pasting a copied element to another
screen is also possible.

(1) Select an element.

(2) Select [Edit] (menu bar), then select [Copy].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse on the element and select [Copy] in the
menu.

(3) Select [Edit] (menu bar), then select [Paste].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse and select [Paste] in the menu.

Copied element is pasted at the
upper left section of the screen.

Reference: � If multiple data creation screens are displayed, an element can be moved over to
another data creation screen by dragging it.
If Ctrl key is being pressed while dragging, an element will be copied instead of
being moved.

� If two Support Tools are started up, copy, cut, paste and dlag & drop operations
can be performed between Support Tools.
For details, refer to 3–3–6.
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Cutting and pasting elements

The procedure for cutting an arranged element to the clip board then pasting it at
another position in the screen is shown below.

The attributes set to the cut source element are also copied.

The pasted element is displayed at the upper left section of the screen.

The element cut to the clip board can be used for pasting as many times as desired
until another element is copied or cut.  Pasting a cut element to another screen is
also possible.

(1) Select an element.

Selection of multiple elements collectively is possible.

(2) Select [Edit] (menu bar), then select [Cut].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse on the element and select [Cut] in the
menu.

(3) Select [Edit] (menu bar), then select [Paste].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse on the element and select [Paste] in the
menu.

Cut element is pasted at the
upper left section of the screen.

Reference: � If multiple data creation screens are displayed, an element can be moved over to
another data creation screen by dragging it.
If Ctrl key is being pressed while dragging, an element will be copied instead of
being moved.

� If two Support Tools are started up, copy, cut, paste are dlag & drop operations
can be performed between Support Tools.
For details, refer to 3–3–6.

Deleting an element

The procedure for deleting an arranged element is described below.

Since the delete operation does not store the element in the clip board, the deleted
element cannot be restored by the paste function.

(1) Select an element.

Selection of multiple elements collectively is possible.
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(2) Select [Edit] (menu bar), then select [Delete].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse on the element and select [Delete] in the
menu.

Moving an overlapped element to the front or back

If multiple elements are overlapped, it is possible to move a selected element to the
front or back of other elements.This command is valid between same kinds of ele-
ments only.

Therefore, it is not possible to change the laying order of touch switch and lamp, for
example.

(However, it is effective between different shapes of fixed display since they are
treated as one kind.)

(1) Select an element.

Selection of multiple elements collectively is possible.

(2) Select [Draw] (menu bar), then select [Bring to Front] or [Send to Back].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse on the object and select [Bring to Front]
or [Send to Back] in the menu.

Choose [Bring to Front] to move the selected element to the foreground and
[Send to Back] to move it to the background.

Undoing the operation

The Undo function will undo or cancel the last (most recent) action that was per-
formed.  Ten times of Undo can be performed.

It is invoked by:

Menu bar: [Edit] → [Undo]

Draw bar: Click on 
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Redoing the operation

The Redo function will repeat the last (most recent) action that was performed.  Ten
times of Redo can be performed.

It is invoked by:

Menu bar: [Edit] → [Redo]

Draw bar: Click on 

6-1-6 Aligning Elements
Two or more elements can be aligned collectively.
There are following six functions for alignment. The buttons below are provided on
the alignment bar.

� Align Top:  (Short cut key: Ctrl + Up Arrow)

� Align Bottom:  (Short cut key: Ctrl + Down Arrow)

� Align Left:  (Short cut key: Ctrl + Left Arrow)

� Align Right:  (Short cut key: Ctrl + Right Arrow)

� Centre in a Column:  (Short cut key: Ctrl + F9)

� Centre in a Row:  (Short cut key: Ctrl + Shift + F9)

These functions can align the elements to the extremely edge in the selected ele-
ments’ range or to the vertical/horizontal center of all the selected objects.

[In case of Align Top, Align Bottom, Align Left, Align Right]

Align
Top

Align
Bottom

Align Left

Align Right

[In case of Centre in a Column, Centre in a Row]

Centre
in a 
Row
Centre in a Column
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However, if touch switch (including elements such as thumbwheel, alarm list/histo-
ry which contain touch switch within themselves) is included in the selected ele-
ments, the touch switch will take precedence for alignment and the other elements
will be aligned to the touch switch as follows. 

[Example] In case of Align Bottom, Align Right

Align
Bottom

Align
Right

Base line for
“Align Bottom”

Base line for
“Align Right”

Reference: � Alignment function can be used also in the Edit Object mode. By using this func-
tion in this mode, position of the lamp/touch switch label or image/library for
image/library lamp ON/OFF status can be aligned easily within the element.    
If alignment function was used in Edit Object mode, only the selected element
will be moved (Alignment is performed towards the whole area of the element).

� Touch switches may not be aligned to the center properly when “Centre in a Col-
umn” or “Centre in a Row” is performed because of the defined touch switch grid
size. (They will be aligned to the nearest center.)

� If alignment function is performed when the filter function is activated, the filter
function will be cancelled.

(1) Select multiple elements to be aligned
Or: select one element which consists of multiple elements and specify the
objective part after entering the Edit Object mode.

(2) Specify any of the aligning method after selecting [Align] from [Edit] menu.  
Or: right–click the mouse and specify the aligning method after selecting
[Align] from pop–up menu. (Short cut key can also be used.  Refer to P129)

6-1-7 Grouping Elements
It is possible to group multiple elements into one element.

When creating a graphic by combining several elements, future editing such as
copying, pasting, and moving will be facilitated if they are grouped.

Grouped elements can be returned to individual elements by ungrouping them.

In the grouped state, it is not permissible to change the element size and property
settings.  To change the size or set properties, ungroup the elements.

Reference: When saving screen data using mmi format, grid setting information and grouping
information will not be stored.
(Refer to 3-3-3 “Saving the Screen Data (Application) File.” )
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Grouping

(1) Specify the elements to be grouped.

(2) Select [Draw] (menu bar), then select [Group].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse and select [Group].

Ungrouping

(1) Select an element in the grouped elements.  (Select only one grouped ele-
ment).

(2) Select [Draw] (menu bar), then select [Ungroup].

This operation is also possible using the pop-up edit menu; display the pop-up
edit menu by right clicking the mouse and select [Ungroup].

6-1-8 Associating Elements with the Touch Switch
If the cursor move touch switch has been created independently later than a cer-
tain element, this touch switch has to be associated with this element in order to
specify the data input field when the touch switch has been pressed on PT.
For NT30, NT30C, NT620S, NT620C, NT625C, it is possible to associate the con-
trol code input touch switches (page and line scroll touch switches) with the alarm
list and history.
It is also possible to disassociate the touch switch with the elements.

Reference: � If the “Auto Arrange” check box is ticked in the Setting property of cursor move
touch switch, the cursor move touch switch will always be moved together with
the attached data input object.  So, it is not possible to move or resize the cursor
move touch switch itself independently.  To move or resize it, first of all cancel the
“Auto Arrange” check box, then move or resize it.

� For NT31, NT31C, NT631, NT631C, the touch switch of trend graph and alarm
list/history is built into each element.  It is only possible to change the location of
the touch switch.  (Size cannot be changed.)
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Association

(1) Select the touch switch which you want to associate.  (Select only one ele-
ment.)

The touch switches which  can be associated to an element should be page or
line scroll touch switch.

(2) Select [Associate With...] from [Draw] menu.

Dialog box which prompts the user to select the elements to be associated will
be displayed.

(3) Choose the data input or Alarm which you want to associate.  Then click

.

Disassociation

(1) Select the touch switch you want to disassociate.  (Select only one element.)

(2) Select [Disassociate] from [Draw] menu.

Touch switch disassociation will be performed.

6-1-9 Centralizing the Label of Lamp and Touch Switch
With the Support Tool, the label of lamp/touch switch can be centralized within the
element (horizontal direction only). This function is useful, for example, when the
label is edited after the creation of lamp/touch switch. Touch switch has two kinds
of areas, one is “displayed figure” and the other is “touch sensing area”. “Centralize
Label” is performed toward the touch sensing area.

(1) Select the lamp/touch switch you want to centralize.
Multiple selection is also possible. However, “Centralize Label” can not be
performed if no lamps or touch switches are included in the selected ele-
ments.
”Centralize Label” can be performed also when elements other than lamp or
touch switch are included in the selected elements. (Nothing is performed for
elements other than lamp or touch switch)

(2) Select [Centralize Label] from [Draw] menu, or click on the  button. (or

press Ctrl key + L)
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Reference: � Centralization of lamp/touch switch label can be also performed by alignment
function (Centre in a Column) in Edit Object mode. However, the result may differ
since the alignment function is performed towards the whole lamp/touch switch
area.

� If “Centre in a Row” is performed for a label in Edit Object mode, the label is
centralized vertically.

6-1-10 Setting Properties
For each element, properties are set to characterize the individual elements.  Basi-
cally, following two types of properties are set.

� General

General settings such as display color and character size.

� Settings (only for elements which have a specific function)

Settings related to data conversion, such as PC (PLC) address and memory
table address.

In addition to the properties shown above, some elements have the following prop-
erties.

� Light Function (only for lamps and touch switches)

Setting of bits (lamp bits) for control which are used when changing display.

� Logging (Data Logging property) (only for trend graph)

Setting of the data logging function which records data.

The following explains only the basic settings.  For details of the properties of each
element, refer to 6-2 “Fixed Display” and later sections.

Displaying the Property Setting Dialog Box

The property setting dialog box is displayed in any of the following operations.

� Using the mouse (1)

(1) Double click an element.

� Using the mouse (2)

(1) Right click the mouse on an element, then select [Properties...].

� Using the menu

(1) Specify the element for which you want to display properties (specify only
one element).

(2) Select [Draw] (menu bar), then select [Properties].

� Using the keyboard

(1) Specify the element for which you want to display properties (specify only
one element).

(2) Press the Enter key while holding down the Alt key.
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Setting the line type

You can select the type of line for polylines, broken-line graphs, and trend graphs.

Dot-dot-dashSolid Dash Dot-dash

The line type is set in a property of individual elements.

Setting the display color

Set the display color of elements.

Color setting is possible with NT30C, NT31C, NT620C, NT625C, and NT631C.

The colors which can be used are shown below.

White, black, blue, red, magenta, green, cyan, yellow

For some elements, [Transparent] may be specified to display a transparent back-
ground.  Note that [Transparent] can be specified only for the elements shown be-
low.

� Background of fixed display text (Either foreground or background has to be
other color.)

� Background of label of lamps and touch switches

� OFF state color of lamps and touch switches

� Background of element tiling patterns

� Setting the color for text and numerals

For text and numerals, color setting is possible both for characters and back-
ground.

Foreground: Specify the color of text and numerals.

Background: Specify the color for the background of text and numerals.  
If [Transparent] is specified, elements arranged behind text is 
visible.

Background color

Foreground color

� Setting the color for graphics

For a graphic, the foreground color can be set.

Foreground: Specify the color of lines in a graphic and the color of the graphic 
itself when the attribute is set to “Inverse”.

Foreground color

Reference: Colour setting is possible only for color-type PT.
However, with NT30 and NT31, setting of white and black (and transparent) is pos-
sible.
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� Setting the tiling color

When tiling a graphic, color designation is possible for the foreground, back-
ground, and border.

Foreground: Specify the tiling color.

Background: Specify the background color of tiling (color visible through 
blank areas in the selected pattern).
If [Transparent] is specified, the background becomes 
transparent, and elements arranged behind text and numerals are 
visible.

Border: Specify the border color of tiling area. 

Background

Foreground

Border

Available tiling patterns are shown below.

When tiling a graphic, the color of border should be set to the same color as set
for graphics which surround the tiling element.  If a different color is specified, or
there is a gap in the border, the tiling fills out the specified area.

Reference: “Color Palette Symbol” for which tiling patterns and color combinations are regis-
tered is supplied with Support Tool as symbol data. Using color palette symbol en-
ables you to register required tiling objects on screen while checking their display
status.  Color palette symbol does not have transparent background patterns.  Bor-
der colors are set to ‘White’.  Change the setting as required when using it.  For
details, refer to 6-10-5 “Operating Procedure of Colour Palette Symbol”.

� Setting the color for lamps and touch switches

When specifying the color for lamps and touch switches, it is possible to specify
the color for the frame, color when ON, and color when OFF.

Frame: Specify the frame color if an element is displayed with a frame.

ON: Specify the color which represents the lamp/touch switch ON status.

OFF: Specify the color which represents the lamp/touch switch OFF status.

If a lamp or a touch switch is set to flash, the ON color and OFF color are dis-
played alternately.

Lamp/touch
switch ON

ON color

Frame

Lamp/touch
switch OFF

OFF color

Lamp/touch
switch flashing

ON color

Frame

OFF color
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� Setting graph colors

When setting the color for bar graphs, analogue meters, broken-line graphs, and
trend graphs, specification is possible for the frame of the graph, + range, –
range, line (foreground), and scale.

Frame: Specify the color of the graph frame.

+ Range: Specify the background color of the graph, to be applied when the nu
meric value is positive.

For a bar graph, the bar is displayed in the specified color in the
positive range.

– Range: Specify the background color of the graph, to be applied when the 
numeric value is negative.

For a bar graph, the bar is displayed in the specified color in the 
negative range.

Line-Colour (Foreground colour): Specify the line color of broken-line graphs 
and trend graphs, and foreground color for 
present value of analogue meters.

Scale Colour:  Specify the scale color of analogue meters.

Foreground color

Scale color

–100%

–100%

–100%

–100%–100%

100%

100%

100%

100%100%

0%0%

0%

0%0%

Frame
color

Frame color

<Trend graph><Broken-line graph>

<Analogue meter><Bar graph>

Frame color
Frame color
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Settings for text display

Set the size and display attributes for displaying fixed display of text and (charac-
ter) strings in a character string memory table (string table) in the manner shown
below.

The following shows only the common settings for text of fixed display.

As an example, the properties for a text display (fixed display) are shown below.

[Font Type]

Specify the font type for displaying alphanumerics and symbols.

Standard: A character is displayed in standard font (16�8 dots).

Half Height: A character is displayed in half-height font (8�8 dots).

Half height Standard

[Scale]

Specify the character size.  (Only 1�1 (Equal) and 2�1 (Wide) can be set for
NT11S.)

1�1 (Equal): A character is displayed in the original size both in height and 
width.

1�2 (High): A character is displayed with doubled height and the original 
width.

2�1 (Wide): A character is displayed with the original height and doubled 
width.

2�2: A character is displayed with doubled height and width.

3�3: A character is displayed with threefold height and width.

4�4: A character is displayed with fourfold height and width.

8�8: A character is displayed with eightfold height and width 
(not possible for NT20S).
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1�1 1�2 2�1 2�2 3�3 4�4 8�8

Reference: With NT31, NT31C, NT631, NT631C with “-V1”, characters of 2�2 or larger scale
are automatically displayed in 32 dot high–definition font. (Marks inserted into a
string are always displayed in 16�16 dot font.)
32 dot font and font type ISO 8859–1 are not available on PT when system pro-
grams of “-V1” type were installed for NT31, NT31C, NT631, NT631C without
“-V1”, even though other functions will be same as “-V1” type. Therefore, in this
case, characters of 2 x 2 or larger scale are displayed in 16 dot font for PT, while
they are displayed in 32 dot font for Support Tool. Also, ISO8859–1 font type can
not be used for PT, CP437 font type is applied.

[Smoothing]

Smoothing processing allows jags to be smoothed when a character is displayed
in an enlarged scale.

Selection of this item is possible for characters of “2�2” or larger and for marks
(16�16 dots).(With NT31, NT31C, NT631, NT631C, smoothing is not performed
for marks.)

Smoothing cannot be selected for NT20S and NT600S since smoothing process-
ing is always executed for characters larger than “2�2” with these models.

Without smoothing With smoothing

[Attribute]

This is an attribute to determine how text is displayed.  Attributes to be displayed
here vary somewhat according to the PT model.

Standard: Text is displayed in the specified color and specified background
color.

Inverse: Text and background are displayed in colors that are the reverse 
of the specified colors.

Flash: Text flashes when displayed.  If this attribute is selected, 
standard display and no display (background color only) are 
alternately displayed.

Inverse Flash: Text is displayed by alternating standard display and inverse 
display.

Reference: To check “Flash” and “Inverse Flash” display on the screen, specify [Simulate
Flash] from [View] menu. (For details, refer to 5–1–3)
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Settings for numeral display

Set the size and display attributes for displaying numeric values of numeral tables
and percentage values in a graph in the manner shown below.

The following shows only the common settings for numeral display.

As an example, the properties of a numeral display are described below.

[Font Type]

Specify the font type.

Standard: A numeric value is displayed in the standard font (16�8 dots).

Half Height: A numeric value is displayed in the half-height font (8�8 dots).

Double Width: A numeric value is displayed in the double-width font 
(16�16 dots).

StandardHalf height
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[Scale]

Specify the character size.  (Only 1�1 (Equal) and 2�1 (Wide) can be set for
NT11S.)

1�1 (Equal): A numeric value is displayed at the original size both in height 
and width.

1�2 (High): A numeric value is displayed with doubled height and original 
width.

2�1 (Wide): A number is displayed at the original height and doubled width.

2�2: A numeric value is displayed with doubled height and width.

3�3: A numeric value is displayed with threefold height and width.

4�4: A numeric value is displayed with fourfold height and width.

8�8: A numeric value is displayed with eightfold height and width 
(not possible for NT20S).

1�1 1�2 2�1 2�2 3�3 4�4 8�8

Reference: With NT31, NT31C, NT631, NT631C with “-V1” , numbers of 2�2 or larger scale
are automatically displayed in 32 dot font.

[Smoothing]

Smoothing processing allows jags to be smoothed when a number is displayed in
an enlarged scale.

Selection of this item is possible, for numbers of “2�2” or larger.

Smoothing cannot be selected for NT20S and NT600S since smoothing process-
ing is always executed for numbers larger than “2�2” with these models.

Without smoothing With smoothing
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[Attribute]

This is an attribute to determine how a numeric value is displayed.  Attributes to be
displayed here vary somewhat according to the PT model.

Standard: The numeric value is displayed in the specified color and 
specified background color.

Inverse: The numeric value and background are displayed in colors 
which are the reverse of the specified colors.

Flash: The numeric value flashes when displayed.  If this attribute is 
selected, standard display and no display (background color 
only) are alternated.

Inverse Flash: The numeric value is displayed by alternating standard display
and inverse display.

Reference: To check “Flash” and “Inverse Flash” display on the screen, specify [Simulate
Flash] from [View] menu. (For details, refer to 5–1–3)

[Display Type]

Specify the notation in which numeric values are displayed.

Decimal: Numeric value is displayed in decimal.

Hexadecimal: Numeric value is displayed in hexadecimal.

The display will differ according to the specified notation even if the same content is
displayed.

Decimal Hexadecimal

[Format]

Specify the number of digits in the integer part and decimal fraction part.

Integer: Specify the number of digits entered in the integer part.

Decimal: Specify the number of digits entered in the decimal fraction part.

Integer part Decimal part
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[Zero Suppression]

Specify whether leading zeros should be suppressed.

Ticked: Leading zeros are suppressed.

Not ticked: Leading zeros are not suppressed.

Without zero suppression With zero suppression

[Display Sign]

Specify if a sign (–) is displayed.

When a negative numeric value is displayed with this item selected, a negative
sign “–” is displayed preceding a numeral.  Since this sign is included in the number
of digits in the integer part, the maximum digit number is reduced by 1.  When this
item is not selected, a negative numeric value is displayed as an absolute value.

Ticked: Numeric values are displayed without a sign.

Not ticked: Numeric values are displayed with a sign.

Without a sign With a sign

Reference: How a numeric value is displayed according to the setting for [Integer], [Decimal],
[Zero Suppression], and [Display Sign] is shown below.

Integer Decimal Zero 
Suppression Display Sign

Data Stored
in Numeral

Table

Display on
the Screen

3 0 Not ticked Check mark not set 12 012

3 0 Not ticked Check mark not set –12 012

3 0 Ticked Check mark not set 12 12

3 0 Ticked Check mark not set –12 12

3 0 Ticked Check mark set 12 12

3 0 Ticked Check mark set –12 –12

3 1 Not ticked Check mark not set 1 000.1

3 1 Not ticked Check mark not set –12 001.2

2 1 Not ticked Check mark set 1 00.1

2 1 Not ticked Check mark set –12 –01.2

2 1 Ticked Check mark set 1 0.1

2 1 Ticked Check mark set –12 –1.2

*: With conventional PT models, negative numeric value data is prefixed by “F”.
For example, “–12” is set as “F0000012”.
With NT31, NT31C, NT631, and NT631C, numeric values are stored as
signed binary data.
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Channel setting for an element

Specify the PC (PLC) address used for reading and writing by an element such as
memory table, lamp, or touch switch.

For a numeral or character string memory table (string table), specify the lower ad-
dress or the least significant address of the word to be referred to.

For a lamp, a touch switch, or a bit memory table, specify the allocated bit number.

When specifying a bit, specify the address and bit position of a word which is re-
ferred to.

Note that, timer (TIM) and counter (CNT) cannot be set for bits or (character) string
words.

� Using PLC address setting dialog box

Normally, a button for displaying the PLC address setting dialog is provided for
PLC address input field.

In the dialog, PLC addres can be set easily by selecting from the available areas.

Example:  Numeral table
(PLC Vendor : OMRON)

Example:  Touch switch
(PLC Vendor : OMRON)

[Channel]

Select the type of channel to be referred to from the list box.

[Address]

Input the address of channel to be referred to.

[Bit]

Input the bit position of channel address to be referred to.

Direct input of PLC address

It is possible to input PC (PLC) address, for example “D00001”, directly into the
address input field . You can input addresses easily when you know which area is
available.

When inputting PLC addresses, input a channel number and a bit number without
a blank following a character which indicates area type. However, in case of nu-
meral table or string table, specification of bit number is not needed.

When you do not specify PLC address, input “- -” into the input field.

Input methods varies according to the “PLC Vendor” setting as follows. Only input
method is described here. For details on specification method of PLC address for
PLC other than OMRON, refer to “PC Connection Operation Manual (V042-E1–�)”
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[PLC Vendor: OMRON]

Possible areas and characters which indicate area type are as follows.

Character Area Type Channel Bit
None Common I/O Area � �

H Holding Relay � �

A Auxiliary Relay � �

L Link Relay � �

T Timer � �

C Counter � �

D Data Memory Area � �

E EM Current Bank � �

�: Specification possible �: Specification not possible

With NT11S, NT20S, NT30, NT30C, NT600S, NT620S, NT620C and NT625C:
Input a channel number as a 4-digit number (leading zeros can be suppressed)
and a bit number as a 2-digit number.

With NT31, NT31C, NT631 and NT631C: 
Input a channel number as a 5-digit number (leading zeros can be suppressed)
and a bit number as a 2-digit number.

[PLC Vendor: MEMLINK]

Possible areas and characters which indicate area types are as follows.

Character Area Type Channel Bit
None Memory Link Area � �

�: Specification possible �: Specification not possible

Input a channel number as a 4-digit number (leading zeros can be suppressed)
and a bit number as a 2-digit number.

[PLC Vendor: Mitsubishi_A]

Possible areas and characters which indicate area types are as follows.

Character Area Type Channel Bit
X Input Relay � �

Y Output Relay � �

M Internal Relay � �

L Latch Relay � �

B Link Relay � �

C Counter � �

T Timer � �

D Data Register � �

R File Register � �

W Link Register � �

�: Specification possible �: Specification not possible

Input a channel number as a 4-digit number (leading zeros can be suppressed)
and a bit number as a 2-digit number.
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[PLC Vendor: Mitsubishi_Fx]
Possible areas and characters which indicate area types are as follows.

Character Area Type Channel Bit
X Input Relay � �

Y Output Relay � �

M Auxiliary Relay � �

S State � �

C Counter � �

T Timer � �

D Data Register � �

�: Specification possible �: Specification not possible

Input a channel number as a 4-digit number (leading zeros can be suppressed)
and a bit number as a 2-digit number.

Batch address change operation

The set PC (PLC) addresses can be changed into the required addresses in a
batch.  Since the change source can be specified as a range, processing such as
changing the address range “DM1000 to 01499” to the address range “DM1800 to
2299” is possible at one time.  Shifting in bit units is also possible.

Reference: Batch address change operation is possible using either the dialog box displayed
by [Tools] → [Table...] or the function called by [Tools] → [Change Address].  De-
pending on how the address change operation is called, the objective addresses
differ – in the operation using the edit dialog box of the memory table, addresses in
the table being edited are objective while all addresses in the entire screen data
are objective of the operation if the operation is performed using the [Tools] menu.

The explanation below is given for the batch address change operation where the
entire screen data is the objective of the operation.  For the procedure to perform
the operation using the edit dialog box of the memory table, refer to 7-1–3 “Batch
Address Change Operation”.

� Description of batch address change dialog box

[Find] – [Channel]

Specify the channel type of the batch change source.

[Find] – [Start Range]

Specify the start address of the source range for the batch address change.
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[Find] – [End Range]

Specify the end address of the source range for batch address change.

The address to be set for [End Range] must always be larger than or equal to the
address set for [Start Range].

[Change to] – [Channel]

Specify the channel type, and start address, after the change.

Addresses are changed within the number of specified points from the start ad-
dress (number of points from “Start Range” to “End Range”).

[Change Comment]

Specify whether or not the same I/O comment appended to an address before
the change is appended to the address after the change.

To append the same I/O comment, click on the check box to display a check mark
in it.

Batch address change processing starts when you click on this button.

� How addresses are changed

In the operation for changing addresses in bit units, processing is executed as-
suming that bit 15 of a word is immediately followed by bit 0 of the next word.

Addresses are changed as shown below according to the set search range and
the address after the change.

Example: Bit memory table

15 10 0

[Change To] – [Address] 
(start address after the change)

Address and Bit set 
for [Start Range]

CIO area Word 0CIO area Word 1

Bit 15 0

Address and Bit set 
for [End Range]

15 0Bit 15 0

Holding relay Word 10Holding relay Word 11

Before change After change

0000010 H0001000

0000012 H0001002

0000100 H0001006

0000110 H0001100

0000115 H0001105
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� Operation procedure

(1) [Tools] (menu bar) → [Change Address]

(2) Select the type of channel before the change in the [Channel] box.

(3) Specify the range of the change by setting addresses at the [Start Range] and
[End Range] boxes.

(4) Specify the channel and the address after the change in the corresponding
boxes in the [Change To] area.

(5) Set a check mark in the Change Comment check box as desired.

If a check mark is set in this check box, I/O comments appended to the ad-
dresses before the change are also appended to the addresses after the
change.

(6) Click on .

Setting the current object status as the existing value

Register the status of the selected object as the existing value of the same kind of
object.  This feature allows the status of the object, when it is registered to the
screen, to be changed, eliminating the operation steps to modify the property of the
object.

Note that the PC (PLC) address and reference memory table cannot be registered
as the existing value.

(1) Specify the object to be registered as the existing value (select only one ob-
ject).

(2) [Draw] (menu bar) → [Use as Default] (Or select [Use as Default] from pop–up
edit menu)

The current set status of the specified object is registered as the existing value
of the same kind of object.
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6-1-11 Relationships between Elements and Memory Tables
The relationships between elements and memory tables are shown below.

When creating an element, attend carefully to the memory table address, capacity,
etc.

�: Reading from a memory table
�: Writing to a memory table

Numeral Memory
Table

Character String
Memory Table
(String Table)

Bit Memory Table

Numeral display � – –

Bar graph � – –

Analogue Meter � – –

Broken-line graph � – –

Trend graph � – –

Numeral setting
+ Touch switch (for inputting control code)*1 � – –

Numeral setting
+ Touch switch (for copy setting)*1 � – –

Numeral setting
+ Touch switch (for numeral input)*1 � – –

Thumbwheel switch �

Alarm list – � �

Alarm history – � �

(Character) string display – � –

(Character) string setting
+ Touch switch (for (character) string input)*1 – � –

(Character) string setting
+ Touch switch (for inputting control code)*1 – � –

(Character) string setting
+ Touch switch (for copy setting)*1 – � –

Standard lamp*2 – – –

Image lamp*2 – – –

Touch switch (for notifying input)*3 – – –

*1: Numeral setting and (character) string setting are used in combination with a
touch switch.

*2: A standard lamp and an image lamp reads the specified PC (PLC) bit 
directly without using a memory table.

*3: A touch switch (for notifying input) directly drives the specified PC (PLC) bit 
ON/OFF without using a memory table.
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6-2 Fixed Display
Fixed display means graphic data which does not have the data communication
function with a PC and a memory table.

Set only general properties.

Reference: Rotation and other processing are not possible for the fixed display.  For image
data, rotation and inverse are possible during creation of the image data.

6-2-1 Polyline
A straight line is drawn.

Polylines cannot be used with NT11S.

(1) A continuous line is drawn and changed into a required shape.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Polyline]

Selection using the drawing toolbar:

Terminology

Vertex

Vertex

Property setting

[General]

Line Style: Specify the type of line
Solid line, dotted line, alternate short and long lines, alternate two 
short and long lines

Attribute

Standard, Flash (Flash can be set only for NT31, NT31C, NT631, and NT631C)

Colour

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
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Guidance

� For line type, the following four choices are provided.

Dot-dot-dashSolid Dash Dot-dash

The line type is specified using the line style property.

� When creating a polyline, draw a continuous line first, then add vertices in the
edit operation to change the drawn continuous line into the desired broken line.

Vertices can be set at up to 254 positions.

� To add a vertex, follow the steps shown below.

(1) Draw a continuous line.

(2) After locating the cursor at a position where a vertex is to be added, right click
the mouse and select [Add Node] in the pop-up menu.

(3) Drag the vertex to the desired position.

Cursor position

[Remove Node]
executed

� To remove a vertex, locate the cursor on the vertex to be removed and select
[Remove Node] in the pop-up menu.
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6-2-2 Arc
An arc is drawn.

Arcs cannot be used with NT11S, NT20S and NT600S.

(1) An arc is drawn.  The radius of an arc can be changed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Arc]

Selection using the drawing toolbar:

Terminology

Center point

End point

Start point

Property setting

[General]

Position

Center point: Indicates the position of the center of an arc.

Start point: Indicates the position of the start point of an arc.

End point: Indicates the position of the end point of an arc.
An arc is drawn anti-clockwise from the start point to the end 
point.

Size: Indicates the radius of an arc.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
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Guidance

� An arc is defined by the center point, the start point, and the end point

The line type is specified using line style attribute.

Center point: Indicates the position of the center of an arc.

End point: Indicates the position of the end point of an arc.
The end point can be dragged to the desired position.

Start point: Indicates the position of the start point of an arc.
When the start point is dragged, the start point position and arc 
radius are changed.

6-2-3 Rectangle
A rectangle is drawn.

Rectangles cannot be used with NT11S, NT20S and NT600S.

(1) A rectangle is drawn.  The length of a vertical and horizontal sides can be
changed.

Operation procedure

Selection using the menu bar: [Objects]  → [Fixed Display] → 
[Rectangle]

Selection using the drawing toolbar:

Terminology

Position
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Property setting

[General]

Position: Indicates the display position of a rectangle.

Size: Indicates the size of a rectangle.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

� A rectangle element can be modified in the manner shown below.

A rectangle can be modified by dragging a green � mark (handle).

Modified in the 
upper left direction

Modified in the
left direction

Modified in the
lower left direction

Modified in the
lower direction

Modified in the
upper direction

Modified in the 
upper right direction

Modified in the 
upper left direction

Modified in the
right direction

Modified in the 
lower right direction

� To tile a rectangle, paste a tiling element into it.

Rectangle

Tiling element

For details of tiling elements, refer to 6-2-8 “Tiling”.

6-2-4 Circle
A circle is drawn.

Circles can be used with all models except for NT11S.

(1) A circle is drawn.  The radius of a circle can be changed.
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Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Circle]

Selection using the drawing toolbar:

Terminology

Center point

Property setting

[General]

Position

Center point: Indicates the position of the center of a circle.

Size: Indicates the radius of a circle.

Attribute: Specify the display attribute. (Setting is not possible with NT20S
and NT600S)
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

� A circle element can be modified in the manner shown below.

A circle can be modified by dragging a green � mark (handle).

Note that a circle cannot be deformed to an oval.

For modification in the
lower right direction

For modification in the
upper left direction

For modification in the
lower left direction

For modification in the
upper right direction



155

Fixed Display Section 6-2

� To tile a circle, paste a tiling element into it.

Tiling element

Circle

For details of tiling elements, refer to 6-2-8 “Tiling”.

6-2-5 Polygon
A polygon is drawn.

Polygons cannot be used with NT11S, NT20S and NT600S.

(1) After a polygon is drawn, it is modified to give the desired shape.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Polygon]

Selection using the drawing toolbar:

Terminology

Vertex   (Node)
Vertex

Attribute point

Vertex

Property setting

[General]

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Position: Indicates the position of Attribute Point (reference point).
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Guidance

� A polygon is created on the basis of a triangle.  After a triangle is drawn, vertices
are added in the edit operation to create a polygon.

Vertices can be set at up to 255 positions.

� To add a vertex, follow the steps shown below.

(1) Draw a polygon.

(2) After locating the cursor at a position where a vertex is to be added, right click
the mouse and select [Add Node] in the pop-up menu.

(3) Drag the vertex to the desired position.

� To remove a vertex, locate the cursor on the vertex to be removed and select
[Remove Node] in the pop-up menu.

Cursor position

[Remove Node] executed

� To tile a rectangle, paste a tiling element into it.

Polygon

Tiling element

For details of tiling elements, refer to 6-2-8 “Tiling”.
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6-2-6 Sector
A sector is drawn.

Sectors cannot be used with NT11S, NT20S and NT600S.

(1) A sector is drawn.  The size of a sector can be changed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Sector]

Selection using the drawing toolbar:

Terminology

Center point

End point

Start point

Property setting

[General]

Position

Center point: Indicates the position of the center of a sector.

Start point: Indicates the position of the start point of a sector.

End point: Indicates the position of the end point of a sector.
A sector is drawn anti-clockwise from the start point to the end
point.

Size: Indicates the radius of a sector.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the line color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
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Guidance

� A sector is defined by the center point, the start point, and the end point

The line type is specified using line style attribute.

Center point: Indicates the position of the center of a sector.

End point: Indicates the position of the end point of a sector.

The end point can be dragged to a desired position to change
the position of the end point.

Start point: Indicates the position of the start point of a sector.

When the start point is dragged, the start point position and 
sector radius are changed.

� When tiling a sector, paste a tiling element in it.

Tiling element

Sector

For details of tiling element, refer to 6-2-8 “Tiling”.

6-2-7 Text
Text is drawn.

Text can be used with all models.

(1) Text is drawn.  Font, size, color, etc. can be changed.

Note Mark data can be inserted into a (character) string.  With NT30, NT30C, NT620S,
NT620C, and NT625C, image data can also be inserted.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Text]

Selection using the drawing toolbar:
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Terminology

Foreground color

Background color

Property setting

[General]

Description: Set the text to be displayed.

Position: Indicates the position where the text is displayed.

Font type: Specify the font.   (Only Standard can be set for NT11S.)
Standard, Half Height

Scale: Specify the character size.  
(Only 1�1 (Equal) and 2�1 (Wide) can be set for NT11S.)
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 
8�8 (Not for NT20S)

Smoothing: Specify whether smoothing processing is executed for characters
larger than “2�2” scale.
(Setting is not possible for NT11S, NT20S and NT600S.  For
NT20S, NT600S, smoothing is always ON.)

Attribute: Specify the display attribute. 
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the text color.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, 
yellow (Transparent is available for NT31, NT31C, NT631, 
NT631C)

Background: Specify the color of the background in the text display area.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, 
yellow

: Select the mark data to be pasted into a (character) string.

: Select the image data to be pasted into a character
string.
(Only for NT30, NT30C, NT620S, NT620C, and NT625C)
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Guidance

� The maximum number of characters that can be input (displayed) is:

NT11S: 20 characters

NT20S: 32 characters

NT30, NT30C, NT31, NT31C: 40 characters

NT600S, NT620S, NT620C/NT625C, NT631, NT631C: 80 characters

� To display “\”, input two characters without a blank, like “\\”.

� It is possible to insert mark data, image data into a (character) string.
(For NT20S, NT600S, mark data can be used only in strings.)

Note that insertion of image data is possible only for NT30, NT30C, NT620S,
NT620C, and NT625C.  Although NT31, NT31C, NT631, and NT631C support
image data, it cannot be inserted into a (character) string.

The procedure for inserting mark data, image data into a (character) string is
shown below.

(1) In the (character) string input field, move the cursor ( | ) to the mark/image data
insertion position.

(2) Select  or  in the dialog box.

The mark selection dialog box or image selection dialog box is displayed.  Se-
lect the mark data, image data to be inserted and click on .

Mark data: FF20 to FFFFH (FF20 to EF5FH for NT11S, NT20S 
and NT600S)

Image data: Only for NT30, NT30C, NT620S, NT620C, and 
NT625C
FE20 to FEFFH

Example: Mark data

(3) The code of the specified data is displayed at the data insertion position in the
(character) string input field.

(4) Click on  to close the (character) string attribute.  The set mark data,

image data, or library data is displayed in the (character) string displayed on
the screen.
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6-2-8 Tiling
The closed area of the graphic (inside the border) will be filled with some pattern
and color.

Tiling cannot be used for NT11S, NT20S and NT600S.

(1) The area inside the border is tiled according to the specified color and pattern.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Tiling]

Selection using the drawing toolbar:

Terminology

Background colorForeground color

Border
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Property setting

[General]

Position: Indicates the position of the tiling element.

Pattern: Specify the tiling pattern.

Colour

Foreground: Specify the foreground color of the tiling area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the tiling area.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, 
yellow

Border: Specify the color of the border of tiling area. 
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Guidance

� A � mark (handle) is displayed when a tiling element is selected.

Property setting and tiling element can be edited by selecting the � mark (han-
dle).

� Tiling is possible for the elements shown below.
Rectangle, circle, polygon, sector

In addition to the elements indicated above, tiling is possible for an area en-
closed by a solid line of the same color (border color).  If an element such as a
lamp which changes status is specified for the border, however, tiling may not be
executed correctly due to changes in color and display.

� To check the tiling status, select [View] (menu bar) then select [Full Tiling].  The
result of tiling will be displayed (in this state, a check mark is set for [Full Tiling] in
the display menu.).

When [Full Tiling] is selected again, then return to the previous � mark (handle).

Selection of
[Full Tiling]

Selection of
[Full Tiling]

� To execute tiling, specify the same color for the border of area and the border of a
tiling element.

Tiling is executed in the enclosed area for which the same color as the color set
for the border is set.  If an enclosed area with the same color does not exist, the
tiling extends outside the enclosed area.

� If the tiling area is not an enclosed area, the tiling spills out the specified area.

� The patterns are displayed in the actual status of tiling according to the setting for
the foreground and background color.

The available tiling patterns are shown below.
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Reference: � If “Full Tiling” is performed, performance of Support Tool may be slower. In this
case, clear the check mark for [Full Tiling] from [View] menu.

� [Full Tiling] is automatically cancelled when a filter function is performed for
“Fixed Display”.

� “Color Palette Symbol” for which tiling patterns and color combinations are regis-
tered is supplied with Support Tool as symbol data.  Using color palette symbol
enables you to register required tiling objects on screen while checking their dis-
play status.  Color palette symbol does not have transparent background pat-
terns.  Border colors are set to ‘White’.  Change the setting as required when us-
ing it.  For details, refer to 6-10-5 “Operating Procedure of Colour Palette
Symbol”.

6-2-9 Image Object (Data)
Image data is displayed.

There are two types of image data. One type of image data references the fixed
code directly, the other type uses indirect reference. Indirect reference is a function
which can change the image data to be displayed by writing the image code to the
numeral table just like the indirect reference of numeral/string display. This en-
ables the animation display by switching the display contents using a simple pro-
gram. For details of the PT models which can use indirect reference, refer to Ap-
pendix D “Table of Functions of Each PT Model”.

Image data cannot be used for NT11S, NT20S and NT600S.

 

(1) Image data created in the bit map (BMP) format is displayed.

Note Bit map data created by general application software running on Windows can be
displayed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → 
[Image Display]

Selection using the drawing toolbar:

Terminology

Foreground color

Background color
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Property setting

[General]

Position: Indicates the display position of image data.
(The reference point is at the upper left corner in the image 
element.)

Size: Indicates the size of image data.

Reference Type

Direct: Set the image code directly.

Code: Indicates the code number of the image data to be displayed.

Mode: Indicates the color mode of the image data (2 colors, 8 colors).

Comment: Displays the comment which is set for the image data.
Indirect: Set this item when the value for the specified numeral table is 

treated as image code and referenced indirectly.

Table No.: Specify the address of numeral table to be referenced. 
When using the indirect reference, set the storage type of 
allocated numeral table to “Binary”. Also, when specifying the 
image code from a program etc., use hexadecimal value since 
the image table code is in hexadecimal.

Colour

Foreground: Set the display color of image data.
 (Setting is possible only when 2 colors is set for the color mode.)

Background: Set the color of background in the image data display area.
(Setting is possible only when 2 colors is set for the color mode.)

: Displays the list for selecting the image data when “Direct” is 

specified. Displays the list for referencing the numeral table 
when “Indirect” is specified.

 

Guidance

� When the image data is firstly specified, the data of character code FE20H (for
NT30, NT30C, NT620S, NT620C, NT625C), or the data that corresponds to
image/library code 0001H (for NT31, NT31C, NT631, NT631C) is arranged as
default.

� The mark shown below will be displayed if image data has not been created for
the specified code.

� To change the image data to be displayed, click on  in the property and select

the desired image data or numeral table from the list.         
If you are using the NT31, NT31C, NT631 or NT631C with “–V1” and its system
program version is 2.1, “Indirect reference” can be set.

The procedure for specifying the desired image data is shown below.
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[Direct]
Specify the code of the image data to be displayed directly.

(1) Click on  at the right side of “Code” after checking the [Direct] button in the

property setting dialog box to display the image data selection dialog box.

(2) If the code of the desired image data is not found in the list, scroll the list using
the scroll bar at the right side of the screen, or click on  to open the
code input dialog box.

Input the code of the desired image data and click on .

By pressing cursor keys (�, �) on keyboard, the contents of the code can be
checked in the preview window one by one.

(3) Select the code of the desired image data to be displayed.

The selected line will be highlighted.

(4) Click on  to close the dialog box.

[Indirect]
Specify the numeral table to be referenced.
With indirect reference, the contents for the specified numeral table are treated as
an image code and the corresponding image data is displayed. This is useful when
you want to change the image data to be displayed according to the statuses. Set
the storage type of numeral table to be referenced by indirect reference to “Binary”
and specify the value (image code) to be stored in hexadecimal since the image
code is in hexadecimal.
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Set the numeral table number to be referenced to “Table No.”.
It is possible to display a numeral table so that you can select the desired table
number from it.
To display a numeral table, follow the procedure below.

(1) Click on  at the right side of “Table No.” after checking the [Indirect] button

in the property setting dialog box to display the numeral table selection dialog
box.

(2) If the number of the desired numeral table is not found in the list, scroll the list
using the scroll bar at the right side of the screen, or click on  to

open the entry input dialog box.

Input the entry of the desired numeral table and click on .

(3) Select the desired numeral table to be referenced.
The selected line will be highlighted.

(4) Click on  to close the dialog box.

How to create the image data is described in 8-1 “Image Editor”.
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6-2-10 Mark
Mark data is displayed.

Mark data can be used for all models.  (With NT11S, NT20S, and NT600S, mark
data can be inserted only in string.)  Since the Support Tool does not support mark
data of 32 � 32 dots and 64 � 64 dots, it is necessary to group 16 � 16 dot marks
if image data created by the DOS version Support Tool is imported.

(1) The mark data, fixed at 16 � 16 dot size, is displayed.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → [Mark]

Selection using the drawing toolbar:

Terminology

Foreground color

Background color

Property setting

[General]

Position: Indicates the display position of mark data.
(The attribute point is at the upper left corner in the mark data.)

Code: Indicates the character code of the mark data to be displayed.

Attribute: Specify the display attribute.
Standard, Inverse, Flash, Inverse Flash
(With NT31, NT31C, NT631 and NT631C, “Inverse” is not
supported.)

Scale: Specify the character size.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 8�8

Smoothing: Specify whether smoothing processing is executed for mark data.*1

(Setting is not possible for NT31, NT31C, NT631 and NT631C)

Colour

Foreground: Set display color of mark data.

Background: Set the color of background in the mark data display area.

: Displays the list for selecting the mark data.
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*1: For NT31, NT31C, NT631, and NT631C, even under condition that the
string has smoothing ON and the mark has inserted, it will not work.

Guidance

� By specifying mark data, special characters and symbols can be created on the
screen.

� To display a mark, specify its code.

� If no mark data has been created for the specified code, a blank is displayed.

� To change the mark data to be displayed, click on  in the property setting
dialog box and select the desired mark data in the list.

The procedure for selecting the desired mark data is shown below.

(1) Click on  in the attribute setting dialog box to display the mark data
selection dialog box.

(2) Specify the mark data to be displayed.  The specified field is displayed en-
larged.  Or, input the character code which corresponds to the mark data to be
displayed into the [Code] input field.

(3) Click on  to close the dialog box.

� For the procedure for creating mark data, refer to 8-3 “Mark Editor”.



169

Fixed Display Section 6-2

6-2-11 Library Object (Data)
Library data is displayed.

There are two types of library data. One type of library data references the fixed
code directly, the other type uses indirect reference. Indirect reference is a function
which can change the library data to be displayed by writing the library code to the
numeral table just like the indirect reference of numeral/string display. This en-
ables the animation display by switching the display contents using a simple pro-
gram. For details of the PT models which can use indirect reference, refer to Ap-
pendix D “Table of Functions of Each PT Model”.

Library data cannot be used for NT11S, NT20S and NT600S.

 

(1) Library data consisting of fixed display elements is displayed.

Note By registering a graphic created using multiple fixed display elements as the library
data, the same graphic can be arranged in different positions.

Operation procedure

Selection using the menu bar: [Objects] → [Fixed Display] → 
[Library Display]

Selection using the drawing toolbar:

Property setting

[General]

Position: Indicates the display position of library data.
(The attribute point is at the upper left corner in the library data.)

Size: Indicates the size of library data. (frame size of the library data)

Reference Type

Direct: Set the library code directly.

Code: Indicates the code of the library data to be displayed.

Comment: Displays the comment which is set for the library data.

Indirect: Set this item when the value for the specified numeral table is 
treated as library code and referenced indirectly.
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Table No.: Specify the address of numeral table to be referenced. 
When using the indirect reference, set the storage type of 
allocated numeral table to “Binary”. Also, when specifying the 
library code from a program etc., use hexadecimal value since 
the library table code is in hexadecimal.

: Displays the list for selecting the library data when “Direct” is 

specified. Displays the list for referencing the numeral table 
when “Indirect” is specified.

Guidance

� When the library data is specified, the data of character code FA20H (for NT30,
NT30C, NT620S, NT620C, NT625C), or the data that corresponds to image/li-
brary code 1000H (for NT31, NT31C, NT631, NT631C) is arranged.

� The mark shown below will be displayed if library data has not been created for
the specified code.

� To change the library data to be displayed, click on  in the property and select

the desired library data or numeral table from the list.         
If you are using the NT31, NT31C, NT631 or NT631C with “–V1” and its system
program version is 2.1, “Indirect reference” can be set.

The procedure for specifying the desired library data is shown below.

[Direct]
Specify the code of the library data to be displayed directly.

(1) Click on at  the right side of “Code” after checking the [Direct] button in the

property setting dialog box to display the library data selection dialog box.



171

Fixed Display Section 6-2

(2) If the code of the desired library data is not found in the list, scroll the list using
the scroll bar at the right side of the screen, or click on  to open the
code input dialog box.

Input the code of the desired library data and click on .

By pressing cursor keys (�, �) on keyboard, the contents of the code can be
checked in the preview window one by one.

(3) Select the code of the library data to be displayed.

The selected line will be highlighted.

(4) Click on  to close the dialog box.

[Indirect]
Specify the numeral table to be referenced.
With indirect reference, the contents for the specified numeral table are treated as
a library code and the corresponding library data is displayed. This is useful when
you want to change the library data to be displayed according to the statuses. Set
the storage type of numeral table to be referenced by indirect reference to “Binary”
and specify the value (library code) to be stored in hexadecimal since the library
code is in hexadecimal.

Set the numeral table number to be referenced to “Table No.”.
It is possible to display a numeral table so that you can select the desired table
number from it.
To display a numeral table, follow the procedure below.
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(1) Click on  at the right side of “Table No.” after checking the [Indirect] button

in the property setting dialog box to display the numeral table selection dialog
box.

(2) If the number of the desired numeral table is not found in the list, scroll the list
using the scroll bar at the right side of the screen, or click on  to

open the entry input dialog box.

Input the entry of the desired numeral table and click on .

(3) Select the desired numeral table to be referenced.
The selected line will be highlighted.

(4) Click on  to close the dialog box.

� For the procedure for creating library data, refer to 8-2 “Library Editor”.
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6-3 Alarm
Alarms are elements which check the status of a bit memory table and change the
contents of the display according to the detected status.  Alarm elements consist of
alarm lists and alarm histories.

Alarm list:

When a bit memory table in the specified range goes ON, the alarm list dis-
plays the corresponding message or image/library data.

Since the bit memory tables to be checked are set for the individual alarm lists,
it is possible to check different ranges of bit memory tables with different alarm
tables.

Bit memory tables in the specified range are checked only while an alarm list is
displayed, and the message and image/library data are displayed in accor-
dance with the bit memory table which is ON.

Alarm history:

When a bit memory table for which a check mark is set for the history property
goes ON, the date/time and the number of going ON events are recorded and
displayed by the alarm history.  All bit memory tables for which a check mark is
set for the history property are objects of alarm history recording.  Therefore, it
is not possible to check different bit memory tables with different alarm histo-
ries.

The status of the bit memory tables for which a check mark is set is always
checked while a PT is running, regardless of whether or not an alarm history
element is displayed.

Note that an alarm history element displays only the record of past events.  It
displays only the contents of the record at the point when it was displayed and
the displayed record remains the same even if the status of the bit memory
table changes after that.

Alarm list and alarm history elements cannot be used with NT11S, NT20S and
NT600S.
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6-3-1 Alarm List
If a bit memory table in the check objective range goes ON, the alarm list element
displays the contents (alarm message) of the character string memory table (string
table) which is allocated to the bit memory table.  It is also possible to display the
corresponding image/library data.

Note It is possible to switch the screen by operating the alarm list element by setting the
screen number to which the screen should be switched for the bit memory table.

No.1

No.2

Screen

Alarm
list

Press
message

Bit memory table
Character string memory
table (String table)

Image/library data

WARNING  HIGH TEMP.

WARNING  HIGH TEMP.

(1) When the bit memory table number in the specified range goes ON, the alarm
list element reads out the alarm message from the character string memory
table (string table) and displays the message at the alarm list area in the
screen.

(2) If an operator touches the displayed alarm message, the specified image/li-
brary data will arrive.

Note The alarm message and the image/library data to be displayed are specified ac-
cording to the setting at the bit memory table.

Operation procedure

Selection using the menu bar: [Objects] → [Alarm] → [List]

Selection using the drawing toolbar:

Related elements and settings

Bit memory table: [Tools] → [Table] → Bit Memory
(Refer to 7-4 “Bit Memory Tables”.)
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Terminology

Frame

Display line

Length

Message Background

Page scroll touch switch

Line scroll touch switch

Image/
library data

Foreground

Background

Property setting

[General]

Position: Indicates the display position of the alarm list.
(The attribute point is at the upper left corner of the alarm list)

Size: Indicates the size of the alarm list.

Message

Length: Specify the number of characters of the message to be 
displayed.

Max. 39 characters: NT30, NT30C, NT31, and NT31C

Max. 40 characters: NT631 and NT631C to which a system program version 
lower than Ver.2.1 is installed

With these models above, the number of characters to be displayed will be less
than these values according to the display method and if the history information
is displayed.

Max. 40 characters: NT620S, NT620C, NT625C, NT631(System Ver.2.1), 
and NT631C(System Ver.2.1)

With these models above, up to 40 characters can be displayed regardless of the
display method etc.

Display Line Qty: Specify the number of messages to be displayed.

Max. 12 lines: NT30, NT30C, NT31, NT31C

Max. 16 lines: NT620S

Max. 24 lines: NT620C, NT625C, NT631, NT631C

Scale: Specify the character size of the message to be displayed.
1 � 1 (Equal), 1 � 2 (High), 2 � 1 (Wide), 2 � 2, 3 � 3, 4 � 4, 8 � 8

Smoothing: Specify if smoothing processing is executed for the message to be 
displayed.
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Line Scroll Touch Switch: Set if a touch switch is set for scrolling messages line 
by line.
Only for NT31, NT31C, NT631, and NT631C

Page Scroll Touch Switch: Set if a touch switch is set for scrolling messages 
page by page.
Only for NT31, NT31C, NT631, and NT631C

Colour

Frame: Specify the color used for the frame of an alarm list.

Background

ON: Specify the background color of the selected message display 
field.

OFF: Specify the background color of the message display fields 
which are not selected.

Image & Library

Display of Image Lib: Specify if the image/library data is displayed.

Colour

Specification of color is valid only when 2-color mode image data is displayed
by a color type PT.

Foreground: Specify the display color of image data.

Background: Specify the background color of the image data display area.

Reference: With NT30, NT30C, NT620S, NT620C, and NT625C, a dialog box is displayed to
set if the “line scroll touch switch” and “page scroll touch switch” are used.
With NT31, NT31C, NT631, and NT631C, whether or not the “line scroll touch
switch” and “page scroll touch switch” are used is determined in the alarm list/his-
tory properties.

[Settings]

List Setting

Start Bit Table Entry: Specify the start number of bit memory tables which 
are checked by the alarm list element.

No. of Bits Referenced: Specify the number of bit memory tables which are 
checked by the alarm list element.

Guidance

� Using a line scroll touch switch and a page scroll touch switch, you can scroll
messages in units of a line or a page within the alarm list display area.

� With NT31, NT31C, NT631, and NT631C, to display a line scroll touch switch
and/or a page scroll touch switch, set a check mark in the line scroll touch switch
and/or a page scroll touch switch check box in the Property setting dialog box.
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� With NT31, NT31C, NT631, and NT631C, a line scroll touch switch and a page
scroll touch switch are a part of an alarm list element.  Therefore, they cannot be
modified as a touch switch.  They can be moved only when the alarm list is modi-
fied.  For NT31, NT31C, NT631, and NT631C, the line and page scroll touch
switch can be moved by clicking the desired touch switch while holding down the
Shift key and Ctrl key. ([Edit Object] from [Edit] menu (or pop–up menu) and Ins
key can also be used for this operation.)

With NT30, NT30C, NT620S, NT620C, and NT625C, however, a line scroll
touch switch and a page scroll touch switch are independent elements and their
position, size, and label can be changed as required.  However, the touch switch
function and the lamp setting should not be changed, otherwise the switch and
the lamp will fail to function correctly on PT.

� To display the image/library data, set a check mark in the check box of [Display
Image Lib] in the Property setting dialog box.

� The procedure for editing the image/library data display area is shown below.

(1) Specify only the image/library data display area (dotted line frame) while hold-
ing down the Shift key and Ctrl key. (automatically enters to “Edit Object”
mode)

Green � marks (handles) are displayed surrounding the image/library data
display area.

There are other methods to enter “Edit Object” mode.  For details, refer to
“Specifying an element consisting of multiple elements” (p123).

(2) Specify the display size of the image/library data display area and move it as
desired.

� If the size of the image/library data is smaller than the display area, the image/li-
brary data is displayed taking the lower left corner of the display area as the refer-
ence.

Image/library data

Image/library data display area

Reference: With NT31, NT31C, NT631, NT631C, if image/library data is larger than the image/
library data display area, the area exceeding the display area will not be displayed
on PT while the whole data is displayed on the Support Tool. Be sure to set image/
library data display area so that image/library data fits inside it.
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� For an alarm list element, the property settings, bit memory table, and character
string memory table (string table) are related to each other as shown below.

:10

:FE20

:0001000

10

11

12

13

ABC

DEF

GHI

JKL

FE20

ABC

Table No.:  Set for “Start Bit Table
Entry”

Alarm list Displayed
at ON

Bit memory table

Character string memory

table (String table)

Image/library data

PC (PLC) address

Character string
memory table
(String table)

Image data

Specified PC
(PLC) bit

Number of bits; Set for “No. of Bits
Referenced”

� An alarm list element is used in combination with bit memory tables.  How they
function is shown below:

[Setting at bit memory table]

� Setting at “Set” dialog box

PLC Address

� Setting at “Function” dialog box

History
Screen No.

Switch Screen
Screen No.

String Table Entry
Image/Library Code

Use of image/library data
Image/library code

Colour

[Property settings for alarm list element]

Start Bit Table Entry
No. of Bits Referenced

� The setting for the [Switch Screen] bit memory table setting differs between
NT30, NT30C, NT620S, NT620C, and NT625C, and NT31, NT31C, NT631, and
NT631C as shown below.

NT30, NT30C, NT620S, NT620C, and NT625C:

Specifies whether or not the screen is switched at the same time the PC
(PLC) bit allocated to bit memory table goes ON.
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NT31, NT31C, NT631, and NT631C:

Specifies whether or not the screen is switched when the message dis-
played at the alarm list is pressed.

The following table shows the appropriate setting of the bit memory table for the
required alarm processing, for your reference.

NT30, NT30C, NT620S, NT620C, and NT625C:

Setting for Bit Memory Table
Usage of Alarm

Function Setting [Switch Screen] [Screen No.]

To display alarm only Alarm/Switch
Screen OFF 0

To display alarm and
switch to a specified
screen in response to
the pressing of alarm
message

Alarm/Switch
Screen OFF As desired

To switch to a specified
screen at the same time
the bit goes ON.

Alarm/Switch
Screen ON As desired

To switch to the pre-
vious screen at the
same time the bit goes
ON.  (Switch to the pre-
vious screen based on
the record of screen
history.)

Alarm/Switch
Screen ON 0

NT31, NT31C, NT631, and NT631C:

Setting for Bit Memory Table
Usage of Alarm

Function Setting [Switch Screen] [Screen No.]

No function  (For regis-
tering only allocated bits
and securing them)

None – –

To display alarm only Alarm OFF –

To display alarm and
switch to a specified
screen in response to
the pressing of alarm
message

Alarm ON As desired

To switch to a specified
screen at the same time
the bit goes ON.

Switch screen – As desired

When converting the bit memory table from NT30, NT30C,
NT620S, NT620C, NT625C to NT31, NT31C, NT631,
NT631C, the function setting is not the same with before

converting.  To adjust the setting of this bit memory table,
please refer to “Data Conversion (Bit memory conversion)”
in Appendix A. 

WARNING
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� The [Settings] of an alarm list element are used to specify the range of bit
memory tables which are subject to the check.

The check objective range is determined by setting the start bit memory table
number and the number of bit memory tables.  The maximum allowable number
of bit memory tables varies according to the PT model and the setting of the num-
ber of bit memory tables.  The range of bit memory table numbers is displayed in
parentheses in the dialog box: set the start memory table number and the num-
ber of memory tables so that the displayed range is not exceeded.

While an alarm list element is displayed, the status of the bit memory tables in the
specified range is always checked and the element displays the message or
image/library data which is set for the bit memory table when a bit memory table
is turned ON.

No.0
   1
   2
   3

 128
 129

Allocation of a PC (PLC) bit to a bit memory table is specified at the bit
memory table.  (Specified character string memory table (string table)
and image/library data code are also specified at the bit memory table.)

Bit memory table PC (PLC)

Alarm
range

The alarm range, i.e., the start address (No.) in the bit memory
table and the size, is specified by the alarm list element.
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6-3-2 Alarm History
If a bit memory table for which a check mark is set for the history property goes ON,
the date/time and the number of going ON events are recorded in an alarm history.
An alarm history element displays the recorded bit table numbers in the order of
occurrence or frequency when the element is displayed.

An alarm history element can also display the contents (alarm message) of the
character string memory table (string table) and the image/library data which are
allocated to the bit memory table. 

Screen

Alarm
history

Bit memory table

Image/library data

WARNING  HIGH TEMP.

WARNING  HIGH PRESS. 98/05/12 18:25

WARNING  HIGH TEMP. 98/04/10 16:02

WARNING  HIGH TEMP.   98/04/10 16:02

No.1

No.2

Character string memory
table (string table)

Alarm history record data

(1) When a bit memory table for which a check mark is set for the history property
goes ON, the alarm history element reads out the alarm message from the
character string memory table (string table) and records the message with the
date/time of the occurrence.  The recorded information is displayed when the
alarm history element is displayed.

(2) If the operator touches the displayed alarm message, the specified image/li-
brary data is displayed.

Note The bit memory tables to be checked are determined according to the settings
made at the individual bit memory tables.

Operation procedure

Selection using the menu bar: [Objects] → [Alarm] → [History]

Selection using the drawing toolbar:

Related elements and settings

Bit memory table: [Tools] → [Table] → Bit Memory
(Refer to 7-4 “Bit Memory Tables”.)
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Terminology

Frame

Display line

Length
Background

Page scroll touch switch

Line scroll touch switch

Background

Image/
library data

Foreground

Message

Property setting

[General]

Position: Indicates the display position of the alarm history.
(The attribute point is at the upper left corner of the alarm history)

Size: Indicates the size of the alarm history.

Message

Length: Specify the number of characters of a message to be displayed.

Max. 39 characters: NT30, NT30C, NT31, and NT31C

Max. 40 characters: NT631 and NT631C to which a system program version 
lower than Ver.2.1 is installed

With these models above, the number of characters to be displayed will be less
than these values according to the display method and if the history information
is displayed.

Max. 40 characters: NT620S, NT620C, NT625C, NT631(System Ver.2.1), 
and NT631C(System Ver.2.1)

With these models above, up to 40 characters can be displayed regardless of the
display method etc.

Display Line Qty: Specify the number of messages to be displayed.

Max. 12 lines: NT30, NT30C, NT31, NT31C

Max. 16 lines: NT620S

Max. 24 lines: NT620C, NT625C, NT631, NT631C

Scale: Specify the character size of the message to be displayed.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 8�8

Smoothing: Specify if smoothing processing is executed for the message to be 
displayed.

Line Scroll Touch Switch: Set if a touch switch is set for scrolling messages line 
by line.
Only for NT31, NT31C, NT631, and NT631C
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Page Scroll Touch Switch: Set if a touch switch is set for scrolling messages 
page by page.
Only for NT31, NT31C, NT631, and NT631C

Colour

Frame: Specify the color used for the frame of an alarm list.

Background

ON: Specify the background color of the selected message display 
field.

OFF: Specify the background color of the message display fields 
which are not selected.

Image & Library

Display of Image Lib: Specify if the image/library data is displayed.

Colour

Specification of color is valid only when the image data of 2-color mode is dis-
played by a color type PT.

Foreground: Specify the display color of image data.

Background: Specify the background color of the image data display area.

Reference: With NT30, NT30C, NT620S, NT620C, and NT625C, a dialog box is displayed to
set if “line scroll touch switch” and “page scroll touch switch” are used.
With NT31, NT31C, NT631, and NT631C, whether or not the “line scroll touch
switch” and “page scroll touch switch” are used is determined by the setting for the
use of control touch switches in the alarm list/history properties.

[Settings]

History Info:

Specify whether or not an alarm message is displayed with date/time of occur-
rence or frequency of occurrence.  If a check mark is set for this item, the date/
time of alarm occurrence is displayed with an alarm message in the case of “or-
der of occurrence”, or the frequency of occurrence is displayed with an alarm
message in the case of “frequency of occurrence”.  The display format of the
date/time of occurrence is set for [Info Type].  If the date/time or frequency of oc-
currence is displayed, the number of alarm message display characters is re-
duced accordingly.

Order Type

Order of Frequency: Alarm messages are displayed in the order of 
occurrence frequency.

Order of Occurrence: Alarm messages are displayed in the order of 
occurrence (from the oldest record or from the newest
record).  The order in which the alarm messages are 
displayed depends on the system memory setting.
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Info Type:

If the setting is so made to display the date/time of alarm occurrence, the display
format of the date/time is specified for this item.  The setting for this item is invalid
if the date/time is not displayed with an alarm message.

Y/M/D h:m (14 digits)
M/D h:m (11 digits)
h:m (5 digits)

Guidance

� Using a line scroll touch switch and a page scroll touch switch, you can scroll
messages in units of a line or a page within the alarm list display area.

� With NT31, NT31C, NT631, and NT631C, to display a line scroll touch switch
and/or a page scroll touch switch, set a check mark in the check box for the line
scroll touch switch and/or a page scroll touch switch in the Property setting dialog
box.

� With NT31, NT31C, NT631, and NT631C, a line scroll touch switch and a page
scroll touch switch are a part of an alarm list element.  Therefore, they cannot be
modified as a touch switch.  They can be moved only when the alarm list is modi-
fied.  To move a line scroll touch switch or a page scroll touch switch, click the
desired touch switch while holding down the Shift key and Ctrl key. ([Edit Object]
from [Edit] menu (or pop–up menu) and Ins key can also be used for this opera-
tion.)

With NT30, NT30C, NT620S, NT620C, and NT625C, however, a line scroll
touch switch and a page scroll touch switch are independent elements and their
position, size, and label can be changed as required.  However, the touch switch
function and the lamp setting should not be changed, otherwise the switch and
the lamp will fail to function correctly.

� To display the image/library data, set a check mark in the check box of [Display
Image Lib] in the Property setting dialog box.

� The procedure for editing the image/library data display area is shown below.

(1) Specify only the image/library data display area (dotted line frame) while hold-
ing down the Shift key and Ctrl key. (automatically enters to “Edit Object”
mode)

Green � marks (handles) are displayed surrounding the image/library data
display area.

(2) Specify the display size of the image/library data display area and move it as
desired.

� If the size of the image/library data is smaller than the display area, the image/li-
brary data is displayed taking the lower left corner of the display area as the refer-
ence.

Image/library data display area

Image/library data
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Reference: With NT31, NT31C, NT631, NT631C, if image/library data is larger than the image/
library data display area, the area exceeding the display area will not be displayed
on PT while the whole data is displayed on the Support Tool. Be sure to set image/
library data display area so that image/library data fits inside it.

� For an alarm history element, the property settings, bit memory table, and char-
acter string memory table (string table) are related to each other as shown be-
low.

Character string memory

table (String table) :10

:FE20

:H0001512

10

11

12

13

ABC

DEF

GHI

JKL

FE20

ABC        02/12

H0001512  97/02/12 10:51

History data

Alarm list

Displayed
at ON

Bit memory table

Image/library data

PC (PLC) address

Character string
memory table
(String table)

Image data

Specified PC
(PLC) bit

Number of bits; Set for “No. of Bits
Referenced”

Table No.:  Set for “Start Bit Table
Entry”

� An alarm history element is used in combination with bit memory tables.  How
they function is shown below:

[Setting at bit memory table]

� Setting at “Set” dialog box

 PLC Address

� Setting at “Function” dialog box

History
Screen No.

Switch Screen
Screen No.

String Table Entry
Image/Library Code

Use of image/library data
Image/library code
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Colour

[Property settings for alarm history element]

History Info
Order Type

� Order of Frequency

� Order of Occurrence

� All bit memory tables for which a check mark is set for the alarm history property
are subject to alarm history recording.
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6-4 Data Input
For inputting numerals and (character) strings in a PT, the following three data in-
put elements are provided.

Numeral input:

A numeric value is input into a numeral setting input field using touch switches to
which numerals are allocated and the input from an extended I/O connected to a
PT.

(Character) string input:

A (character) string is input to a (character) string input field using touch switches
to which characters are allocated and a bar code reader connected to a PT.

Thumbwheel switch:

Touch switches which increase or decrease a numeral are provided at each digit
of an input field; a numeric value can be input by simply pressing the + and –
touch switches.

String input is not possible for NT11S, NT20S and NT600S.

6-4-1 Numeral Input
You can write numeric data to a numeral memory table using touch switches and
extended inputs.

Touch switches must be allocated numerals or the copy function beforehand.

For extended inputs, numerals must be allocated beforehand.

Input using touch switches (control code input function)

PT

No.1
No.2
No.3
No.4
No.5

50

50

Screen

Numeric keys
System keypad

Input field  key

Numeral
memory table

Writing

(1) Create numeric keys using the touch switch control code input function, or
create a system keypad using the screen property. 
(With NT31, NT31C, NT631, NT631C, system keypad is not available.)

(2) Set a numeric value in the numeral setting input field using the numeric keys
on the screen.

(3) Press the touch switch to which the  key code is allocated to write the data
set at the input field to the specified numeral memory table.
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Input using touch switches (copy function + control code input function)

PT

No.1
No.2
No.3
No.4
No.5

50

50
50

Screen

Set

 keyInput field

Numeral
memory table

Copying the
set data

Set

(1) Copy the preset data (numeral memory table or constant) to the input field us-
ing the copy function allocated to a touch switch.

(2) Press the touch switch to which the  key code is allocated (by the control
code input function) to write the data which was copied (set) to the input field to
the specified numeral memory table.

Reference: To copy (in the numeral table) and display a numeral by a single key operation,
without using the  key code, use a touch switch (copy function) and a numeral
display element.

PT

No.1
No.2
No.3
No.4
No.5

50

50 50

Screen

Display field

Part type A

Numeral
memory table

Input using extended input (control code input function)

PT

No.1
No.2

No.3
No.4
No.5

50
50

 key

Screen

Input field

Extended
input

Numeral
memory table

External 
numeric keys

(1) By turning ON an external switch which is connected to an external input, the
numeral or the control code set for the extended input function can be input to
the numeral setting input field.

(2) Press the touch switch to which the  key code is allocated to write the data
set at the input field to the specified numeral memory table.
(For the setting of an extended input, refer to 7-5 “Extended I/O Input Tables”.)

Operation procedure

Selection using the menu bar: [Objects] → [Data Input] → [Numeral]

Selection using the drawing toolbar:
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Related elements and settings

Touch switch (control code input): [Objects] → [Touch Switch] → 
Control code input function

Touch switch (copy setting): [Objects] → [Touch Switch] → 
Copy setting

Extended I/O input table (control code input):
[Tools] → [Table] → Control code function

Terminology

Cursor (focus) moving touch switch Foreground

Background

Focus (cursor) frame

Sign digit

Integer Decimal

Input digits of maximum limit

Property setting

[General]

Position: Indicates the display position of the numeral setting input field.
(The attribute point is at the upper left corner of the input field.)

Font type: Specify the font for the numerals to be input.
Standard, Half Height, Double Width 
(Only Standard can be set for NT11S.)

Size: Specify the size of numerals to be displayed.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 
8�8 (Not supported for NT20S) (Only 1�1 (Equal) and 
2�1 (Wide) can be set for NT11S.)

Smoothing: Specify whether or not smoothing processing is executed for 
numerals.
(Setting is not possible for NT11S, NT20S and NT600S.)

Attribute: Specify the display attributes (attributes to be displayed depend on 
PT models.)
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the numeral color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the numeral display area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
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[Settings]

Table Entry: Specify the table number of the numeral memory table where input 
data is stored.

Display Type (Only Decimal can be set for NT11S.)*1

Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in 
hexadecimal.

Format*2

Integer: Specify the number of digits of the integer part of the input data.

Decimal: Specify the number of digits of the decimal fraction part of the 
input data.

Limit (Setting is not possible for NT11S.)*1

Maximum: Specify the upper limit of the input data.*3

Minimum: Specify the lower limit of the input data.*3

Zero Suppression:*1 Specify whether or not leading zeros are suppressed to 
display the input data.

Display Sign:*1 Specify if a sign is displayed for a negative value.

Focus Frame: Specify whether or not the frame which indicates the data 
input objective is displayed.  (Setting is not possible for 
NT11S, NT20S and NT600S.)

Focus Attribute: Specify how the input data is displayed before it is 
confirmed.
Standard, Inverse, Flash, Inverse Flash

*1: Setting is not possible when a numeral input is used as a temporary input field
for NT31, NT31C, NT631, NT631C.

*2: When a numeral input is used as a temporary input field fot NT31, NT31C,
NT631, NT631C, only No. of digits (sign digit + integer digit + decimal point +
decimal digit) can be specified, since the digits such as decimal digits are de-
termined by the numeral input field on a base screen.

*3: An input method for a negative value in decimal differs between the following
types of PT.

� With NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C: 
Put “F” which indicates a negative value at the most significant digit.
(eg. F0000008)

� With NT31, NT31C, NT631, and NT631C: 
Put “−” (negative sign) at the most significant digit.
(eg. −8)
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Guidance

� When a numeral input element is specified, a dialog box is displayed to set
whether the cursor moving touch switch is automatically created or not.

Note It is possible to create a touch switch to which a cursor moving key is allocated lat-
er.

[Create Cursor Move Touch Switch]

Specify whether or not a cursor moving touch switch is automatically created.  Set-
tings may not be possible for some PT models.

Each time a numeral input or thumbwheel object is newly created, a numeral table
number (where input data is stored) is automatically set as 0→1→2... incremental-
ly (Table number after the last set one will be the next default number). A numeral
table number can be changed by displaying the property setting dialog box. (It is
also possible to change it later.)

� A numeral input element itself creates a numeral setting input field.  It is always
used with a control code inputting touch switch (control code input function) or a
system keypad.  Data is input to a numeral setting input field using the control
code input touch switches and the system keypad which are displayed with the
numeral setting input field.

After creating touch switches (control code
input) or a system keypad on the same
screen (includes a keyboard window),
pressing the key allocated the control
code [1] enters [1] in the numeral setting
input field.  If key [2] is then pressed, the
input field shows “12”.
Press the         key to store the data input
into the input field in the numeral memory
table.

0 0 0 0 0 . 0 0

1 2

 

 

 1   1

 2  12

   

 

This data input field is created by a numeral
input element.

The input field and the control code input touch
switch are automatically correlated.  Carry over
is processed automatically.

Control code inputting
touch switch

Numeral setting
input field

Touch

Touch

Touch → This is stored
in the memory
table.

12
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� The procedure for creating a control code input touch switch is shown below.

(1) Set the control code input function for a touch switch.

(2) Select the code from the control code list.

The control code input function allows an arbitrary name for a label of a touch
switch.  Click on  of  to display the label input dialog box.  Input a
label.

Confirmation

� A system keypad is created in the manner shown below.

With NT31, NT31C, NT631, and NT631C, a system keypad cannot be created.

(1) Select [Screen] (menu bar), then select [Properties].

This operation is also possible by selecting [Properties] after displaying the
pop-up edit menu, which is displayed by right clicking the mouse or by double
clicking the mouse with the mouse cursor placed at a position other than an
element.

(2) Set a check mark for the system keypad in the screen properties.

Numeral input element

System keypad

Note: A system keypad is automatically
displayed when a numeral setting
element or a (character) string set-
ting element is created in the same
screen.

� The allowable maximum number of input digits is determined by the setting for
the [Format] and [Display Sign] properties.
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� Even if multiple input fields are arranged in a screen, input is possible only for
one numeral setting input field.  Therefore, it is necessary to create a touch
switch (cursor moving touch switch, or arrow symbol touch switches) which can
be used to select the desired numeral setting input field.  If the “Create Cursor
Move Touch Switch” check box is ON when creating the input element, a cursor
moving touch switch is automatically created overlapping a numeral setting in-
put field.  By simply pressing this input field, the cursor is moved.

No.1

No.2

No.3

Data input field

Cursor moving
touch switch

Numeric keys

If a touch switch on input field No. 2 is pressed, the No. 2 input field becomes the
objective field for data input.  The data input using the numeric keys is stored in
input field No. 2.

� A cursor moving touch switch is created using the dialog box which is displayed
when creating a numeral input element.  The properties for the cursor moving
touch switch can be set in the same manner as for a standard touch switch.

How the properties for a touch switch are set is shown below.

For details of [Settings], refer to 6-8 “Touch Switches”.
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� If a check mark is set for [Use Window/Keyboard Screen] in the cursor moving
touch switch setting properties, it is possible to display the specified window/key-
board at the same time the cursor is moved.

This feature allows appropriate numeric keys for the input field to be displayed.

It is possible to create a temporary input field in addition to numeric keys.
(With NT31, NT31C, NT631, NT631C with “-V1”, all objects other than thumb-
wheel switch can be created on window.)

Window/Keyboard

Displayed when the
input field is touched.

� It is possible to create a temporary input field at the same time as numeric keys
are arranged in the window/keyboard.

A temporary input field is created using a numeral input element.

When a numeral input element is arranged in the window/keyboard, the element
is automatically set as a temporary input field.

Only one numeral input element (temporary input field) can be created for one
window/keyboard.

� Setting processing differs as shown below depending on whether or not a tem-
porary input field is used.

[When a temporary input field is used]

Numeral memory table
Storing by pressing

      key

Temporary input field

(1)

(2)

(1) The data which is input using numeric keys is displayed in the temporary input
field.

(2) Input the  key, and the data in the temporary input field is set in the numeral
setting input field and stored in the numeral memory table at the same time.
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[When a temporary input field is not used]

Numeral memory table
Storing by pressing

      key

(2)

(1)

(1) The data input using numeric keys is directly set in the numeral setting input
field.

(2) Press the  key, and the set data is stored in the numeral memory table.

Reference: With NT31, NT31C, NT631, NT631C, the settings such as “Display Sign” can not
be set at setting property of temporary input field (These settings are determined
by the numeral input field on a base screen).  When a numeral input field is used as
a temporary input field for NT31, NT31C, NT631, NT631C, specify the required
No. of digits (sign digit + integer digit + decimal point + decimal digit).

CAUTION

When the numeral values entered are confirmed, upper/lower limits

are checked. Otherwise the system may operate unpredictably.

Note 1. The data set in the input field is not stored in the numeral memory table until the
 key (button where the Return key code is set) or the ENT key is pressed.

At the end of data input, always press the  key or the ENT key.

2. To correct the data set in the input field, use the CLR key, the BS key, and the
DEL key.

3. When a numeral setting input field is moved, the touch switch is also moved
automatically.  To modify or move a numeral setting input field and a touch
switch independently, cancel the check mark set for [Auto Arrange] in the [Set-
tings] page of the touch switch properties.

4. The cursor can also be moved using an arrow symbol key touch switch.  The
cursor moves in the order the numeral input elements were created; this order
can be changed after creating the elements.
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5. With NT31, NT31C, NT631, NT631C, when hexadecimal value is input, it is
regarded as signed binary data and upper/lower limit check is performed.
Therefore, if the top bit is “1”, it is regarded as negative value and input will be
prohibited when the minimum limit was set as “0”. In this case, set those value
such as “$80000000” (–2147483648) for minimum limit setting to prevent it
from being checked.

Reference: At the numeral setting input field, the written numeric value in the numeral memory
table is displayed when the  key is pressed.  Since this is different from the one
read from the numeral memory table, it is necessary to use another numeral input
element to read out the data from the same address of the numeral memory table.

No.1

No.2

Screen

Numeral input element

Set numeral

Pop-up window/keyboard

Numeric keys

Numeral setting input field

Numeral memory table

Set numeral

6-4-2 (Character) String Input
You can write (character) string data to a character string memory table (string
table) using touch switches and a bar code reader.

Touch switches must be allocated (character) strings or a key code (control code
input and (character) string input function), or the copy function beforehand.

Input using touch switches ((character) string input function + control code input function)

PT

No.1
No.2
No.3
No.4
No.5

ABCABC

ABC DEF GHI

Screen

Touch switches

Input field

Writing

 key

Character string memory
table (String table)

(1) Set the (character) strings to be input using the (character) string input func-
tion to touch switches.

(2) Press a touch switch to set the label which is set for the touch switch into the
(character) string input field.

(3) Press the touch switch for which the  key code is allocated (by the control
code input function) to write the (character) string set at the input field to the
specified character string memory table (string table).
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Input using touch switches (copy function + control code input function)

No.1
No.2
No.3
No.4
No.5

ABC

ABCABC

ABC

PT

Screen

Input field

Character string memory
table (String table)

SET

 key

Copying the

set data

(1) Copy the preset data (character string memory table (string table)) to the input
field using the copy function allocated to a touch switch.

(2) Press the touch switch for which the  key code is allocated (by the control
code input function) to write the data which was copied (set) into the input field
to the specified character string memory table (string table).

Reference: To copy (in the character string memory table (string table)) and display a (charac-
ter) string by a single key operation, without using the  key code, use a touch
switch (copy function) and a (character) string display element.

Part type A

Part type A

No.1
No.2
No.3
No.4
No.5

PT

Screen
Character string
memory table
(String table)

Display field

Part type A

Part type A
Copy

Input using a bar code reader

Character string
memory table
(String table)

PT

No.2

No.3
No.4
No.5

ABC
ABC

No.1

Screen

Input field

Bar code reader

(1) By reading out a bar code using a bar code reader, the bar code data can be
input to the (character) string setting input field.  If “automatic confirm” is set for
bar code reading operation by the memory switch of a PT, the read-out (char-
acter) string is automatically written to a character string memory table (string
table).

(2) If the setting for bar code reading operation is “manual confirm”, the data set in
the input field is written to the specified character string memory table (string
table) when the touch switch allocated the  key code is pressed.

(For details of memory switch setting, refer to the operation manual for PT.)
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Operation procedure

Selection using the menu bar: [Objects] → [Data Input] → [String]

Selection using the drawing toolbar:

Related elements and settings

Touch switch ((character) string input): [Objects] → [Touch Switch] → 
(Character) string input function

Touch switch (control code input): [Objects] → [Touch Switch] → 
Control code input function

Touch switch (copy setting): [Objects] → [Touch Switch] → 
Copy setting

Terminology

Cursor (focus) moving touch switch

Focus (cursor) frame

Background

Foreground

Property setting

[General]

Position: Indicates the display position of the numeral setting input field.
(The attribute point is at the upper left corner of the input field.)

Font type: Specify the font of the (character) string to be input.
Standard, Half Height

Size: Specify the size of (character) string to be displayed.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 8�8

Smoothing: Specify whether or not smoothing processing is executed for 
(character) strings.

Attribute: Specify the display attribute (attributes displayed depend on the PT 
model.)
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the (character) string color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the (character) string 
display area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow
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[Settings]

Table Entry:*1 Specify the table number of the character string memory table 
(string table) where input data is to be stored.

Length: Specify the number of characters to be input.

Focus Frame: Specify whether or not the frame which indicates the data input 
objective is displayed.

Focus Attribute: Specify how the input data is displayed before it is confirmed.
Standard, Inverse, Flash, Inverse Flash

*1: Setting is not possible when a string input is used as a temporary input field for
NT31, NT31C, NT631, NT631C.

Guidance

� When a (character) string input element is specified, the dialog box is displayed
to set whether the cursor moving touch switch is automatically created or not.

Note It is possible to create a touch switch to which a cursor moving key is allocated lat-
er.

[Create Cursor Move Touch Switch]

Specify whether or not a cursor moving touch switch is automatically created.

Each time a string input object is newly created, a string table number (where input
data is stored) is automatically set as 0→1→2... incrementally (Table number after
the last set one will be the next default number). A string table number can be
changed by displaying the property setting dialog box. (It is also possible to change
it later.)

� A (character) string input element itself creates a (character) string setting input
field.  It is always used with a control code inputting touch switch (control code
input function) or a system keypad.  Data is input to a (character) string setting
input field using the control code input touch switches and the system keypad
which are displayed with the (character) string setting input field.
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 A   A

 B  AB

  

 

Touch

Touch

Touch → This is stored
in the charac-
ter string
memory table
(string table).

After creating touch switches ((character)
string input and control code input) or a
system keypad on the same screen (in-
cludes a pop-up window), pressing the key
allocated label [A] enters [A] in the (charac-
ter) string setting input field.  If the touch
key allocated [B] is then pressed, the input
field shows “AB”.
Press the      key to store the data input to
the input field in the character string
memory table (string table).

A B

 

 

 

 

This data input field is created by a (character)
string input element.

The input field and the control code input touch
switch are automatically correlated.  Insertion of
a (character) string is automatically processed.

Control code
inputting touch
switch

(Character) string
setting input field

AB

� The procedure for creating a (character) string input touch switch is shown be-
low.

(1) Set the (character) string input function for the touch switch function.

(2) Set a check mark for the [Label] property.

(3) Click on  and input the (character) string as a label.

A label may be either a character or a (character) string consisting of multiple
characters.  When a touch switch is pressed, the (character) string set as the
“label” is set to the (character) string input field.

Property setting for input key-string touch switch
Example

NT31C

Dialog box for
inputting a label



201

Data Input Section 6-4

� The number of characters which can be set for a (character) string input touch
switch and the number of characters which are actually written to a (character)
string input field differ depending on the PT model, as shown below.

PT Model Number of Characters
(Label)

Number of Characters
(Written to Input Field)

NT30, NT30C, NT31C, NT31C Max. 40 characters Max. 40 characters

NT620S, NT620C, NT625C,
NT631, NT631C

Max. 80 characters Max. 40 characters

� The procedure for creating a control code input touch switch is shown below.

(1) Set the control code input function for a touch switch.

(2) Select the code from the control code list.

(3) The control code input function allows an arbitrary name for a label of a touch
switch.  Click on  of  to display the label input dialog box.  Input
a label.

Confirmation

� The number of characters which can be input depends on the setting for the
[Length] property.

� Even if multiple input fields are arranged in a screen, input is possible only for
one (character) string input field.  Therefore, it is necessary to create a touch
switch (cursor moving touch switch, or arrow symbol touch switches) which is
used to select the desired (character) string input field.  If the [Focus Frame]
property is selected, a cursor moving touch switch is automatically created over-
lapping a (character) string input field.  The cursor moves when the input field is
pressed.

No.1

No.2

No.3

ABCABC

Data input field
Cursor moving
touch switch

If the touch switch on input field No. 2 is pressed, the No. 2 input field becomes
the objective field for data input.  The input (character) string is stored in input
field No. 2.
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� A cursor moving touch switch is created using the dialog box which is displayed
when creating a (character) string input element.  The properties for the cursor
moving touch switch can be set in the same manner as for a standard touch
switch.

How the properties for a touch switch are set is shown below.

For details of [Settings], refer to 6-8 “Touch Switches”.

� If a check mark is set for [Use Window/Keyboard Screen] in the cursor moving
touch switch setting properties, it is possible to display the specified window/key-
board at the same time as the cursor is moved.

This feature allows appropriate numeric keys for the input field to be displayed.

It is possible to create a temporary input field in addition to numeric keys.

(With NT31, NT31C, NT631, NT631C with “-V1”, all objects other than thumb-
wheel switch can be created on a window.)

Window/Keyboard

Displayed when the
input field is touched.
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� It is possible to create a temporary input field at the same time as numeric keys
are arranged in the window/keyboard.

A temporary input field is created using a (character) string input element.

When a (character) string input element is arranged in the window/keyboard, the
element is automatically set as a temporary input field.

Only one string input element (temporary input field) can be created for one win-
dow/keyboard

� Setting processing differs as shown below depending on whether or not a tem-
porary input field is used.

[When a temporary input field is used]

CBA

ABCDEF

ABCDEF

ABCDEF

FED

HG

Character string memory
table (String table)

Temporary input field

Storing by pressing

      key

(1)

(2)

(1) The input (character) string is displayed in the temporary input field.

(2) Press the  key, and the (character) string in the temporary input field is set in
the (character) string input field and stored in the character string memory
table (string table) at the same time.

[When a temporary input field is not used]

CBA

ABCDEF

ABCDEF

FED

HG

Storing by pressing

      key Character string memory
table (String table)

(1)

(2)

(1) The input (character) string is directly set in the (character) string input field.

(2) Press the  key, and the set data is stored in the character string memory
table (string table).

Reference: When there are no string to show, string input will be invisible.
Therefore, with Support Tool, dotted-line frame is displayed in character fore-
ground color enclosing string input.
(This frame will not be displayed on PT)
This frame can not be set to off.  However, the dotted–line frame can be set to ON
and OFF when printing screen image (refer to P461).
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Note 1. The data set in the input field is not stored in the character string memory table
(string table) until the  key (button where the Return key code is set) or the
ENT key is input if “manual confirm” is set for the bar code read operation (set
using the PT memory switches).
If “manual confirm” is set, always input the  key or the ENT key at the end of
data input.

2. To correct the data set in the input field, use the CLR key, the BS key, and the
DEL key.

3. When a (character) string input field is moved, the touch switch is also moved
automatically.  To modify or move a (character) string input field and a touch
switch independently, cancel the check mark set for [Auto Arrange] in the [Set-
tings] page of a touch switch property.

4. The cursor can also be moved using an arrow symbol key touch switch.  The
cursor moves in the order the (character) string input elements were created;
this order can be changed after creating the elements.
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6-4-3 Thumbwheel Switch
Thumbwheel switches are provided as means to input numeric data.  “+” and “–”
keys are provided at each input digit to allow you to input numeric data at individual
digits.  (Thumbwheel switch cannot be used with NT11S.)

1234

Numeral
memory table

(1) Touch the “+” or “–” key at each digit of thumbwheel switches to set numeric
data.

(2) The numeric data set using the thumbwheel switch is written to a numeral
memory table.

Note If thumbwheel switches are used to input numeric data, the input data is directly
written to a numeral memory table without being set in a data input field.

Operation procedure

Selection using the menu bar: [Objects] → [Data Input] → 
[Thumbwheel Switch]

Selection using the drawing toolbar:

Terminology

Frame:  Foreground

Frame:  Background

Character Colour:  Foreground

Character Colour:  Background

End plate

Sign digit Integer Decimal

Input digits of maximum limit

Property setting

[General]

Position: Indicates the display position of the thumbwheel switch.
(The attribute point is at the upper left corner of the thumbwheel 
switch.)

Size: Specify the size of the thumbwheel switch.
Small, Medium, Large
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Attribute: Specify the display attribute (attributes displayed depend on the PT 
model.)
Standard, Inverse, Flash, Inverse Flash

End Plate: Specify whether or not end plates are displayed at the ends of the 
thumbwheel switch.

Thumbwheel Colour

Frame: Specify the color of thumbwheel switch frame.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Foreground: Specify the foreground color of the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Character Colour

Foreground: Specify the foreground color of the numeric value displayed in 
the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the background color of the numeric value displayed in 
the thumbwheel switch.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

[Settings]

Table Entry: Specify the table number of the numeral memory table where input 
data is stored.

Display Type

Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in 
hexadecimal.

Format

Integer: Specify the number of digits of the integer part of the input data.

Decimal: Specify the number of digits of the decimal fraction part of the 
input data.
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Limit

Maximum: Specify the upper limit of the input data.*1

Minimum: Specify the lower limit of the input data.*1

Display Sign: Specify if a sign is displayed for a negative value.

*1: An input method for a negative value in decimal differs between the following
types of PT.

� With NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C: 
Put “F” which indicates a negative value at the most significant digit.
(eg. F0000008)

� With NT31, NT31C, NT631, and NT631C: 
Put “−” (negative sign) at the most significant digit.
(eg. −8)

Guidance

Each time a numeral input or thumbwheel object is newly created, a numeral table
number (where input data is stored) is automatically set as 0→1→2... incremental-
ly (Table number after the last set one will be the next default number). A numeral
table number can be changed by displaying the property setting dialog box. (It is
also possible to change it later.)

� The size of a thumbwheel switch can be selected from the following three sizes.

Large

Small

Medium

� End plates can be displayed at both ends of a thumbwheel switch.

Without end plateWith end plates

� With a thumbwheel switch, the data input method can be selected as decimal or
hexadecimal.

Decimal selection: Numbers in the range of 0 to 9 can be set at each digit.

Hexadecimal selection: Numbers in the range of 0 to 9 and A to F can be set at 
each digit.

� For [Decimal] property, specify the position of a decimal point in the numeral to
be displayed.  Numeric data is written to a numeral memory table without a deci-
mal point and input data is stored as an integer.

Numeral “2341” is written to
a numeral memory table.
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� In the sign digit, “  ” or “–” is displayed.  To set a positive value, specify a blank (“  ”).
For a negative value, specify “–”.

CAUTION

When the numeral values entered are confirmed, upper/lower limits

are checked. Otherwise the system may operate unpredictably.

Note 1. If you use a thumbwheel switch to input numeric data, the set data is written to
a numeral memory table at each pressing of the “+” or “–” key.
This means that the values during data setting are also written to the memory
table.

2. With a thumbwheel type numeric setting input field, if n...n � m...m [upper lim-
it: 1n...n, lower limit: 0m...m (“n” and “m” are arbitrary values at each digit)],
carry over and shift to the lower digit are not possible at the highest digit posi-
tion.

Example:

When “1200” is set for “Maximum” and “201” for “Minimum”, if the initial value is a
3-digit value, the setting value can be changed only in the range of 201 to 999, and
if the initial value is a 4-digit value, the setting value can be changed only in the
range of 1000 to 1200.
This is because the limit check function detects an error if the most significant digit
value is changed from “0” to “1” or from “1” to “0”.
To avoid this problem, set the maximum and minimum limits so that “n...n � m...m”
or provide a touch switch separately to write a value at carry over or shift to the
lower digit.

3. With NT31, NT31C, NT631, NT631C, when hexadecimal value is input, it is
regarded as signed binary data and upper/lower limit check is performed.
Therefore, if the top bit is “1”, it is regarded as negative value and input will be
prohibited when the minimum limit was set as “0”. In this case, set those value
such as “$80000000” (–2147483648) for minimum limit setting to prevent it
from being checked.
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6-5 Lamps
The status of a lamp changes according to the status of a PC (PLC) bit.

Two types of lamp element are provided – standard lamps which change their dis-
play status (ON/flash/inverse flash) and image/library lamps which show different
image/library data in the lamp ON and OFF states.

Image/library lamps cannot be used with NT11S, NT20S and NT600S.

6-5-1 Standard Lamps
A lamp (OFF/ON/flash) is displayed in accordance with the status of a PC (PLC)
bit.

PC (PLC)
Bit status

(1) The status of a lamp is changed according to the allocated PC (PLC) bit.

Operation procedure

Selection using the menu bar: [Objects] → [Lamp] → [Standard]

Selection using the drawing toolbar:

Terminology

Label

Frame

ON color/
OFF color

Property setting

[General]

Position: Indicates the display position of a standard lamp.
(The reference point is at the upper left corner of the standard lamp)

Size: Indicates the size of a standard lamp.

Label: Specify whether or not a label is appended to a standard lamp.

Frame: Specify whether or not a frame is displayed for a standard lamp.

Shape: Displays shapes of a standard lamp.
(Selectable shapes vary according to the PT model)
Rectangle, Circle, Polygon, Sector
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Colour

Frame: Specify the color of a lamp frame if [Frame] is selected.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

ON: Specify the display color of a standard lamp when the PC (PLC)
bit is ON.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a standard lamp when the PC (PLC)
bit is OFF.
(Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, 
yellow

: Displays the dialog box used to edit a label.  This button is valid 
only when [Label] is selected.

: Copies the I/O comment set to the lamp bit as a label.

[Light Functions]

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) which drives a standard
lamp ON/OFF.

I/O Comment: Specify the comment of the PC (PLC) bit which drives a
standard lamp ON/OFF.

Lamp Attribute

ON Type: Specify the status of a standard lamp which is ON.

Light, Flash

: Displays the dialog box used to specify the bit number.

: Displays an I/O comment table.

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from
[View] menu.
Additionaly, to view flashing display of lamp attribute, select [Simulate Flash] from
[View] menu.  For details, refer to 5–1–3.

Guidance

� The following kinds of standard lamps are provided.

SectorRectangle Circle Polygon

� The shape of a lamp can be modified when you select polygon or sector.

Use the element edit function to modify the lamp shape.  (For details, refer to
P123)
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(1) Click on a line of a polygon or a sector while pressing the Shift key and Ctrl key.

(2) Drag a green � mark to modify the graphic.

(3) To add a green � mark (addition of a vertex), position the mouse cursor on the
line in a graphic and execute the vertex addition operation (right click the
mouse → [Add Node]).

To delete a green � mark (deletion of a node), position the mouse cursor on
the green � mark to be deleted and execute the vertex deletion operation
(right click the mouse → [Remove Node]).

(4) Drag the added green � mark to modify the shape of the graphic.

Example: Modification of the shape of polygon

� A standard lamp element can display a label (lamp name).

To display a label, set a check mark in the check box of the [Label] attribute and
click on .  The dialog box for setting a label is displayed.  Set the proper-
ty for the label to be displayed.

For the procedure for setting the properties, refer to 6-2-7 “Text”.  For NT31,
NT31C, NT631, and NT631C, it is possible to set different colors for lamp ON and
lamp OFF by setting [Colour – OFF] and [Colour – ON] instead of setting label col-
or.  However, background color is fixed to “transparent” for NT31, NT31C, NT631
and  NT631C.

 button in the property dialog can copy the I/O comment set to the

lamp bit as a label.

� To edit the position of a label, use the element edit function.  (For details, refer to
P122)

(1) Click on the label while pressing the Shift key and Ctrl key.

(2) Drag the label to change the display position.

(1) (2)
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Reference: � With a standard lamp, only the lamp color and the label color change.  To change
the contents of a label, create image/library lamps and display different image/li-
brary data according to the status of the lamp.

Example:

ON OFF

Image/library lamp

� With NT31, NT31C, NT631, and NT631C, image data cannot be inserted into a
label.

6-5-2 Image/library Lamps
Different image/library data are displayed according to the status of a PC (PLC) bit.

PC (PLC)

Bit status

Display when
the bit is OFF

Display when
the bit is ON

(1) The image data or the library data is switched to be displayed according to the
status of the allocated PC (PLC) bit.

Operation procedure

Selection using the menu bar: [Objects] → [Lamp] → [Image]

Selection using the drawing toolbar:

Terminology

Image/library data
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Property setting

[General]

OFF State

Code: Specify whether or not image/library data is displayed in the 
 lamp OFF state and the code of the image/library data to be 

displayed.

ON State

Code: Specify whether or not image/library data is displayed in the 
lamp ON state and the code of the image/library data to be 
displayed.

: Specify the image data to be displayed when the lamp is ON/
OFF.

: Specify the library data to be displayed when the lamp is ON/
OFF.

Colour (Only for NT31C and NT631C.  Setting is not possible for other color types
of PT.)

Foreground: Set the display color of an image element.
(Specification of color is valid only when the color mode is “2 
colors”.  Setting is not possible for a monochrome type PT.)

Background: Set the display color of the background in the image element 
display area.
(Specification of color is valid only when the color mode is “2 
colors”.  Setting is not possible for a monochrome type PT.)

[Light Functions]

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) which drives an image/li-
brary lamp ON/OFF.

I/O Comment: Specify the comment of the PC (PLC) bit which drives
an image/library lamp ON/OFF.

: Displays the dialog box used to specify the bit number.

Displays an I/O comment table.

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from
[View] menu.  For details, refer to 5–1–3.
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Guidance

� For image/library lamp element, the image/library data which is displayed when
the PC (PLC) bit is ON and the image/library data which is displayed when the
PC (PLC) bit is OFF are specified independently.

To display the image data or the library data only when the PC (PLC) bit is ON or
OFF, cancel the check mark in the check box of the bit status for which the image/li-
brary data is not to be displayed.

� To select the image/library data to be displayed, click on /
 and select the desired image/library data from the list.

Click on the line of the desired data to display the line in reverse video and click on
.

Clicking on  enables the direct display of the specified code.

� If the data is not registered to the specified code, the mark shown below is dis-
played on the screen.

� For the procedure for creating the image data, refer to 8-1 “Image Editor”.

� For the procedure for creating the library data, refer to 8-2 “Library Editor”.
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6-6 Numeral Display
The contents of a numeral memory table are displayed.

Numeral displays can be used with all models.

PT

No.1
No.2
No.3
No.4
No.5

50

50

Screen

Display field

Read

Numeral
memory table

(1) The contents of the specified numeral memory table are displayed.

Operation procedure

Selection using the menu bar: [Objects] → [Numeral Display]

Selection using the drawing toolbar:

Terminology

Display digits of maximum limit

Foreground

Background

Sign digit Integer Decimal

Property setting

[General]

Position: Indicates the display position of the numeral display field.
(The reference point is at the upper left corner of the display field.)

Font Type: Specify the font of the numeric value to be displayed.
Standard, Half Height, Double Width
(Only Standard can be set for NT11S.)

Scale: Specify the scale of the numeric value to be displayed.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4, 8�8
(Only 1�1 (Equal) and 2�1 (Wide) can be set for NT11S.)

Smoothing: Specify whether or not smoothing processing is executed for 
numeric values to be displayed.
(Setting is not possible for NT11S, NT20S and NT600S.)
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Attribute: Specify the display attribute (attributes displayed depend on the PT 
model.)
Standard, Inverse, Flash, Inverse Flash

Colour

Foreground: Specify the numeral color.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the numeral display area.
(Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

[Settings]

Reference:

Indirect Reference:

If a numeral in the specified memory table is treated as the reference table
number for indirect reference, specify this item.  (Setting is not possible for
NT11S.)

Table Entry:

Specify the address of the numeral memory table to be referred to.  If [Indirect
Reference] is not selected, the contents of this numeral memory table are dis-
played, and if [Indirect Reference] is selected, the contents of this numeral
memory table are treated as the reference table number and the contents of
the reference memory table are displayed.

Display Type (Only Decimal can be set for NT11S.)

Decimal: Specify this item to display the input numeric value in decimal.

Hexadecimal: Specify this item to display the input numeric value in 
hexadecimal.

Format

Integer: Specify the number of digits of the integer part of the input data.

Decimal: Specify the number of digits of the decimal fraction part of the 
input data.

Zero Suppression: Specify whether or not leading zeros are suppressed to 
display the input data.

Display Sign: Specify if a sign is displayed for a negative value.

: Displays the list of numeral memory tables.
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Guidance

� With a numeral display element, the memory table designation method can be
selected as direct designation or indirect designation.

Example: Specifying numeral memory table address “2”.

5 5
1

2

3

4

5

5 123
1

2

3

4

5 123

Direct designation

Numeral
memory table

Display

The contents of the specified
memory table are displayed.

Indirect designation

Numeral
memory table

Display

The contents of the specified
memory table are treated as the
table address reference value and
the contents of the referenced
memory table are displayed.

Indirect designation is possible only in the following cases.  Do not apply for other
cases.

� When C200H I/F unit is used.

� When NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C, NT631,
or NT631C is used.

� When an NT20S or NT600S which uses the direct connection ver. 5. is
used.

With conventional models, up to 50 indirect designation settings can be made per
screen, including both numeral display and character string display.

� For numeral display elements, it is possible to select whether numeric values are
displayed in decimal (signed/unsigned) or hexadecimal.

23456
23456

5BA0

Numeral
memory table Display in decimal

Display in hexadecimal

Reference: � With NT31, NT31C, NT631, and NT631C, numerals are always stored as signed
binary data.  When allocating numeral memory tables to PC (PLC) words, it is
possible to select whether the data is recognized in BCD or recognized in hexa-
decimal using the [Storage Type] property.
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According to the combination of the storage type and display method, numeric
values are stored and displayed in the manner shown below.

00005BA0
2 3 4 5 6

5 B A 0

0 0 0 2

3 4 5 6

5 B A 0

0 0 0 0

PC (PLC) channel 
(2-word allocation)

Recognition in BCD
Numeral
memory table

Display

Recognition in hexadecimal

Display in decimal

Display in hexadecimal

� With NT30, NT30C, NT620S, NT620C, and NT625C, the only difference in deci-
mal/hexadecimal display of a numeric value is whether or not “F” at the most sig-
nificant digit is treated as a sign or a numeral.  With NT31, NT31C, NT631, and
NT631C, however, the stored numeric value is converted for display according
to the decimal/hexadecimal designation.

� For [Decimal], the number of digits entered in decimal fraction part is specified.
Since integers are stored in numeral memory tables, a decimal point is ap-
pended according to this setting when a numeral is displayed.

1234 12.34

If setting for [Decimal] is “2”.

Numeral
memory table

� If [Display Sign] is selected, a blank (“  ”) is displayed for a positive value and “–” is
displayed for a negative value.

If a negative value is displayed with [Display Sign] deselected, it is displayed as
an absolute value.

� For [Format] (number of numeral digits; integer part + decimal fraction part), set
a sufficient value according to the contents of the numeral memory tables.

The allowable display range for numeric values is shown below.

Display Method Conventional Models New Models

Hexadecimal 00000000 to FFFFFFFFH 00000000 to 7FFFFFFFH

Decimal (signed) –9999999 to 9999999 –2147483648 to 2147483647

Decimal (unsigned) 0 to 99999999 0 to 2147483647*1

Conventional models: NT11S, NT20S, NT600S, NT30, NT30C, NT620S,
NT620C, NT625C

New models: NT31, NT31C, NT631, NT631C

*1: Since a negative value is also displayed as a positive value when [Display
Sign] is deselected, “−2147483648” is displayed as “2147483648”, even
though the maximum value that can be stored in the numeral memory table
is “2147483648”.
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6-7 (Character) String Display
The contents of a character string memory table are displayed.

(Character) string displays can be used with all models.

PT

Display field

Character string memory
table (String table)Screen

No.1
No.2
No.3
No.4
No.5

TOOL

TOOL

Read

(1) The (character) string stored in the specified character string
memory table (string table) is displayed.

Operation procedure Selection using the menu bar: [Objects] → [String Display]

Selection using the drawing toolbar:

Terminology

Background

Foreground

Property setting

[General]

Position: Indicates the display position of the (character) string display field.
(The reference point is at the upper left corner of the display field.)

Font Type: Specify the font of characters to be displayed.
Standard, Half Height
(Only Standard can be set for NT11S.)

Scale: Specify the scale of characters to be displayed.
1�1 (Equal), 1�2 (High), 2�1 (Wide), 2�2, 3�3, 4�4
8�8 (Not possible for NT20S)

Smoothing: Specify whether or not smoothing processing is executed for 
characters to be displayed.  (Setting is not possible for NT11S, 
NT20S and NT600S.)

Attribute: Specify the display attribute (attributes displayed depend on the PT 
model.)
Standard, Inverse, Flash, Inverse Flash
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Colour

Foreground: Specify the character color.
 (Can only be set for PTs with color display.)
White, black, blue, red, magenta, green, cyan, yellow

Background: Specify the color of the background in the (character) string 
display area.  (Can only be set for PTs with color display.)
Transparent, white, black, blue, red, magenta, green, cyan, 
yellow

[Settings]

Reference

Indirect Reference: If the numeric value in the specified memory table is
treated as the reference table number and used for indi-
rect table reference, specify this item.  (Setting is not
possible for NT11S.)

Table Entry: Specify the entry of the character string memory table
(string table) to be referred to.  If [Indirect Reference] is
not selected, the contents of this character string
memory table (string table) are displayed.  If [Indirect
Reference] is selected, the contents of this numeral
memory table are treated as the reference table number
and the contents of the referenced character string
memory table (string table) are displayed.

Length: Specify the number of characters to be displayed.

: Displays the list of numeral memory tables or character string memory 
tables (String Table).  In indirect designation, the list of numeral memory 
tables is displayed and in direct designation, the list of character string 
memory tables (String Table) is displayed.

Guidance

� With a (character) string display element, the memory table designation method
can be selected as direct designation or indirect designation.

Example

Specifying memory table address “2”

TOOL

Character string
memory table
(String table)

Indirect designationDirect designation

Display

TOOL
1

2

3

4

5

Character string
memory table
(String table)

Display

TOOL
1

2

3

4

5 TOOL

The contents of the specified
memory table are displayed.

The contents of the specified numeral
memory table are treated as the table
address reference value and the 
contents of the referenced memory
table are displayed.

Numeral
memory table

1

2

3

4

5
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Indirect designation is possible only in the following cases.  Do not apply for other
cases.

� When C200H I/F unit is used.

� When NT30, NT30C, NT31, NT31C, NT620S, NT620C, NT625C, NT631, or
NT631C is used.

� When an NT20S or NT600S which uses direct connection ver. 5 is used.

With conventional models, up to 50 indirect designation settings can be made per
screen, including both numeral display and (character) string display.

� If the value set for [Length] (the number of digits to be displayed) is smaller than
the number of characters in the specified character string memory table (string
table), the specified number of characters is displayed from the first character of
the (character) string.  The remaining characters are not displayed.

� To display mark data or image data, specify the address of the mark data or
image data as shown below.

Note that image data cannot be inserted into a (character) string when using
NT11S, NT20S, NT31, NT31C, NT600S, NT631, or NT631C.

ABC

DisplaySetting

ABC<!FFFE>

Mark data at code FFFE

Reference: When there are no string to show, string input will be invisible.
Therefore, with Support Tool, dotted-line frame is displayed in character fore-
ground color enclosing string input.
(This frame will not be displayed on PT.)  
This frame can not be set to off.  However, the dotted–line frame can be set to ON
and OFF when printing screen image (refer to P461).
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6-8 Touch Switches
When a touch switch is pressed, any of the nine functions shown below is execut-
ed.  In addition to the general functions such as the input notification (notify bit) and
the screen switching (standalone) function, a variety of functions can be realized
including control codes used in combination with a data input element.  (Touch
switches cannot be used for NT11S.)

CAUTION

Do not use input functions such as PT touch switches for  applications

where danger to human life or serious property damage is possible or for

emergency switch applications.

[Notify bit touch switch]

PT

ON/OFF
notification

Switch PC (PLC)

Specified
bit goes
ON/OFF

(1) When a touch switch is pressed, the specified bit in the PC
(PLC) goes ON/OFF.
Set switches, reset switches, alternate switches, and momentary
switches can be used.

[Screen switching touch switch]

Screen 1

Switch

Screen 2

Switching
to screen 2

(1) When a touch switch is pressed, the screen is switched to the
screen with the specified screen number.

[(Character) string input function touch switch]

A B C D E F G H I

ABC

(Character) string data input field
(by (character) string input element)

(1) When a touch switch is pressed, the label of the touch switch is
stored in the (character) string input field.

Note This type of touch switch is always used in combination with a
(character) string input element.

[Pop-up window/keyboard function touch switch]

OPEN CLOSE

Standard screen (base screen)

Window/Keyboard screen

(1) When a touch switch (OPEN) is pressed, the specified window
(keyboard screen) is displayed on the screen presently dis-
played.

(2) When a touch switch (CLOSE) is pressed, the window (key-
board screen) presently displayed closes.
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[Control code input touch switch (Input key – Control)]

Standard screen

Input field

1 2 3 4

(1) When a touch switch is pressed, the input processing of the con-
trol code is executed as shown below.

� 0 to 9 numeral keys:
Data setting at the numeral setting input field

� CLR key:
Clearing the numeral setting input field

�       key:
Confirmation

� Arrow symbol key:
Switching among continuous/overlapping screens
Moving the cursor in the numeral setting input field

Numeric keys can be created using the touch switches assigned
these control codes.
Note These touch switches are always used with a numeral/(charac-

ter) string input element.  (The element to be used differs ac-
cording to the allocated control codes.)

[Copy setting touch switch]

Memory
table

50
COPY

50
Copy DestinationCopy Source

Numeral memory table
Character string
memory table (String
table)
Input field specified by
cursor

Numeral memory table
Character string
memory table (String
table)
Constant

(1) When a touch switch is pressed, the data in the memory table or
a constant is copied to another memory table or input field.

[Window move touch switch]

Window moves

MOVE

(1) When a touch switch (window move touch switch) is pressed,
the window can be moved by touch panel operation at PT.
When you press the destination (center of the window will come
here), window will be moved to that position.

Note Window move touch switch can be created only on window/
keyboard screen.
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[Cursor moving touch switch]

Data input field 1

Data input field 2

Data input field 3

Input cursor

moves

Input cursor

moves

(1) When a touch switch (cursor moving touch switch) in an input
field is pressed, the cursor moves to that input field.

Note The cursor moving touch switch should be specified when
creating a numeral or (character) string input element.  (The
cursor moving touch switch can be added later.)

[Print screen function touch switch]

PRINT

Printing screen
hard copy

(1) When a touch switch is pressed, a hard copy of the screen is
output to a printer.

Operation procedure Selection using the menu bar: [Objects] → [Touch Switch]

Selection using the drawing toolbar:

Terminology

Frame

Label

Colour – ON, OFF

Property setting

[General]

Position: Indicates the display position of a touch switch frame (the area which 
senses pressing of the switch.)
(The reference point is at the upper left corner of the touch switch 
frame)

Size: Indicates the size of a touch switch frame.

Label: Specify whether or not a label is appended to a touch switch frame.

Frame: Specify whether or not a frame is displayed for a touch switch.

Shape: Specify the shape of a touch switch.
Standard, Shadow, 3-Dimension, Rectangle, Circle, 
Polygon, Sector

Show ON State:
Specify the status when touch switch is pressed.  When this check 
box is ticked, touch switch will be lighten. (Not valid for 3-Dimension)
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Colour

Frame: Specify the color of a touch switch if [Frame] is selected.
(Can only be set for PTs with color display.)

White, black, blue, red, magenta, green, cyan, yellow

ON: Specify the display color of a touch switch which is ON.
(Can only be set for PTs with color display.)
(Setting is valid only when [Show ON state] is selected.)

White, black, blue, red, magenta, green, cyan, yellow

OFF: Specify the display color of a touch switch which is OFF.
(Can only be set for PTs with color display.)

Transparent, white, black, blue, red, magenta, green, cyan, 
yellow

: Displays the dialog box used to edit a label.  Specify the touch
switch label.

: Copies the I/O comment set to the lamp bit as a label.  

However, in case of notify bit touch switch, I/O comment set to
the notify bit is copied.  (Copy source name is displayed at the
right side of the button.)

[Settings]

Function: Specify the touch switch function.  Select from the following nine
functions.

Notify bit

Switch screen

Input key – Control

Input key – Window/Keyboard

Input key – String

Copy setting

Cursor move

Window move (Only available on Window/Keyboard Screen)

Print screen

The setting contents differ depending on the selected touch switch function.

For details of setting, refer to “Guidance”.

[Light Function]

Touch switch also has the light function like a lamp.

Address

PC (PLC) Bit Address: Specify the bit at the PC (PLC) which drives a touch
switch ON/OFF.

I/O Comment: Specify the comment of the PC (PLC) bit which
drives a touch switch ON/OFF.
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Lamp Attributes

ON Type: Specify the status of a touch switch which is ON.

Light, Flash

: Displays the dialog box used to specify the bit number.

: Displays an I/O comment table.

Reference: To check lamp ON status on the editing screen, select [Simulate ON/OFF] from
[View] menu.
Additionaly, to view flashing display of lamp attribute, select [Simulate Flash] from
[View] menu.  For details, refer to 5–1–3.

Guidance

[Common description]

� The following shapes can be used for touch switch elements.
(Selectable shapes vary according to the PT model.)

Rectangle

SectorCircle Polygon

3-DimensionStandard Shadow

Although [Standard] and [Rectangle] have the same shape, how the touch switch
frame is defined differs between them.  With [Standard], the touch switch frame
itself provides the display graphic.  With [Rectangle], however, a rectangle shape
can be specified independently of the touch switch frame and the touch switch
frame can be separated from the rectangle shape.

� If rectangle, circle, polygon, or sector is selected, only the shape of a graphic can
be modified in the procedure shown below.  The touch switch frame (touch sens-
ing area) remains unchanged even if the shape is modified.

Use the element edit function to modify the touch switch shape.  (For details, re-
fer to P122.)

(1) Click on a line of a graphic while pressing the Shift key and Ctrl key.

(2) Drag a green � mark to modify the graphic.

(3) To add a green � mark (addition of a node) in a polygon, position the mouse
cursor on the line in a graphic and execute a vertex addition operation (right
click the mouse → [Add Node]).

To delete a green � mark (deletion of a node), position the mouse cursor on
the green � mark to be deleted and execute a vertex deletion operation (right
click the mouse → [Remove Node]).
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(4) Drag the added green � mark to modify the shape of the graphic.

Example: Modification of the shape of polygon

(1) (2) (3) (4)

� A touch switch element can display a label (touch switch name).

To display a label, set a check mark in the check box of the [Label] property and
click on .  The dialog box for setting a label is displayed.  Set the prop-
erty for the label to be displayed.

For the procedure for setting the properties, refer to 6-2-7 “Text”.  When using
NT31, NT31C, NT631, and NT631C, it is possible to set different colors for the
lamp ON and lamp OFF states.  With these models, however, it is not permissible
to insert image data.

 button in the property dialog can copy the I/O comment set to the

PLC address as a label.

In case of Notify Bit function: I/O comment of notify bit

In case of other function: I/O comment of lamp bit

� To edit the position of a label, use the element edit function.  (For details, refer to
P122)

(1) Click on the label while pressing the Shift key and Ctrl key.

(2) Drag the label to change the display position.

(1) (2)
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6-8-1 Input Notify Touch Switch
Function: Notify bit

Settings

Address

PC (PLC) Bit Address: Specify the PC (PLC) bit which is driven ON/OFF ac-
cording to the operation of a touch switch.

I/O comment: Specify the comment of the PC (PLC) bit which is
driven ON/OFF according to the operation of a touch
switch.

Action Type

Set, Reset, Alternative, Momentary

: Displays the dialog box used to specify the bit number.

: Displays the I/O comment table.

Guidance

� The input notify touch switch drives the specified PC (PLC) bit ON/OFF in re-
sponse to the pressing of the touch switch.

� The status of the PC (PLC) bit when the touch switch is pressed is processed as
shown below according to the setting for [Action Type].

Set: Drives the PC (PLC) bit ON when the touch switch is pressed.  The
PC (PLC) bit stays ON even after the touch switch is released.

Reset: Drives the PC (PLC) bit OFF when the touch switch is pressed.
The PC (PLC) bit stays OFF even after the touch switch is re-
leased.

Alternative: Drives the PC (PLC) bit from OFF to ON or from ON to OFF when
the touch switch is pressed.  The PC (PLC) bit is turned ON when
the touch switch is pressed while it is OFF and if the touch switch is
pressed when the PC (PLC) bit is ON, the PC (PLC) bit goes OFF.

Momentary: Drives the PC (PLC) bit ON when the touch switch is pressed;  the
PC (PLC) bit remains ON only while the touch switch is being
pressed.  The PC (PLC) bit goes OFF when the touch switch is
released.

6-8-2 Switch Screen Touch Switch
Function: Switch screen

Settings

Screen No.:Specify the screen number of the screen to which the display is to 
change when the touch switch is pressed.

Guidance

The switch screen touch switch changes the displayed screen at a PT to the speci-
fied screen.
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6-8-3 (Character) String Input Touch Switch
Function: Input key – String

Settings

Label: Indicates the (character) string which is input into the (character) string in-
put field when the touch switch is pressed.  The label is set using the label
edit function.

Related elements and setting

(Character) string input element:
[Objects] → [Data Input] → [String] (Refer to 6-4-2 “(Character) String Input”.)

Guidance

� The (character) string input touch switch is used for inputting a (character) string
to a (character) string input field.

� The (character) string to be input is set for a label in the [General] attributes.  It
may be a single character or multiple (character) strings.

� Numeric keys can be created on the screen by combining (character) string input
touch switches and control code input touch switches.

� For details of (character) string input elements, refer to 6-4-2 “(Character) String
Input”.

Note (Character) string input touch switches are always used in combination with (char-
acter) string input elements.

6-8-4 Pop-up Window/Keyboard Function Touch Switch
Function: Input key-Window/Keyboard

Settings

Screen No.:
Specify the window (keyboard screen) type (Local 1 or Local 2) and
screen number of the window (keyboard screen) which is displayed
when the touch switch is pressed.

Window Position: Specify the bottom left co-ordinate of window to be displayed.

Action Type:
Specify how the window/keyboard is displayed when the touch switch
is pressed.

Open, Close, Toggle

Replace Local Window:

Specify the behaviour of windows when another window of the same
type (Local 1, Local 2) is already displayed when opening a window.
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Guidance

The input key-window/keyboard touch switch is used for displaying the window
(keyboard screen) overlapping the presently displayed screen (base screen).

This touch switch function can not be used with NT20S and NT600S.
Settings shown below can be made only with NT31, NT31C, NT631, NT631C with
“-V1”.

Local 2
Window Position
Replace Local Window

Display methods of window/keyboard varies depending on PT models.

[With NT30, NT30C, NT620S, NT620C, NT625C, and NT31,NT31C, NT631,
NT631C without “-V1”.]

How the window/keyboard is displayed is determined by the setting 
for [Action Type].

Action Type

Open: Displays the specified window/keyboard. If another window/
keyboard is already displayed, it is closed and then the specified
window/keyboard is opened.  If the specified window/keyboard is
already displayed, no operation is executed.

Close: Closes the presently displayed window/keyboard.  No operation
is executed if no window/keyboard is displayed.

Toggle: Closes the presently displayed window/keyboard and opens the
specified window/keyboard.  If the specified window/keyboard is
already opened, the window/keyboard closes.

[With NT31, NT31C, NT631, NT631C with “-V1”]

How the window is displayed is determined by the settings for [Action
Type] and [Replace Local Window].

Action Type

Open: Displays the specified window. If another window of the same
type (Local 1, Local 2) is already displayed, follows the setting for
[Replace Local Window]. If the specified window is already 
displayed in specified type, no operation is executed.

Close: Closes the presently displalyed window with specified type 
(Local 1, Local 2) and number.  No operation is executed if 
specified window is not displayed in specified type.

Toggle: Closes the window with specified type (Local 1, Local 2) and
number if it is presently displayed and opens the specified 
window if it is not opened.  If another window of the same type is
already displayed, follows the setting for [Replace Local 
Window].
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Replace Local Window

Check mark: If another window of the same type (Local 1, Local 2) is 
already displayed, no operation is executed.

No check mark:If another window of the same type(Local1, Local 2) is already
displayed, closes the window and then opens the specified
window.

6-8-5 Control Code Input Touch Switches
Function: Input key-Control

Settings

Control Key: Specify the key code which is input when the touch switch is 
pressed.  (Select from 39 kinds of codes.)

Some codes cannot be specified depending on the PT model.

Related elements and setting

Numeral input element:
[Object] → [Data Input] → [Numeral] (Refer to 6-4-1 “Numeral Input”.)

(Character) string input element:
[Object] → [Data Input] → [String] (Refer to 6-4-2 “(Character) String Input”.)

Guidance

� Control code input touch switches control data input processing, cursor move-
ments, etc.

� The contents of control are selected from the codes shown below.

Control code input touch switches are used in combination with numeral input
elements, (character) string input elements, continuous screens, alarm list ele-
ments, and alarm history elements.

(1) Combination with numeral input elements, (character) string input elements,
and continuous screens

If control code input touch switches are arranged with a numeral input element
or a (character) string input element on the same screen (including the win-
dow (keyboard) and the base screen), these touch switches can be used to
input data into the input field.

Numeric keys and other data input devices can be created by combining
these items.

: Inputs numeral “0” in a data input field.

: Inputs numeral “1” in a data input field.

: Inputs numeral “2” in a data input field.

: Inputs numeral “3” in a data input field.

: Inputs numeral “4” in a data input field.

: Inputs numeral “5” in a data input field.

: Inputs numeral “6” in a data input field.
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: Inputs numeral “7” in a data input field.

: Inputs numeral “8” in a data input field.

: Inputs numeral “9” in a data input field.

: Inputs hexadecimal “A” in a data input field.

: Inputs hexadecimal “B” in a data input field.

: Inputs hexadecimal “C” in a data input field.

: Inputs hexadecimal “D” in a data input field.

: Inputs hexadecimal “E” in a data input field.

: Inputs hexadecimal “F” in a data input field.

: Moves cursor in a data input field one character left.

: Moves cursor in a data input field one character right.

: Deletes numeric value/(character) string in a data input field.

: Cancels inputs in a data input field.

: Backspaces a cursor to delete a character in a data input field.

: Deletes the character at the cursor location in a data input field.

: Confirms inputs in a data input field (cursor remains in this field.).

: Confirms inputs in a data input field (cursor moves to the next input field.).

: Toggles plus (+) and minus (–) sign in a data input field.

: Inputs a decimal point in a data input field.

: Moves the input cursor to the data input field at the upper left area.

: Moves the cursor to the data input field immediately above the present 
data input field.

: Moves the cursor to the data input field immediately below the present
 data input field.

: Move the cursor to the left data input field.

: Move the cursor to the right data input field.

: Moves the cursor to the previous data input field in the order.

Changes the continuous screen to the previous screen.

: Moves the cursor to the next data input field in the order.

Changes the continuous screen to the next screen.
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Reference: With  and  keys, the cursor moves between the data input fields in the order the
data input fields were made.  However, the order of moving the cursor can be
changed with [Set Order] of [Draw] menu.

(2) Combination with alarm list elements and alarm history elements

This control code can be selected only with NT30, NT30C, NT620S, NT620C,
and NT625C.  With NT31, NT31C, NT631, and NT631C, these touch
switches are a part of alarm list/history elements.

These touch switches can be created automatically when creating an alarm
list/history.

: Scrolls up alarm list/history display page (page scroll).

: Scrolls down alarm list/history display page (page scroll).

: Scrolls up alarm list/history display page (line scroll).

: Scrolls down alarm list/history display page (line scroll).

(3) PT control

: Stops buzzer.

: Displays system menu.

Reference: Any required (character) string can be used as the label of a control code input
touch switch.  For example, “SET” can be used as the label of a control code touch
switch.

Click  in the  attributes to display the label setting dialog box.  Input
a label in the displayed dialog box.

6-8-6 Copy Setting Touch Switch
Function: Copy setting

Settings

Copy From

Numeral Table: Specifies a numeral table for the copy source.

String Table: Specifies a character string memory table (string table) for
the copy source.

Code: Specifies copying a constant (numeric data).

Data setting field: Specify the memory table number when a numeral table or
a character string memory table (string table) is specified.
When code is specified, specify a constant here.

Copy To

Numeral Table: Specifies a numeral table for the copy destination.

String Table: Specifies a character string memory table (string table) for
the copy destination.

Cursor Position: If this is specified, the numeral input field or the character
string input field, which is the active input objective, is se-
lected for the copy destination.
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Data setting field: Specify the memory table number when a numeral table or
a character string memory table (string table) is specified.
If Cursor Position is selected, this field is invalid.

: Displays the list of numeral/character string memory tables
(string tables).

Guidance

� A copy setting touch switch is used in the cases shown below.

[Copying the data in a memory table to another memory table]

part3
part2
part1

Character string memory
table (String table)

SET 2

SET 3

part1
SET 1

By setting the data in several memory tables beforehand, the necessary data can
be copied to the work area as needed.

Note Data copying from a memory table to a memory table is possible only between
memory tables of the same type; from numeral memory table to numeral memory
table, and from character string memory table (string table) to character string
memory table (string table).

[Copying a constant to a numeral memory table (setting)]
Numeral
memory table

1234
1234SET 1

2345SET 2

3456SET 3

By setting a constant in the data setting field of a copy function touch switch before-
hand, the necessary data can be copied to a numeral memory table as desired.

Note Copying a constant to a string table is not possible.

[Copying data or a constant in a memory table to an input field]
Numeral
memory table

1234

CONSTANT

1

Character string memory
table (String table)

PT

1234

PT

Numeral input
field

(Character)  string
input field

By setting the setting data to a memory table or a touch switch beforehand, the
data is copied to the input field at the cursor location as desired.

Since the data is copied to the input field, it can be modified after copying.



Numeral/(character) string input field

When the touch switch

at the top is pressed

Numeral/(character) string input field

Specified window opens.

Touch switches

assigned with

cursor movement

and window open

functions

1 2 3 4 5 6

–41.8

 ABCDE

1 2 3 4 5 6

–41.8

1 2 3
654
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6-8-7 Cursor Moving Touch Switch
Function: Moving cursor

Settings

Use Window/Keyboard Screen:
Specify whether or not the window (keyboard
screen) is displayed when the cursor is moved.

Screen No. : Specify the screen type (Local 1/Local 2) and the screen
number of the window (keyboard screen) to be 
displayed when moving a cursor.

Window position: Specify the bottom left co–ordinate of window to be 
displayed.

Replace Local Window: Specify the behavior of windows when another window
of the same type (Local 1/Local 2) is already displayed
when opening a window.

Auto Arrange: Specify if a touch switch is to move with, or 
independently of, an input field when the input fields 
shifts.

Related elements and setting

Numeral input element:
[Object] → [Data Input] → [Numeral] (Refer to 6-4-1 “Numeral Input”.)

(Character) string input element:
[Object] → [Data Input] → [String] (Refer to 6-4-2 “(Character) String Input”.)

Guidance

� When a cursor moving touch switch is pressed, input is enabled at the specified
(or associated) input field.

� Settings shown below can be made only with NT31, NT31C, NT631, NT631C
with “-V1”.

Local 2 
Window Position 
Replace Local Window

� If a cursor moving touch switch is created automatically at the creation of a nu-
meral/(character) string input element, the touch switch is created overlapping
the input field.

� It is possible to specify a window (keyboard) for a cursor moving touch switch.
This specification enables display of the specified window (keyboard) by simply
pressing the cursor moving touch switch.
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Reference: � A cursor moving touch switch can be created automatically when creating a nu-
meral input element or a (character) string input element.

� If [Auto Arrange] is selected, it is not possible to move a touch switch indepen-
dently.  To move a touch switch independently, deselect this attribute.

� If a cursor moving touch switch is created later independently, the touch switch
can be associated with a specific input field.  Specify the touch switch and select
[Draw] (menu bar) → [Associate With].  To disassociate the touch switch from an
input field, select [Draw] (menu bar) → [Disassociate].

� Cursor movement among data input fields is also possible using control code
input touch switches for which arrow-symbol key codes are set.

6-8-8 Window Moving Touch Switch
Function: Moving window

Settings

Function setting only.

Guidance

When a window move touch switch on a window is pressed, window can be moved
by touch panel operation at PT.

This touch switch function is available only with NT31, NT31C, NT631, NT631C
with “-V1”.

Procedure for moving a window is as follows.

1)Press a window move touch switch on a window to be moved.

2)Press the touch panel at a destination position of a window (center position of
window comes) and a window moves to that position.

Screen Screen

Window Window in a moving status

Screen



237

Touch Switches Section 6-8

6-8-9 Print Screen Touch Switch
Function: Print screen

Settings

Printing of Display Screen

Start: Specify when starting printing of screen hard copy.

Abort: Specify when aborting printing.

Guidance

� A print screen touch switch is used to print the image (hard copy) of the presently
displayed screen.

� Printing of a hard copy can be aborted by pressing the abort touch switch if it is
selected in Settings.

� The print screen function cannot be used with NT20S and NT600S.

� With conventional models where the same memory area is shared by the print
screen function and the input key–window/keyboard function, it is not possible to
print a hard copy while a window (keyboard) is displayed.
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6-10 Registering Created Elements (Symbol Manager
Operation)

The created graphic data can be collectively registered as an element by using the
Symbol Manager.  The graphic data registered collectively in a group is called
“symbol” or “symbol data”.

By registering data which is often used by the Support Tool, it is possible to use the
same data among multiple screen data (Application).

Since the graphic data for creating a keyboard and keypads for each PT model and
color/pattern combinations of tiling objects are registered and provided with the
Support Tool, you can save time when creating graphics.

6-10-1 Screen Configuration of Symbol Manager
The symbol manager screen configuration is shown below.

Symbol name

Menu bar

Symbol icon

Folder

Folder name

A folder represents one symbol data file, and symbols displayed under the folder
represent the individual symbol data registered in that file.

The name of the selected folder, or the name of the file which stores the selected
symbol is displayed in the title column of the Symbol Manager window.

File configuration

The symbol manager is controlled in a data file which is separate from the screen
data file.

The symbol data file configuration is shown below.

NTST3.2 SPPLMNT.SBL

SYMFILE1.SBL

SYMFILE2.SBL

SYMFILE3.SBL

File storing the keyboard and keypad data

Group of files storing newly registered symbols
A file is created for each symbol

Colour PL. SBL File storing tiling objects

Reference: For the Support Tool, keyboard data and colour palette is provided for each PT
model as a symbol data.  If the Support Tool is supplied in a CD-ROM, symbols of
ISO elements and sample collection are also provided.  These symbol files are
installed  with the Support Tool.
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6-10-2 Basic Symbol Manager Operation
Starting up the symbol manager

(1) [Window] (menu bar) → [Symbol Manager]

Reference: � The symbol manager window is always displayed at the top of the windows dis-
played on the screen.  If this disturbs your operation, minimize the window by
either clicking on the  button at the upper right area in the window or selecting
the [minimize] item from the control menu box displayed by the clicking on the
button at the upper left area in the window.

� The symbol manager memorizes the folder which was open when you quit the
symbol manager last time and opens the same folder automatically when you
next start the symbol manager.  The symbol registration state in the folder is,
however, the state when the folder was saved last.

Basic operation

� Menu bar

File New: Creates a new file (folder).

Open: Displays a file (folder) which is not displayed in the screen.

Close: Closes the file (folder) presently displayed in the screen.
(The file is not deleted although it disappears from the
screen.)

Save: Saves the specified folder by overwriting the present file.

Save As: Saves the specified folder by changing the file name.
(Folder name remains unchanged.)

Save All: Saves all folders to the individual files.

Exit: Lets you exit the symbol manager.

Edit Cut: Moves the specified symbol data to the clip board.
(The data is deleted from the symbol manager.)

Copy: Copies the specified symbol data to the clip board.
(The data remains in the symbol manager.)

Paste: Pastes the symbol data, stored in the clip board by cut or
paste, to the active screen.

Delete: Deletes the specified symbol data from the symbol manager.
(The data is not stored in the clip board.)

Choose Icon: Changes the icon design of the symbol data.

Change Label: Changes a folder or symbol name.
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View Status Bar: Specifies whether or not the “status bar” which
displays menu item functions, etc. is displayed
under the window.  In the menu, if there is a check
mark to the left of [Status Bar], the status bar is 
displayed.

Help Contents: Displays the help information.

Search for Help on: Enables you to display help information
on the input word.

About Symbol Manager: Displays information such as the version
of the symbol manager.

� Screen Operation

Double click on the folder or symbol name,
and the folder opens to display the list of
registered symbol data.
Double clicking on the folder or symbol
name while the list of the registered symbol
data is displayed causes the folder to close
so that only the folder name is displayed.

“+” indicates that symbol data is registered for the folder.  “–”
is displayed when the folder is open.
Clicking on this has the same effect as double clicking on the
folder name.

Reference: Folders are displayed in the alphabetical order of the folder names.  In a folder, the
list of symbol data displays the symbol data in the alphabetical order of the symbol
names.
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6-10-3 Operating the Symbol Manager
Opening a folder (file)

Open a folder in which symbol data is registered.
By opening the symbol collections supplied with the Support Tool or the files saved
by the symbol manager (P274), it is possible to display the opened data in the sym-
bol manager and to use the required one for screen creation.

Reference: � The following symbol data files are supplied with the Support Tool.

Colour Palette Symbol (ColourPL.SBL)

Keyboard/Keypad Collection (Spplmnt.SBL)

ISO Symbol Collections (ISO7000 (XXXX–XXXX).SBL) (CD–ROM version
only)

� The opened folders (symbol data files) in the symbol manager remain displayed
until they are closed. The symbol manager memorizes the folder configuration
when you quit the symbol manager last time and displays the same state when
you next start the symbol manager. (The symbol registration state in the folder is
the state when the folder was saved last.)

� While registering a symbol from a screen or pasting it to a screen, the folder to be
used (symbol data file) should be opened. However, if the symbol data file has a
“Read Only” property, the characters “Read Only” is displayed in the symbol
manager.  In this case, it is not possible to perform symbol registration.

(1) Select [File] in the menu bar, then select [Open].

The dialog to specify the file name is displayed. In the dialog, the folders which
contain the symbol data file to be read are displayed. (File type is fixed to
“Symbol Files (*.SBL)”)

(2) Specify the desired folder and file name and click on .

Opened symbol data file is displayed in the symbol manager.

Ex: Opening ISO Symbol file (ISO7000 (0001–0099).SBL)



272

Registering Created Elements (Symbol Manager Operation) Section 6-10

Closing a folder (file)

Close the unnecessary folder (symbol data file) to remove it from the symbol man-
ager.

(1) Select the folder which should be closed in the symbol manager. The folder
name is displayed in reverse video.

(2) Select [File] in the menu bar, then select [Close].

If the file has not been saved, the message asking you whether to save it or not
is displayed.

(3) If you click , the window to specify the file name is displayed.

Specify the file name and save it. (If you click  in the file name specify-

ing window, the symbol folder closes without being saved. If you click
, the symbol folder closes without being saved. (Registered symbol

will be discarded.) For details on saving, refer to “Saving a folder (file)” in
P274.

Creating a new folder

Create a new folder to register the symbol data by the procedure shown below.

By collecting symbols related with each other in the same folder, the screen data
creation operation can be facilitated since searching for symbol data is simple.

Select [File] in the menu bar, then select [New].

A new folder is named as “No description”.

� Changing folder name

To change the folder name to one that is easy to understand, follow the operation
shown below.

(1) Select the folder name which should be changed.  The folder name is dis-
played in reverse video.

(2) Select [Edit] in the menu bar, then select [Change Label].
The label name change dialog box is displayed.

(3) Set the desired folder name and click on .



Drag the symbol to the desired folder, then release the mouse.
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Registering the symbol data

A graphic consisting of several elements is registered as a single element
(symbol).

After registering the symbol data, be sure to perform the file save operation.

To register the symbol data, select the elements to be registered collectively and
drag them to the symbol manager folder where they are to be registered.

The element in the source screen remains as it is.

For a new symbol, symbol name “New Symbol x” (“x” is a serial number) is as-
signed.

Reference: The symbol data can be registered also by the following operation.

(1) Select the elements to be registered in the source screen and select [Copy] or
[Cut] from [Edit] menu in the Support Tool.

(2) Select [Paste] from [Edit] menu in the symbol manager.

In this case, symbol name “Pasted Symbol x” (”x” is a serial number) is assigned
for a new symbol.

� Changing the symbol name

To change the symbol name to the one easy to understand, follow the operation
shown below.

(1) Select the symbol name which should be changed.  The symbol name is dis-
played in reverse video.

(2) Select [Edit] in the menu bar, then select [Change Label].
The label name change dialog box is displayed.

(3) Set your desired symbol name and click on .
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� Changing the symbol icon

It is possible to change the icon of the symbol data to a desired one.  To change
the icon, follow the procedure shown below.

The data which can be used for an icon is bit map data.

(1) Select the symbol for which the icon should be changed.  The symbol name is
displayed in reverse video.

(2) Select [Edit] in the menu bar, then select [Choose Icon].

The data selection dialog box is displayed.

(3) Specify the bit map data which should be used as an icon and click on
.

Reference: For an icon, 16�16-dot, 8-color bit map data can be used.  Although bit map data
larger than 16�16 dots can be used, only the 16�16 dots at the upper left area of
such data is used.

Saving a folder (file)

After registering the symbol data, save the registered data to a file by the operation
shown below.

Select [File] in the menu bar, then select [Save], [Save As], or [Save All].

If there is a folder which has not been saved, the file name specifying window is
displayed regardless of the save method you chose.  If this window opens, specify
the file name to save the folder.  Please note that the file name specifying window
does not show the objective folder name, which means that the objective folder for
saving cannot be distinguished if you select [Save All] when there are several un-
saved folders.  It is advisable to save a folder which has not been saved by assign-
ing a file name beforehand.

Overwrites the file where the symbol data was originally
stored with the symbol data in the specified folder.

Saves the symbol data of the specified folder to the file of the
specified file name.

Overwrites the individual original files with the symbol data
which was open.

Reference: Before executing [Save] or [Save As], click the object folder.



Drag the symbol to the data creation screen and release the mouse.
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Copying/deleting the registered symbol

Registered symbols can be moved or copied to another folder or deleted.

To move, copy, or delete a registered symbol, select [Edit] in the menu bar, then
select the required function ([Cut], [Copy], [Paste], [Delete]).

Moves the specified symbol to the clip board.
The specified symbol is deleted from the source folder.

Copies the specified symbol to the clip board.
The specified symbol remains in the source folder.

Pastes the symbol, stored in the clip board by the cut or copy
function, to the currently selected folder.

Deletes the specified symbol.
The symbol is not stored in the clip board.

Move or copy of a symbol is also possible by dragging the symbol using the mouse.

� If a symbol is dragged to another folder, the symbol is moved.

� If a symbol is dragged to another folder while the Ctrl key is held, the symbol is
copied.

In these operations, the “+” mark is displayed at the mouse cursor.

6-10-4 Pasting a Symbol to Screen
To paste a registered symbol to the data creation screen of the Support Tool, select
the symbol and drag it to the desired position on the data creation screen, then
release the mouse.

The symbol is copied to the data creation screen.

The symbol copied to a data creation screen can be used in the same manner as
other elements.

Reference: � Symbols created by different PT models can be pasted to a data creation screen.
In this pasting operation, the symbol data is automatically converted and, if an
error occurred in data conversion, an error message is displayed.  For details,
refer to Appendix A “Data Conversion”.

� Concerning image/library data, only the code is registered at the symbol manag-
er.  Therefore, if the image/library data is pasted to another screen data file, the
image/library data of that code in the file to which the data was pasted is dis-
played.
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� If the ISO symbols, supplied by the CD-ROM version Support Tool, are used with
NT20S, or NT600S, those symbols that consist of elements which are not sup-
ported may not be displayed correctly.

� Image/library collection, supplied by the CD–ROM version Support Tool, can be
used only with models which can use image/library.

Pasting an ISO symbol

To paste an ISO symbol to the data creation screen of the Support Tool, select the
symbol and drag it to the desired position on the data creation screen, then release
the mouse.  (Same operqation as the other symbols.)

Drag the symbol to the data creation screen and release the mouse.

Reference: It is not possible to change the colors and size of ISO symbols, since the elements
are registered in the grouped status.

6-10-5 Operating Procedure of Color Palette Symbol
Color palette symbol

Color palette symbol is a symbol for which tiling objects are registered with their
tiling patterns, foreground and background colors respectively combined. You can
select required tiling objects while checking the tiling status on screen.

Color palette symbol is separated into tiling patterns and the each pattern is set as
one symbol as follows. Combinations of foreground and background colors are
registered for each symbol.
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Operation procedure

Follow the procedure below to use color palette symbol.

1. Open new screen to place color palette on it.

2. Drag required tiling pattern symbol from palette symbol and drop it on the
screen created in 1.

3. Select [Ungroup] from [Draw] menu to cancel the grouped status (default sta
tus) after confirming that the dragged symbol is in selected status.

4. Clear the check mark for [Full Tiling] from [View]menu to select the tiling object
easily after you decided which one to use, then drag it to the objective screen
while depressing [Ctrl] key (or perform copy&paste).
To check the tiling status, select [Full Tiling] from [View] menu. However, in this
status, the position of tiling object will not be clear. Cancel the [Full Tiling] status
when required.

5. Border color of tiling objects in color palette symbol is set to “White”. Change
the border color of tiling object by displaying property sheet if required.
Note that the transparent background color is not registered for color palette
symbol.
Change the property afterwards when you want to apply transparent 
background.



278

Registering Created Elements (Symbol Manager Operation) Section 6-10



���

������� �
	
��� ����
 �
�����

������ ��	
�� ��� ����� � � �� ��� ������ ������ ��
�� ���� �� ����������� ����� ����� ����� ����� ��� ���� ���

����������� ���� �� ������

��� �����  !������ "#$� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����� %�������  !������ "#$� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����" &�����  !������ "#"� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����' (���� )������ �����  !������ "#*� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����* +���  !������ "#,� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����- ��!� .������ &�����  !������ "#/� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����, ��	
� 0��!
��  !������ 	� &!������� ��� ��	
� 1��	�� "/$� � � � � � � � � � � � � � � � � � � � � � �

��" 1�����
 ������ ��	
�� "/�� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��"��  !������ ��������� "/�� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��"�" %�
���� +
����� "/"� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��"�' 0�����!��� �� 1�����
 ������ ��	
� 2��
�� "/"� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��' ��������� &���� ������ ��	
�� �&���� ��	
��� "/#� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��'��  !������ ��������� "/#� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��'�" %�
���� +
����� "//� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��'�' 0�����!��� �� ��������� &���� ������ ��	
� �&���� ��	
�� 2��
�� "//� � � � � � � � � � � � � � �

��'�* .������ ���3 0��� ��� � ����������� &���� '$"� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��'�- .������ .���� 0��� ��� � ����������� &���� '$'� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��'�, .������ ��	���� 0��� ��� � ����������� &���� '$*� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��* (�� ������ ��	
�� '$-� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��*��  !������ ��������� '$,� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��*�" %�
���� +
����� '$,� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��*�' 0�����!��� �� (�� ������ ��	
� 2��
�� '$,� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��- +4����� .5 .!�� ��	
�� '�$� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��-��  !������ ��������� '��� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��-�" 0�����!��� �� +4����� .5 .!�� ��	
� 2��
�� '�"� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��, +4����� .5  ��!�� ��	
� '�-� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��,��  !������ ��������� '�-� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��,�" 0�����!��� �� +4����� .5  ��!�� ��	
� 2��
�� '�,� � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��� .5 ������ ��	
�� '��� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

�����  !������ ��������� '��� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����" 0�����!��� �� .5 ������ ��	
� 2��
�� '�#� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

����' .�!����� .5 ������ ���� ������ ������� '"$� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��# 2�6�� .!�� 1����� ��	
� '"*� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��#��  !������ ��������� '"*� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �

��#�" 0�����!��� �� 2�6�� .!�� 1����� ��	
� '"*� � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � � �



���

������ ����	
��� ������� �	


��� ������ �	
�����

��� ������	
� �������� �����
 �� ��� ������ ������ 	� ����	�� ������

���� �����	
 �����	

��� �����	

����� ������� ���	
� �����	

������ �����	������	�� �����	

��������� 	����� ������� �����	

��� �����	

������	�
 ������ �� ����	��	
� ��� 
������ ���� 	�� ��	��	
� �
 ��� ������	�� �	
�

������� ����� 
������� ��� ����� �� ��� ����� ������ ���
��� �� ����
 �����

���
 	� �
���� ��� ��� �	���

����� �������	� 
�������

��� ������
�� �����
 	������ ��� �����
 
������ �
 ��� ����� 
������ 	
 ��	��

��� ����	�	� ����� 	� ���� 	
 ��� ���� �� � �	��� �
 ��� �����
 �� �����
� ��	��

��������
� �� ��� ����	�	� ����� 	� 	�������

���������� ������
�� ������	�
 	� ���	 �
�� ���
 � ������ ����� �	
�� 	� ���
� �	�� ���
 �����!�  �����! ������	�
� "� ��� ������ ����� �	
�� 	� ����� ���� ��� �����
�
�������� 	���� ��#� ������
�� ������	�
 	� 
�� ����	����



���

������ ����	
��� ������� �	


��	��
��
� � ��������� �
��� ��

 ����� $
���!

%	������ ��� ������� ����� 
������

 &����
'�����!

%	������ ��� �����
 
����� �� ��� ����� 
����� ����� ��� ����	�	� ����� 	� ����

(������ ��� 	������ 
����� 	� � �����
 
����� �� � ����� 
����� ��
 �� ����)

�	
� ���� ��� 	������ 
����� �� ����
 ������

*�� �����
 
������� �
�� � 
����� 	� 	�������

*�� ����� 
������� � 
����� 	� ������ �� � ��� ��	�� �������
�� ��� �����

�����

��� ���� �������
�	
� ����� ����� ��� ������	+� ������

,�� ����� ����

� ������� ������ �����

& ,�������� ���	
� ������ ����� �&��	
� ������

- -	� ������ �����

" $#��
� "'� 	
��� �����

� $#��
� "'� ������ �����

 ,����
��!

%	������ �����
 �����
�� ��������
	
� �� � �����
 
������

 ��� �� ������
���!

%	������ ��� 
����� �� �������
��� �� ��� �����
 �� ��� ������

������
�

�.� ,�	�� �
 ��� ����� 
����� �� ��� ������
�� ������ ������

�/� ,�	�� �
 � 0	�� �� ������
�� �����
'����� 
����� 	� 	�������

�1� "
 ��� ������
�� 	���� ��#� ����	�� ��� ������	�� �����
'����� 
����� �


��	�� �
 �

2� �
 �����
��	�� �� ��� ������	�
 ������ ��� ��� ����� ��	�� �
 ��� �����)

�	�� �����
��

��� ����	�	� �����
 �������	����� ���
� �� 	����� ��� ����	�	� �����
��



���

������ ����	
��� ������� �	


����� ����	� 
�������

3�� ��
 ������ ����	�	� ��� ��� 	
 � ����� �� ��	
� ��� ������ ������	�
� �
 ����

������� ��� ���
 ��� �	�� ��� ��	�� ����

&����� �
 ���������
� 	� ����	��� ��� ��� ������	
� ����� �� ������ ������

���� ���� ������ �
 ���������
� 	� ������ �#����� ����� ��� �
 �� ������

��	� ���
� ���� ������ �
 ���������
� 	� ����	��� �	��	
 ��� ��
�� ���� ���

�����
� ������ ���	�	�
 	
 ��� ����� �� ��� ���� 
����� �� ��� ������

����� ���� ������	�� �� &�����'���������
�

������� ������ ����� 4, �40,� ������ 	
	�	�� �����

,�������� ���	
� ������ �����
�&��	
� ������

4, �40,� ������ ��
��
�� �� 	
	�	�� �����

-	� ������ ����� 4, �40,� ������ 	����'�	����� ���

"'� �����
� ����� "'� �����
�

$#��
� "'� 	
��� ����� 555

$#��
� "'� ������ ����� 555

��	��
��
� � 	����� �
��� ��

�� ����� ������� �	����� ����� �� ��	��	�� �� �	����� �����

���
��������� ���� �� �����	�

 &����� -�!

&���	�� ��� ������	�� ��� ��� ��� ������ �� ���������
� ������	�
�

4, �40,� �����6 %��� ��� ��� ���� �
 ������� �� �������

"
	�	�� ����� ���
��
���6 %��� ��� ��� ��� 	
	�	�� ������ �� � 
������ ������ �����

�� ��������� ���	
� ������ ����� ����	
� �������

"����'�	����� ���6 "����'�	����� ���� ��� ��� � �	� ������ ������

"'� �����
�6 "'� �����
� 	
 "'� �����
� �������

 *	
 (���!

&�� ��� ��� �� �� ������� ��� �� ��������



���

������ ����	
��� ������� �	


 ������� (	��!

&�� ��� 
�� ��� �� ������� ��� ��� ��� ���  *	
 (���!�

,�	��	
� ��	� �����
 ������ ������ �������	
��

(��
 ��� ����	�	� ��� 	� ���
� ��� ������ 	
 ��� ����� �������	����� ����� �� ���

���
 ����� 
������

&����� ��� ��� 
�#� �������
�� �� ��	��	
� �
 ��	� �����
 ���	
�

,�	��	
� ��	� �����
 ������ ������� �������	
��

��� ��� ����	�	� ���  *	
 (���! 	� ������� ��� �
 ������� �	�� ��� ��� ��� ���

 ������� (	��!�

(��
 ��� ����	�	� ��� 	� ���
� ��� ������ 	
 ��� ����� �������	����� ����� �� ���

���
 ����� 
������

&����� ��� ��� 
�#� �������
�� �� ��	��	
� �
 ��	� �����
 ���	
�

,�	��	
� ��	� �����
 ������ ������� �������	
��

��� ��� ����	�	� ���  *	
 (���! 	� ������� ��� �
 ������� �	�� ��� ��� ��� ���

 ������� (	��!�

2�� �������
��� ��� ������� �	�� ��� ����	�	� ��� �� �
� �	���

������
� �������� �	������

�.� &���	�� ��� ����� ����� ���� ����� ���	�	�
 �� ��� ������ ��
����

�/� ,�	�� �
 �

�1� &����� ��� ������	�� �� ��� ������ 	
 ���  &����� -�! ��#�

�7� &���	�� ��� ������ ������	�� ��� 	
 ���  *	
 (���! ��#�

�8� ,�	�� �
 �



���

������ ����	
��� ������� �	


������
� �������� ���������

�.� &���	�� ��� ����� ����� ���� ����� ���	�	�
 �� ��� ������� ��
����

�/� ,�	�� �
 �

�1� &����� ��� ������	�� �� ������� 	
 ���  &����� -�! ��#�

�7� &���	�� ��� ��� �� �� ������� 	
 ���  *	
 (���! ��#�

�8� &���	�� ��� ��� �� ������� ��� �� ��� 	
 ���  ������� (	��! ��#�

�9� ,�	�� �
 �� �

������

������

����� ��	� ������� ������ 
�������

��� ��� 4, �40,� ������� ��
 �� ���
�� 	
�� ��� ��:�	�� ������� 	
 �

������ &	
�� ��� ���
�� ������ ��
 �� ����	�	� �� � ��
��� �������	
� ���� ��

���
�	
� ��� ����� ��
�� ;%<.=== �� =.7>>? �� ��� ����� ��
�� ;%<.@== ��

//>>? 	� ����	��� �� �
� �	��� &�	��	
� 	
 �	� �
	�� 	� ���� ����	����

���� ���� ��� ����� ����� ���
�� ������	�
 	� ������ �
�� ��� 	������ �������

"
���
�
� �	�� ��� �����	�
 �� ��� ������� ��	� ����� ���
�� �	�� �� ��������

�� ��� ����� ������

��	��
��
� � ����� �����		 ������ �
��� ��

 *	
! ))  ,��

��!

&���	�� ��� ���

�� ���� �� ��� ����� ���
�� �������



��	

������ ����	
��� ������� �	


 *	
! ))  &���� ��
��!

&���	�� ��� ����� ����� �� ��� ������ ��
�� ��� ��� ����� ����� ���
���

 *	
! ))  $
 ��
��!

&���	�� ��� �
 ����� �� ��� ������ ��
�� ��� ����� ����� ���
���

��� ����� �� �� ��� ���  $
 ��
��! ���� ������ �� ������ ���
 �� �:��� �� ���

����� ��� ���  &���� ��
��!�

 ,��
�� ��! ))  ,��

��!

&���	�� ��� ���

�� ���� �
 ����� ����� ����� ��� ���
���

2������ ��� ���
�� �	��	
 ��� 
����� �� ����	�	� ��	
�� ���� ��� ����� �)

���� �
����� �� ��	
�� ���� ;&���� ��
��? �� ;$
 ��
��?��

 ,��
�� ,����
�!

&���	�� ������� �� 
�� ��� ���� "'� �����
� ����
� �� �
 ����� ������ ���

���
�� 	� ����
� �� ��� ����� ����� ��� ���
���

�� ����
 ��� ���� "'� �����
�� ��	�� �
 ��� ����� ��# �� 	����� � ����� ����

	
 	��

-���� ����� ���
�� �������	
� ������ ���
 ��� ��	�� �
 ��	� �����
�

�� �����		�	 ��� �������

"
 ��� ������	�
 ��� ���
�	
� ������� 	
 �	� �
	��� �������	
� 	� �#����� ��)

���	
� ���� �	� .8 �� � ��� 	� 	���	����� ������� �� �	� = �� ��� 
�#� ����

2������ ��� ���
�� �� ����
 ����� �����	
� �� ��� ��� ������ ��
�� �
 ���

����� ����� ��� ���
���

�������� -	� ������ �����

�� �� �

!���	
� "�# $$ !%������#

������ ������� ����� ��� ���	
��

%������ �	� ��� ���

��� !����� ��	
�#

��� 	
�	 �
� ���� 	
�	 �
� �

��� �� �

%������ �	� ��� ���

��� !	� ��	
�#

�� ���� �� �

������ 
��	� �
� ��������� 
��	� �
� ���

������ ���	
� ����� ���	
�

� ��

�� ���

� ���

�� ���

��� ����



��


������ ����	
��� ������� �	


������
� ��������

�.� ,�	�� �
 �

�/� &����� ��� ���� �� ���

�� ������ ��� ���
�� 	
 ���  ,��

��! ��#�

�1� &���	�� ��� ��
�� �� ��� ���
�� �� ����	
� ������� �� ���  &���� ��
��! �


 $
 ��
��! ��#���

�7� &���	�� ��� ���

�� �
 ��� ����� ����� ��� ���
�� 	
 ��� ��������
	
�

��#�� 	
 ���  ,��
�� ��! �����

�8� &�� � ����� ���� 	
 ��� ,��
�� ,����
� ����� ��# �� ��	���

"� � ����� ���� 	� ��� 	
 ��	� ����� ��#� "'� �����
�� ����
� �� ��� �)

������ ������ ��� ���
�� ��� ���� ����
� �� ��� ������� ����� ���

���
���

�9� ,�	�� �
 �

����� ��� 
�������

��� �������� ��� �����	
�� ����	
�� ����	
�� ����	
�� �
 	
�����
��� ����	
� ��

��� ��� ��� 	
 � ������ ����� 	� ����	�� ������

"
 ��� ;���� �� 
�#�? ������	�
� ��� ����	�	� 	
�����
��� ����
� 	� �������	�����

�� �� ��� ��� 	
 ��� ������ ����� �� ��� ������ �����	�
 �
 ���	� �� ���

������ ����� �	�� ��� 
�#� 
������

��� �������� ��� ����	��	
� ��� 	
�����
��� ����
� �� �� ��� ��� ;���� �� 
�#�?

	� �#���	
� 	
 A).)8 ;,��� "
�����
� &���	
� ������	�
?�

���������� � �� ����� �	�	
�� ��	�� �
 �� �	��� ��	�� ��� ����� �
 � ����� 
�����
�� 	����� ��� ��
�� ���
 ������ ��� ��	�� �	� ��
��	�
 	
 ��	� ��
�� "� ��� 
��
�� ����	��� �� ������ �
 �	� ��
��	�
 	� �
 	
��� �	�� 	� 	������� "� ��� ������	�

�� �
 �	� ��
��	�
 	� 
�� ����	���� ���� ��	�� ��� ����� �
 � ����� 
����� �	�� ��
������ ��� �
�	�� �	
� �
� ����� ����� ��	�� �
 �� �	��� ��	�� ��� �����
�
 � ����� 
����� �� 	����� ��� ��
��

� (��
 ��� ��� �����
 ��� �	��� �� ��� ���� 4� ���� ��� ���
� ��	
�  "�����

,����
�
�! �����
� 	� 	� ����	��� �� ����� ��� ����� ��� ��	�� ��� ���'���)

	� �� �
� &������ ���� �� � ����� �� �
����� &������ ����� �*�� ���	��� ����� ��

1))1))9�



���

������ ����	
��� ������� �	


 ,����!

,����� ��� ��� 	
 ��� ������� ������ ������

 ,��!

,��� ��� ��� 	
 ��� ������� ������ ����� �
 ������ 	� 	
 ��� ��	� �����

��� ��� ��� ��
 �� ����� �� �
����� ������ ������

 ,���!

,��	�� ��� ��� 	
 ��� ������� ������ ����� �� ��� ��	� �����

��� ���	� ��� ��
 �� ����� �� �
����� ������ ������

 4����!

4����� ��� ��� ����� 	
 ��� ��	� ���� �� ��� ;���? �� ;����? ��
��	�
 �� ���

������ ����� �� ��� ������ ���	�	�
�

 ,��� �� ��#�!

$#������ ��� ;���� �� 
�#�? ������	�
�

B�� ��	� ��
��	�
 	� �#����� 	����� �����	
� �� ��� ����� ���� �� ����
 ������

����� ����
"
�����
� "���

����� ����
"
	�	�� C���� 4, �40,� 2����

������� ������ ����� 2	�	�
 �������	
� 2	�	�
 �������	
�

,�������� ���	
� ������ �����
�&��	
� ������

,�

�� �� ����	�	�� 2	�	�
 �������	
�

-	� ������ ����� ,�

�� �� ����	�	�� 2	�	�
 �������	
�

$#��
� "'� 	
��� ����� ,�

�� �� ����	�	��

$#��
� "'� ������ ����� ,�

�� �� ����	�	��

������
� �������� �������

��� ����� ��
��	�
 ������ ��� ��� �� ��� ����	�	� ����� �� � ������

&	
�� ��� ��� 	� 
�� ����� 	
 ��� ��	� ����� ��� ��� ����� �� ��� ����� ��
��	�


��

�� �� ������� �� ��� ����� ��
��	�
�

�.� ,�	�� �
 ��� ����� 
����� �� ��� ��� �� �� �������

�/� ,�	�� �
 �� �	��� ��	�� ��� ����� 
������

�1� &�����  ,����!�



���

������ ����	
��� ������� �	


������
� �������� �����

��� ��� ��
��	�
 ���� ��� ��� �� ��� ����	�	� ����� �� � ����� �
 ������ 	� 	
 ���

��	� �����

��� ��� ����� �� ��� ��� ��
��	�
 ��
 �� ��� ��� ����	
��

�.� ,�	�� �
 ��� ����� 
����� �� ��� ��� �� �� ����

�/� ,�	�� �
 �� �	��� ��	�� ��� ����� 
������

�1� &�����  ,��!�

������
� �������� �����

��� ���� ��
��	�
 ���	�� ��� ��� �� ��� ����	�	� ����� �� � ����� �� ��� ��	�

�����

��� ��� ���	� �� ��� ���� ��
��	�
 ��
 �� ��� ��� ����	
��

�.� ,�	�� �
 ��� ����� 
����� �� ��� ��� �� �� ���	��

�/� ,�	�� �
 �� �	��� ��	�� ��� ����� 
������

�1� &�����  ,���!�

������
� �������� ���	���

��� ����� ��
��	�
 ������ ��� ��� ����� 	
 ��� ��	� ���� �� ��� ��� �� ���� �����)

�	�
 �� ��� ����	�	� ������

�.� ,�	�� �
 ��� ����� 
����� �� ��� ����� ����� ��� ��� 	� �� �� ������

�/� ,�	�� �
 �� �	��� ��	�� ��� ����� 
������

�1� &�����  4����!�

������
� �������� ����   !����

��� ;���� �� 
�#�? ��
��	�
 ���	�� ��� ��� �� ��� ����	�	� ����� �� � ������

����� �� ��� 
�#� ����� ����� �	
� ��� ����	�	� ����
� �� ��� �#	��	
� ����

��� �������� ��� ����	��	
� ��� 	
�����
��� ����
� 	� �#���	
� 	
 A).)8 ;,���

"
�����
� &���	
� ������	�
?�

�.� ,�	�� �
 ��� ����� 
����� �� ��� ���� ������ ������

�/� ,�	�� �
 �� �	��� ��	�� ��� ����� 
������

�1� &�����  ,��� �� ��#�!�



���

������ ����	
��� ������� �	


����� ���� ��	����� ����� 
�������

�� ��� ��� 	
�����
��� ����
� ��� ��� ��� ;���� �� 
�#�? ������	�
� ������ ���

����� ����	�� ������

 ,��� "
�����
� &���	
� 	���� ��#!

 C����! ))  "
�����
� -�!

&���	�� ��� 	
�����
��� ����
� ��� ��� 	
	�	�� ����� ��� 	
 � 
������ ������

������

��� ����
� ��� ���� 	� ���	 �
�� ��� 
������ ������ �������

 C����! ))  "
��� ����!

&���	�� ������� ��� 	
�����
��� ����
� 	� ����	�	� 	
 ��	��� �� ��#���	����

��� ����	�	� 	��� 	� 	�
�	�	� �� ��� � 	
	���	�
 �� � ��	� �����
�

��� ����	
� 	� ���	 �
�� ��� 
������ ������ �������

 2����! ))  "
�����
� -�!

&���	�� ��� 	
�����
��� ����
� ��� ����� ��������

 2����! ))  *�����!

&���	�� ������� ��� 	
�����
��� ����
� 	� ����	�	� 	
 ��	��� �� ��#���	����

��� ����	�	� 	��� 	� 	�
�	�	� �� ��� � 	
	���	�
 �� � ��	� �����
�

������
� ��������

�.� ,�	�� �
 �

�/� &���	�� ��� 	
�����
��� ����
� �� �� �� �� ��� 	
	�	�� ����� 	
 ��� 
������

������ ����� ��  C����! ))  "
�����
� -�!�

�1� &���	�� ������� ��� 
����	�
 �� ��� 	
�����
��� ����
� ��� ����� 	� ��	���

�� ��#���	��� ��  C����! ))  "
��� ����!�

�7� &���	�� ��� ����� ����� 	
�����
��� ����
� ��  2����! ) "
�����
� -�!

�8� &���	�� ������� ��� 
����	�
 �� ��� 	
�����
��� ����
� ��� ����� 	� ��	���

�� ��#���	��� ��  C����! ))  "
��� ����!�

�9� ,�	�� �
 �� ����� ��� 	���� ��#�



���

������ ����	
��� ������� �	


�A� ,�	�� �
 ��� ����� 
����� �� ��� ���� ������ ������

�@� ,�	�� �
 �� �	��� ��	�� ��� ����� 
������

�>� &�����  ,��� �� ��#�!�

���� !�"#� $���#�� 
������� "� ���	������ �� !�"#� %&�"��

� %����	��	�
 ��  D� ��! 	���� ��#

 $
���!

&���	�� ��� ����� 
����� �� ��� ����� �� �� 	�������

��� ������ ����� �� ��� ����	�	� ����� 
������

������
� ��������

�.� ,�	�� �
 �

�/� &���	�� ��� ����� 
����� �� ��� ����� �� �� 	�������

�1� ,�	�� �
 �



���

����	� ������ �	���� ������� �	�

��� ���
��� �
���� ����
�

������� <����� ������

������� ������ ������ ��� ����� ����	� 	
 � 4� �� ����� 
����	� ����� ����

2 
������ ������ ����� 	� �������� �� �
� �� ��� ���� 	
 � 4, �40,� �
 ���


������ ������ ����� ��� ��� 	����� ��
 �� ����� �	�� ��� 4, �40,��

(	�� �����
�� ���� �� 
������ 	������ ������ �
 
������ 	
���� ���	
�'��	�	
�

�� � 
����	� ����� 	� �#����� �� ����	��	
� ��� 
������ ������ ����� 
������

�� �����

�����	� �	���
�����	���	���

��
	�� ����
�� � �
��

 � ! "�#
	��
���
�$� %&&���

'���
��%�

��&�
	� &�&
�

�	(��

�)�*��&�
	� �����	�

���&���

)�*���&�
	� �	�	

����� ���&���

+	
 �
	�,

�

�

)

�

*

�

&����


�"

'�	�

�
���

'�	�
�,	
��

�,	
��

�,	
��

����� 
������� '��	��&��

2 
������ ������ ����� 	� 	������ �� ��� ������	�
 ����	�� ������

� 2� ��� �������� ����	
�� ��� 	
	�	��� �����
��� ��	�� �
 	
 ��� ����� 
�����

�	���

� &�����  �����! ���
� ���� �  �����!� ���
 ��	�� ���  �������! ����

"���
��

*�� 
������ ������ ������� ��� ������	�� �� �
 ������	�
 	� ����	�	� �� ��	��	
�

�
 � �	
�� ��� 
�������� ����	
� ��
 �� ��� �� 	
��� ��	
� � ������� �� ��

������	�
 ��	
� � ���)��
 �	���

*�� ��� ������	�
 �������� ��� � � �

� � �
 � ����� �� A). ;,����
 ������	�
?�

����� ���� ��

�� �� ��� 	� 	� 	� 	������ �� ��� ������	�
 ��	
� �


�����
� ����������

���������� *�� 4� ����� ����� ���
 ��/=& �
 ��9==&� 
������ ������ ������ ��� /7A ��
��� /88 ��� ��� �� ��� ����� ��
��	�
 �
� ���������� ��

�� �� �������� �� � 4,
�40,��



���

����	� ������ �	���� ������� �	�

����� ��#��� �#�����

� (��
 ���	
� 
������ ��� ���� � 
������ ������ �����

������� 	����� �����
�

 ������! �  ������� %	�����!

-�� ����� �����
�

 ������! �  D����! �  -�� D����!

2
������ ����� �����
�

 ������! �  D����! �  2
������ <����!

-����
)�	
� ����� �����
�

 ������! �  D����! �  -����
)�	
� D����!

���
 ����� �����
�

 ������! �  D����! �  ���
 D����!

� (��
 ��	�	
� 
������ ��� �� � 
������ ������ �����

������� 	
��� �����
�

 ������! �  %��� "
���! �  �������!

���������� ��	��� �����
�

 ������! �  %��� "
���! �  ���������� &�	���!

� (��
 ����	
� 
������ ��� ������
 
������ ������� �� ���
 ����	
� � ��
���
�

��� � 
������ ������ �����

����� ��	��� ����� ����	
��

 ������! �  ����� &�	���! �  &���	
��)),��� &���	
�! 	
 �������� �����

����� $��	������ �� %&����# (����� !�"#� )��#��

��� 	����� ������ ���	�� ��	����� ���
	
� �
 ��� 4� ����� ��� �#�����

�����
 ����
 ����� 	� ��� ��1.� ��1.,� ��91.� �
 ��91.,�



���

����	� ������ �	���� ������� �	�

 C����!

&���	�� ��� 	
	�	�� ����� �� �� ��� ���
 ��� ����� 	� ��	���� ��� ��� 4� 	� ������ ��

��� ��� 	� ���
�� ���� &����� <�
� �� �E��

��� ��
�� �� ������ ��	�� ��
 �� 	
��� 	
 ��	� �	�� 	� ����
 ������

4� <��� "
��� ���� "
��� ��
��

����� ���
 ��1.� ��1.,� -,% *>>>>>>> �� >>>>>>>>����� ���
 ��1.� ��1.,�
��91.� �
 ��91. B�#���	��� ======== �� ********&'

��1.� ��1.,� ��91.� %��	��� �/.7A7@197@ �� /.7A7@197A��1.� ��1.,� ��91.�
�
 ��91. B�#���	��� F======== �� F********&(

G.6 ;*? 	
 ��� ���� �	�
	�	��
� 	�	� ���	�	�
 �@�� 	�	�� 	
	����� � 
����	�� ������

G/6 (	�� ��1.� ��1.,� ��91.� �
 ��91.,� � ��#���	��� 
����� ��
 ��

	
��� �� �
���	
� ;F? �� ��� ���	

	
� �� � 
����	� ������ ��� 	
���

��#���	��� ����� 	� ��
����� �� ��	��� ��� 	������

*�� 4� ����� ����� ���
 ��1.� ��1.,� ��91.� �
 ��91.,� ��� 	
��� @)	�	�

��#���	��� ����� 	� �	���� ����� �� 	� 	�H ����� ��� 
� 	��	
��	�
� ������
 -,%

�
 ��#���	��� ��� ����� ������ "� ��� 	
��� 
����	� ����� 	� 	������ 	
 -,%

������� ;*? 	
 ��� ���� �	�
	�	��
� 	�	� ���	�	�
 �@�� 	�	�� 	� ������ �� � 
����	��

�	�
�

(	�� ��1.� ��1.,� ��91.� �
 ��91.,� ��� 	
��� 
����	� ����� 	� ����� �����

��
����	�
 �� �	�
� �	
��� ��� �/ ������

&���	
� �� �
 	
	�	�� ����� 	� ���	 ���
 ��� ������ ��
��	�
 	� 
�� ������� �
 ���

 "
	�	��! 	��� 	� ������� ��� ��� 
������ ������ ������ �
 	
 ��	� ���� ��� ��
��
�

�� ��� 
������ ������ ����� 	� �����
� �� ��� 	
	�	�� ������ "� ��� 4� ��� ���

������ ����� 	
	�	��	+��	�
 ��
��	�
� ��	� ��
��	�
 ��
 ���� �� ��� �� �����
 ���

��
��
� �� � 
������ ������ ����� �� ��� 	
	�	�� ������

 "
	�	��!

&���	�� ������� �� 
�� ��� ��
��
� �� ��� 
������ ������ ����� 	� ��	���
 �� ���

�������� ��� 	
 ��� ���� ���
 ��� 4� 	� ��	���� �
 �� ������ �� ��� ��� 	�

���
�� ���� &����� <�
� �� �E��

��� ���� ;	
	�	��	+�? ���
� ��� �������	
� �� 	
	�	��	+� ��� ��
��
� �� � ��� 	
 ���

���� �	�� ��� ��
��
� 	
 � 
������ ������ ������ ��� ����	
� ���  "
	�	��! 	� 
�� ���	

	� ��� 
������ ������ ����� 	� 
�� �������� �� � ��� 	
 ��� �����

�� ���� ���  "
	�	��! 	��� ���	� ��	�� �
 ��� ����� ��# �� 	����� � ����� ���� ��� 	


��� ��#� "� ��� ��# 	� ��	��� �
 ��	�� 	� 	� 	
 ��� ���	 ������ ���  "
	�	��! 	��� 	� ���

	
���	�



���

����	� ������ �	���� ������� �	�

���������� ��� ��
��
� �� 
������ ������ ������ �� ��� ����� �� 4� ������	�
 	� �� ����
 ��)
��� �����	
� �� ������� �� 
�� � 
������ ������ ����� 	� �������� �� ��� �����
���  "
	�	��! ����	
� ��� ��� 
������ ������ ������ �
 ������� �� 
�� ��� ������
��
��	�
 	� ����

���������	 �� ��	������
���� � !�	����	

���������	 ��
����

��	������
�����	
 "��# $�� "��#

��������# �	������%�#
�&���#�

'(����	
 	� ����  � ��)
��*�� &���� �����	�#
����� ��� ��� +��# �	 ���
�����

�	����� &���� �� ��� 	� ����
 � ��) ��*��
����� ��� ��� +��# �	 ���
�����

�	����� &���� �� ��� 	� ����  � ��) ��*�� �� �� �� �	�����,
�%�# *) -)��� .�	� �/������	
����� ��� ��� +��# �	 ��� �����

$�� �	������%�#
��	&���#�

��	��	� �� +��# �	 ��� ����

$�� ��������# ��	&���#� '(����	
 	� ����  � ��)
��*�� &���� �����	�#

�	����� &���� �� ��� 	� ����
 � ��) ��*��

�	 ���� 	� ���� ��*�� ��� *��	 �	������%�# �	 ��� �)�,
��  �	� �/������	0 �	����� &���� �� ��� 	� ����
 � ��) ��*��

 &������ ����! ��
�� ��� ��1.� ��1.,� ��91.� �
 ��91.,�

&���	�� 	� � 
������ 	
 ��� 4, �40,� 	� ������ �� -,% �� �	
��� ��� ���
 ���	
�'

��	�	
� ��� ��
��
� �� � 4, �40,� ��� �� ��	�� � 
������ ������ ����� 	� ����)

����� ��	� ����	
� 	� ���	 �
�� ��� ��1.� ��1.,� ��91.� �
 ��91.,� (	�� �����

4� ������ 
����	� ������ ��� ������ ������ �� -,%�

-,%6 ��� ��
��
� �� �
 �������� ��� 	� ������ �� -,%

��	
��� ��� ��	�����

(��
 ��� ��
��
� �� �
 �������� ��� 	� ���� 	� 	� ����� �� �	�
�

�	
��� ���� "� ;*? 	� ��� �� ��� ���� �	�
	�	��
� 	�	� ���	�	�
 	
 ��� ����)

���� ���� ��� ��
��
� 	� ������ �� � 
����	�� ������ "� �
 ����� 	�

���
 	
 ��� ��
��
� �� �
 �������� ��� �;2? �� ;$? �� ��� ���� �	�
	�	��
�

	�	� ���	�	�
 �� ;2? �� ;*? 	
 ����� ���
 �� ��� ���� �	�
	�	��
� 	�	� ���	)

�	�
�� ��� ��� ��� ��
��
� 	� 
�� ����� 	
 � 
������ ������ ���� ���)

�	����� ����� ��
��
� ����	
� 	
 ��� 
������ �������

(��
 ��� 	� ��	���
 �� �
 �������� ���� ��� �	�
� �	
��� ��� 	
 ���


������ ������ ����� 	� ��
����� 	
�� -,% ������ ��	�	
�� "� � 
���)

�	�� ����� 	� ��	���
� ;*? 	� �
���� �� ��� ���� �	�
	�	��
� 	�	� ���	�	�
�

�"
 ��	� ����� ��� 
����� �� �������� 	�	�� 	� ����� �� �
��� "� ��� 
��)

��� �� 	�	�� 	
 ��� ��
��
� �� � 
������ ������ ����� 	� ������� ���
 ���


����� �� 	�	�� �� ��� �������� ��� 	
 ��� 4, �40,�� �
�� ��� 
����	�

����� 	� ��	���
 ���� ��� ����� �	�
	�	��
� 	�	� ������



��	

����	� ������ �	���� ������� �	�

-	
���6 ��� ��
��
� �� �
 �������� ��� 	� ������ �� �	
��� ����

(��
 ���	
� ��� ��
��
� �� ��� �������� ���� ��� ��� ��
��
� 	�

����� 	
 � 
������ ������ ����� �	����� ���
���

(��
 ��	�	
� � 
����	� ����� �� ��� �������� ���� ��� ��
��
� �� ���


������ ������ ����� 	� ��	���
 �� 	� 	�� "� ��� 
����� �� 	�	�� 	
 ��� ��
)

��
� �� � 
������ ������ ����� 	� ������� ���
 ��� 
����� �� 	�	�� �� ���

�������� ��� 	
 ��� 4, �40,�� �
�� ��� 
����	� ����� 	� ��	���
 ���� ���

����� �	�
	�	��
� 	�	� ������

&�����6 ,�
����� �� ��� ����	
� ���  ������� %	����� ����! ��  &�����! 	
 ��� 4,

�40,� ,�
�	�����	�
�

 (���!

&���	�� ��� 
����� �� ���� �� �� �������� �� � 
������ ������ ������

��� ����	��� ����	�	���	�
� ��� ;.? �
 ;/?�

� "� ��� ����	
� 	� . ���� ��� 7)	�	� -,% �� �	
��� ��� 	� ����� �� ��� 4� �
 4,

�40,��

� "� ��� ����	
� 	� / ����� ��� @)	�	� -,% �� �	
��� ��� 	� ����� �� ��� 4� �
 4,

�40,��

(��
 ��� ����	
� 	� ;/?� ��� .�� �� 7�� 	�	� ��� 	� �������� �� ��� ����� 	�	� ��� 	


��� 4, �40,� �
 ��� 8�� �� @�� 	�	� ��� 	� �������� �� ��� �	���� 	�	� ����

� 4� ����� ����� ���
 ��1.� ��1.,� ��91.� �
 ��91.,

"� ��� ����	
� ��� ���
 ��� �� 	����� � �	�
� �
� 	�	� ��	� 7� 	
 ��� ���� �	�
	�	��
�

	�	� ���	�	�
 	� ������ �� �������
�	
� � �	�
H 	� ;*? �.... 	
 �	
���� 	� ���� ���


����	� ����� 	� ������ �� 
����	�� �
 	� �
� ����� ��� 	� ���� ��� 
����	�

����� 	� ������ �� ���	�	��� ���������� 	� ��� 
����	� ����� 	� 	������ �	�� �

�	�
� ��� ��#	��� 
����� �� �	�
	�	��
� 	�	�� �� � 
����	�� ����� 	� ;1? 	� ;. ���?

	� ��� �
 ;A? 	� ;/ ����? 	� ����

�������� (��
 . ��� 	� ���� ��� ����� ;5./1? 	� ������ �� ;*./1? 	


��#���	��� 	
 � 
������ ������ ������

&	�	������ ���
 / ���� ��� ���� ��� ����� ;5./1789A? 	� ������ ��

;*./1789A? 	
 ��#���	��� 	
 � 
������ ������ ������



��


����	� ������ �	���� ������� �	�

� 4� ����� ��1.� ��1.,� ��91.� �
 ��91.,

��������� �� ��� 
����� �� �������� ����� / ���� ��� ������ ������ ��� �


������ ������ ����� �
 � 
����	� ����� 	� ����� �� �	�
� �	
��� ���� "� ���

����	
� ���  &������ ����! 	� ��	���� ;*? ������	
� �� ��� ���� �	�
	�	��
� 	�	�

���	�	�
 	� ������ �� � 
����	�� �	�
� "
 ��	� ����� ���������� ��� 
����� �� �	�)


	�	��
� 	�	�� �� � 
����	�� ����� 	� �
� 	�	� ���� ���
 ��� 
����� �� �	�
	�	��
�

	�	�� �� � ���	�	�� ������ �� �	�� ��
��
�	�
�� 4� ������

�������� "� ��� ����	
�� ��� ;-,%? �
 ;. ���?� ��� ����� ;�./1? 	� ������ ��

;*./1? 	
 � 4, �40,� ��� �
 ;******@8? 	
 � 
������ ������

������ B������� ��� ����� ;*./1? 	
 � 4, �40,� ��� 	� ;====*./1?

�9.A1. 	
 ��	���� 	
 � 
������ ������ ����� 	� ���  &������ ����! 	�

��#���	����

&	�	������ 	� ��� ����	
�� ��� ;-,%? �
 ;/ ����?� ��� ����� ;�./1789A?

	� ������ �� ;*./1789A? 	
 � 4, �40,� ��� �
 ;**$%/>A>? 	
 � 
�)

����� ������ ������ B������� ��� ����� ;*./1789A? 	
 � 4, �40,�

��� 	� ;*./1789A? ��/7>179A.1 	
 ��	���� 	
 � 
������ ������

����� 	� ���  &������ ����! 	� ��#���	����

�������

�	 �� �����
1��#

1���� 2� $�3 �� 1��#� -����
� 2)/� �	 $� ���� .� ��) 2�*��

!��4 � � +��# ��5 !!!!!!6�
��	 #��� ��7 ���4�

� � +��# ��	��) !!!!!��4
��	 #��� ��7 �46��

!��48��9 � � +��#� ��5 !!'5�:9:
��	 #��� ��7 ���48��9�

� � +��#� ��	��) !��48��9
��	 #��� ��7 ��8:48�9�4�

8��9 � � +��# ��5 ��59
��	 #��� ��7 �8��9�

� � +��# ��	��) 8��9
��	 #��� ��7 ��99�9�

!��9 � � +��# ��5 !!'5�:9:
��	 #��� ��7 ���48��9�

�:9: � � +��# ��	��) !!'5�:9:
��	 #��� ��7 ���48��9�

!�� "� �
�� �
� ��� 	� �������� �������� ��� ���� ��� 
�������� �� �#����� � 
�)

���	� ������ �
�� ��� ����� 7 	�	�� �� � 
����	� ����� ��� ��� �� ��	���
� 2 ����	)

�	�
� 
����� �� ���� ���� �� �������� ��� ���	
�'��	�	
� � 
����	� ������



���

����	� ������ �	���� ������� �	�

 40, 2����!

&���	�� ��� 4, �40,� ����� ������ ������ �� ��� ���� ����� 
������ ������

������ ��� ���������

 "'� ,����
�!

&���	�� � �����
� ��� � 4, �40,� ����

2 �����
� ��
 �����	�� �� �� .9 �����������

 ���!

"
	����� ������� ��� ����� �	�� ��� ����	�	� 
����� 	� ������ ��� �� 
���

3��6 2����� ��� �� �
 �����
��

��6 ��� ����

"� ��� 	
	���	�
 	� ;3��?� ��� ��
 ����� ����� ��� ����� 	
 :����	�
 	� ��� �� ��	��)

	
� �
 �

�*�� ���	�� �� � ����� �� A).). ;������
�� ������	�
?��



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

��� ������
� ����� �
���� ����
� ������ ����
��

,�������� ���	
� ������ ������ �&��	
� ������� ��� ����� ����	� 	
 � 4� �� �����

����������� ���	
� ����

2 ��������� ���	
� ������ ����� ����	
� ������ 	� �������� �� . �� /= ���� 	
 � 4,

�40,� �
 � ��������� ���	
� ������ ����� ����	
� ������ ��� ��� 	����� ��
 ��

����� �� ��� 4� �
 ��� 4, �40,��

"� 	� ����	��� �� 	
���� ���� ���� 	���� ��� �� �	����� ��� 	
�� � ����������� ���	
��

���� ����� �������� ��..&� ��/=& �
 ��9==& � 
�� ���� 	���� ��� �
 �	)

����� ���� (	�� ��1.� ��1.,� ��91.� �
 ��91.,� 	� 	� 
�� ����	��	��� �� 	
����

	���� ��� �
 �	����� ��� 	
�� � ����������� ���	
��

(	�� �����
�� ���� �� ����������� ���	
� 	����� �
 ����������� ���	
� 	
���� ���)

	
�'��	�	
� �� ����������� ���	
� ��� 	� �#����� �� ����	��	
� ��� ��������� ���	
�

������ ����� ����	
� ������ 
������

�� �����

�����	� �	���

�����	���	���

�� � �
��

 � ! "�#
	��
���

�$� %&&���

'���
��%�

�,	
	%��
 ��
���
&�&
� �	(��
!��
��� �	(��#

�-'��
!�,	
	%��
# ��
���

�����	� ���&���

 .!�,	
	%��
# ��
���

����� ���&���

�

�

)

�

*

�

�%
���

�"

'�	�

�
���

�,	
��

�,	
��

����� 
������� '��	��&��

2 ��������� ���	
� ������ ����� ����	
� ������ 	� 	������ �� ��� ������	�
 �)

���	�� ������

� 2� ��� �������� ����	
�� ��� 	
	�	��� �����
��� ��	�� �
 	
 ��� ����� 
�����

�	���

� &�����  �����! ���
� ���� �  �����!� ���
 ��	��  &��	
�! ����

"���
��

*�� ��������� ���	
� ������ ������ ����	
� �������� ��� ������	�� �� ������	�
 	�

����	�	� �� ��	��	
� �
 � �	
�� ��� 
�������� ����	
� ��
 �� ��� �� 	
��� ��	
� �

������� �� �� ������	�
 ��	
� � ���)��
 �	���

6 "
����� ���� ����

6 "
����� 	���� ����

6 "
����� �	����� ����

*�� ��� ������	�
 �������� ��� � � �

� � �
 � ����� �� A). ;,����
 ������	�
?�

����� ���� ��

�� �� ��� 	� 	� 	� 	������ �� ��� ������	�
 ��	
� �


�����
� ����������



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

����� ��#��� �#�����

� (��
 ���	
� ���� � ��������� ���	
� ������ ����� ����	
� ������

�,��������� ���	
� 	����� �����
�  ������! �  &��	
�!

2���� �	��  ������! �  2����! �  0	��!

2���� �	�����  ������! �  2����! �  B	�����!

� (��
 ��	�	
� �� � ��������� ���	
� ������ ����� ����	
� ������

�,��������� ���	
� 	
��� �����
�  ������! �  %��� "
���! �  &��	
�!

� (��
 ����	
� ����������� ���	
�� ������
 ��������� ���	
� ������ ������

����	
� �������

����� ��	��� ����� ����	
��  ������!�  ����� &�	���!�  ,��� &���	
�!

����� $��	������ �� �����	�� ����� (����� !�"#� *����� !�"#�+
)��#��

 C����!

&���	�� ��� 	
	�	�� ����� �� �� ��� ���
 ��� ����� 	� ��	���� ��� ��� 4� 	� ������ ��

��� ��� 	� ���
�� ���� &����� <�
� �� �E��

*�� �
 	
	�	�� ������ � ����������� ���	
� ��
��	
	
� � ��#	��� �� 7= ���������� ��


�� ����	�	�� �/= ���������� ��� ��..&� 1/ ���������� ��� ��/=&�

�� 	����� ;I?� 	
��� ��� ���������� �	����� � ���
�� �	�� ;II?�

&���	
� �� �
 	
	�	�� ����� 	� ���	 ���
 ��� ������ ��
��	�
 	� 
�� ������� �
 ���

 "
	�	��! 	��� 	� ������� ��� ��� ��������� ���	
� ������ ����� ����	
� ������� �
 	


��	� ���� ��� ��
��
� �� ��� ��������� ���	
� ������ ����� ����	
� ������ 	� �����
�

�� ��� 	
	�	�� ������ "� ��� 4� ��� ��� ������ ����� 	
	�	��	+��	�
 ��
��	�
� ��	� ��
�)

�	�
 ��
 ���� �� ��� �� �����
 ��� ��
��
� �� � ��������� ���	
� ������ �����

����	
� ������ �� ��� 	
	�	�� ������

-� ��	��	
� �
 � � �� � ��� ��
 	
���� ����

���� 	���� ���� �� �	����� ��� 	
�� � ����������� ���	
�� �(	�� ��1.� ��1.,�

��91.� �
 ��91.,� �
 ��� 
�� �
������



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

 "
	�	��!

&���	�� ������� �� 
�� ��� ��
��
�� �� ��� ��������� ���	
� ������ ����� ����	
�

������ ��� ��	���
 �� ��� �������� ���� 	
 ��� ���� ���
 ��� 4� 	� ��	���� �
 ��

������ �� ��� ��� 	� ���
�� ���� &����� <�
� �� �E��

��� ���� ;	
	�	��	+�? ���
� ��� �������	
� �� 	
	�	��	+� ��� ��
��
� �� ���� 	
 ���

���� �	�� ��� ��
��
� 	
 � ��������� ���	
� ������ ����� ����	
� ������� ��� ����	
�

���  "
	�	��! 	� 
�� ���	 	� � ��������� ���	
� ������ ����� ����	
� ������ 	� 
�� ����)

���� �� � ���� ����

�� ����  "
	�	��! ���	� ��	�� �
 ��� ����� ��# �� 	����� � ����� ���� ��� 	
 ��� ��#�

"� ��� ��# 	� ��	��� �
 ��	�� 	� 	� 	
 ��� ���	 ������  "
	�	��! 	� ��� 	
���	�

���������� ��� ��
��
� �� ��������� ���	
� ������ ������ ����	
� ������� �� ��� ����� �� 4� ��)
����	�
 	� �� ����
 ����� �����	
� �� ������� �� 
�� � ��������� ���	
� ������
����� ����	
� ������ 	� �������� �� ��� ����� ���  "
	�	��! ����	
� ��� ��� ��������� ���	
�
������ ����� ����	
� ������� �
 ������� �� 
�� ��� ������ ��
��	�
 	� ����

���������	 �� ��	������
��	������ �����	


���������	 ��
����

��	������
�����	
 "��# $�� "��#

��������# �	������%�#
�&���#�

'(����	
 ��������� ����	

 � ��) ��*�� �����	

��*��� ��	��	� �����	�#
����� ��� ��� +��# �	 ���
�����

�	����� &���� �� ��� ������,
��� ����	
  � ��) ��*��
�����	
 ��*���
����� ��� ��� +��# �	 ���
�����

��	��	� �� ��� ��������� ����	
  � ��) ��*�� �����	

��*��� �� �� �� �	������%�# *) -)��� .�	� �/������	
����� ��� ��� +��# �	 ��� �����

$�� �	������%�#
��	&���#�

��	��	� �� � +��# �	 ��� ����

$�� ��������# ��	&���#� '(����	
 ��������� ����	

 � ��) ��*�� �����	

��*��� ��	��	� �����	�#

�	����� &���� �� ��� ������,
��� ����	
  � ��) ��*��
�����	
 ��*���

��	��	� �� ��� ��������� ����	
  � ��) ��*�� �����	

��*��� �� �� �� �	������%�# *) -)��� .�	� �/������	

 (���!

&���	�� ��� 
����� �� ���� 	
 ��� 4, �40,� �� �� �������� �� ��� ��������� ���	
�

������ ����� ����	
� �������

��� 
����� �� �������� ���� ���	�� ���
	
� �
 ��� 4� ���� �� ����
 ��)

����

�2 .�#�� $�3 �� ��������# ���		���

$2��- � �� � +��#� �� �� � �����������

$2�- � �� �� +��#� �� �� 4� �����������

$240 $24-0 $24�0 $24��0 $2�-0 $2��-0
$2���0 $2����0 $2�4�0 $2�4��

� �� � +��#� �� �� 8 �����������

�
� ��� ��������
� �� / �����������

2 ����������� ���	
� 	� �������� �� ��� 4, �40,� ���� 	
 �
	�� �� / ����������� ��)

�	

	
� �	�� ��� �������� ���������� ���� ����� 	�	� ���� �� �	���� 	�	� �����

��� ��� ���� 	� .)���� �� /)�����



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

!�� "� ��� 
����� �� ���������� 	
 � ��������� ���	
� ������ ����� ����	
� ������ 	� ����)

�� ���
 ��� 
����� �� ���� ���� ��� 
����� �� ���������� �:��� �� ��� 
����� ��

����	�	� ���� 	� ��
� �� ��� 4, �40,� ���	

	
� �	�� ��� ����� �� ��� �����������

���	
��

%��)*+ %�
�� �����	
 �� ,( -����./

0���� ��������� �	 �� �������������� ����	
 ������ �����

�����	
 ������

�� �����	
 �� ,1 -����./
2�34�56

34

2�

�)

�5

6

& ,*+. �� 	�� ��	�/

.,� !%,	
	%��
# ��
��� �� ���� �� ����� �
) %,	
	%��
�/ (�������� ���, �,� ����&��
%,	
	%��
 �� �,� !%,	
	%��
# ��
���/ 	��
	��%	��� � �
�� �
& ���
 �
� �
,��,�
 �
��

0��1 !,�2	��%�&	�# �� ����
�� �� (�	�3
	
�	��

 40, 2����!

&���	�� ��� 4, �40,� ����� ������ ������ �� ��� ���� ����� ��������� ���	
�

������ ������ ����	
� ������� ��� ���������

 "'� ,����
�!

&���	�� � �����
� ��� � 4, �40,� ����

2 �����
� ��
 �����	�� �� �� .9 �����������

 ���!

%	������ ������� ��� ����� �	�� ��� ����	�	� 
����� 	� ������ ��� �� 
���

3��6 2����� ��� �� �
 �����
��

��6 ��� ����

"� ��� 	
	���	�
 	� ;3��?� ��� ��
 ����� ����� ��� ����� 	
 :����	�
 	� ��� �� ��	��)

	
� �
 � ���� ���� ��	� ������	�
 	� 
�� ����	��� ���
 ����	
� � ���������

���	
� ������ ����� ����	
� ������ ���� ��� �������� 	���� ��# �� �
 �����
��

�*�� ���	�� �� � ����� �� A).). ;������
�� ������	�
?��



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

����� �������� (��, $�� ��� � *�����	��+ �����

�� 	
���� ���� ��� 	
�� �
 	
	�	�� ������ ������ ��� ����� ����	�� ������

�.� 2���� ����	��	
� ��� C���� �	��� ���� ��� ������ �� ��� ���	�	�
 ����� ��� ����

��� 	� �� �� 	
������

�/� ,�	�� �
 �

��� &��� <��� 	���� ��# 	� 	�������

�1� &���	�� ��� ���� ��� 	
 ��� �	�� �� ���� ����

�7� ,�	�� �
 �

��� ��� �� ��� ����	�	� ���� ��� 	� 	
����� �� ��� C���� �	��� ��� ����

	����� 	� 
�� 	������ �����

! �	���� 5��7 # �����	 !  4 # �����	

�����	 �����	

�

5��7 ����



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

����� �������� ����� $�� ��� � *�����	��+ �����

�� 	
���� 	���� ��� 	
�� �
 	
	�	�� ������ ������ ��� ����� ����	�� ������

���� ���� 	
����	�
 �� 	���� ��� 	
�� � ����������� ���	
� 	� ����	��� �
�� �	��

��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,�

�.� 2���� ����	��	
� ��� C���� �	��� ���� ��� ������ �� ��� ���	�	�
 ����� ���

	���� ��� 	� �� �� 	
������

�/� ,�	�� �
 �

��� "���� ����� 	���� ��# 	� 	�������

�1� &���	�� ��� 	���� ��� 	
 ��� �	�� �� 	���� ����

�7� ,�	�� �
 �

��� ��� �� ��� ����	�	� 	���� ��� 	� 	
����� 	
�� ��� C���� �	��� ���

	���� ��� 	����� 	� 
�� 	������ �����

! �	���� ���
� # �����	 !  4 # �����	

�����	

�

���
� ����

�����	

���������� -� ��	��	
� �����
� �
 	���� ��� �	�� 
� ��� ��
 �� �� �� ��� �	���

3�� ��
 �	��� 	
���� ��	� 	���� �� � ���	
� �
 ���
 ���	���� ��� 	���� ��� �����)
���� �E�� ��� 	���� �	��� �� ������ 	���� �����



���

��	�	�
�� �
���� ������ �	���� ��
���� �	����� ������� �	�

���� �������� -�"���� $�� ��� � *�����	��+ �����

�� 	
���� �	����� ��� 	
�� �
 	
	�	�� ������ ������ ��� ����� ����	�� ������

���� ���� 	
����	�
 �� �	����� ��� 	
�� � ����������� ���	
� 	� ����	��� �
�� �	��

��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,�

�.� 2���� ����	��	
� ��� C���� �	��� ���� ��� ������ �� ��� ���	�	�
 ����� ��� �	)

����� ��� 	� �� �� 	
������

�/� ,�	�� �
 �

��� 0	����� ����� 	���� ��# 	� 	�������

�1� &���	�� ��� �	����� ��� 	
 ��� �	�� �� �	����� ����

�7� ,�	�� �
 �

��� ��� �� ��� ����	�	� �	����� ��� 	� 	
����� �� ��� C���� �	��� ��� �	�����

��� 	����� 	� 
�� 	������ �����

! �	���� ������� # �����	 !  4 # �����	

�

������� ����

�����	�����	

���������� -� ��	��	
� �����
� � �	����� ��� �	�� 
� ��� ��
 �� �� �� ��� �	���

3�� ��
 �	��� 	
���� ��	� �	����� �� � ���	
� �
 ���
 ���	���� ��� �	����� ��� �����)
���� �E�� ��� �	����� �	��� �� ������ �	����� �����



��	

��
 ������ �	���� ������� �	

���  � �
���� ����
�

2 �	� ������ ����� 	� �
 ���� ��	�� �������� �	�� � ���� �� �#����� � ������ ��
��	�


���
 ��� ����	�	� �	� ���� ���

-	� ������ ������ ����	� ��� ;�����
 ��	���	
� ��
��	�
? ��	�� ��	����� ���

�����
 ���
 ��� ����	�	� 4, �40,� �	� ���� �� �
 ��� ;����� ��
��	�
? ��	��

	������ ��� ����� ������� �� ���� ��� ���
� �� ����� �������
�� 	� ��� ����	�	�

4, �40,� �	� ���� ���

-� �������	
� � �	� ������ ����� �� � 4, �40,� �	�� ��� ��
 �� ����� ������
 �

4, �40,� �
 � 4��

"����� 	�
���
�� �����
�

�%
��� ����%,���

�%
��� �� 4 )

 � ! "�#

	��
��� 4 �����

+�� &�&
� �	(��

���%�����  � ! "�# (�������	 '

�����	 (

5��%	��� (�� ��

�"

#���� �����
�

�,	
	%��
 ��
���
&�&
� �	(��
!��
��� �	(��# �� � ��

�&	��$��(
	
� %��� 67)�

 � ! "�# 	��
���� �������

��� ������ �����

��

��

�)

��

��������� ����	

������ �����
�����	
 ������

5+�

�76

8��

9:"

���
� ����

67)�

���%�����  � ! "�# (��

5+�

%���� ����

�����	��� ��


������ �

(�� ���� ��

"�� ��	
� �� ��� ������ ������ ���� ��� ����7�	
 ��� �������� �� ���

�� ��� ����� ����/

�����	���

�� 
������

� ��%,���

	 &���	��

���%������ ���&

� (� %	����

���%������ ���&

� (� %	����

��

��
�� �� 	�	
& ,���
�

5+� ;<$�*$��



��


��
 ������ �	���� ������� �	

����� 
������� '��	��&��

��� �	� ������ ����� ����	
� 	���� ��# 	� 	������ �� ������	
� �	���� �� ��� ��)

����	�
� ����	�� ������

� 2� ��� �������	�� �� ��� ����� �	�� �����
�� ��	�� �
 ��� ����� 
����� �	���

� &�����  �����! ���
� ���� �  �����!� ���
 ��	��  -	� <�����! ����

"���
��

*�� �	� ������ ������� ��� ������	�� �� ��� ������	�
 	� ����	�	� �� ��	��	
� �
 �

�	
�� ��� 
�������� ����	
� ��
 �� ��� �� 	
��� ��	
� � ������� �� �� ������	�


��	
� � ���)��
 �	���

*�� ��� ������	�
 �������� ��� � � �

� �
 � ����� �� A). ;,����
 ������	�
?� ����� ����

��

�� �� ��� 	� �	� ������ ����� 	� 	������ �� ��� ������	�
 ��	
�

�
 �����
� ����������

����� ��#��� �#�����

2���� �	�� �����
�  ������! �  2����! �  0	��!

2���� �	����� �����
�  ������! �  2����! �  B	�����!

����� $��	������ �� �� (����� !�"#� )��#��

2� ��� ������
�� �� �	� ������ ����� ����	
�� ������ ����� �� 9)1 ;2����?�

(��
 ��
����	
� ��� �	� ������ ����� ���� ��1=� ��1=,�

��9/=&� ��9/=,� ��9/8, �� ��1.� ��1.,� ��91.� ��91.,�

��� ��
��	�
 ����	
� 	� 
�� ��� ���� �	�� ������ ��
����	
�� ��

����� ��� ����	
� �� ��	� �	� ������ ������ ������ ����� �� ;%���

,�
����	�
 �-	� ������ ��
����	�
�? 	
 2���
	# 2�

�������



���

��
 ������ �	���� ������� �	

$���	 	�� � �	� ��� 	����� 	�
���
�� �����
�

�� ��� ��� �����
 ��	���	
� ��
��	�
� ������ ��� �������� ������

�.� "
��� 40, ����� 	������ �
 � 40, ����� �	�� �
 � �	� ������ ����� ��

��	�� �
 �
 	
��� 40, ����� �
 � 40, ����� 	����� ������ ��

;,��

�� ����	
� ��� �
 �����
� 	
 4.71�� "
��� "'� �����
� 	� ��:�	���

�/� ,�	�� �
 �� 	����� ��
��	�
 	�����

�1� &����� ;&�	��� &����
? ���� ��
��	�
 ����� ��#�

&���	
� 	���� ��� �����
 ��	���	
� ��
��	�
 ��� 	�������

�7� &�� �����
 
����� �� �� ��	���� ��� ;&����
 ���?�

� &���	
�� �� ���� �� ;&��? 	����

 40, 2����!

&���	�� ��� �	� 	
 � 4, �40,� ����� ������ 	� �������� �� ��� �	� ������ ������

 "'� ,����
�!

&���	�� � �����
� ��� � 4, �40,� �	��

2 �����
� ��
 �����	�� �� �� .9 �����������

� &���	
�� �� ���� �� ;*�
��	�
? 	����

 *�
��	�
!

&�����  2����'&�	��� &����
! ��� ��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,�

�
 ������  &�	��� &����
! ��� ��1.� ��1.,� ��91.� ��91.,�

 &�	��� &����
! ��
�� ��� ��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,�

�� ���� ��� �����
 ��	���	
� ��
��	�
 ���	� ��	�� �
 ��� ����� ��# �� 	����� �

����� ���� 	
 	�� "� ��� ��	�� �
 ��� ����� ��# ���
 	� ������ ��� � ����� ���� 	
 	��

��� ����� ���� 	� ������ �
 ��� �����
 ��	���	
� ��
��	�
 	� ��� 	
���	�

*�� ��1.� ��1.,� ��91.� �
 ��91.,� ������� �� 
�� ��� �����
 ��	���	
� ��
�)

�	�
 	� ��� 	� �����	
� �� ��� ����	
� ���  *�
��	�
!�

 &����
 ���!

&���	�� ��� �����
 ��� �� ��� �����
 �� ��	�� ��� �����
 ��	����� ���
 ��� �	�

������ ����� ���� ���

$���	 	�� � �	� ��� ����� �����
�

�� ��� ��� ����� ��
��	�
� ������ ��� �������� ������

�.� "
��� 40, ����� 	������ �
 � 40, ����� �	�� �
 � �	� ������ ����� ��

��	�� �
 �
 	
��� 40, ����� �
 � 40, ����� 	����� ������

�� ;,��

�� ����	
� ��� �
 �����
� 	
 4.71�� "
��� "'� �����
� 	� ��:�	���

�/� ,�	�� �
 �� 	����� ��
��	�
 	�����

�1� &����� ;2����? �� ;2����'&�	��� &����
? ���� ��
��	�
 ����� ��#�

&���	
� 	���� ��� 2���� ��
��	�
 ��� 	�������

�7� <��� ��� ����	
�� ��� ��� ����� ��
��	�
� �&�� ������



���

��
 ������ �	���� ������� �	

� &���	
�� �� ���� �� ;&��? 	����

 40, 2����!

&���	�� ��� �	� 	
 � 4, �40,� ����� ������ 	� �������� �� ��� �	� ������ ������

 "'� ,����
�!

� &���	�� � �����
� ��� � 4, �40,� �	��

2 �����
� ��
 �����	�� �� �� .9 �����������

� &���	
�� �� ���� �� ;*�
��	�
? 	����

 *�
��	�
!

&�����  2����'&�	��� &����
! ��� ��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,�

�
 ������  2����! ��� ��1.� ��1.,� ��91.� ��91.,�

 &�	��� &����
!

��� ���
	
� �� ���  &�	��� &����
! ����	
� 	����� ������
 ��1=� ��1=,�

��9/=&� ��9/=,� ��9/8, �
 ��1.� ��1.,� ��91.� ��91.,�

� ��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,

�� ��� ��� ����� ��
��	�
� ��� ����� ��# ���� 
�� ���� � ����� ���� ��� 	
 	�� "� 	�

���� ��� �����
 ��	���	
� ��
��	�
 	� ��������

� ��1.� ��1.,� ��91.� �
 ��91.,

�� 	����� ��� ����	�	� �����
 �� ��� ������	�
 �� �
 ����� �	��'�	����� �����
��

��� � ����� ���� 	
 ��� ����� ��#� ,���� ��� ����� ���� 	
 ��� ����� ��# 	
 ����


�� �� 	����� ��� ����	�	� �����
�

 &����
 ���!

��� ������� ���� 	������ 	
 ��� ����� �	��'�	����� �����
� 	� � ����� ��	��� �


�����	
� ��� ����� ��	��� ��	�� 	� 	
 ��� ������� ����� 	������ ��� ����	�	�

�����
�

� ��1=� ��1=,� ��9/=&� ��9/=,� �
 ��9/8,

&���	�� ��� �����
 ��� �� ��� �����
 �� ��	�� ��� �����
 ����� ��	��� �� ���

������	�
 �� ��� ����� �	��'�	������ &���	�� ;=? 	� ��� � 
�� ��	��� ��� �����
�

� ��1.� ��1.,� ��91.� �
 ��91.,

&���	�� ��� �����
 ��� �� ��� �����
 �� �� 	������ 	� � ����� ���� 	� ��� ���

 &�	��� &����
!� ��� ����	
� ��� ��	� 	��� 	� 
�� ���	 �
���� � ����� ���� 	� ���

���  &�	��� &����
!�

 &��	
� ����� $
���!

&���	�� ��� ��������� ���	
� ������ ����� ����	
� ������ 
����� ����� ��� �����)

������ ���	
� ��	�� 	� 	������ �� � ������� 	� ����� ���
 ��� �	� ������ �����

���� �� �� ��� �	� ������ ����� ���	����� ��� ��� ����� �	����� 	� 	�������

 "����'0	����� ,��!

"� ��� ��
� �� 	����� 	���� ��� �� �	����� ��� ���
 � ������� 	� �������� ��� �

����� ���� 	
 ��� ����� ��# �
 ����	�� ��� 	����'�	����� ��� ����� ��	��	
� �


�� �



���

��
 ������ �	���� ������� �	

 ,�����! ))  *�������
!

&���	�� ��� ����� 	
 ��	�� ��� ������� 	����� �	�� 	� 	������ ���
 � �������

	� ��������

�,�
 �
�� �� ��� ��� 4�� �	�� ����� 	�������

(�	��� ������ ����� ��� ����
��� ����
� ���
� ������

� ,�� ����	
� 	
 ��� 	����'�	����� ��� �	��

(��
 ����	
� � ��� 	
 ��� 	����'�	����� ��� �	��� ��� ��	�� ��� ��
 �� ��)

����� ���� ��� �	�� �� �
 �����
��	�� �� 	���� 	
��� �� � ����	�	� ��� ��	
� �

��������

&���	
� ��� 	���� ���

�� ��� �
 	���� ��� 	
 ��� 	����'�	����� ��� �	�� �� ������	
� 	���� ��� ����

��� �	��� ������ ��� �������� ����	�� ������

�.� &���	�� ��� 	����'�	����� ��� �	�� ����� ��� ��� 	� ����

�/� ,�	�� �
 �

�1� &���	�� ��� 	���� ��� ���� ��� �	���

�7� ,�	�� �
 �

��� ��� �� ��� ����	�	� 	���� ��� 	� 	������ 	
 ��� 	����'�	����� ���

�	���

!�	���� ���
�#
�����	

! 4# �����	

&���	
� ��� �	����� ���

�� ��� � �	����� ��� 	
 ��� 	����'�	����� ��� �	�� �� ������	
� �	����� ��� ����

��� �	��� ������ ��� �������� ����	�� ������

�.� &���	�� ��� 	����'�	����� ��� �	�� ����� ��� ��� 	� ����

�/� ,�	�� �
 �

�1� &���	�� ��� �	����� ��� ���� ��� �	���

�7� ,�	�� �
 �

��� ��� �� ��� ����	�	� �	����� ��� 	� 	������ 	
 ��� 	����'�	����� ���

�	���

!�	���� �������#
�����	

! 4# �����	



���

��
����� ��� ���
 �	���� ������� �	�

��! "#
�$
$ %&� %�	� ����
�

2
 �#��
� "'� 	
��� ����� 	� ��� �� ��� � ��
��	�
 �� ��� 	
��� ����	
�� �� �
 �#)

��
� "'� �
	� �� �������� � 4, �40,� �	� �� �� ������� ���

$#��
� "'� �
	�� ��
 �� ��� �
�� �	�� ��1= �
 ��1=,�

��� ������	
� ��
��	�
� ��
 �� ��� �� �#��
� "'� �
	� 	
��� ����	
����

"����� 	�
���
��

�����	 '

�����	 (

�"

72��
�	� �����

72������ �$� ����� �	(��

������ ���	�
���

� ������� ��

(��
 ��� 	
��� ����	
�� ���� ��� ��� �����
 	� ��	���� �� ��� ��� �����
�

"� ;=? 	� ���� ��� 	����� �����
� �� ��� ����	��� �����
�

!�
�� �
�

����� (��
 � ! "�#
	��
����

�������

�"

72��
�	� �����

 � ! "�#

72������ �$� ����� �	(��

��� �#��
� "'� 	
��� ����� 
��	�	�� ��� 4, �40,� �� ��� ������ ���'�**� �� ���

	
��� ����	
���

����� ��� 
����

������� ���	

���� ����
��
������� �	�����

�"

72��
�	� �����

72������ �$� ����� �	(��

�	�	 ����� �����

����

(��
 ��� 	
��� ����	
�� ���� ��� 	� ��� ��� ���� ������ �� �����	
� �� ��� ��
����

���%



���

��
����� ��� ���
 �	���� ������� �	�

������
�� ���&�
��� �''

����	�
�� �����
���

��� ����
��

72��
�	� �����

72������ �$� ����� �	(��

+	%3���,�

��

+	%3���,�

�66

�"

(��
 ��� 	
��� ����	
�� ���� ��� ��� �����	��� ��	�� ��� ���
 ���
� �** �� ���

;,�
��� -����	��� ���? ��
��	�
 ��� �� � ������ ��	��� 	� ���
� �� �� ��	�����

��� �����
� 2 �����	��� �** ��
��	�
 ������	
� ����	���� 	� �������	����� ����	�

��� ��� �����
 ��	���	
� ��
��	�
 �
 ��� ��
���� ��� 	
��� ��
��	�
�

%� 
�� ��� ��� 	
��� ��
��	�
 �� � 4� �#��
� "'� 	
��� ���

����	���	�
� ��	�� ���� ����� ����� 	
���� �
'�� ���	���

������ �� �� �
 ������
�� ��	��� ��
��	�
�

����� 
������� '��	��&��

2
 �#��
� "'� 	
��� ����� 	� 	������ �� ������	
� ��� ������	�
 ����	�� ��)

����

� &�����  �����! ���
� ���� �  �����! �  $#��
� "'� "
���! ��� � ;��	��	
� �


����� ���? �

"���
��

&���	
�� ��� ��� �#��
� "'� 	
��� ����� �	��� ��
 �� ��� �� ��	
� ��� ����	
�

	���� ��# ��	�� 	� 	������ �� ��	��	
� �
 �

*�� ��� ������	�
 �������� ��� � � �
 � ��)

��� �� A). ;,����
 ������	�
?�

�������



���

��
����� ��� ���
 �	���� ������� �	�

����� $��	������ �� �.����� �/
 ���& !�"#� )��#��

���6 $#��
� "'� �
	� 	
��� ����	
�� 
������

,
��6 4����
��'����
�� �� ��� �����	��� �** ��
����	
� ����	�����

<��� ��	� ����	
� �� ;&��? 	�����

*�
��	�
6 *�
��	�
 ��� ��� ��� 	
��� ����	
���

���	�� �	�� &�	��� &����
� "
��� J��)),�
�����

<��� ��	� ����	
� �� ;&��? 	�����

%����	��	�
6 ,�
��
�� ��� �� ;*�
��	�
? ��� ����
�

<��� ��	� ����	
� �� ;&��? 	�����

 ,�
��� -����	��� ���!

&���	�� ������� �� 
�� ��� �����	��� �** ����� 	� �� �� ��
�����

�� ��� ��� ;,�
��� -����	��� ���? ��
��	�
� ��	�� �
 ��� ����� ��# �� ��� � �����

���� 	
 	��

"� ��� � 
�� ��
� �� ��� ��� ;,�
��� -����	��� ���? ��
��	�
� ����� ��� ����� ���� 	


��� ����� ��#�

��	� ����	
� 	� ���	 ���
  ��
�! ��  ���	�� -	�! 	� ��� ���  *�
��	�
!�

;,�
��� -����	��� �**? ��
��	�
 	� �������	����� ����	� ��� ��� �����
 ��	���	
�

��
��	�
 �
 ��� ��
���� ��� 	
��� ��
��	�
�

 *�
��	�
!

&���	�� ��� 	
��� ����	
�� ��
��	�
�

� ��
�

� &�	��� &����


� ���	�� -	�

� "
��� J�� )) ,�
����



���

��
����� ��� ���
 �	���� ������� �	�

(��� "�
��� "����� 
	 	���
�
��

 &����
 ���!

&���	�� ��� �����
 ��� �� ��� �����
 �� ��	�� ��� �����
 ����� �� ��	���� ���


��� 	
��� ����	
�� ���� ���

(��� !�
�� )
� 
	 	���
�
��

 ���	�� -	� 2����!

&���	�� ��� 4, �40,� �	� ����� ��� ���
� �� ��� 	
��� ����	
�� ��	
� �� 	� 
��	�	��

 ,����
��!

&���	�� � �����
� ��� � 4, �40,� �	��

2 �����
� ��
 �����	�� �� �� .9 �����������

(��� *$���� +�� ,, �����- 
	 	���
�
��

 ,�
���� J��!

&����� ��� ��
���� ��� �� �� 	
��� ���
 ��� 	
��� ����	
�� ���� �� ���� ��� �	���

6 "
���� 
������ ;=? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;.? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;/? 	
 � ��� 	
��� �	���



���

��
����� ��� ���
 �	���� ������� �	�

6 "
���� 
������ ;1? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;7? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;8? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;9? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;A? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;@? 	
 � ��� 	
��� �	���

6 "
���� 
������ ;>? 	
 � ��� 	
��� �	���

6 "
���� ��#���	��� ;2? 	
 � ��� 	
��� �	���

6 "
���� ��#���	��� ;-? 	
 � ��� 	
��� �	���

6 "
���� ��#���	��� ;,? 	
 � ��� 	
��� �	���

6 "
���� ��#���	��� ;%? 	
 � ��� 	
��� �	���

6 "
���� ��#���	��� ;$? 	
 � ��� 	
��� �	���

6 "
���� ��#���	��� ;*? 	
 � ��� 	
��� �	���

6 %������ 
����	� �����'����������� ���	
� 	
 � ��� 	
��� �	���

6 ,�
�	��� 	
���� 	
 � ��� 	
��� �	�� ������� ����	
� 	
 ��	� �	�����

6 ������� ���� �K� �
 �	
�� ��� �	�
 	
 � ��� 	
��� �	���

6 "
���� � ��	��� ��	
� 	
 � ��� 	
��� �	���

6 <���� ��� 	
��� ������ �� ��� ��� 	
��� �	�� �� ��� ����� ���� �����

6 <���� ��� ������ �� ��� ��� 	
��� �	�� 	���	����� ����� ��� �����
�

��� 	
��� �	���

6 <���� ��� ������ �� ��� ��� 	
��� �	�� 	���	����� ����� ��� �����
�

��� 	
��� �	���

6 <��� ��� ������ �� ��� ���� ��� 	
��� �	���

6 <��� ��� ������ �� ��� �	��� ��� 	
��� �	���

6 <���� ��� ������ �� ��� ����	��� ��� 	
��� �	�� 	
 ��� �����

,��
��� ��� ��
�	
���� �����
 �� ��� ����	��� �����
�

6 <���� ��� ������ �� ��� 
�#� ��� 	
��� �	�� 	
 ��� �����

,��
��� ��� ��
�	
���� �����
 �� ��� 
�#� �����
�

6 &���� -�++���

6 %	������ &����� ��
��

2���� ����	
� ��� 	���� ��� ��� ������� ��
��	�
 ���	��� �����
� 
��	�� �	�� ��
����

��� 	
����� ��	�� �
 �

��� ����	�	� ��
��
�� ��� 	������ 	
 ��� �#��
� "'� 	
��� ������



��	

��
����� ��� �
�
 �	��� ������� �	�

��' "#
�$
$ %&� ��	� ����


2
 �#��
� "'� ������ ����� ��
����� ��� ������ ����	
�� �� �
 �#��
� "'� �
	�

�����	
� ��� ��'�** ������ �� � 4, �40,� �	��

$#��
� "'� �
	�� ��
 �� ��� �
�� �	�� ��1= �
 ��1=,�

 � ! "�# 	��
����

��� ������)

�"

8���	�� ������

�� �����

72������ �$� ����� �	(��

�� �� 
������� '��	��&��

2
 �#��
� "'� ������ ����� 	� 	������ �� ������	
� ��� ������	�
 ����	�� ��)

����

� &�����  �����! ���
� ���� �  �����! �  $#��
� "'� ������! ���

"���
��

(	�� �
 �#��
� "'� ������ ������ ��� ������	�� �� �
 ������	�
 	� ����	�	� ��

��	��	
� �
 ��� �	
�� &���	
� 	� �������� �� ��	
� ��� ����	
� 	���� ��# ��	�� 	�

	������ �� ��	��	
� �
 �

*�� ��� ������	�
 �������� ��� � � �
 � ��)

��� �� A). ;,����
 ������	�
?�



��


��
����� ��� �
�
 �	��� ������� �	�

�� �� $��	������ �� �.����� �/
 
&�& !�"#� )��#��

 ���!

$#��
� "'� �
	� ������ ����	
�� 
������

 40, 2����!

&���	�� ��� 4, �40,� �	� ��	�� ��
����� ��� ������ ����	
�� �� �
 �#��
� "'� �
	��

 "'� ,����
�!

&���	�� � �����
� ��� � 4, �40,� �	��

2 �����
� ��
 �����	�� �� �� .9 �����������



���

��� ������
 �	���� ������� �	�

��� %&� ����
� ����
�

"'� �����
� ������ ��� ����� ����	� 	
 � 4� �� ��
��� ��� �����
� ��� �� ���

���� �
 �	�� 	
 � 4, �40,� ���� ��� ��� �� ��� &������ �����

"� 	������ �����
�� �
 4, �40,� ���� �
 �	�� ����	�	� �� 
������ ������

������� ��������� ���	
� ������ ������ ����	
� �������� �	� ������ ������� �#)

��
� "'� 	
��� ������� �#��
� "'� ������ ������� �
 �����
��� 	
 ��� ���� ��

�	��� ��� 	������ �����
�� ��
 �� �	���

���������� "� ;))))? 	� 	������ ��� ;40, -	� 2����? ���
 	�� ;���? 	� ;3��?� ������ �	����� 40,
����� �#	���

,�	��	
� �
 �
����� �� �
�� ��	�� ������� 	� ������ �	����� 40, �)

�����

����� 
������� '��	��&��

2
 "'� �����
� ����� 	� 	������ �� ������	
� ��� ������	�
 ����	�� ������

� (��
 �������	
� 4, �40,� ����� �� ��� ����	
� �� ����� �
 ����� ��	�����

,�	�� �
 	
 ��� "'� �����
� �	�� �� ��� �������	�� 	������ ��� ���� �����
�

� &���	�� ��� �	� �	�� � ,�	�� �


$#�����6

,�	��

�  �����! ���
� ���� �  �����! �  "'� ,����
��! ��� � &���	�� ��� �	� �	�� �

���������� � (��
 �
�� �	�	
� �
 "'� �����
� �� � 4, �40,� ����� �������� �� �
 ���)
��
�� ���� ��� ��� "'� �����
� ����� ���� ��� �������� 	���� ��# �� ��� �����
��

� �� ��� �
 "'� �����
� ��� ����	��� 4, �40,� �������� ������ ���  �����! ��
��
���
 ������  �����!�



���

��� ������
 �	���� ������� �	�

"���
��

�� �	� �
 ����� �� � �����
�� 	����� ��� ����	
� 	���� ��# �� ��	��	
� �


�� �	� 	������ �
 � ������

*�� ��� ������	�
 �������� ��� � � �
 � ����� ��

A). ;,����
 ������	�
?� ����� ���� ��

�� �� ��� 	� 	� 	� 	������ ��

��� ������	�
 ��	
� �
 �����
� ����������

����� $��	������ �� �/
 ������ !�"#� )��#��

%	�����	
� ����	�	� ��� �
 �	� "'� �����
�

$	�	
� �
 �	
� "'� �����
�

�
	����
�� $.� ������ �� 	���
�
�� ��� ��� �
�

��� 	���� 	������ �
 �
 "'� �����
� ����� ��� ����
 ������

 2����!

%	������ ��� 4, �40,� ��� �� �	� 
����� ��	�� ��������
� �� ��� �����
��

 "'� ,����
��!

%	������ ��� �����
� ��� ��� 4, �40,� ��� �� �	��

 ������
��!

%	������ 	� ��� ���

�� 	� ������ ��� �� 
���

3��6 2����� ��� 	
 �
 �����
� �� � ������

��6 ��� ����

"� ��� 	
	���	�
 	� ;3��?� ��� ��
 ����� ����� ��� ��� 	
 :����	�
 	� ��� �� ��	��)

	
� �
 �

�*�� ���	�� �� ��� �����
� ����� �� A).). ;������
�� ������	�
?��

*�� ���	�� �� ��� �����
� ����� �� A).)/ ;&����� ������	�
?�



���

��� ������
 �	���� ������� �	�

��
�
�� � ���
�� �� $.� ������

� $	�	
� ���	��	
�� �
 "'� �����
�

�� �	� ���	��� ��� "'� �����
� ������ ���� ��	�� �
 ��� ����� 
������ ���
 ��	��

�� �	� 	������ �
 � ������

� 2	
� �
 "'� �����
�

�� ��� ��� �
 "'� �����
�� ����� ��	��	
� �
 ��� ����� 
����� �� ��� ���
� �	��

�� ��� ������� ��	�� �

� &���	
� 	���� 	
 ��� ��� 	���� ��#

 ,��

��!

&���	�� ��� ���� �� ���� ����� 
��� 	
 4, �40,�� ��� ��	�� � �����
� 	� �� ��

	�������

 2����!

&���	�� ��� ����� 
����� ����� ��� "'� �����
� �� �� �	�� 	� ��������� "�

��� ����	�� � 
�� ����� �� �	�� �
 "'� �����
� ��
 �� ���

"� � �����
� 	� �������� ��	
� �
 �����
� �� � ����� �	��� ;3��? 	� 	������ ���

 ������
��!�� 	� 	� 
�� ����	��� �� ���
�� ��� �����
��

"� 	� ����	��� �� ���
�� ��� �����
� 	� 	� 	� 
�� �������� ��	
� �
 �����
� �� �

������

 -	�!

&���	�� ��� 4, �40,� �	� 
����� ����� ��� "'� �����
� �� �� �	�� 	� ����)

����� "� ��� ����	�� � 
�� ����� �� �	�� �
 "'� �����
� ��
 �� ���

"� � �����
� 	� �������� ��	
� �
 �����
� �� � ����� �	��� ;3��? 	� 	������ ���

 ������
��!�� 	� 	� 
�� ����	��� �� ���
�� ��� �����
��

"� 	� ����	��� �� ���
�� ��� �����
� 	� 	� 	� 
�� �������� ��	
� �
 �����
� �� �

������



���

��� ������
 �	���� ������� �	�

 "'� ,����
��!

&���	�� � �����
� ��� � 4, �40,� ����� �� �	��

2 �����
� ��
 �����	�� �� �� .9 �����������

����� �������� �/
 ������ ���� -����� '������

(	�� ��)���	�� &������ ���� ��� (	
��� >8'>@� 	� 	� ����	��� �� 	����� "'� ����)


�� ���� ���� ������� ��	�� ��� ���	����� ��	
� &3&<2, &������ &��� ��
&3&<2, ,4�� �0��� ������� �� , ���	�� �	�� �
 �#��
�	�
 ;�&4.? �
��� "� ��

���� ���� �	�� �
 ����� �� 	
��� "'� �����
��

��	� ����	�
 ����	��� ��� 	����� ����� �� "'� �����
��

���������� � (	�� &3&<2, &������ &���� ���
 ���	
� ���� �������� "'� �����
�� ���
�������	����� ���� 	
 � �	�� �	�� �
 �#��
�	�
 ;�&4.?�
&3&<2, ,4� ����� ���� ������� 	
 ;&&& ������� �G�&4.�? �
 ��� ��	� �	��
�� 	����� "'� �����
��

� "'� �����
� �� ,C<.',C ���	�� ��
 
�� �� 	������ �	�� &������ �����

� (	�� &3&<2, ,4�� 	� 	� 
�� ����	��� �� ���� ���� ������� �� 40, �	�� ;)L? 	
 �
�	�� �	�� �
 �#��
�	�
 ;�&4.?� ���������� &������ ���� ��
 
�� 	����� "'� ���)
��
� �� ���� ������� ��� ;)L? ������ �	�� &3&<2, ,4��

��
�
�� 
� $.� ������

(��
 �
 "'� �����
� ����� �� &������ ���� ��� �
 �#	��	
� "'� �����
� �� ���


���� ���

�� "'� �����
� �
 	�� �	� "'� �����
� �#	�� 	
 ���� ������� �� ��

	������ ����� ===8,B6%%%� ===8./6$$$�� ��	��	�� �	�� �� �� �������� �&������


����� ����� �	���� ��	��	����

�.� $#	��	
� "'� �����
� 	
 &������ ���� �	
 "'� �����
� ������

�/� "'� �����
� �� �	� 	
 ���� ������� �� �� 	������

�1� "'� �����
� �� ���

�� 	
 ���� ������� �� �� 	������

�������� $#	��	
� "'� �����
�� 	
 &������ ���� �	
 "'� �����
� ������

,��

�� ' -	� "'� ,����
�

===8 ,B 222

===9=1 ---

===A ,B ,,,



���

��� ������
 �	���� ������� �	�

"'� �����
�� 	
 ���� ������� �� �� 	������

,��

�� ' -	� "'� ,����
�

===8 ,B %%%

===8./ $$$

===9 ,B ***

===9.1 DDD

===A=@ BBB

===@ ,B """

�

"'� �����
�� 	
 &������ ���� �	
 "'� �����
� ������ ����� 	�����	
�

&9 8����	
 �� �����	� �	 ������� "��� ��	 �� �����	� ������

�����
�� � $.� ������	 �  
��� . ������

�	���',��
��� � 
�� ���� ���	� ��
 
������ ���� ����� �����
 ;�	���',��
�)

�� 
�����?�

B������� �	�� �
 "'� �����
� ����� �� &������ ����� 	� 	� ����	��� �� 	
��� �	���

�
 ,��
��� �����������

&� ���
 ��� �	���',��
��� 
����� 	� 	������� "'� �����
� ����� ������ ���

���� �����
� ���� ��� �	��� �
 ���
��� �� ��� ���� 
������

"
 ���� "'� �����
� ����� �� &������ ���� ��� �
 �#	��	
� "'� �����
� ��� �	���� ��

�	��� �
 ���
���� �#	��	
� "'� �����
� 	
 &������ ���� �	
 "'� �����
� ������

����� ��	��	�� �
 	������ "'� �����
� �	�� �� ����� �
�� ��� �
 ����� �
��

�������6 $#	��	
� "'� �����
� 	
 &������ ���� �	
 "'� �����
� ������

,��

�� ' -	� "'� ,����
�

�"<==/ 222

,��==/ ---

,��==1 ,,,



���

��� ������
 �	���� ������� �	�

"'� �����
�� 	
 ���� ������� �� �� 	������

,��

�� ' -	� "'� ,����
�

�"<',��=== %%%

�"<',��==/ $$$

�"<',��==1 ***

�"<',��==7 DDD

�

$#	��	
� "'� ����
��� 	
 &������ ���� �	
 "'� �����
� ������ ����� 	�����	
�

&9 8����	
 �� �����	� �	 ������� "��� ��	 �� �����	� ������

$���� ��������

*����� ��� �������� ����� �� 	����� "'� �����
� ���� ���� ��������

�.� &����� ;"����� "'� ,����
��? ���� ;�����? ��
��

%	���� ��# �� ����	�� "'� �����
� 	� 	�������

�/� &���	�� ��� "'� �����
� �	�� �;�&4.?� �� �� 	������ �
 ��	�� �
 �

"'� �����
� "����� 	� ��������� (�	�� 	�����	
�� �������� �	�� �� 	������

�
 ������ ����

�1� (��
 ��� ������	�
 	� �	
	���� ��� ������� ;"����� �� "'� ,����
��� �����)

�	�
 ���������? 	� 	������� ���
� ��	�� �
 �

(��
 �
 "'� �����
� 	����� ��� ������ �� ���� 
�� �� �
� ������� ��

������ ��� ������� ;*�	�� �� 	����� "'� �����
�? 	� 	������� ���
 ��	�� �


� "
 ��	� ����� ��� ��
��
�� �� "'� �����
� ����� 	
 &������ ����

����	
 �
���
���

"� ��	� ������� ��# 	� 	������� ����� ��� ������	
� ��	
���



���

��� ������
 �	���� ������� �	�

� "� ��	� � ������� �	�� ��� �<��� ,)���	�� 40,M

� "� ��� �#��
�	�
 ;�&4.? �&&& ������� �	�� �������M

"
 ���� �<��� &3&<2, ,4� 	� ���� ����� ��#����� ��� ���� ������� 	
 &&&

������� �G�&4.� ������ �
 ���
 ��� ��	� �	�� �� 	����� "'� �����
��

���������� � "� ��� ���� �	�� �� 	����� "'� �����
�� ���
 ����� ��� ��
� "'� �����
���

� ����� ��� ;40, �����?� ;"'� ,����
��?� �
 ;������
��? 	
 �
 "'� �����
��
������ ��� ����� �	�� 
� �����
� �
 
� ������
�� �	�� 
�� �� ��
���� ��
4�� �&�� ������

-�	
� ������
�� ��� ������
��

(	�� �����
�� � �

(	����� ,����
�� � �

�6 ,�
 �� ��
���� �6 ,�
 
�� �� ��
����

���� ���� ��� �	
� 	
 �
 "'� �����
� ����� �	�� �
�� ��� 40, ����� 	� 	
��� ����

������ ��� ����� �	�� 
�� �� ��
���� �� 4�� �
 �� � ������� ���
 ��� ��� 	�

������ �� ��� &������ ����� ��� �	
� 	����� �	�� �� ����� ���	� ���� ����	�� ���


���	
� ��� 	
 ��	 ��������

� &������ ���� ��
 
�� 	����� ���� ���
 1=== 40, ������� �	�� �����
��� &�

	� ����� ��� ���� ���
 1=== 40, ������� �	�� �����
��� �
�� ��� �������

�	�� �� 	������ �� ��� 40, ������� ���� 1=== �
��	��� �"'� �����
� 	�����

������	�
 �	�� �� �	
	��� 
���������

������� �
��	�� ��� 	������ �
 $���� 0��� ����� ���� �� ������	
�  $���� 0��!

����  C	��! ��
� �
 ��	
� 	��

� 4�	��	�� �� ���

�� ����� �� �� 	������ 	� �� �������� ,"� ��� � �	����� ��	��	���

�2� ��� �����
�� ���� ���
 1=== �
��	��� % �	�� �� ��� �	�������

,"� �-	��

0 �-	��

B �-	��

�"<',��

2 �-	��

,"� �,��

���

0 �,��

���

B �,��

���

2 �,��

���

% �,��

���

"'� �����
� ����� 	������ ���� 	
 
����	���'��������	��� �����



���

 !"�� ���
 ��
�#� �	��� ������� �	�

��( )�*
� %�	� ���+� ����


��	� ����� 	� �
�� ���	����� ��� ��..&� ��� *)J�� "
��� ���	�� ����� ��
�	��� �� ����

�
��	��� $��� �
��� 	� ���	�
� �� � ��
��	�
 ��� 	
 ��� 4� ��	��� "� ����	�	�� � 4,

�40,� ������ �	� �� �� ������ �� � ��������
	
� ��
��	�
 ����

��0�� 
������� '��	��&��

2
 *)J�� "
��� ���	�� ����� 	� 	������ �� ������	
� ��� ������	�
 ����	�� ��)

����

� &�����  �����! ���
� �����  �����!�  *)J�� "
��� ���	��! ����&���	�� ��� �	�

�	�� �

��0�� $��	������ �� )�1�� ���& %���� !�"#�

 ����� $
��� ������!

��� ����� �
��� 
����� �	��� �� ��� N���O �����
 	� 
�� �	������ 2�� ����� �
��	��

��� �	��� 	
 ����
	
� ���� �� ���	� �
��� 
������� �����	
� ���� +��� �� �
� ����

���
 ��� ��#	��� 
����� �� �
��	���

����� ��� *)J�� "
���

= *.

. */

/ *1

1 *7

 40, -	� 2����!

&���	�� ��� 4, �40,� �	� ��	�� ��� ��
� �� �	
� �	�� ��� *�
��	�
 J���

 "'� ,����
�!

&���	�� � �����
� ��� � 4, �40,� ����� �� �	��

2 �����
� ��
 �����	�� �� �� .9 �����������



325

SECTION  8
Editing Graphic Data

The graphic data edit function creates images in the bit map data format, library data using fixed elements, and marks which
display special characters and symbols.

8-1 Image Editor 326. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-1-1 Operating the image table 326. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-1-2 Creating Image Data Using Image Editor 329. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

8-2 Library Editor 339. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-2-1 Operating the library table 339. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-2-2 Creating Library Data Using Library Editor 342. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

8-3 Mark Editor 347. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-3-1 Screen Configuration 347. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
8-3-2 Creating Marks Using the Mark Editor 348. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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8-1 Image Editor
The procedure for creating images of any required shape in the bit map (BMP) for-
mat is described below.

The bit map format graphic data which has been created using a Windows-based
general purpose application software can be pasted onto the image creation
screen by using the image editor via the clip board.

Created image data can be inserted into a (character) string in an image/library
lamp display, alarm list display, alarm history display, or (character) string display.

With NT31, NT31C, NT631, and NT631C, it is not possible to insert image data into
a (character) string.

Reference: Image editor has the following features.
� You can draw any graphics in the bit map format freely.
� It is possible to import Image data from the different screen data file.
� Selected image data can be expanded or shrunk.
� The bit map file can be pasted onto the image editor.
� Copy, cut, paste operation of image data is possible.
� Preview display of selected image data is available on the image table.

8-1-1 Operating the image table
Image table dialog is configured as follows.

[Edit] Deletes, cuts, copies or pastes the image data of the selected. . . . . . . . 
code (P327�329). It is possible to select two or more codes
and delete them collectively.

[Goto Code] Code number can be specified and the cursor moves to the. 
code. The operation method is same as the “Goto Entry” of
memory table (refer to 7–1–6).

[Preview] Switches the preview window ON and OFF (P327).. . . . 

[Open] Displays the editing screen (image editor) of the selected code. . . . . . 
(P331). When two or more codes are selected, edit screens of
all the selected codes can be opened collectively.

[New] Registers the new image code to the image table (P329).. . . . . . . 
Only the registered image codes are listed on the image table.
Press this button when you are going to create new image data.
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[Delete] Deletes the image data of the selected code. When two or more. . . . . 
codes are selected, they can be deleted collectively.

[Close] Closes the image table dialog.. . . . . . 

[Help] Displays “Help” about the image table dialog box.. . . . . . . 

� Specifying a code

To specify a code for operations, click on the objective line (image code).
To specify the continuous codes collectively, click on the first code to be selected
and then the last code to be selected while pressing the Shift key.
If you click on a code while pressing the Ctrl key, the code will be selected or de-
selected alternately each time it is clicked.   

� Preview Function

Support Tool provides a preview function which can display the contents of the
selected code.
When two or more codes are selected, the preview of the code selected last will
be displayed in preview window. 
The preview window can be switched ON and OFF by pressing the /

 button.

� Deleting the image data

To delete an image data, follow the procedure below. Deleted image data will not
be stored to the clipboard and its code itself will be also deleted. When two or
more codes are selected, they will be deleted collectively.

(1) Select [Image Editor] from [Tools] menu.
The image table is displayed.

(2) Select the code of the image data to be deleted.
When two or more codes are selected, they can be deleted collectively.

(3) Perform one of the following operations.
�  button → [Delete]
� Right click on the selected code → [Delete]
�  button
Selected code will be deleted after you click on  button in the con-
firmation dialog box.



328

Image Editor Section 8-1

� Cutting/copying the image data

To cut or copy an image data, follow the procedure below. The cut/copied image
data will be stored to the clipboard and can be pasted to the other codes.
In case of “cut”, cut code will be deleted from the image table. In case of “copy”,
copied code remains in the image table.

Reference: When two Support Tools are started up by [Import Component] from [File] menu,
the data which is cut or copied on the image table of one Support Tool can be
pasted onto the image table of another Support Tool (PT model setting of the two
screen data files should be the same). For details, refer to 3–3–6.

(1) Select [Image Editor] from [Tools] menu.

The image table is displayed.

(2) Select the code of the image data to be cut or copied.

Select only one code. When two or more codes are selected, cut/copy opera-
tion can not be performed.

(3) Click on  button or right click on the selected code.

(4) Select [Cut] or [Copy].

Image data of the selected code will be stored to the clipboard. In case of [cut],
confirmation dialog box will be displayed. After clicking on  button, cut
code will be deleted from the image table. 

� Pasting the image data

To paste an image data which is stored in the clipboard by cut or copy operation,
follow the procedure below.

Reference: � When two Support Tools are started up by [Import Component] from [File] menu,
the data which is cut or copied on the image table of one Support Tool can be
pasted onto the image table of another Support Tool (PT model setting of the two
screen data files should be the same). For details, refer to 3–3–6.

� If the paste operation is performed, the image data previously registered to the
code is overwritten and lost. (Confirmation dialog box will be displayed.)

� When an image data is pasted, the property (size, colours, compression, com-
ment) of the image code is changed to that of the new one.

(1) Select [Image Editor] from [Tools] menu.

The image table is displayed.
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(2) Select the code of the image data to be pasted.

Select only one code. When two or more codes are selected, paste operation
can not be performed.

(3) Click on the  button or right click on the selected code.

(4) Select [Paste].

[Paste] can not be selected if the image data to be pasted is not stored in the clip-
board. After clicking on  button in confirmation dialog box, image data will
be pasted to the selected code.

� Quitting the image table

You can quit the image table in any of the two ways described below.
� Clicking on the  button of the image table dialog.

� Clicking on   at the upper right corner of the image table dialog.

8-1-2 Creating Image Data Using Image Editor
� Registering new image data

(1) Select [Image Editor] from [Tools] menu.

The image table is displayed.

(2) Click on  button.

The “New Image Entry” dialog box is displayed.
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(3) Set the code, size, colours, compression, comment of the image data to be
newly created, then click on .

� Setting for New Image Entry dialog box

Code: Specify the code to which the new image data is registered.
When the dialog box is opened, the smallest unused code is
set.

Colours: Specify whether the image data is created in “2 Colours”
(monochrome) or “8 Colours” (color).

Search Direction: Unregistered code can be searched by  button. In

“Search Direction”, specify “Up” (to the smaller code) or
“Down” (to the larger code) to designate the direction to
which search operation is executed.

Width: Specify the width of the image data as a number of dots.

Height: Specify the height of the image data as a number of dots.
The image data size can be set in the range from 8 x 8 dots
(minimum) to the screen size of the PT to be used (maxi-
mum). The image data width and height must be specified in
units of 8 dots.

Compression: Specify the data format for storing the created image data.
Check mark set: Image data is compressed for storage.
Check mark not set: Image data is stored without being com-
pressed.

Comments: Specify the comment for the image data to be created.

: Searches the unused code. Specify the search direction in

“Search Direction”.
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Displaying image editor

(1) [Tools] (menu bar) → [Image Editor]

The image table is displayed.

(2) Select the code in the image table and click on  or double click the

mouse on the objective code line.
When two or more codes are selected, edit screens (editors) of all the se-
lected codes can be opened collectively. Image table dialog automatically
closes at the same time the editor is displayed.

� Changing the property

To change the property of the code which is already registered, open the editor
and then display the property dialog of the image data as follows.

Double click with         tool,
or Right click → [Properties]

Double click,
or Right click → [Properties]

[Code]: Displays the code of the selected image data.

[Size]: Displays the size of the specified image data.
To change the size, set the desired size.

[Mode]: Displays the specified color mode.
To change the color mode, set the desired color mode.

[Compression]: Specify the data format for storing the created image data.

Check mark set: Image data is compressed for storage.

Check mark not set: Image data is stored without being
compressed.

Although the data size of the created image data will be reduced
if the data is compressed, the speed of display on the screen will
be slowed a little.

[Comments]: Specify the comment for the image data to be created.
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Screen Configuration of Image Editor

The screen configuration of the image editor is described below.

Tool box

Font selection

Line width selection

Point type selection

Pattern selection

Color selection

Tool selection

Edit area

Operating the image editor

Using the image editor, you can create a graphic in the desired shape in the edit
area as combinations of lines, points, rectangles, and circles after selecting the
tool and drawing conditions (color, tiling pattern, point type, line width, and font).

� Tool selection

Used to specify the range to copy, cut, move, shrink or expand the created 
graphic.

The range is specified by dragging the mouse cursor.
To cancel the range specifying frame, select the tools other than , .

Range specifying frame

Used to move the graphic which is defined by the range specifying frame.

The range specifying frame can be dragged, or a pop-up menu can be dis-
played by right clicking the mouse.

Used to draw a point.

Click the mouse at the position where a point is to be drawn: a point is
drawn in the size specified by point type selection and in the color speci-
fied as foreground color.

Used to draw a line.

By dragging the mouse cursor from the start point to the end point of the
line to be drawn, the desired line is drawn in the width specified by line
width selection and in the specified foreground color.
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Used to draw a rectangle.

By dragging the mouse cursor, a rectangle is drawn having opposing cor-
ners at the start and the end point of dragging, having the line of the speci-
fied width (line width selection) and in the specified foreground color.  The
inside of the rectangle is tiled with the colors specified as foreground color
and background color in the specified pattern.

Used to draw a circle or an oval.

By dragging one corner or one side of a rectangle which circumscribes the
circle or oval to be drawn, the desired circle or oval is drawn with a line of
the specified width (line width selection) and in the specified foreground
color.  The inside of the circle or oval is tiled with the colors specified as
foreground color and background color in the specified pattern.

Used to draw a character.

Click the mouse at the position where a character is to be drawn and the
character cursor is displayed.  Input characters: the input characters are
displayed in the color specified as foreground color with the background
displayed in the specified background color.

Select this tool when tiling the inside of the closed area of a drawn graphic.

The area is tiled according to the specified pattern and in the colors speci-
fied as foreground color and background color.

� Color selection

Displays background color Color selection palette

Displays foreground color

On the color selection palette, move the cursor to the desired color and click the
mouse; a left click selects the foreground color and a right click selects the back-
ground color.

� Pattern selection

Selection box

Move the cursor to the desired pattern and left click the mouse; the selection box
moves to the pattern at the cursor location, indicating that the pattern is selected.

� Point type selection

Selection box

Move the cursor to the desired point type and left click the mouse; the selection
box moves to the point type at the cursor location, indicating that the point type is
selected.
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� Line width selection

Selection box

Move the cursor to the desired line width type and left click the mouse; the line
width type display at the cursor location will be highlighted, indicating that the line
width type is selected.

� Font designation

Displays sample characters

Click on the  button and the font selection dialog box is displayed.

After selecting the font, the style, and the size, click on .

� Modifying the size of an image data

Specify the range to be modified using  and drag one of green � marks (han-
dles) that enclose the range specifying frame.   
Position the mouse cursor on a green handle, and the shape of mouse cursor
changes as shown below. (The arrow indicates the same direction as the arrow
mark in the handle.)

Drag the mouse cursor in the indicated direction to modify the size of an image
data.

Reference: To shrink the size of an image data, shrink it by one dragging operation without
releasing the button of the mouse. If you try to expand the image data which was
shrunk once, the shape or the colour may be modified.
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Zooming the edit area

It is possible to display the edit area at an enlarged size to facilitate drawing fine
areas and creating small images.

To change the display size of the edit area, select [View] in the menu bar then
choose [Zoom]; specify the zoom percentage.

Modifying Graphics

Created graphics can be mirrored (flipped) up and down or right and left, or turned
90° left or right.

The mirroring and 90° turn operations are possible for the graphic in the range
specifying frame.

To modify the graphic, select [Edit] (menu bar) → [Rotate or Flip], then specify the
desired modification method.

Flip Horizontal Flip Vertical Rotate Left Rotate Right
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Cutting/copying/deleting graphics

You can cut, copy, paste, and delete the created graphic.

Cut, copy and delete operations are valid for the graphic in the range specifying
frame.

To call the desired operation, select [Edit] in the menu bar, then specify [Cut],
[Copy], [Paste], or [Delete].  (or right click the mouse, then specify [Cut], [Copy], or
[Paste])

Cuts the graphic in the range specifying
frame and stores it in the clip board.

Copies the graphic in the range specifying
frame onto the clip board.

Pastes the graphic in the clip board to the
specified position.
Deletes the graphic in the range specifying
frame.

Reference: Image data which is cut or copied on one image editor window can be pasted onto
the other image editor window (The data can be pasted until another data is stored
to the clipboard). 
When more than one image editor window is displayed or when two Support Tools
are opened by [Import Component] from [File] menu (same PT model setting), cut,
copy and paste operations between these image editor windows are possible. For
details, refer to 3–3–6.

Saving to the bit map file

You can save the created graphic to the file in bit map format.
This operation is valid for the graphics in the range specifying frame.

To save the graphic to the bit map file, follow the procedure below.

(1) Specify the area to be saved in a file with a range specifying frame.

(2) Select [Copy To] from [Edit] menu.
The dialog box to specify the file name is displayed.

(3) Set the folder and file name and click on .

Graphics in the range specifying frame is saved in a file.
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Pasting from the bit map file

You can read out the graphics saved in a bit map file and paste them onto the
image editor.
The graphics can be pasted onto the image editor which is currently activated.

To paste the graphic from the bit map file, follow the procedure below.

(1) Select [Paste From] from [Edit] menu.
The dialog box to specify the file to be read is displayed.

(2) Specify the folder and file name and click on .

Read out graphic is pasted onto the image editor enclosed with a range speci-
fying frame.

(3) Select [Clip] from [Edit] menu.
Image data size is changed to the read out image size.

Instead of the procedure (3), it is also possible to drag the read out image to the
required position.

Changing the image data size

The image data size can be changed in either of the following two ways.

� Changing the size by property setting

� Changing the size to the range specifying frame size

� Changing the size by property setting

Change the setting for [Size] in the image editor property settings to change the
size of the image data.

The image data size is changed according to the new setting; the reference point
of the size change is at the upper left corner of the present size.

If the size is reduced, part of the created graphic may be cut.
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� Changing the size to the range specifying frame size

The size of the image data can be changed to fit the size of the specified range
specifying frame.

Select [Edit] in the menu bar, then select [Clip].

Quitting the image editor

You can quit the image editor in any of the three ways described below.

� Clicking on  at the upper right corner of the image editor.

� Selecting [Close] from the control menu box of the image editor.

� Double clicking the control menu box of the image editor.

Control menu box
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8-2 Library Editor
Graphics of any required shape can be created by combining fixed elements.  The
created graphic can be registered as one element (library data) and any number of
elements can be displayed at any positions in any screen using the library display
function.

Created library data can be used for image/library lamp display, alarm list display,
alarm history display.

Reference: Library editor has the following features.
� You can draw any graphics by combining fixed elements.
� It is possible to import library data from the different screen data file.
� Fixed display elements can be copied, cut, pasted from the editing screen 
� Copy, cut, paste operation of library data is possible.
� Preview display of selected library data is available on the library table.

8-2-1 Operating the library table
Library table dialog is configured as follows.

[Edit] Deletes, cuts, copies or pastes the library data of the selected. . . . . . . . 
code (P340�342). It is possible to select two or more codes
and delete them collectively.

[Goto Code] Code number can be specified and the cursor moves to the. 
code. The operation method is same as the “Goto Entry” of
memory table (refer to 7–1–6).

[Preview] Switches the preview window ON and OFF (P340).. . . . 

[Open] Displays the editing screen (library editor) of the selected code. . . . . . 
(P343). When two or more codes are selected, edit screens of
all the selected codes can be opened collectively.

[New] Registers the new library code to the library table (P342).. . . . . . . 
Only the registered library codes are listed on the library table.
Press this button when you are going to create new library data.

[Delete] Deletes the library data of the selected code. When two or more. . . . . 
codes are selected, they can be deleted collectively.

[Close] Closes the library table dialog.. . . . . . 

[Help] Displays “Help” about the library table dialog box.. . . . . . . 
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� Specifying a code

To specify a code for operations, click on the objective line (library code).
To specify the continuous codes collectively, click on the first code to be selected
and then the last code to be selected while pressing the Shift key.
If you click on a code while pressing the Ctrl key, the code will be selected or de-
selected alternately each time it is clicked.

� Preview Function

Support Tool provides a preview function which can display the contents of the se-
lected code.
When two or more codes are selected, the preview of the code selected last will be
displayed in preview window. 
The preview window can be switched ON and OFF by pressing the /

 button.

� Deleting the library data

To delete a library data, follow the procedure below. Deleted library data will not be
stored to the clipboard and its code itself will be also deleted. When two or more
codes are selected, they will be deleted collectively.

(1) Select [Library Editor] from [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be deleted.
 When two or more codes are selected, they can be deleted collectively.

(3) Perform one of the following operations.
�  button → [Delete]
� Right click on the selected code → [Delete]
�  button
Selected code will be deleted after you click on  button in the con-
firmation dialog box.

� Cutting/copying the library data

To cut or copy a library data, follow the procedure below. The cut/copied library
data will be stored to the clipboard and can be pasted to the other codes.
In case of “cut”, cut code will be deleted from the library table. In case of “copy”,
copied code remains in the library table.
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Reference: When two Support Tools are started up by [Import Component] from [File] menu,
the data which is cut or copied on the library table of one Support Tool can be
pasted onto the library table of another Support Tool (PT model setting of the two
screen data files should be the same). For details, refer to 3–3–6.

(1) Select [Library Editor] from [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be cut or copied.
Select only one code. When two or more codes are selected, cut/copy opera-
tion can not be performed.

(3) Click on the  button or right click on the selected code.

(4) Select [Cut] or [Copy].
Library data of the selected code will be stored to the clipboard. In case of
[cut], confirmation dialog box will be displayed. After clicking on  but-
ton, cut code will be deleted from the library table.

� Pasting the library data

To paste a library data which is stored in the clipboard by cut or copy operation,
follow the procedure below.

Reference: � When two Support Tools are started up by [Import Component] from [File] menu,
the data which is cut or copied on the library table of one Support Tool can be
pasted onto the library table of another Support Tool (PT model setting of the two
screen data files should be the same). For details, refer to 3–3–6.

� If the paste operation is performed, the library data previously registered to the
code is overwritten and lost. (Confirmation dialog box will be displayed.)

� When a library data is pasted, the property (size, colours, compression, com-
ment) of the library code is changed to that of the new one.

(1) Select [Library Editor] from [Tools] menu.
The library table is displayed.

(2) Select the code of the library data to be pasted.
Select only one code. When two or more codes are selected, paste operation
can not be performed.

(3) Click on the  button or right click on the selected code.
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(4) Select [Paste].
[Paste] can not be selected if the library data to be pasted is not stored in the
clipboard. After clicking on  button in confirmation dialog box, library
data will be pasted to the selected code.

� Quitting the library table

You can quit the library table in any of the two ways described below.
� Clicking on the  button of the library table dialog.

� Clicking on   at the upper right corner of the library table dialog.

8-2-2 Creating Library Data Using Library Editor
� Registering new library data

(1) Select [Library Editor] from [Tools] menu.
 The library table is displayed.

(2) Click on  button.

The “New Library Entry” dialog box is displayed.

(3) Set the code, size, colours, compression, comment of the library data to be
newly created, then click on .
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� Setting for New Library Entry dialog box

Code: Specify the code to which the new library data is registered.
When the dialog box is opened, the smallest unused code is
set.

Search Direction: Unregistered code can be searched by  button. In

“Search Direction”, specify “Up” (to the smaller code) or
“Down” (to the larger code) to designate the direction to
which search operation is executed.

Comments: Specify the comment for the library data to be created.

Find Next: Searches the unused code. Specify the search direction in
“Search Direction”.

Displaying library editor

(1) [Tools] (menu bar) → [Library Editor]
The library table is displayed.

(2) Select the code in the library table and click on  or double click the

mouse on the objective code line.
When two or more codes are selected, edit screens (editors) of all the se-
lected codes can be opened collectively. Library table dialog automatically
closes at the same time the editor is displayed.

� Changing the property

To change the property of the code which is already registered, open the editor and
then display the property dialog of the library data as follows.

Double click, or
Right click → [Properties]

[Code]: Displays the code of the selected library data.

[Size]: Displays the size of the specified library data.
Size data is not displayed if there are no elements in the library
data specifying frame.

[Comments]: Specify the comment for the library data to be created.
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Screen Configuration of Library Editor

The screen configuration of the library editor is described below.

Edit area

Library data specifying frame

Operating the library editor

Using the library editor, you can create a graphic using fixed elements in the same
manner as creating graphics in a standard screen.  The size of the library data
specifying frame is taken as the size of the library data.  The position and size of the
library data specifying frame can be changed as needed.

Only the graphic in the range of the library data specifying frame is registered as
the library data.

For details on how to use fixed elements, refer to 6–2 “Fixed Display”.

Reference: Library data which is cut or copied on the library editor window can be pasted onto
the other library editor window or standard editing screen (The data can be pasted
until another data is stored to the clipboard). Also, fixed–display elements which
were cut or copied from standard editing screens can be pasted onto the library
editor window.
When more than one library editor window is displayed or when two Support Tools
are opened by [Import Component] from [File] menu (same PT model setting), cut,
copy and paste operations between these library editor windows are possible. For
details, refer to 3–3–6.

Library data Display of library data

A circle extending outside
the specifying frame is not
displayed as library data.
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Changing the size and display position of the library data specifying frame

To change the size of the library data specifying frame or move it, follow the steps
described below.

(1) Click the mouse on the dotted lines of the library data specifying frame.

Green � (handles) are displayed enclosing the library data specifying frame.

(2) The size can be changed by dragging a handle.

Position the mouse cursor on a green handle: the shape of the mouse cursor
changes as shown below.  Drag the mouse cursor in the indicated direction to
change the size of the library data specifying frame.

(3) The library data specifying frame can be moved by dragging the frame at posi-
tions other than handles.

When handles are displayed, position the mouse cursor on the dotted line at a
position where there is no handle: the shape of mouse cursor changes as
shown below.  Drag the mouse.  The frame moves as it is dragged.

(4) After changing the size and the position of the library data specifying frame,
click on the screen at a position other than on the frame.

The size and the position of the library data specifying frame is determined
and the handles are cleared.

To change the size and the position of the library data specifying frame, repeat
the procedure above from step (1).
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Setting grids

To set a grid on the library editor screen, select [Screen] (menu bar) and [Grid].

The necessary settings for displaying grids are same as those for a standard
screen.  For details, refer to 5-1-2 “Grid Setting”.

Quitting the library editor

You can quit the library editor in any of the three ways described below.

� Clicking on  at the upper right area of the library editor.

� Selecting [Close] from the control menu box of the library editor.

� Double clicking the control menu box of the library editor.

Control menu box
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8-3 Mark Editor
Special symbols and marks can be created by tiling selected dots in a 16�16 dot
area.  (For NT11S it is 8�16 dot.)

The created mark data can be inserted into mark data displays and (character)
string displays.

Reference: The NT-series Support Tool cannot handle marks of 32�32 dots and 64�64 dots.
If marks created by the DOS version Support Tool are imported, 32�32 or 64�64
dot size marks must be represented by dividing and grouping them as 16�16 dot
size mark data.

8-3-1 Screen Configuration
The screen configuration of the mark editor is shown below.

Drawing toolbar

Standard toolbar Image display area

Edit area



348

Mark Editor Section 8-3

8-3-2 Creating Marks Using the Mark Editor
Displaying the mark editor

(1) [Tools] (menu bar) → [Mark Editor]

The mark data list dialog box is displayed.

In the mark data list dialog box, the mark data registered for the codes are dis-
played.

(2) Select the code in the mark data list dialog box and click on , or
double click the area corresponding to the code in the list.

A code can be selected either from the displayed list or by specification in the
[Code] field.  If a code is selected in the list, the specified part is displayed en-
larged.
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Operating the mark editor

Using the mark editor, you can create a mark by tiling dots arranged in a matrix.

To tile a dot, position the cursor on it and left click the mouse.  To cancel tiling, right
click the mouse on a tiled dot.

Created graphics can be copied or pasted using the standard toolbar, and lines,
rectangles, and circles can be easily created using the drawing toolbar.

Reference: When two Support Tools are started up by [Import Component] from [File] menu,
the data which is cut or copied on the mark editor of one Support Tool can be
pasted onto the mark editor of another Support Tool (PT model setting of the two
screen data files should be the same). For details, refer to 3–3–6.

* Standard toolbar

Open (mark data list dialog box is opened)

Redo (operation canceled by undo is executed again)

Undo (previous operation is canceled)

Paste (data that has been copied or cut is pasted)

Copy (graphic in the specified range is copied)

Cut (graphic in the specified range is cut)

Register (mark data is registered)

* Drawing toolbar

� Toolbar

Used to move the graphic defined by the range specifying frame

By positioning the cursor on graphic defined by the range specifying 
frame after positioning the cursor on it and dragging, the graphic is 
moved.

Used to specify the range of a created graphic to copy, cut, or move.

By dragging the cursor from one corner to the diagonally opposing 
corner, the range specifying rectangle frame is defined.
To cancel the range specifying frame, select the tools other than 

, .

Range specifying frame

Used to tile dots.

After placing the cursor on a dot to be tiled, left click the mouse.

To cancel tiling, place the cursor on a tiled dot and right click the mouse.
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Used to draw a line.

By dragging the mouse cursor from the start point to the end point, dots 
arranged on a line are tiled.

Used to draw a rectangular frame.

By dragging the mouse cursor, the dots on a rectangle which has its 
diagonally opposing corners at the start and the end point of the 
dragging route are tiled.

Used to draw a circular or oval frame

By dragging the mouse cursor between two diagonally opposing 
corners of a rectangle which circumscribes the desired circle or oval 
frame, the dots on the circle or oval are tiled.

Used to draw a tiled rectangle

By dragging the mouse cursor, the dots inside a rectangle which has its 
diagonally opposing corners at the start and end point of the dragging 
route are tiled.

Used to draw a tiled circle or oval

By dragging the mouse cursor between two diagonally opposing 
corners of a rectangle which circumscribes the desired circle or oval 
frame, the dots inside the circle or oval are tiled.

Used to move the entire drawn graphic.

Drag the edit area and the graphic drawing position moves.

Used to turn the entire drawn graphic through 90°.

Left clicking on the edit area turns the graphic clockwise and right 
clicking turns the graphic counterclockwise.

Right click

Left click
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Referring to graphics

The mark editor allows you to refer to or reuse the existing graphics or sample
characters to draw desired new marks.

Click on  button and the reference graphic display area is displayed.

Reference graphic
display area

To close the reference graphic display area, click on  button again.

� Referring to the existing mark data

To display the existing mark data as reference for creating a new mark, click on
 above the reference graphic display area.  The mark data list dialog box is

displayed.

Select the data you want to use as the reference in the mark data list dialog box and
click on , or double click the mouse on the desired reference data.
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Referring to characters

The mark editor allows you to use the existing characters as the reference for
creating characters.  Click on  above the reference graphic display area, and the

reference character setting dialog box is displayed.

Input the characters you want to use as the reference and click on .

For the reference characters, two characters (8 dot size) can be input.

To change the font and/or size of the characters used as the reference, click on
.  The character setting dialog box is displayed.

(Presently, “Color” setting is not 
supported.  It will be invalid even 
if it was specified.)

Copying the reference graphics

To reuse the existing graphic displayed in the reference graphic display area,
specify the range to be copied and click on  above the reference graphic display

area.  After copying the graphic, click on  above the edit area.

Paste button Copy button

Specifying
the copy range



353

Mark Editor Section 8-3

Quitting the mark editor

To quit the mark editor, click on the  button of the mark editor.

If you click on , the created mark data is discarded before you quit the
mark editor.

[OK] button

Deleting mark data

To delete the mark data, specify the mark data to be deleted in the mark data list
dialog box and click on .

Reset button
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SECTION  9
Example Screens

This section is intended to familiarize you with the operation of the Support Tool through actual operation.

The operational procedures for creating example screens are explained step by step.

Please follow the steps shown in this section and create example screens in order to understand the functions and the features of
the Support Tool. 

Please do not forget to save the screen data frequently.  (Refer to 3-3-3 “Saving the Screen Data (Application) File”.)

The sample screen data to be created in this section is supplied by the CD–ROM version Support Tool.
Use this data to check the setting status etc.
(This data is provided just as a sample screen data. It is not created for the purpose of actual operation on PT after downloading it
to PT.)

9-1 Example Screen Configuration 356. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-1-1 Screen Configuration 356. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-1-2 Screen Transfer among Example Screens 357. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

9-2 Operation Flow 363. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3 Creating the Sample Data 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

9-3-1 Starting up the Support Tool 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-2 [File] – [New] 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-3 Setting the PT Configuration 367. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-4 Setting Memory Tables 368. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-5 Creating the Menu Screen 371. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-6 Creating the Monitor Screen (Child Screen 1) 375. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-7 Creating the Monitor Screen (Child Screen 2) 381. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-8 Creating the Monitor Screen (Parent Screen) 392. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-9 Creating the Set Screen 393. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-10 Creating the Alarm Screen 405. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-11 Creating the Alarm List Library Data 411. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-12 Creating the Pop-up Display Numeric Keys 413. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-13 Saving the Created Data 417. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
9-3-14 Downloading to the PT 418. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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9-1 Example Screen Configuration
The configuration and screen transfer of the example screens you are going to
create are described below.

9-1-1 Screen Configuration

Monitor
button

Menu Screen (Screen No. 1)

Monitor Screen (Screen No. 2) Set Screen (Screen No. 3)

Alarm Screen
(Screen No. 4)

Menu
button

Menu
button

Menu
button

Monitor
button

Set
button

Set
Screen
button

Monitor
Screen
button

Alarm
button

Alarm
Screen
button

Alarm
button

PT power ON

Set
button
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Create the Monitor Screen as an overlapping screen comprising screen No. 10
and screen No. 11.

Parent screen (screen No. 2) Child screen (screen No. 10) Child screen (screen No. 11)

9-1-2 Screen Transfer among Example Screens
How the displayed screen switches according to the button operation is shown be-
low.

Menu Screen

� [Monitor Screen] button

Switches the screen to the Monitor Screen (screen No. 2).

� [Set Screen] button

Switches the screen to the Set Screen (screen No. 3).

� [Alarm Screen] button

Switches the screen to the Alarm Screen (screen No. 4).
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Monitor Screen

� [Numeral Display 1]

Displays the value of DM0000 in the PC (PLC).

� [Numeral Display 2]

Displays the value of 32-bit data, the sum of DM0001 and DM0002 in the PC
(PLC).

� [Trend graph]

Displays the value of DM0003 and DM0004 in the PC (PLC) in the form of a trend
graph.

Set the –100%, 0%, and 100% values as shown below.

value for –100% value for 0 value for 100%

DM0003 –800 0 800

DM0004 0 600 1200

� [Lamp1] to [Lamp 5]

Displays the ON/OFF state of L000000 to L000004 in the PC (PLC).

When L000000 is ON (OFF), Lamp 1 goes ON (OFF).

When L000001 is ON (OFF), Lamp 2 goes ON (OFF).

When L000002 is ON (OFF), Lamp 3 goes ON (OFF).

When L000003 is ON (OFF), Lamp 4 goes ON (OFF).

When L000004 is ON (OFF), Lamp 5 goes ON (OFF).

� [Image Lamp]

Displays the ON/OFF state of L000005 in the PC (PLC).

Display when L000005 is ON.

Display when L000005 is OFF.
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� [Bar Graph 1]

Displays the value of DM0005 in the PC (PLC) in the form of a bar graph.

Set the –100%, 0%, and 100% values as shown below.

value for –100% value for 0 value for 100%

DM0005 –500 0 500

� [Bar Graph 2]

Displays the value of DM0006 in the PC (PLC) in the form of a bar graph.

Set the –100%, 0%, and 100% values as shown below.

value for –100% value for 0 value for 100%

DM0006 –300 0 300

� [Menu]

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen No.
1).

� [Set]

This is a screen switching button.

When you touch this button, the screen switches to the Set Screen (screen No.
3).

� [Alarm]

This is a screen switching button.

When you touch this button, the screen switches to the Alarm Screen (screen
No. 4).

Set Screen

� [Numeral Input 1]

Used to set the data at two words, DM0010 and DM0011, in the PC (PLC).
When you touch the numeral display area, numeric keys are displayed (pop-up
window), allowing you to input the data.
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� [Numeral Input 2]

Used to set the data at two words, DM0012 and DM0013, in the PC (PLC).
When you touch the numeral display area, numeric keys are displayed (pop-up
window), allowing you to input the data.

� [Thumbwheel]

Used to set the data at DM0014 in the PC (PLC).

� [String Display], [Auto.]/[Man.]/[Step]/[Reset]

When you touch any of the [Auto.], [Man.], [Step], and [Reset] buttons, the follow-
ing (character) string is displayed in the [String Display] filed.

[Auto.] button: Automatic

[Man.] button: Manual

[Step] button: Step

[Reset] button: Reset

� [Start]

This is a momentary type button.

When you touch this button, L000100 in the PC (PLC) goes ON.

If L000200 in the PC (PLC) goes ON, the button lights.

� [Stop]

This is a momentary type button.

When you touch this button, L000101 in the PC (PLC) goes ON.

If L000201 in the PC (PLC) goes ON, the button lights.

� [Menu]

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen No.
1).

� [Monitor]

This a screen switching button.

When you touch this button, the screen switches to the Monitor Screen (screen
No. 2).

� [Alarm]

This is a screen switching button.

When you touch this button, the screen switches to the Alarm Screen (screen
No. 4).
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Alarm Screen

� Alarm list and contents

Allocate 0002000 to 0002007 in the PC (PLC) as alarm bits.

If any of the allocated bits goes ON, the corresponding alarm message is dis-
played.

When you touch the alarm message, the corrective action and details of the
alarm are displayed in the alarm content display area.

Bits Alarm Message Alarm Content Display

0002000 Line 1 Error Set line 1.

0002001 Line 2 Error Set line 2.

0002002 A-spot Screw Error Check torque screw.

0002003 B-spot Screw Error Check torque screw.

0002004 Low Pressure Check pipe and valve.

0002005 Area 1 Alarm Detection near entry.  Confirm safety
before restarting the line.

0002006 Area 2 Alarm Detection near entry.  Confirm safety
before restarting the line.

0002007 PC (PLC) Network
Error

Check the PC (PLC) and the network.

� [Menu]

This is a screen switching button.

When you touch this button, the screen switches to the Menu Screen (screen No.
1).

� [Monitor]

This is a screen switching button.

When you touch this button, the screen switches to the Monitor Screen (screen
No. 2).

� [Set]

This is a screen switching button.

When you touch this button, the screen switches to the Set Screen (screen No.
3).
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Required environment

The required hardware environment for the creation of the example screens is
shown below.

� PT model: NT620C/625C

� Image memory: 512 Kbytes

� Memory table capacity:
Numeral memory table 512
Character string memory table  (String table) 256
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9-2 Operation Flow
Create the example screens by following the steps shown below.

Start up the Support Tool

↓

[File] – [New]

↓

Set PT configuration

↓

Set memory tables

↓

Creating the Menu Screen

Create new screen (screen No. 1)

↓

Set properties for screen No. 1

↓

Create screen title

↓

Create [Monitor Screen] button

↓

Create [Set Screen] button

↓

Create [Alarm Screen] button

↓

Creating Monitor Screen

Create new screen (screen No. 10)

↓

Set properties for screen No. 10

↓

Create screen title

↓

Create numeral display field of [Numeral Display 1]

↓

Create numeral display field of [Numeral Display 2]

↓

(1)
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(1)
↓

Create [Trend graph]

↓
Create new screen (screen No. 11)

↓
Set properties for screen No. 11

↓
Create [Lamp 1] to [Lamp 5]

↓
Create image data for image lamp

↓
Create [Image Lamp]

↓
Create [Bar Graph 1]

↓
Create [Bar Graph 2]

↓
Create [Menu] button

↓
Create [Set] button

↓
Create [Alarm] button

↓
Create parent screen  

(screen No. 10, 11 as child screens)

↓

Creating the Set Screen

Create new screen (screen No. 3)

↓
Set properties for screen No. 3

↓
Create screen title

↓
Create numeral input field of [Numeral Input 1]

↓
Create numeral input field of [Numeral Input 2]

↓
Create [Thumbwheel]

↓
(2)
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(2)
↓

Create [Start] and [Stop] buttons

↓

Create [String Display] display field

↓

Create [Auto] button

↓

Create [Man.] button

↓

Create [Step] button

↓

Create [Reset] button

↓

Create [Menu] button

↓

Create [Monitor] button

↓

Create [Alarm] button
↓

Creating the Alarm Screen

Create new screen (screen No. 4)

↓

Set properties for screen No. 4

↓

Create screen title

↓

Create alarm list

↓

Create [Menu] button

↓

Create [Set] button

↓

(3)
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(3)
↓

Create [Monitor] button

↓

Create alarm library data

↓

Create numeric keys for pop-up window display

↓

Save the created data

↓

Download the created data
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9-3 Creating the Sample Data
This section describes the operational procedure and data creation procedure
step by step according to the operation flow shown in 9-2 “Operation Flow”.

Reference: The explanation in this section assumes that the default value of each object’s
property is not changed since installation.

9-3-1 Starting up the Support Tool
At the start-up screen of Windows,  double click the Support Tool icon to start the
Support Tool.  (Refer to 3-1 “Starting-up and Exiting the Support Tool”.)

9-3-2 [File] – [New]
Select [File] in the main menu, then select [New] to create a new file.
(Refer to 3-3-1 “Creating New Screen Data (Application) File”.)

9-3-3 Setting the PT Configuration
At the PT configuration setting dialog box, set the items as shown below.
(Refer to 3-3-1 “Creating New Screen Data (Apprication) File”.

PT Type PT Model NT620C/625C

PLC Vendor OMRON

Font Type CP437

Comments SAMPLE DATA

System Initial Screen 1

Backlight OFF Check mark set, 60
min

Resume function Check mark not set

Number of Numeral Table 512
Table Entries String Table 256

Bit Memory Table 256

Printer for PT Printer ESC/P

Mode Colour

History Setting Alarm (Use Ring Buffer) Check mark set

Buzzer Enable Check mark set, On
Error

Key Input Check mark not set

After setting the PT configuration items as indicated above, click on .
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9-3-4 Setting Memory Tables
Set the memory tables (numeral memory tables, character-string memory tables
(string tables), and bit memory tables).  (Refer to section 7 “Memory Table Set-
ting”.)

Opening a table

(1) Select [Tools] (menu bar) → [Table].

Setting numeral memory tables

(1) Make the numeral memory table settings as shown below.

No. Value Initial Words PC (PLC)
Address

I/O
Comments Ref

0 0 � 1 D00000 Mtr: Num.disp.1 ––

1 0 � 2 D00001 Mtr: Num.disp.2 ––

2 0 � 1 D00003 Mtr: Trd.graph 1 ––

3 0 � 1 D00004 Mtr: Trd.graph 2 ––

4 0 � 1 D00005 Mtr:
Bar graph 1

––

5 0 � 1 D00006 Mtr:
Bar graph 2

––

––

10 0 � 2 D00010 Set:
Num.input 1

––

11 0 � 2 D00012 Set:
Num.input 2

––

12 0 � 1 D00014 Set:
Thumbwheel

––
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Setting character string memory tables

(1) Click on [String].

(2) Make the character string memory table settings as shown below.

No. Value Initial Words
PC (PLC)
Address

I/O Comments Ref

0 0 –– ––

10 Automatic � 0 –– ––

11 Manual � 0 –– ––

12 Step � 0 –– ––

13 Reset � 0 –– ––

––

20 Line 1 Error � 20 D00150 Alarm data 1 ––

21 Line 2 Error � 20 D00170 Alarm data 2 ––

22 A-spot Screw Error � 20 D00190 Alarm data 3 ––

23 B-spot Screw Error � 20 D00210 Alarm data 4 ––

24 Low Pressure � 20 D00230 Alarm data 5 ––

25 Area 1 Alarm � 20 D00250 Alarm data 6 ––

26 Area 2 Alarm � 20 D00270 Alarm data 7 ––

27 PC (PLC) Network Error � 20 D00290 Alarm data 8 ––



370

Creating the Sample Data Section 9-3

Setting bit memory tables

(1) Click on [Bit Memory].

(2) Make the bit memory table settings as shown below.

Press  to set the following items.

� Function

� History

� Switch Screen

� String Table Entry

� Image/Library Code

� Colour

Press  to set the following items.

(Direct input on a bit memory table is also possible.)

� PLC Address

� I/O Comments

No. Function Switch
Screen History

String
Table
Entry

Image/
Library
Code*1

Colour PC 
Address

I/O
Comments

0 Alarm/Switch
Screen

20 FA20 White 0002000 Alarm 1

1 Alarm/Switch
Screen

21 FA21 White 0002001 Alarm 2

2 Alarm/Switch
Screen

22 FA22 White 0002002 Alarm 3

3 Alarm/Switch
Screen

23 FA22 White 0002003 Alarm 4

4 Alarm/Switch
Screen

24 FA23 White 0002004 Alarm 5

5 Alarm/Switch
Screen

25 FA24 White 0002005 Alarm 6

6 Alarm/Switch
Screen

26 FA24 White 0002006 Alarm 7

7 Alarm/Switch
Screen

27 FA25 White 0002007 Alarm 8

*1: With NT31, NT31C, NT631, NT631C, set “Alarm” for function and unmark the
check box for “Switch Screen”.
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9-3-5 Creating the Menu Screen
Create the Menu Screen.

Display the data creation window for screen No. 1, which is displayed at the start-
up of the Support Tool, at the front.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 1.  (Refer to 5-1-1
“Setting the Screen Attributes”.)

Attributes Screen No. 1

History �

Title Menu Screen

Comment Menu Screen

Buzzer �, Short

Load Local 1 (Keyboard)

System Keypad

Colour Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid �

Snap to Grid �

Creating the screen title ([Menu Screen])

� Setting the characters

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text] (Refer to 6-2-7
“Text”.)

(2) Click the mouse with the mouse cursor set at the position where the screen
title is to be displayed (at the intended upper left corner of text).
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(3) Set the properties as shown below.

Description Menu Screen

Position ––

Font Type Standard

Scale 2�2

Smoothing �

Attribute Standard

Colour Foreground White

Background Transparent

(4) Adjust the position of “Menu Screen” on the data creation screen by drag-
ging it.

� Surrounding the title with a frame

(5) Select [Objects] (menu bar) → [Fixed Display] → [Rectangle].  (Refer to
6-2-3 “Rectangle”.)

(6) On the data creation screen, drag the “rectangle” so that it encloses the
“Menu Screen” (character) string.

(7) Use the properties as they are.

(8) Adjust the size and the position of the frame (rectangle).

Creating the [Monitor Screen] button

� Setting the touch switch outline

(1) Select [Objects] (menu bar) → [Touch Switch].  (Refer to 6-8 “Touch
Switches”.)

(2) Create the outline of the [Monitor Screen] button by dragging the mouse on
the data creation screen.

(3) Set the properties as shown below.



373

Creating the Sample Data Section 9-3

General Position ––

Size ––

Label �

Description Monitor Screen
(Refer to the follow-
ing) *1

Frame �

Shape 3-Dimension

Show ON State ––

Colour Frame White

ON White

OFF Transparent

Settings Function Switch Screen

Screen No. 2

Light Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attribute Light

*1: Press  to set the label.
After completing the setting, go to the next step without clicking on

 button.

� Setting the touch switch label

(4) Press  in the general property of a touch switch and set the label
properties as shown below.

Description Monitor Screen

Position ––

Font Type Standard

Scale 2�2

Smoothing �

Attribute Standard

Colour Foreground White

Background Transparent

Click on , (return to touch switch property) then click on

 again.

� Adjusting the size and position of the touch switch

(5) Adjust the size and position of the frame of [Monitor Screen] button.

(6) Specify the [Monitor Screen] button.

(7) Select [Centralize Label] from [Draw] menu.
The label is centralized.
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Creating the [Set Screen] button

� Copying and pasting the [Monitor Screen] button

(1) Specify the [Monitor Screen] button.

(2) Select [Edit] (menu bar) → [Copy].  (Refer to 6-1-5 “Copying, Cutting, Past-
ing and Deleting Elements”.)

(3) Select [Edit] (menu bar) → [Paste].  (Refer to 6-1-5 “Copying, Cutting, Past-
ing, and Deleting Elements”.)

(4) Drag the [Monitor Screen] button, displayed at the upper left area in the data
creation screen, to the position where you want to create the [Set Screen]
button.

� Modifying to the [Set Screen] button

(5) Double click the moved button and modify the properties as shown below.
Note that other properties must be left unchanged.

Attribute Label �

Description Set Screen*1

Settings Screen No. 3

*1: Press  to set the label.

Creating the [Alarm Screen] button

� Copying and pasting the [Monitor Screen] button

(1) Specify the [Monitor Screen] button.

(2) Select [Edit] (menu bar) → [Copy].

(3) Select [Edit] (menu bar) → [Paste].

(4) Drag the [Monitor Screen] button, displayed at the upper left area in the data
creation screen, to the position where you want to create the [Alarm Screen]
button.

� Modifying to the [Alarm Screen] button

(5) Double click the moved button and modify the properties as shown below.
Note that other properties must be left unchanged.

General Label �

Description Alarm Screen*1

Settings Screen No. 4

*1: Press  to set the label.
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9-3-6 Creating the Monitor Screen (Child Screen 1)
The monitor screen is an overlapping screen with screen Nos. 10 and 11 as its child
screens.  When creating an overlapping screen, create the child screens first.
Here, create screen No. 10 as child screen 1.

(1) Select [Screen] (menu bar) → [New].  (Refer to 4-2-3 “Creating a New
Screen”.)

(2) At the screen selection dialog box, set “Standard Screen”.

(3) At the new standard screen dialog box, set “10” for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 10.

Attributes Screen No. 10

History �

Title Monitor Screen-1

Comment Monitor Screen-1

Buzzer

Load Local 1 (Keyboard)

System Keypad

Colour Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid �

Snap to Grid �



376

Creating the Sample Data Section 9-3

Creating the screen title ([Monitor Screen])

� Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy “Menu Screen” character string and its frame (rectangle) on screen
No. 1 and paste them to screen No. 10.

(2) Adjust the display position of the pasted character string and frame to the
desired position.

� Modifying to [Monitor Screen]

(3) Double click the “Menu Screen” character string and modify the properties
as shown below.  Note that other properties must be left unchanged.
If selection of the “Menu Screen” (character) string is not easy, select [Edit]
(menu bar) → [Select Object], then click on the fixed display text.

Description Monitor Screen

(4) Adjust the size of the frame (rectangle).

Creating the data display field ([Numeral Display 1])

� Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the numeral
display field title is to be displayed (at the intended upper left corner of text).

(3) Set the properties as shown below.

Description Numeral Display 1

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Transparent
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(4) Adjust the position of “Numeral Display 1” on the data creation screen by
dragging it.

� Creating the numeral display field

(5) Select [Objects] (menu bar) → [Numeral Display].  (Refer to 6-6 “Numeral
Display”.)

(6) Click the mouse with the mouse cursor set at the position where the numeral
display field is to be displayed (at the intended upper left corner of numeral
display).

(7) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 2�2

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

Settings Reference Indirect
Reference

Table Entry 0

Display Type Decimal

Format Integer 4

Decimal 0

Zero Suppression �

Display Sign �

(8) Adjust the position of the numeral display field by dragging it.

� Surrounding the numeral display field with a frame

(9) Select [Objects] (menu bar) → [Fixed Display] → [Rectangle].

(10) On the data creation screen, drag the “rectangle” so that it encloses the nu-
meral display field.

(11) Use the properties as they are.

(12) Adjust the size and the position of the frame (rectangle).
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Creating the numeral display field ([Numeral Display 2])

� Copying and pasting the numeral display field ([Numeral Display 1])

(1) Copy “Numeral Display 1” (character) string, numeral display field, and its
frame (rectangle).

(2) Paste the copied contents and move them to the desired position (for dis-
playing [Numeral Display 2]).

� Modifying to [Numeral Display 2]

(3) Double click the “Numeral Display 1” (character) string and modify the prop-
erties as shown below.  Note that other properties must be left unchanged.

Description Numeral Display 2

� Modifying the numeral display field

(4) Double click the numeral display field ([       0] displayed) and modify the prop-
erties as shown below.  Note that other properties must be left unchanged.

Settings Reference Indirect
Reference

Table Entry 1

Format Integer 8

Decimal 0

(5) Drag the numeral display field ([       0]) to the desired display position.

� Modifying the frame

(6) Specify the copied frame (rectangle) and adjust the size and the position.
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Creating the trend graph

� Setting the graph

(1) Select [Objects] (menu bar) → [Graph] → [Trend Graph].  (Refer to 6-9-4
“Trend Graph”.)

(2) At the trend graph display position, drag the mouse to set the trend graph
display area as desired.

(3) Set the general properties as shown below.

General Position ––

Size ––

Display Type Standard

Drawing Width 3

Frame �

Display Sign �

Direction Right

Sampling Cycle 1 *1

Colour Frame White

+ Range Black

– Range Black

*1: For NT31, NT31C, NT631, NT631C, sampling cycle of trend graph must be
multiple of 5 (minimum 5).

� Setting the graph line
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(4) Double click the [Settings] tab and click on .

Set the line 1 properties as shown below.

Line Value Table Entry 2

Display % �

Line Colour Cyan

Style Solid (          )

100% Table Entry

Value �, 800

0% Table Entry

Value �, 0

–100% Table Entry

Value �, –800

(5) Click on  to close the line 1 properties.

(6) Click on  to add line 2.

Set the line 2 properties as shown below.

Line Value Table Entry 3

Display % �

Line Colour White

Style Dot-dash (             )

100% Table Entry

Value �, 1200

0% Table Entry

Value �, 600

–100% Table Entry

Value �, 0

Click on , (returns to setting property) then click on  again.

� Adjusting the size and position of the frame and % display

(7) Specify the trend graph and select [Edit] (menu bar) → [Select Object].

(8) In the list, specify [0%] (Line 1 display %) at the upper right of the trend graph
and drag it to the “%” display position for Data 1.

Reference: Even if elements are overlapped, you can select the desired element easily using
the [Select Object] function.  For elements such as a trend graph which consist of
several elements, use the [Edit Object] function to make element selection easier.

(9) Specify [–100%] (Line 2 display %) at the upper right of the trend graph and
drag it to the “%” display position for Data 2.

(10) Specify the trend graph frame and adjust the size and the position.
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� Displaying an example

Create the example of display using fixed display text and straight lines.

(11) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(12) Click the mouse with the mouse cursor positioned at the “Data 1” display
position.

(13) Set “Data 1” in the (character) string setting (Fixed Display – Text) dialog
box.

(14) Adjust the “Data 1” display position.

(15) Select [Objects] (menu bar) → [Fixed Display] → [Polyline].  (Refer to 6-2-1
“Polyine”.)

(16) Drag the mouse cursor in the range (from the start point to the end point)
where a line is to be displayed to the left of [Data 1].

Set the line property as shown below.

General Line Style Solid

Line Colour Cyan

(17) Specify the drawn line and adjust the length and the position of the line.

(18) Create the example display of “Data 2” in the same manner.

Set the line property as shown below.

General Line Style Dot-dash

Line Colour White

9-3-7 Creating the Monitor Screen (Child Screen 2)
Here, create screen No. 11 as child screen 2.

(1) Select [Screen] (menu bar) → [New].

(2) At the screen selection dialog box, set “Standard Screen”.

(3) At the new standard screen dialog box, set “11” for the screen No.
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Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 11.

Attributes Screen No. 11

History �

Title Monitor Screen-2

Comment Monitor Screen-2

Buzzer

Load Local 1 (Keyboard)

System Keypad

Colour Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid �

Snap to Grid �

Creating the lamps ([Lamp 1] to [Lamp 5])

� Creating the frame of lamp 1

(1) Select [Objects] (menu bar) → [Lamp] → [Standard].  (Refer to 6-5
“Lamps”.)

(2) At the [Lamp 1] display position in the data creation screen, drag the mouse
to create the lamp frame.
In this step, a rectangular frame is created.

(3) Set the properties as shown below.
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General Position ––

Size ––

Label �, Lamp 1 (refer
to the following) *1

Frame �

Shape Circle

Colour Frame White

ON White

OFF Transparent

Light Address PC (PLC) Bit Address L0000000
Functions I/O Comment Lamp 1

Lamp Attrib-
ute

ON Type Light

*1: Press  to set the label.
If the I/O comment is already set for the PLC address of light function,

clicking on  button copies the label.

After completing the setting, go to the next step with clicking on 

button.

� Setting the label for lamp 1

(4) Press  in the general property of a lamp and set the label proper-
ties as shown below.

Comment Lamp 1

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Transparent

Click on , (returns to lamp property) then click on  again.

Reference: With NT31, NT31C, NT631, and NT631C, “Colour: ON” and “Colour: OFF” can be
set independently for a label so that the lamp can be displayed in different colors in
the ON and OFF states.
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� Adjusting the size and position of the lamp

(5) Specify the “Lamp 1”.

(6) Select [Edit Object] from [Edit] menu.
For methods of specifying an element consisting of multiple elements, refer to
6–1–3 “Selecting an Element”.

(7) Specify the “Lamp 1” and adjust the size and position of the lamp frame.

(8) Adjust the position of the “Lamp 1” (character) string by dragging it.

� Creating lamp 2

(9) Copy [Lamp 1] and paste it onto the data creation screen.

(10) Move the pasted [Lamp 1] to the [Lamp 2] position.

(11) Double click the mouse on the pasted [Lamp 1] and modify the properties as
shown below.  Note that the properties not shown here must be left un-
changed.

General Label �, Lamp 2 *1

Light Address PC (PLC) Bit Address L0000001
Functions I/O Comment Lamp 2

*1: Press  to set the label.
If the I/O comment is already set for the PLC address of light function,

clicking on  button copies the label.

(12) Create [Lamp 3], [Lamp 4], and [Lamp 5] in the same manner.

(13) Modify the properties as shown below meeting the individual lamps.

Lamp 3 �, Lamp 4 �, Lamp 5

General Label �, Lamp 3*1
�, Lamp 4*1

�, Lamp 5*1

Light
Functions

Address PC (PLC)
Bit Address

L0000002 L0000003 L0000004

I/O 
Comment

Lamp 3 Lamp 4 Lamp 5

*1: Press  to set the label.
If the I/O comment is already set for the PLC address of light function,

clicking on  button copies the label.

Creating the image/library lamp image data

Create two kinds of image data for the image/library lamp.

Create the image data for codes FE20 and FE21.
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FE20

(1) Select [Tools] (menu bar) → [Image Editor].

(2) Click on .

(3) Set the properties as shown below and click on .

Code FE20

Size Width 64

Height 48

Mode 8 Colours

Compression �

(4) Click on  to create the image data. (For the image data creation

procedure, refer to 8-1 “Image Editor”.)

(5) Close the image editor.

(6) Call the image editor again and create the image data for code FE21.

Reference: It is possible to copy image data FE20 onto FE21 on the image table so that it can
be reused.
Follow the procedure below.
a. Click on  and register the code FE21 (Properties other than code 

need not be changed).
b. Specify FE20 and select [Copy] by pressing  button.
c. Specify FE21 and select [Paste] by pressing  button.

Creating the [Image Lamp]

� Creating the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the label
“Image Lamp” is to be displayed.

(3) Set the properties as shown below.
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Description Image Lamp

Position ––

Font Type Standard

Scale 2�2

Smoothing �

Attribute Standard

Colour Foreground White

Background Transparent

(4) Adjust the position of “Image Lamp” (character) string on the data creation
screen by dragging it.

� Setting the image/library lamp

(5) Select [Objects] (menu bar) → [Lamp] → [Image].

(6) Click the mouse with the mouse cursor set at the position where the image/
library lamp is to be displayed (at the intended upper left corner).

(7) Set a check mark in the check box of the [Code] for OFF, in General, and
click on .

(8) In the image table, specify “FE20” and click on .

(9) Set a check mark in the check box of the [Code] for ON, in General, and click
on .

(10) In the image table, specify “FE21” and click on .

(11) Set the lamp function properties as shown below.

Light Address PC (PLC) Bit Address L0000005
Functions I/O Comment Image Lamp

(12) Adjust the display position of the image/library lamp.

Reference: With NT31, NT31C, NT631, and NT631C, codes assigned to image data are from
0001 to 0FFF.

Creating [Bar Graph 1] and [Bar Graph 2]

� Creating the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].
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(2) Click the mouse with the mouse cursor set at the position where the charac-
ter string of [Bar Graph 1] is to be displayed (at the intended upper left corner
of bar graph).

(3)  Set the properties as shown below.

Description Bar Graph 1

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

(4) Adjust the position of “Bar Graph 1” (character) string on the data creation
screen by dragging it.

� Creating the bar graph frame

(5) Select [Objects] (menu bar) → [Graph] → [Bar Graph].  (Refer to 6-9-1 “Bar
Graph”.)

(6) Drag the mouse cursor at the position where bar graph 1 is to be displayed
(drag between diagonally opposing corners) to create the frame of [Bar Graph
1].

(7) Set the properties as shown below.

General Position ––

Size ––

Frame �

Display Sign �

Direction Right

Colour Frame White

+ Range White

– Range White

Settings Value Table Entry 4

Display % �

100% Table Entry

Display % �, 500

0% Table Entry

Display % �, 0

–100% Table Entry

Display % �, –500
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� Setting the % display

(8) After specifying the bar graph, select [Edit] (menu bar) → [Edit Object].

(9) Double click on [0%] and set the properties as shown below.

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute ––

Colour Foreground White

Background Black

� Adjusting the size and position of bar graph frame and % display

(10) Specify [0%] at the upper left of the trend graph and drag it to the “%” display
position.

(11) Specify the bar graph frame and adjust the size and position of bar graph
frame.

� Creating bar graph 2

(12) Specify all of label, bar graph frame, and % display of [Bar Graph 1] and
copy and paste them onto the data creation screen.

(13) Move the pasted bar graph 1 element, which was pasted at the upper left
area in the data creation screen, to the position of [Bar Graph 2].

(14) Double click the label “Bar Graph 1”, which has been moved to the bar graph
2 position, and modify the properties as shown below.

Label Bar Graph 2

(15) Double click on the frame of bar graph 2 and modify the properties as shown
below.  Note that other properties must be left unchanged.

Settings Value Table Entry 5

Display % �

100% Table Entry

Display % �, 300

0% Table Entry

Display % �, 0

–100% Table Entry

Display % �, –300
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Creating the [Menu] button, [Set] button, and [Alarm] button

� Creating the [Menu] button frame

(1) Select [Objects] (menu bar) → [Touch Switch]

(2) Create the [Menu] button frame by dragging the mouse at the button display
position.

(3) Set the properties as shown below.

General Position ––

Size ––

Label �, Menu (refer to
the following) *1

Frame �

Shape 3-Dimension

Show ON State �

Colour Frame White

ON White

OFF Transparent

Settings Function Switch Screen

Screen No. 1

Light Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attribute  Attribute Light

*1: Press  to set the label.
After completing the setting, go to the next step without clicking on

 button.

� Setting the label of [Menu] button

(4) Press  in the general property of a touch switch and set the label
properties as shown below.
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Description Menu

Position ––

Font Type Standard

Scale 1�1 (Equal)

Smoothing ––

Attribute Standard

Colour Foreground White

Background Transparent

Reference: With NT31, NT31C, NT631 and NT631C, “Colour: ON” and “Colour: OFF” can be
set independently for a label so that the lamp can be displayed in different colors in
the ON and OFF states.

Click on , (returns to touch switch property) then click on 

again.

� Adjusting the size and position of the touch switch

(5) Specify the [Menu] button and select [Edit] (menu bar) → [Edit Object].

(6) Adjust the size and position of [Menu] button frame.

(7) Adjust the position of label “Menu” by dragging it.

� Creating the [Set] button

(8) Copy the [Menu] button and paste it on the screen.

(9) Move the [Menu] button pasted at the upper left area of the screen to the
[Set] button position.

(10) Double click the moved button and modify the properties as shown below.
Note that other properties must be left unchanged.

General Label �, Set *1

Settings Screen No. 3

*1: Press  to set the label.

(11) Create the [Alarm] button in the same manner.
Modify [Alarm] button properties as shown below.

General Label �, Alarm *1

Settings Screen No. 4

*1: Press  to set the label.
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� Creating the frame

(12) Select [Objects] (main menu) → [Fixed Display] → [Rectangle].

(13) Drag the mouse so that the rectangular frame encloses the three buttons.

(14) Use the properties as they are.

(15) Adjust the size and the position of the frame (rectangle).

� Setting the [Switch Screen] (character) string

(16) Select [Objects] (main menu) → [Fixed Display] → [Text]

(17) Click the mouse with the mouse cursor set at the position where the [Switch
Screen] (character) string is to be displayed (at the intended upper left cor-
ner).

(18) Set the properties as shown below.

Description Switch Screen

Position ––

Font Type Standard

Scale 1�1 (Equal)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

(19) Adjust the position of the “Switch Screen” (character) string on the data cre-
ation screen by dragging it.

(20) Specify the “Switch Screen” (character) string, then select [Draw] (menu
bar) → [Bring to Front].  (For details of Moving an overlapped element to the
front or back, refer to 6-1-5 “Copying, Cutting, Pasting and Deleting Ele-
ments”.)

The “Switch Screen” (character) string is brought to the front of the frame.

Reference: The positional relationship in the display of the same kind of elements, such as
among fixed display elements, can be controlled by selecting [Draw] → [Bring to
Front] or [Send to Back].
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9-3-8 Creating the Monitor Screen (Parent Screen)
Register screens No. 10 and N0. 11 as child screens of screen No. 2.  Screen No. 2
is regarded as a parent screen of an overlapping screen.  (Refer to 5-3-2 “Overlap-
ping Screens”.)

(1) Select [Screen] (menu bar) → [New].

(2) In the screen type designation dialog box, select “Parent Screen” and click on
.

(3) In the setting dialog box of a parent screen, set the displayed items as shown
below.

Parent Screen Screen No. 2

Type Overlapping

(4) Specify “10” in the standard screen box and click on .

(5) Specify “11” in the standard screen box and click on .

(6) Click on .
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9-3-9 Creating the Set Screen
Create screen No. 3 (new screen) as the Set Screen.

(1) Select [Screen] (menu bar) → [New].

(2) At the screen selection dialog box, set “Standard Screen”.

(3) At the new standard screen dialog box, set “3” for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 3.

Attributes Screen No. 3

History �

Title Set Screen

Comment Set Screen

Buzzer

Load Local 1 (Keyboard)

System Keypad

Colour Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid �

Snap to Grid �

Creating the screen title ([Set Screen])

� Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy the “Menu Screen” (character) string and its frame (rectangle) on
screen No. 1 and paste them onto screen No. 3.

(2) Adjust the display position of the pasted (character) string and frame to the
desired position.
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� Modifying to [Set Screen]

(3) Double click the “Menu Screen” (character) string and modify the properties
as shown below.  Note that other properties must be left unchanged.

Description Set Screen

(4) Adjust the size of the frame (rectangle).

Creating the data input field ([Numeral Input 1])

� Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the data
display field title is to be displayed (at the intended upper left corner).

(3) Set the properties as shown below.

Description Numeral Input 1

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Transparent

(4) Adjust the position of “Numeral Input 1” on the data creation screen by drag-
ging it.

� Creating the data input field

(5) Select [Objects] (menu bar) → [Data Input] → [Numeral].  (Refer to 6-4-1
“Numeral Input”.)

(6) Click the mouse with the mouse cursor set at the position where the data
input field is to be displayed (at the intended upper left corner).

(7) At the cursor moving touch switch use selection dialog box, set the dis-
played items as shown below.

Create Cursor Move Touch Switch �
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� Setting the numeral input field

(8) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 2�2

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

Settings Table Entry 10

Display Type Decimal

Format Integer 8

Decimal 0

Limit Maximum 99999999

Minimum 0

Zero Suppression �

Display Sign �

Focus Frame �

Focus Attribute Standard

� Setting the cursor moving touch switch

(9) Double click on the touch switch area (dotted line frame) created at the nu-
meral input field position and set the properties as shown below.
If selection of the touch switch is not easy, choose [Select Object] from [Edit]
menu and select the touch switch from the list.
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General Position ––

Size ––

Label

Frame �

Shape Standard

Show ON State �

Colour Frame White

ON White

OFF Transparent

Settings Function Cursor Move

Use Window/Keyboard Screen �

Screen No. 1900

Auto Arrange *1

Light Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attribute Light

*1: Uncheck the check mark for “Auto Arrange”.  Otherwise, it is not pos-
sible to change the position of each numeral input and touch switch.

� Adjusting the size and position of numeral input 1 input field and the touch switch

(10) Specify only the touch switch area and adjust the size and the position.

(11) Specify only the numeral input field and adjust the size and the position.

Creating the numeral input field ([Numeral Input 2])

� Copying and pasting the numeral input field ([Numeral Input 1])

(1) Copy “Numeral Input 1” (character) string, numeral display field, and touch
switch and paste them to the data creation screen.

(2) Move the (character) string, numeral display field, and touch switch pasted
at the upper left area of the screen to the desired position (for displaying [Nu-
meral Input 2]).

(3) Double click the “Numeral Input 1” (character) string and modify the proper-
ties as shown below.  Note that other properties must be left unchanged.

Description Numeral Input 2

(4) Double click the data input field ([       0] displayed) and modify the properties
as shown below.  Note that other properties must be left unchanged.

Settings Table Entry 11
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Creating the thumbwheel switch

� Creating the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the title is to
be displayed (at the intended upper left corner of text).

(3) Set the properties as shown below.

Description Thumbwheel

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

(4) Adjust the position of “Thumbwheel” on the data creation screen by drag-
ging it.

� Creating the thumbwheel switch

(5) Select [Objects] (menu bar) → [Data Input] → [Thumbwheel Switch].
(Refer to 6-4-3 “Thumbwheel Switch”.)

(6) Click the mouse with the mouse cursor set at the position where the thumb-
wheel switch is to be displayed (at the intended upper left corner of thumb-
wheel).
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(7) Set the properties as shown below.

General Position ––

Size Medium

Attribute Standard

End Plate �

Thumbwheel Frame White
Colour Foreground White

Background Black

Character Foreground White
Colour Background Black

Settings Table Entry 12

Display Type Decimal

Format Integer 4

Decimal 0

Limit Maximum 999

Minimum F0009999

Display sign �

(8) Adjust the position of the thumbwheel switch on the data creation screen by
dragging it.

Creating the [Start] button and the [Stop] button

� Creating the [Start] button frame

(1) Select [Objects] (menu bar) → [Touch Switch]

(2) Create the [Start] button frame by dragging the mouse at the button display
position.

(3) Set the properties as shown below.



399

Creating the Sample Data Section 9-3

General Position ––

Size ––

Label �, Start (refer to
the following) *1

Frame �

Shape Shadow

Show ON State ––

Colour Frame White

ON White

OFF Transparent

Settings Function Notify Bit

Address PC (PLC) Address L0000100

I/O Comments Start  Switch

Action Type Momentary

Light Address PC (PLC) Address L0000200
Function I/O Comments Start  lamp

Lamp Attrib-
ute

General Light

*1: Press  to set the label.
After completing the setting, go to the next step without clicking on

 button.

(4) Press  in the general property of a touch switch and set the label
properties as shown below.

Description Start

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

Click on , (returns to touch switch property) then click on 

again.

� Adjusting the size and position of [Start] button

(5) Specify the [Start] button and select [Edit] (menu bar) → [Edit Object].

(6) Adjust the size and position of [Start] button frame.

(7) Adjust the position of the label “Start” by dragging it.
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� Creating the [Stop] button

(8) Copy the [Start] button and paste it on the data creation screen.

(9) Move the [Start] button pasted at the upper left area of the screen to the
[Stop] button position.

(10) Double click the moved button and modify the properties as shown below.
Note that other properties must be left unchanged.

General Label �, Stop *1

Settings Address PC (PLC) Address L0000101

I/O Comments Stop Switch

Light Address PC (PLC) Address L0000201
Function I/O Comments Stop lamp

*1: Press  to set the label.

Creating the character string display field ([String Display])

� Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(2) Click the mouse with the mouse cursor set at the position where the “String
Display” (character) string is to be displayed (at the intended upper left cor-
ner of text).

(3) Set the properties as shown below.

Description String Display

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

(4) Adjust the position of the “String Display” on the data creation screen by
dragging it.
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� Creating the (character) string display field

(5) Select [Objects] (menu bar) → [String Display].

(6) Click the mouse with the mouse cursor set at the position where the charac-
ter string display field is to be displayed (at the intended upper left corner of
string display field).

(7) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

Settings Reference Indirect
Reference

Table Entry 0

Length 20

(8) Adjust the position of the (character) string display field by dragging it.

� Creating the (character) string display field frame

(9) Select [Objects] (menu bar) → [Fixed Display] → [Rectangle].

(10) On the data creation screen, drag the “rectangle” so that it encloses the
character string display field.

(11) Use the properties as they are.

(12) Adjust the size and the position of the frame (rectangle).

Creating the [Auto] button, [Man.] button, [Step] button, and [Reset] button

� Creating the [Auto] button frame

(1) Select [Objects] (menu bar) → [Touch Switch]
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(2) Create the [Auto] button frame by dragging the mouse at the button display
position.

(3) Set the properties as shown below.

General Position ––

Size ––

Label �, Auto (refer to
the following) *1

Frame �

Shape Shadow

Show ON State �

Colour Frame White

ON White

OFF Transparent

Settings Function Copy Setting

Copy From Numeral Table

String Table �

Code

Entry (Text Box) 10

Copy To Numeral Table

String Table �

Cursor Position

Entry (Text Box) 0

Light
Function

Address PC (PLC) Ad-
dress

––

I/O Comments ––

Lamp Attribute On Type Light

*1: Press  to set the label.
After completing the setting, go to the next step without clicking on

 button.

� Setting the label of [Auto] button

(4) Press  in the general property of a touch switch and set the label
properties as shown below.

Description Auto

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black
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Click on , (returns to touch switch property) then click on 

again.

� Adjusting the size and position of [Auto] button

(5) Specify the [Auto] button and select [Edit] (menu bar) → [Edit Object].

(6) Adjust the size and position of [Start] button frame.

(7) Adjust the position of the label “Auto” by dragging it.

� Creating the [Man.] button

(8) Copy the [Auto] button and paste it onto the data creation screen.

(9) Move the [Auto] button pasted at the upper left area of the screen to the
[Man.] button position.

(10) Double click the moved button and modify the properties as shown below.
Note that other properties must be left unchanged.

General Label �, Man. *1

Settings Copy From Numeral Table

String Table �

Code

Entry (Text Box) 11

*1: Press  to set the label.

� Creating the [Step] button and the [Reset] button

(11) Create the [Step] button and the [Reset] button in the same manner as the
[Man.] button.
For the [Step] button and the [Reset] button, change the properties as
shown below.

[Step] button [Reset]
button

General Label �, Step �, Reset

Settings Copy From Numeral Table

String Table � �

Code

Entry (Text Box) 12 13
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� Creating the button group title bar

(12) Select [Objects] (menu bar) → [Fixed Display] → [Polyline].

(13) While pressing the shift key, drag the polyline from start point to the second
vertex, and then from the second vertex to the third vertex.  Repeat this pro-
cedure to create the desired form.  Release the Shift key just before reach-
ing at the last point.

Reference: To draw continuous polyline, press shift key when drag operation is finished.  Drag-
ging this end point creates continuous polyline.

(14) Use the properties as they are.

� Creating the “Select” (character) string

(15) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(16) Click the mouse with the mouse cursor set at the position where the “Select”
character string is to be displayed (at the intended upper left corner of text).
In the (character) string setting (Fixed Display–text) dialog box, set “Select”.

(17) Set the properties as shown below.

Description Select

Position ––

Font Type Standard

Scale 1�1 (Equal)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

(18) Adjust the position of the “Select” (character) string on the data creation
screen by dragging it.

(19) Specify the “Select” (character) string, then select [Draw] (menu bar) →
[Bring to Front].

The “Select” (character) string is brought to the front of the title bar.

Creating the [Menu] button, [Monitor] button, and [Alarm] button
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� Copying and pasting the buttons from screen No. 11

(1) Copy the “Switch Screen” (character) string, frame (rectangle), [Menu] but-
ton, [Set] button, and [Alarm] button collectively and paste them to screen
No. 3.

(2) Adjust the display position of the pasted (character) string, frame (rectan-
gle), and buttons.

� Modifying to the [Monitor] button

(3) Double click the [Set] button and change the properties as shown below.
Note that other properties must be left unchanged.

General Label � ,Monitor *1

Settings Screen No. 2

*1: Press  to set the label.

(4) Resize the [Monitor] button larger than others.

9-3-10 Creating the Alarm Screen
Create screen No. 4 (new screen) as the Alarm Screen.

(1) Select [Screen] (menu bar) → [New].

(2) At the screen selection dialog box, set “Standard Screen”.

(3) At the new standard screen dialog box, set “4” for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 4.
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Attributes Screen No. 4

History �

Title Alarm Screen

Comment Alarm Screen

Buzzer

Load Local 1 (Keyboard)

System Keypad

Colour Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid �

Snap to Grid �

Creating the screen title ([Alarm Screen])

� Copying the screen title from screen No. 1 (Menu Screen)

(1) Copy the “Menu Screen” character string and its frame (rectangle) on
screen No. 1 and paste them onto screen No. 4.

(2) Adjust the display position of the pasted character string and frame to the
desired position.

� Modifying to [Alarm Screen]

(3) Double click the “Menu Screen” (character) string and modify the properties
as shown below.  Note that other properties must be left unchanged.

Description Alarm Screen

(4) Adjust the size of the frame (rectangle).

Creating the alarm list

� Setting the title

(1) Select [Objects] (menu bar) → [Fixed Display] → [Text].
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(2) Click the mouse with the mouse cursor set at the position where the “Alarm
List” (character) string is to be displayed (at the intended upper left corner of
text).

(3) Set the properties as shown below.

Description Alarm List

Position ––

Font Type Standard

Scale 1�1 (Equal)

Smoothing �

Attribute Standard

Colour Foreground White

Background Black

(4) Adjust the position of the “Alarm List” (character) string on the data creation
screen by dragging it.

� Creating the alarm list

(5) Select [Objects] (menu bar) → [Alarm] → [List].  (Refer to 6-3-1 “Alarm List”.)

(6) Click the mouse with the mouse cursor set at the position where the alarm
list is to be displayed (at the intended upper left corner).

(7) Make the following settings in the dialog box for selecting whether or not the
line scroll touch switches and page scroll touch switches are used.

Create Line Scroll Touch Switch �

Create Page Scroll Touch Switch �

Reference: For NT31, NT31C, NT631, and NT631C, this dialog box is not displayed.  For
these models, create the alarm list and then set whether or not the line/page scroll
touch switches are created in the property settings.

(8) Set the properties as shown below.
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General Position ––

Size ––

Message Length 32

Display Line Qty 8

Scale 1�2 (High)

Smoothing �

Colour Frame White

Back- ON White
ground OFF Black

Image & Library Display ImageLib �

Colour Foreground White

Background Black

Settings List Settings Start Bit Table Entry 0

No. of Bits Referenced 8

(9) Adjust the display position of the alarm list by dragging it.

After that, click on any position in the screen other than the alarm list to cancel the
alarm list selected state (edit state).

� Changing the frame of the line scroll (down) touch switch

(10) Specify the switch at the bottom in the touch switches at the right side of the
alarm list and adjust its size and position (move it to the lowest line in the
alarm list).

(11) Double click the line scroll (down) touch switch and set the properties as
shown below.
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General Position ––

Size ––

Label �, <!FFF9> *1

Frame �

Shape Standard

Show ON State �

Colour Frame White

ON White

OFF Transparent

Settings Function Input Key-Control

Control Key

Light
Function

Address PC (PLC) Ad-
dress

––

I/O Comments ––

Lamp Attribute General Light

*1: Here, the label is not changed.  (If you need to change it, press
 button.)

After completing the setting, go to the next step without clicking on  but-

ton.

Reference: With NT31, NT31C, NT631, and NT631C, the touch switches used to control the
alarm list are a part of the list and their properties, such as the label and the size,
cannot be changed.  Only the position can be adjusted.

(12) Press  in the general property of a touch switch and set the label
properties as shown below.  
Note that other properties must be left unchanged.

Foreground Color Cyan

(13) Adjust the position of the label graphic by dragging it.

� Setting the page down, page up, and line scroll (up) touch switches

(14) Modify the page down, page up, and line scroll (up) touch switches in the
same manner as the line scroll (down) touch switch.
Refer to the screen in P?? to check the position of each touch switch.

Modify the properties of the individual touch switches as shown below.
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Page down Page up Scroll up

General Position –– –– ––

Size –– –– ––

Label �, <!FFF7> �, <!FFF6> �, <!FFF8>

Frame � � �

Shape Standard Standard Standard

Show ON State � � �

Colour Frame White White White

ON White White White

OFF Transparent Transparent Transparent

Settings Function Input
Key-Control

Input
Key-Control

Input
Key-Control

Control Key

Light
Function

Address PC (PLC)
Address

–– –– ––

I/O
Comments

–– –– ––

Lamp
Attribute

General Light Light Light

(15) Modify the foreground color of the label graphic to cyan as with the line scroll
(down) touch switch.

Reference: With NT31, NT31C, NT631, and NT631C, the touch switches used to control the
alarm list can be adjusted only in position.
Size, color, label can not be changed.  If you want to move the position, select [Edit]
(menu bar) → [Edit Object] (or right click → [Edit Object]) and specify the touch
switch.

� Setting for the image/library data display field

(16) Specify the alarm list and select [Edit] (menu bar) → [Edit Object].

(17) Specify the image data display field, displayed at the central left part of the
alarm list, and adjust the size and the position.
(Resize the size to 200 X 200 dots.)
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Creating the [Menu] button, [Monitor] button, and [Set] button

� Copying and pasting the buttons from screen No. 3

(1) Copy the “Switch Screen” (character) string, frame (rectangle), [Menu] but-
ton, [Monitor] button, and [Alarm] button collectively and paste them onto
screen No. 4.

(2) Adjust the display position of the pasted (character) string, frame (rectan-
gle), and buttons.

� Modifying to the [Set] button

(3) Double click the [Alarm] button and change the properties as shown below.

General Label � ,Set *1

Settings Screen No. 3

*1: Press  to set the label.

9-3-11 Creating the Alarm List Library Data
Create the library data which is displayed at the occurrence of an alarm.

Create the library data for FA20 to FA25.  (For the library data creation procedure,
refer to 8–2 “Library Editor”.)

FA20 FA21 FA22

FA23 FA24 FA25

Set line 1. Set line 2. Check torque
screw.

Check pipe and
valve.

Detection near
entry.  Confirm
safety before re-
starting the line.

Check the PC
(PLC) and the
network.

Reference: With NT31, NT31C, NT631, and NT631C, the library data codes are 1000 to 3FFF.
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� Creating the library data of code FA20

(1) Select [Tools] (menu bar) → [Library Editor].

(2) Specify “FA20” in the library table and click on .

(3) Click the library creation area frame (dotted lines) which is displayed at the
upper left area in the library creation screen and drag the point at the lower
right corner.  The mouse cursor position is displayed under the screen;
change the frame size to X=200, Y=200 (size: 200�200).

(4) Select [Objects] (menu bar) → [Fixed Display] → [Text].

(5) Click the mouse at the position where the (character) string is to be dis-
played (at the intended upper left corner of text).

(6) Set the properties as shown below.

Description Set Line 1

Position ––

Font Type Standard

Scale 1�2 (High)

Smoothing �

Attribute Inverse Flash

Colour Foreground White

Background Black

(7) Adjust the “Set Line 1” (character) string display position by dragging it.

(8) After creating the library data of code FA20, click  at the upper right

section in the FA20 library editor to close it.

� Creating the library data of code FA21 to FA25.

(9) Create the library data of code FA21 to code FA25 in the same manner.
If (character) string occupies more than one line, create the (character)
string line by line.

Reference: It is possible to copy library data FA20 to other code so that it can be reused.  Follow
the procedure below.
a. Specify FA20 and select [Copy] by pressing  button.
b. Specify the code to be pasted and select [Paste] by pressing  

button.
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9-3-12 Creating the Pop-up Display Numeric Keys
Create the numeric keys displayed in the pop-up window at screen No. 1900.

Reference: With NT30, 30C, NT620S, NT620C, and NT625C, screen numbers of the screen
where a window/keyboard screen can be created are restricted to 1900 to 1979.
With NT31, NT31C, NT631, and NT631C, however, a window/keyboard screen
can be created for any screen number as with a standard screen (1 to 3999).

Creating the window/keyboard screen

For details of window/keyboard screen, refer to 5-4 “Window/Keyboard Screen”.

(1) Select [Screen] (menu bar) → [New].

(2) At the screen selection dialog box, set “Window/Keyboard Screen”.

(3) At the new standard screen dialog box, set “1900” for the screen No.

Setting the screen properties

(1) Select [Screen] (menu bar) → [Properties].

(2) Set the screen properties as shown below for screen No. 1900.

Attributes Screen No. 1900

History

Title

Comment Pop-up Numeric Keys

Buzzer

Load Local 1 (Keyboard)

System Keypad

Colour Background Black

Grid Grid Size Custom
Horizontal Spacing: 5
Vertical Spacing: 5

Display Grid �

Snap to Grid �
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Creating the screen (numeric keys)

� Creating the [0] key frame

(1) Select [Objects] (menu bar) → [Touch Switch]

(2) Create the outline of the [0] key by dragging the mouse on the data creation
screen.

(3) Set the properties as shown below.

General Position ––

Size ––

Label �, 0 (refer to the
following) *1

Frame �

Shape Standard

Show ON State �

Colour Frame White

ON White

OFF Transparent

Settings Function Input Key-Control

Control Key

Light Address PC (PLC) Address ––
Function I/O Comments ––

Lamp Attrib-
ute

General Light

*1: Press  button to set the label.
After completing the setting, go to the next step without clicking on

 button.
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� Setting the label of the [0] key

(4) Press  buton in the general property of a touch switch and set the
label properties as shown below.
Note that other properties must be left unchanged,

Scale 2�2

Smoothing �

Click on , (returns to touch switch property) then click on 

again.

� Adjusting the size and position of the [0] key

(5) Specify the [0] key and select [Edit] (menu bar) → [Edit Object].

(6) Adjust the size and position of [0] key frame.

(7) Drag [0] to adjust the display position.

Reference: The explanation above described the procedure for creating numeric keys using
the touch switch control code input function.  The Support Tool, however, provides
numeric keys as symbol data and you do not have to create numeric keys by using
the pre-registered numeric keys; in the menu bar, select [Window] → [Symbol
Manager] and drag the numeric keys appropriate for your PT model from the sym-
bol file (Supplmnt.sbl).  The selected numeric keys can be registered on the
screen.  For details, refer to 6-10 “Registering Created Elements (Symbol Manag-
er Operation)”.

� Creating other keys

(8) Copy the [0] key, paste it onto the screen and move the pasted [0] key to the
position of the key to be created ([1] to [↵ ]).
Once the [0] is copied to the clipboard, it remains on the clipboard until the
next cut or copy operation.

(9) Set the properties as shown below for the individual keys.

1 2 3 4 5 6 7

General Label �, 1 *1 �, 2 *1 �, 3 *1 �, 4 *1 �, 5 *1 �, 6 *1 �, 7 *1

Settings Control Key

8 9 . CLR +/– ↑ ↓

General Label �, 8 *1 �, 9 *1 �, . *1 �, CLR
*1

�, +/– *1 �,  *2
<!FFFA>

�,  *2
<!FFFB>

Settings Control Key

↵

General Label �, *2
<!FFFF>

Settings Control Key

*1: Press  button to set the label.

*2: Press  button to set the label.  It is also possible to select a
mark by pressing  button in the label property.
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(10) For the [+/–] key and the [CLR] key, modify the label size to “1�2”.  For other
keys, the label size should not be modified.

(11) Select all the touch switches above.

(12) Select [Centralize Label] from [Draw] menu.
The position of all the labels for the selected touch switch is centralized hori-
zontally.

Creating a temporary input field

(1) Select [Objects] (menu bar) → [Data Input] → [Numeral].

(2) Click the mouse with the mouse cursor set at the position where the data input
field is to be displayed (at the intended upper left corner of numeral input field).

(3) At the cursor moving touch switch use selection dialog box, set the displayed
items as shown below.

Create Cursor Move Touch Switch

Reference: With NT31, NT31C, NT631, and NT631C, this dialog box is not displayed and, ac-
cordingly, the cursor moving touch switch cannot be set at the temporary input
field.  For a temporary input field, the setting of “Create Cursor Move Touch Switch”
is not so significant.  Even with NT20S, NT30, NT30C, NT600S, NT620S,
NT620C, and NT625C, it is not necessary to set this property.

(4) Set the properties as shown below.

General Position ––

Font Type Standard

Scale 2�2

Smoothing �

Attribute Standard

Colour Foreground Black

Background White

Settings Table Entry 10

Display Type Decimal

Format Integer 8

Decimal 0

Settings Limit *1 Maximum 99999999

Minimum 0

Settings Zero Suppression �

Display Sign �

Settings Focus Frame �

Focus Attribute Standard

*1: The setting is not needed for NT31, NT31C, NT631 and NT631C.
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(5) Specify the numeral input field and adjust the position.

Setting the pop-up display range frame

Set the range for pop-up display.

(1) Move the range specifying frame, displayed at the upper left section in the
screen, to the numeric key area and adjust its size so that the keys and tempo-
rary input field are enclosed.

For details of changing the size and the position of pop-up display frame, refer
to “Window/Keyboard Screen”.

9-3-13 Saving the Created Data
(1) Select [File] (menu bar) → [Save As].  (Refer to 4-2-9 “Saving the Screen Data

(Application) to a File”.)

(2) Specify the file name of the file where the created data is saved (example:
SAMPLE.ONW) and click on .
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9-3-14 Downloading to the PT
Setting the PT status control area and PT status notify area

(1) Select [Tools] (menu bar) → [PT Configuration].

(2) Click the [Control/Notify Area] tab and set the properties as shown below.
(For details of Control/Notify area, refer to 3-3-1 “Creating New Screen Data
(Application) File.”)

PT Control Area PC (PLC) Address D00100

Comments Control Area

PT Notify Area PC (PLC) Address D00110

Comments Notify Area

Downloading to the PT

(1) Place the PT in the [transfer mode] by the system menu operation.

(2) At the Support Tool, select [Connect] (menu bar) → [Download (NT-series
Support Tool → PT)] → [Application].

Downloading of the screen data starts.  During screen data download, the
screen as shown below is displayed.

For details of the screen data download, refer to 4-2-12 “Sending (Downloading)
the Data to a PT” and 11-3 “Sending (Downloading) the Data”.
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SECTION  11
Data Communications with a PT

This section describes the procedure for sending the created and edited screen data to a PT to register them in the PT and also the
procedure for reading the data registered in the PT.

11-1 Preparation for Data Communications with a PT and Data Communication Procedure 438. . . . . . 
11-1-1 Connection to PT 438. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-1-2 Available Data Communication Methods by PT Models 439. . . . . . . . . . . . . . . . . . . . . . . . 
11-1-3 Data Communication Procedure 440. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

11-2 Communication Setting at the Support Tool 441. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-3 Sending (Downloading) the Data 442. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-4 Receiving (Uploading) Data 445. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-5 Receiving (Uploading) the History Record 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
11-6 Setting and Reading the Date and Time 449. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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11-1 Preparation for Data Communications with a PT and Data
Communication Procedure

11-1-1 Connection to PT
To send/receive data between a PT and the NT-series Support Tool (personal
computer), connect them with a cable.

� Cable

The recommended communication cable supplied by OMRON has a 25-pin
RS-232C connector at the end for connection to a personal computer.  To con-
nect to a PC/AT compatible personal computer which has a 9-pin (female) con-
nector, use a 25-pin to 9-pin conversion adapter available on the market.

Recommended cable is in the Appendix I.

� Connection

Connect the RS-232C connector at the personal computer to the Support Tool
connection port at the PT.

For the location of the connection port in the PT, refer to the Appendix of the
User’s Manual of the PT.  With some models of PT, it is necessary to disconnect
from the host before connecting the Support Tool.

An example of connection is shown below assuming NT31/NT31C.

RS-232C, 9 pins
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11-1-2 Available Data Communication Methods by PT Models
Data communication is possible by the two methods indicated below.

� Batch transmission of all screen data

� Data transmission in screen and data units (individual transmission)

Whether or not individual data transmission is possible depends on the PT model
as shown below.

PT Model Batch Transmission Individual Transmission

NT11S � �

NT20S � �

NT600S � �

NT30 � �

NT30C � �

NT620S � �

NT620C, NT625C � �

NT31 � �

NT31C � �

NT631 � �

NT631C � �

�: Possible �: Not possible

Reference: The type and content of individual transmission differs between NT20S/NT600S
and NT31, NT31C, NT631, NT631C.  For details, refer to 11-3 “Sending (Down-
loading) the Data” and 11-4 “Receiving (Uploading) Data”.

In case of NT31, NT31C, NT631 and NT631C, screen data file that can be trans-
mitted is as follows depending on the version of PT hardware and the system pro-
gram version installed in a PT.

Use the method below to check the system program version of a PT (For details of
the operation of a PT, refer to the manual of PT).

(1) Display the system menu on a PT.

(2) At the upper right position of the system menu screen, its version is displayed,
like “Ver.2.10”. If you are using NT31, NT31C, NT631 or NT631C, it is also
possible to check the PLC vendor by selecting [Expansion Mode] → [Version
Display].
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Type of PT 
Hardware

NT31, NT31C, NT631, NT631C
without “–V1”

NT31, NT31C, NT631, NT631C
with “–V1”

PT model 
selected at 
Support Tool

System
program
Ver.1.0

System
program
Ver2.0

System
program
Ver2.1

System
program
Ver1.0

System
program
Ver2.0

System
program
Ver2.1

NT31, NT31C, NT631,
NT631C without “–V1” � � � ∆1 ∆1 ∆1

NT31, NT31C, NT631,
NT631C with “–V1” � ∆2 ∆2 � � �

NT31, NT31C, NT631,
NT631C with “(System
Ver.2.1)”

� � ∆2 � � �

� : Downloading/Uploading is possible (Both “Batch Transmission” and “Individ-
ual Transmission” are possible).

�: The message shown below is displayed on transmitting.
Application version mismatched; communication aborted.

∆1: Message warning you about 32 dot font and font type ISO–8859 is displayed
on transmitting. If this combination is selected, 32 dot font and font type
ISO–8859 are displayed on a PT but they are not available on the Support
Tool.

∆2: Message warning you about 32 dot font and font type ISO–8859 is displayed
on transmitting. If this combination is selected, 32 dot font and font type
ISO–8859 are displayed on the Support Tool but they are not available on a
PT (16x16 font and CP437 font type are used on the PT).

Note) If the vendor (manufacturer) of the PLC you are using and the PLC vendor
setting of the created screen data is different, transmission is not possible.
The following message is displayed. 
Memory access mismatched: communication aborted

11-1-3 Data Communication Procedure
The procedure for transmitting data between a PT and the Support Tool is indi-
cated below.

[Setting for communications at Support Tool]

Set the RS-232C port and baud rate at the Support Tool (personal computer).

↓
[Set PC (PLC) to Transmit mode]

Place the PT in the Transmit mode to allow communications of the data be-
tween the PT and the personal computer.

For details of this procedure at PT, refer to the User’s Manual of your PT.

↓
[Selecting the data to be sent/received]

From the menu at the Support Tool, select the direction of data transmission
(download/upload) and the kind of data to be transmitted.  Depending on the
data, more detailed selection may be possible.
After the data has been determined, data transmission will start.
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11-2 Communication Setting at the Support Tool
Set the baud rate and communication port at the Support Tool (personal computer)

Operation procedure

(1) Select [Connect] (menu bar) → [Comms. Setting].

The communication dialog box is displayed.

(2) Set the data for the displayed items.

The meanings of the items are described below.

Item Description

COM Port Specify the RS-232C port to be used.
Specify either “COM1” or “COM2”.

Baud Rate Set the data communication rate.
If “High” is set, high-speed data communication is possible.
(Not available for NT11S.)
It is recommended to specify “Standard” to ensure error-free
communication if a communication error occurs due to an
inadequate communication environment.
Data communication at the “Standard” setting will take
about twice the time required in the “High” setting.

Verify Select this item by setting a check mark in the check box if
you want to check the communication data at the same time
it is transmitted.  Please note that this setting is allowed only
for NT11S, NT20S and NT600S.

(3) After completing the setting for all items, click on .
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11-3 Sending (Downloading) the Data
To send (download) the data created or edited by the Support Tool to a PT, follow
the steps shown below.

The type of data which can be sent is indicated in the table below.

Data Type Description

Application (in file units) All data is sent in batch.

Screen Data is sent in units of a screen.
It is possible to send the data of several screens
at a time.
When sending the data of a parent screen, you
can specify whether or not the data of the child
screens should be sent with the parent screen
data.

Direct Access Information NT20S and NT600S:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area, numeral/character string memory
tables (string tables), etc.

NT31, NT31C, NT631, and NT631C:
Information of the PC (PLC) addresses allo-
cated to PT status control area, PT status
notify area and window control area (models
with “–V1” only).

System Memory* The setting contents of “System” of “PT Configu-
ration” are sent and set at the PT.

Table NT20S and NT600S:
The following data is sent in a batch.

� Numeral memory table data

� Character string memory table (String table) data

� Mark data

NT31, NT31C, NT631, and NT631C:
The following data can be sent individually.
� Numeral memory table

� Character string memory table (String table)

� Bit memory table

� Mark data

� Image data

� Library data

* With NT31, NT31C, NT631, NT631C, individual transmission of the system
memory is not possible.  Therefore, the contents of the following data stored in a
PT can not be overwritten.
� Number of numeral table � Number of string table
� Number of bit memory table � Screen history setting
� Alarm history setting � Numeral storage type
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Reference: � When data is sent from the Support Tool to a PT, the existing data in the PT is lost.
Therefore, make sure that the existing data in the PT is backed up by the Support
Tool before executing data transmission from the Support Tool to the PT.

� With the Support Tool on CD–ROM, NT Transfer Utility which is exclusively used
for downloading/uploading the screen data is supplied (For details, refer to Ap-
pendix C).

Operation procedure

(1) Select [Connect] (menu bar) → [Download (NT-series Support Tool → PT)].

The menu is displayed, allowing you to select the data to be sent.

The items which can be selected vary according to the PT model.

Selection of “Screen” is not possible if screen data is not selected.

(Pressing “Ctrl key + “Shift key” + “D” executes Application downloading.)

(2) Select the data to be sent.

Data transmission timing is determined according to the type of data selected
to be sent.

Data Type Description

Application (in file units) Data transmission starts immediately.

Screen If a parent screen is included in the screens
selected to be sent, a dialog box is displayed
requesting you to specify whether child
screens are sent with the parent screen.
Set a check mark for the “Include Child
Screen” item if you want to send the child
screens with the parent screen.
Data transmission starts when                  is
clicked.

Direct Access Information Data transmission starts immediately.

System Memory Data transmission starts immediately.

Table NT20S and NT600S:
Data transmission starts immediately.

NT31, NT31C, NT631, and NT631C:
The dialog box where the information to be
sent is specified is displayed.
Only the information for which a check
mark is set is sent.
Data transmission starts when 
is clicked.

(3) Place the PT in the Transmit mode so that the data sent from the Support Tool
can be received.

If the PT is not in the Transmit mode, a “timeout error” occurs in about 10 sec-
onds at the Support Tool.  In this case, set the PT in the Transmit mode and
click on  in the error message dialog box.
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(4) While the data is being sent to the PT, the progress of data transmission is
indicated by a bar graph.

To abort the operation, click on .

Reference: If data transmission is aborted, it is necessary to initialize the image data memory
in the Maintenance mode (System Menu).  Execute the same processing if data
transmission is interrupted due to trouble.

When sending all the screen data (Application), initialization is not necessary since
initialization is automatically executed.

CAUTION

When transferring the data in units of screens, if there are changes in

memory table and /or direct access, transfer such data along with the

screen data. 

Otherwise the system may operate unpredictably.
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11-4 Receiving (Uploading) Data
To receive (upload) data stored in a PT at the Support Tool as the screen data be-
ing edited, follow the steps shown below.

The type of data which can be received is indicated in the table below.

Data Type Description

Application (in file units) All data is sent in batch.

Screen Data is received in units of a screen.
It is possible to receive the data of several
screens at a time.
When receiving the data of a parent screen, you
can specify whether or not the data of the child
screens is to be received with the parent screen
data.

Direct Access Information NT20S and NT600S:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area, numeral/character string memory
tables (string tables), etc.

NT31, NT31C, NT631, and NT631C:
Information on the PC (PLC) addresses allo-
cated to the PT status control area, PT status
notify area and window control area (models
with “-V1” only).

System Memory* The contents of “System” set at the PT are re-
ceived and set for “System” of “PT Configura-
tion”.

Table NT20S and NT600S:
The following data is received in a batch.

� Numeral memory table data

� Character string memory table (String table) data

� Mark data

NT31, NT31C, NT631, and NT631C:
The following data can be received individually.
� Numeral memory table data

� Character string memory table (String table) data

� Bit memory table data

� Mark data

� Image data

� Library data

* With NT31, NT31C, NT631, NT631C, some of the individual transmission of the
system memory is restricted.  The contents of the folowing data stored in the
Support Tool can not be overwritten.
� Numeral table � String table
� Bit memory table
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Reference: � When the Support Tool receives data from a PT, the data being edited at the Sup-
port Tool is lost.  Therefore, make sure that the edit data is saved in a file before
executing data receiving from the PT to the Support Tool.

� With NT31, NT31C, NT631, NT631C, individual uploading of table is possible.
However, it may take time to upload bit memory table.  In this case, perform batch
transmission of the application (in file units).

� With the Support Tool on CD–ROM, NT Transfer Utility which is exclusively used
for downloading/uploading the screen data is supplied (For details, refer to Ap-
pendix C).

Operation procedure

(1) Select [Connect] (menu bar) → [Upload (PT → NT-series Support Tool)].

The menu is displayed, allowing you to select the data to be received.

The items which can be selected vary according to the PT model.

(Pressing “Ctrl key” + “Shift key” + “U” executes Application uploading.)

(2) Select the data to be received.

The data receiving timing is determined according to the type of data selected
to be received.

Data Type Description

Application (in file units) Data receiving starts immediately.

Screen If a parent screen is included in the screens
selected to be received, a dialog box is dis-
played requesting you to specify whether
child screens are to be received with the
parent screen.
To specify multiple screens in batch, specify
the screen numbers in the manner “1, 3 - 5,
7”, delimiting them with commas “,” and  hy-
phens “–”.
Set a check mark for the “Include Child
Screen” item if you want to receive the child
screens with the parent screen.
Data receiving starts when                   is
clicked.

Direct Access Information Data receiving starts immediately.

System Memory Data receiving starts immediately.

Table NT20S and NT600S:
Data receiving starts immediately.

NT31, NT31C, NT631, and NT631C:
The dialog box is displayed where the in-
formation to be received is specified.
Only the information for which a check
mark is set is received.
Data receiving starts when                   is
clicked.
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(3) Place the PT in the Transmit mode so that the data can be transmitted to the
Support Tool.

If the PT is not in the Transmit mode, a “timeout error” occurs in about 10 sec-
onds at the Support Tool.  In this case, set the PT in the Transmit mode and
click on  in the error message dialog box.

(4) While the data is sent from the PT, the progress of data transmission is indi-
cated by a bar graph.

To abort the operation, click on .



448

Receiving (Uploading) the History Record Section 11-5

11-5 Receiving (Uploading) the History Record
It is possible to receive (upload) the display history record data and the alarm histo-
ry record data, recorded in a PT, at the Support Tool to save them in a file.

The type of history record data which can be received is indicated in the table be-
low.

PT Model Screen Display 
History Record Data

Alarm History 
Record Data

NT11S, NT20S � �

NT30, NT30C, NT600S,
NT620S, NT620C, NT625C � �

NT31, NT31C, NT631, NT631C � �

The received history record data is saved in a desired folder by assigning a file
name.  The extension of the file name is fixed as “.LOG”.

Since the file is described in a special format, the contents cannot be read using
Windows 95/98 general application tools.

Reference: The history record data file (.LOG) can be output to a printer, saved in an RTF file,
or output to the screen, using the [Print] function or the [Print Preview] function of
the Support Tool.

To analyze the history record data using other software, convert the file into an RTF
file so that it can be read by other software.

Operation procedure

(1) Select [Connect] (menu bar) → [Get History Log].

The menu is displayed, allowing you to select the history record to be re-
ceived.

The items which can be selected vary according to the PT model.

(2) Select the history record to be received.

The dialog box for setting the file name for saving the history record is dis-
played.

(3) Set the folder and file name where the history record is to be saved and click
on .

Receiving of the history record data starts.

(4) Place the PT in the Transmit mode so that it can send the data to the Support
Tool.

If the PT is not in the Transmit mode, a “timeout error” occurs in about 10 sec-
onds at the Support Tool.  In this case, set the PT in the Transmit mode and
click on  in the error message dialog box.

(5) While the data is sent from the PT, the progress of data transmission is indi-
cated by a bar graph.

To abort the operation, click on .
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11-6 Setting and Reading the Date and Time
It is possible to set the date and time to PT from the Support Tool or to read the date
and time from the PT to display them at the Support Tool.

The functions which can be used are indicated below.

PT Model Setting Date/Time Reading Date/Time

NT11S, NT20S, NT600S � �

NT30, NT30C, NT620S,
NT620C, NT625C � �

NT31, NT31C, NT631, NT631C �* �*

*: PT has the clock function.  For displaying and setting the date/time at a PT, use
the System Menu.

Operation procedure

(1) Select [Connect] (menu bar) → [Date and Time].

The date and time dialog box is displayed.

[Current Date & Time]

Displays the date and time at the time the dialog box is displayed.

[Date]

This area is used for sending/receiving date data to/from a PT.

To set the date at a PT, set “Year, Month, Day, and Day of Week” here and
execute sending (downloading).

Click the  button to download it to the PT.

To read the date data of a PT, execute receiving (uploading) and the result is
displayed here.

Click the  button to upload it from the PT.

At first, the same contents as displayed at [Current Date & Time] are dis-
played.
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[Time]

This area is used for sending/receiving the time to/from a PT.

To set the time at a PT, set “Hour, Minute, and Second” here and execute
sending (downloading).

Click the  button to download it to the PT.

To read the time data of a PT, execute receiving (uploading) and the result is
displayed here.

Click the  button to upload it from the PT.

At first, the same contents as displayed at [Current Date & Time] are dis-
played.

Used to download the date and time data, set at [Date] and [Time], to a PT to
set them.

Used to upload the date and time data in a PT and display them at [Date] and
[Time].

(2) To set the date and time at a PT, set the data at [Date] and [Time] and click on
.

To read the date and time of a PT, click on .

Data transmission starts when  or  is clicked.

(3) Place the PT in the Transmit mode so that communications between the Sup-
port Tool and the PT are enabled.

If the PT is not in the Transmit mode, a “timeout error” occurs in about 10 sec-
onds at the Support Tool.  In this case, set the PT in the Transmit mode and
click on  in the error message dialog box.

(4) In the case of receiving (uploading), the date and time data which have been
read from the PT are displayed at [Date] and [Time].
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SECTION  12
Making Reports

The Support Tool provides a function for displaying various kinds of data, such as screen data and memory table use status, in
the form of a list, and printing them.

12-1 Report Types 452. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-1 Cross-Reference 453. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-2 Direct Connection Information 454. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-3 History Report 455. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-4 Image/Library Report 455. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-5 Mark List 456. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-6 Screen Image 457. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-7 Screen List 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
12-1-8 Table Report 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

12-1-9 Validation Report 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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12-1 Report Types
The Support Tool outputs the following types of report.

� Cross-Reference

� Direct Connection Information

� History Report

� Image/Library Report

� Mark List

� Screen Image

� Screen list

� Table Report

� Validation Report

Output of these reports can be selected from the following three types (use [Print
Preview] for outputting to the display).

Printer:

Screen image, setting data, etc. are output to a printer.

Rich Text Format (file):

Various setting data, etc. are output to a file in RTF.

Display (print preview):

Screen image, setting data, etc. are displayed on the screen before output
to a printer.

The screen image can be output to a file in bit map format using [Screen] (menu
bar) → [Copy to Image].  (Refer to 12-4 “Outputting the Screen Image”.)
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12-1-1 Cross-Reference
The use statuses of memory tables such as numeral memory tables and character
string memory tables (string table) are printed or displayed.

The cross-reference allows you to find the screens where a specific memory table
is used.
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12-1-2 Direct Connection Information
Direct connection information is printed or displayed.

This report is available only when the direct connection setting data has been set.
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12-1-3 History Report
By specifying the display history record file or the alarm history record file, sent
from a PT, the history record data can be printed or displayed.

The history record which can be read by the Support Tool depends on the PT mod-
el as shown below (refer to 11-5 “Receiving (Uploading) the History Record”).

NT30, NT30C, NT600S, NT620S, NT620C, NT625C

� Screen display history record

NT31, NT31C, NT631, NT631C

� Screen display history record

� Alarm history record

[Screen History Report]  98/05/01 12:51 P.455

[Screen History of Occurrence]
Screen No   Month  Day  Hour  Minute  Comments                  
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2           
1                  4          15    19       58        HISTORY TITLE             
2                  4          15    19       58        HISTORY TITLE 2

[Screen History of Frequence]
Screen No  Count  Comments                  
1                10         HISTORY TITLE             
2                10         HISTORY TITLE 2           

12-1-4 Image/Library Report
A list of the image data and the library data is printed or displayed.

Type     Code   Compression   Colour Mode     Size     Comments                              
Image    1         Yes                   8 Colours          64x48                                          
Image    2         Yes                   8 Colours          64x48                                          
Library  1000      –                   –                        200x200                                        
Library  1001      –                   –                        200x200                                        
Library  1002      –                   –                        200x200                                        
Library  1003      –                   –                        200x200                                        
Library  1004      –                   –                        200x200                                        
Library  1005      –                   –                        200x200                                        

[Image/Library List]  .rtf   98/04/30 22:01 P.455
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12-1-5 Mark List
A list of mark data is printed or displayed.

[Mark List]  98/04/30 22:01 P.456

Reference: In the case that the font size for Display Properties of Control Panel is set to large
font, it may be printed while part of mark list is being chipped off.  When it occurs,
please select [Start] – [Settings] – [Control Panel], then open the Display Proper-
ties and set the font size in Setting to small font, and perform the mark list printing
(displaying).
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12-1-6 Screen Image
The screen image and the setting contents of a screen are printed or displayed (to
print the screen image, add [Screen Image] to the simultaneously printed items.
With the default status, check mark is set).

You can select whether or not to inverse screen image for printing.
It is also posible to select whether or not to include screen grid or dotted line frame
for string display etc. for printing (P461).

Reference: It is possible to save each screen image to a bit map file.  In this case, open the
screen to be saved and select [Screen] - [Copy to Image].  The saved screen
image can be edited using the application software such as “Paint”.

Screen No.:  1 Standard Screen
Screen Comment:  Menu Screen

 

[Fixed Display: Rectangle/Square]
Start Pos  End Pos    FrGnd Colour   BkGnd Colour   Attribute     
 10,  10    204,  59     White               Transparent       Standard      

[Fixed Display: Text/Mark]
Position   Font          Scale       Smoothing  Attribute     FrGnd Colour  BkGnd Colour  Description
 20,  15   Standard       2x2            Yes            Standard    White              Transparent      Menu Screen
    

[Touch Switch Display]
Start Pos  End Pos    Function                    Frame             Disp SPos  Disp EPos  Attr Pos  Lamp Bit   
On State  Attribute     Frame Col  Off Col      On Col     Flash Col  Label Pos     Font        Scale   Smoothing
 Attribute     Label Fg Col  Label Bg Col  Label On Col  Label                
181, 141   500, 200   Switch Screen No. 2    3–Dimension   181, 141   500, 200    –        –––––––
No             Light           White      Transparent   White       White        230, 155      Standard   2x2         Yes
  tandard      White              Transparent   –             Monitor Screen       

181, 221   500, 280   Switch Screen No. 3     3–Dimension    181, 221   500, 280   –       –––––––    
Yes            Light            White       Transparent    White       Whit        265, 235     Standard    2x2         Yes 
Standard    White               Transparent   –             Set Screen           

181, 301   500, 360   Switch Screen No. 4   3–Dimension   181, 301   500, 360   –         –––––––    
Yes            Light            White      Transparent     White      White       250, 315      Standard    2x2         Yes
    Standard      White           Transparent   –              Alarm Screen         

[Fixed Display: Rectangle/Square]
Start Pos  End Pos    FrGnd Colour   BkGnd Colour   Attribute     
 10,  10      204,  59    White                Transparent       Standard      

[Fixed Display: Text/Mark]
Position   Font          Scale       Smoothing  Attribute       FrGnd Colour  BkGnd Colour  Description
 20,  15   Standard      2x2          Yes              Standard     White                Transparent     Menu Screen
                                                     

[Touch Switch Display]
Start Pos  End Pos    Function                           Frame               Disp SPos  Disp EPos  Attr Pos  Lamp Bit   
On State  Attribute  Frame Col  Off Col        On Col     Flash Col    Label Pos  Font              Scale     Smoothing
 Attribute     Label Fg Col  Label Bg Col  Label On Col    Label
181, 141   500, 200   Switch Screen No. 2        3–Dimension   181, 141   500, 200     –           –––––––    
No            Light        White         Transparent  White       White         230, 155   Standard        2x2          Yes
Standard      White           Transparent      –                      Monitor Screen       

181, 221   500, 280   Switch Screen No. 3         3–Dimension   181, 221   500, 280   –            –––––––    
Yes           Light         White         Transparent  White      White         265, 235   Standard        2x2          Yes
 Standard      White             Transparent     –                   Set Screen           

181, 301   500, 360   Switch Screen No. 4         3–Dimension    181, 301   500, 360   –         –––––––    
Yes            Light         White        Transparent   White       White        250, 315   Standard       2x2         Yes
 Standard        White             Transparent     –                Alarm Screen         



458

Report Types Section 12-1

12-1-7 Screen List
Screen numbers and comments are printed or displayed.

12-1-8 Table Report
The setting contents of memory tables are printed or displayed.

12-1-9 Validation Report
The results of an error check on the setting contents are printed or displayed.

The contents to be printed or displayed are the same as in the error display dialog
box.

Reference: When printing the validation report after executing the error check, a confirmation
message requesting you to confirm if you want to print the report after executing
the error check is displayed since this processing takes a long time.
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12-2 Printing Reports
This section describes the procedure for printing reports (screen data, memory
table use status, etc.) using a printer.

12-2-1 Printer Setting
To print a report using a printer, it is necessary to set the type of printer and print
mode.

To set the printer information, display the Print Setup property by selecting [File]
(menu bar) → [Print Setup].

Printer: Set the information of the printer you are going to use.

Name: Specify the printer by selecting the printer name from the list of
registered printer names.

Status: Displays the status of the selected printer, and the number of
files in the queue.

Type: Displays the name of the driver which is set for the selected
printer.

Where: Displays the name of the port which is set for the selected printer.

Comment: Displays the comment which is set for the selected printer.

Paper: Set the paper size and the paper tray.

Size: Set the size of paper to be used.

Source: Set the paper tray to be used.

Orientation: Set the direction of printing paper.

Portrait: Specify this item if the data is to be printed parallel to the shorter
dimension of the paper.

Landscape: Specify this item if the data is to be printed parallel to the longer
dimension of the paper.

[Properties]: Used to set the printer properties.

Since the setting differs according to the printer, refer to the manual of the printer
driver.

Reference: If the print setup, print, or print preview has been executed under condition that no
printer driver has been installed, there may be times Support Tool does not move
correctly.
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12-2-2 Output to a Printer
To output the report to the printer, follow the procedure shown below.

(1) Select [File] (menu bar) → [Print].
The Reports dialog box is displayed. (page 461)

(2) Set “Printer” for [Destination].

(3) To specify the printing position of the paper, click on [Set Margins ..] button.
The Set Margins dialog box is displayed.
After setting the items in this dialog box, click on .  The Reports dia-

log box is displayed again.

(4) To set the header/footer, click on the [Header/Footer] button.
The Header and Footer dialog box is displayed.
After setting the items in this dialog box, click on .  The Reports dia-

log box is displayed again.

(5) After completing the setting, click on  in the Reports dialog box.

The Print dialog box is displayed. (page 465)
Set the print range and the number of copies.

(6) After completing the setting, click on  in the Print dialog box.

Printing starts.

[Print]

[Reports]

[Set Margins]

[Header and Footer]
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Reports dialog box

In this dialog box, the contents of printing, and printing header/footer, are set.

Report Type: Select the type of report to be printed.

Destination: Specify the destination of report output.

Printer: The report is output to the printer.
Rich Text Format: The report is output to a file.

Header: Specify this item to attach the header.
The contents of header can be specified by pressing .

Footer: Specify this item to attach the footer.
The contents of footer can be specified by pressing .

� Specification of “Screen Image”

If you specify “Screen Image” for [Report Type], a dialog for setting and selecting
the range and print items is displayed.

Screen Image Attribute

Inverse Print: Specify this item when you want to inverse
black and white for printing. 
When this item is selected, the screen image
will be monochrome even when color–printer is
used. With the color–type PT, the screen image
will be turned to gray and the screen will be in-
verse for printing.

Hide Screen Grid: Specify this item when you do not want to in-
clude screen grid for printing. With the default
status, check mark is set. If it is unchecked, the
grid is printed according to the grid setting of
each screen’s property.
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Show Dotted Line Frame: Specify this item when you want to include the
dotted line frame for the following objects.
� Dotted line frame indicating the position of

string input and string display
� Dotted line frame indicating the touch sens-

ing area of touch switch
� Dotted line frame indicating the display posi-

tion of image/library data of an image lamp
(The status of an image lamp to be printed
depends on the [Simulate ON/OFF] setting
of [View] menu. With lamp ON status, dis-
play position of image/library data for OFF
state is shown with the dotted line frame and
with lamp OFF status, display position of
image/library data for ON state is shown with
the dotted line frame.)

Screen: Specify the screen to be printed.

All: Select this item to print all screens.

Range: Select this item if you want to print only specified screens.
Specify the screen numbers using a comma (,) as a delimiter.
By joining two page number with a hyphen (–), you can specify
the range.  (“5 - 12”, for example, indicates the range from screen
No. 5 to screen No. 12.)

Include: Specify the items to be printed.
It is possible to select all items.

Screen Image: Specify this to print the screen image.

Screen Information: Specify this to print the detailed screen setting
information.

Lamp/Touch Switch Number:
Specify this when there is a lamp and/or touch switch
on the screen and you want to print the allocated bit 
number of a lamp and/or touch switch.  Usually in the
case of a touch switch, the allocated bit number 
specified when setting a lamp is printed.  If the notify
bit function is set, however, the notify bit number is
printed.

Memory Table Number: Specify this when there is a (character) string dis-
play, numeral display, bar graph, and/or input
setting element on the screen and if you want to
print the element with the set memory table num-
ber.

Image/Library Number: Specify this when there is image data display
and/or library data display on the screen and you
want to print the displayed data with the image/li-
brary code number.
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� Specification of “History Report”

If you specify “History Report” for [Report Type], you are requested to specify the
file name where the display history record data sent from the PT is stored.

� Specification of “Validation Report”

If you specify “Validation Report” for [Report Type], you are requested to specify
whether an error check is to be executed and then the result of the check is to be
printed or the present error log information is to be printed.

If an error check is executed, the existing error log is lost.  To keep the record on
the error for which the message is displayed like after the conversion, select
“Print Current Error Log Window”.

To print the result of error check, click on  after selecting “Print After

Validation”.  A message asking if you want to execute an error check is dis-
played.  The time necessary for error check execution varies depending on the
registered screen data.

Reference: � Printing information on errors occurring during data conversion
The procedure for printing information on errors occurring during data conver-
sion is shown below.

(1) Data of NT-series Support Tool

� Open the source file.

� Select [Tools] → [PT Configuration] and specify the PT model (conversion
destination).

� Execute data conversion.

Data of DOS version

� Specify the file using [File] → [Import].

� Execute data conversion.
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(2) If an error occurs, the message “Application conversion has resulted some
messages in Error Log.” is displayed.
Click on .

(3) Select [View] → [Error Log] to display the error log.

(4) Select [File] → [Print] and set the properties as shown below.

� Report Type: Validation Report

� Destination: Printer, or Rich Text Format

� Screen: Print Current Error Log Window

For details of data conversion, refer to Appendix A “Data Conversion”.

Setting margins

Specify the margins to define the print area.
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The units for dimensions can be selected between “cm” and “inch”.

Setting footer and header

Specify contents of header and footer to be printed.

The header/footer print position can be set as “Left”, “Center”, or “Right”.
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Left Center Right

Footer

Header

Left Center Right

Page numbers, date, time, and file name can be printed automatically.
To select the item to be printed as a header or a footer, move the cursor to the print
location and click on the corresponding button ( , , ,

).
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Print dialog box

Printer: Set the printer to be used.

Range: Specify the pages to be printed.

All: All pages are printed.

Pages: Only the specified pages are printed.
The pages to be printed are specified as a range.

The pages to be specified here are actual print pages and it must be
taken into consideration that one screen data does not always corre-
spond to one print page.  If you want to print the screens partially, use
the “Print Preview” function to check the correspondence between
pages and screens to specify pages.

Print to File: Specify this item to output the contents to be printed to a file.  The
file format differs depending on the printer used.
After setting a check mark in the check box, click on :

the file name setting dialog box is displayed.

Copies: Specify the number of copies to be printed.

Number of copies: Set the number of copies.

Collate: Specify if the same page is printed in a group when printing multiple
copies.  (The same page is printed in a group if a check mark is set
in the check box.)

12-2-3 Output to a File (RTF)
Reports can be output to a file in the rich text format.

The operation for outputting the reports to a file is basically the same as that for
printing them.

Reference: The rich text format is a file format used for document data; in this file format, infor-
mation such as characters and indents is retained.  The data saved in this format is
highly interchangeable among Windows 95/98 applications.

Operation procedure to output to a file is shown below:

(1) Select [File] (menu bar) → [Print].
The Report dialog box is displayed.  (page 461)

(2) Set “Rich Text Format” for [Destination].

(3) To specify the print position of the paper, click on [Set Margins ..].
The Set Margins dialog box is displayed.
After setting the items in this dialog box, click on .  The Reports dia-

log box is displayed again.
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(4) To set the header/footer, click on the [Header/Footer].
The Header and Footer dialog box is displayed.
After setting the items in this dialog box, click on .  The Reports dia-

log box is displayed again.

(5) After completing the setting, click on  in the Reports dialog box.

[Reports]

If you click on  in the Reports dialog box, the dialog box used to specify

the report output file is displayed.  Specify the file name and click on , then
the report is output to a file.

For details on operations at the Reports dialog box, the Set Margins dialog box,
and the Header and Footer dialog box, refer to 12-2-2 “Output to a Printer”.
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12-3 Displaying the Print Image (Preview)
Before printing a report, it is possible to visually check the print image on the
screen.

The procedure for displaying the print image is basically the same as that for out-
putting the report to a printer.

Operation procedure to display the print preview is shown below:

(1) Select [File] (menu bar) → [Print Preview].
The Reports dialog box is displayed.

(2) To specify the print position of the paper, click on [Set Margins ..].
The Set Margins dialog box is displayed.
After setting the items in this dialog box, click on .  The Reports dia-

log box is displayed again.

(3) To set the header/footer, click on the [Header/Footer].
The Header and Footer dialog box is displayed.
After setting the items in this dialog box, click on .  The Reports dia-

log box is displayed again.

(4) After completing the setting, click on  in the Reports dialog box.

For details, Reports dialog box, the Set Margins dialog box, and the Header and
Footer dialog box, refer to 12-2-2 “Output to a Printer”.

The operation procedure at the preview screen is shown below.

Print: Specify this item to output the data to the printer.

Next Page: Specify this item to display the next page.

Prev Page: Specify this item to display the previous page.

Two Page: Specify this item to display two pages on the screen.

Zoom In: Specify this item to enlarge the displayed image.

After moving the  cursor to the desired position, click the
mouse and the specified area is enlarged.

Zoom Out: Cancels the enlarged display mode.

Close: Closes the print preview screen.



468

Outputting the Screen Image Section 12-4

12-4 Outputting the Screen Image
It is possible to output only the data creation screen in the bit map format.

The output data can be used in other applications to be displayed or printed.

The operation procedure for outputting the screen image is shown below.

(1) Display the screen to be output at the front.

(2) Select [Screen] (menu bar) → [Copy to Image].
The file name setting dialog box is displayed.

(3) Specify the folder and file name and click on .

Reference: The screen image of the editing screen is saved in the bit map file without change.
If you want to save an inversed image to a file, select [ File] - [Print] and set “Screen
Image” for “Report Type” and “Rich Text Format” for “Destination”, set a check
mark for “Inverse Print”and output it.  (refer to 12–2–3)
If you use this method, the screen image will be monochrome even when the col-
or–printer is used.
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This section provides reference information on using the Support Tool, information on the operational procedure for the system
installer which is supplied with the Support Tool.  Please refer to the information that you need.
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APPENDIX  A
Data Conversion

This section describes the data conversion method between different direct access
types and different PT models.

In the following explanation, NT20S, NT30, NT30C, NT600S, NT620S, NT620C,
and NT625C are referred to as “conventional models” and NT31, NT31C, NT631,
and NT631C (including models with “-V1”) are referred to as “new models”.

Direct Access Types
Direct access type can be set at “PLC Vendor” of “PT Type (PT Configuration)”.
Changing PLC vendor of existing screen data changes direct access type.
The direct access types which can be handled by the Support Tool (Ver. 3.�) are
as follows.

OMRON : This is a direct access for OMRON  PLCs

Memory Link : This is a simulative direct access with which host and PT 
execute sending or receiving of command via RS-232C/422A
communication.

Mitsubishi A : This is a direct access for Mitsubishi A series PLC.

Mitsubishi FX : This is a direct access for Mitsubishi FX series PLC.

Memory Link, Mitsubishi A and Mitsubishi FX can be set only with NT31, NT31C,
NT631 and NT631C with “-V1”.

Reference: � The direct access version which can be handled by the Support Tool is:

NT20S, NT600S: Ver. 5

Conventional models other than NT20S, NT600S: Ver. 4

New models: No direct access versions

� Depending on the direct access types, exclusive system program may be need-
ed for the PT hardware.
For details of the system programs and system installer, refer to Appendix B
“System Installer Operation”.

� To create screen data to be used for direct access (PLC vendor) other than OM-
RON, Memory Link, Mitsubishi A and Mitsubishi FX, use system installer of DOS
version.

Conversion between different direct accesses (PLC vendor)

With the Support Tool (Ver. 3.2), data conversion between different direct ac-
cesses such as OMRON→Mitsubishi A or Mitsubishi FX→OMRON is possible.

However, data conversion between different direct accesses is limited to data of
the same PT model. (e.g. Between NT31-V1 data for OMRON and Mitsubishi A)

When both direct accesses and PT model are different, convert data to that of the
same PT model first (see figures in next page) and then convert the direct access
type.
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Conversion between conventional PT models (Between same direct access)

NT620C/NT625CNT620S NT30CNT30

NT600S NT20S

Conversion from conventional PT model to new PT model (Between same direct access)

NT620C/NT625CNT620SNT30C

NT31 (–V1)

NT30

NT31C (–V1) NT631 (–V1) NT631C (–V1)

Conversion between new PT models (Between same direct access)

NT631

NT31

NT631C

NT31C

NT631–V1

NT31–V1

NT631C–V1

NT31C–V1

NT631–V1

NT31–V1

NT631C–V1

NT31C–V1

System Program Ver.2.0 System Program Ver.2.1

Data can be converted from the PT models without “-V1” to those with “-V1” freely
regardless of the PT models.

It is possible to convert the screen data for the lower system program version to
that for the higher system program version freely regardless of the PT models.
However, conversion towards the opposite direction is not possible (ex. PT models
with V1 → PT models without –V1 or higher system program version → lower sys-
tem program version).
When the PT models with the large screen size are converted to those with the
smaller screen size (ex. NT631 → NT31), the elements exceeding the screen size
after conversion are deleted.
Note that when the screen data is converted, user group and grid information will
be lost.

Reference: The data conversions shown above indicate the conversion of entire screen data
files.

If an element registered to the symbol manager is registered for a screen of anoth-
er PT model, the data is converted.  In this case, conversion is performed in ele-
ment units.  For data conversion in element units, the restrictions shown above are
not applicable and element data can be converted between any combination of PT
models.

Data Conversion Procedure
The data conversion procedure is shown below.

(1) Open the existing screen data file.

Open the existing screen data file, which is the source for data conversion.

If the data has been created using the DOS version Support Tool, select [File]
(menu bar) → [Import] in the Support Tool screen to open the file.

For details of the operation, refer to 3-3-2 “Reading the Existing Screen Data
(Application) File” or 3-3-5 “Importing (Reading) the DOS Version Screen
Data (Application) File”.
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(2) Convert the data.

At the Support Tool, select [Tools] (menu bar) → [PT Configuration], then se-
lect the [PT Type] tab.  Select the conversion destination PT model or PLC
Vendor (refer to P48 “Dialog Box Settings in the PT configuration”.).

Click on , and the data conversion confirmation message is dis-

played.  Click on  again to execute data conversion.

� NT11S cannot convert to other model from [PT Configuration].  If you want,
please use symbol manager to convert to other model.

Reference: After converting the screen data, there might be some messages in the error log.
This error messages will disappear when the screen data has been edited.  
Especially for the converting errors, it is not possible to reproduce these errors
even if the error check (Validation) has been performed.  So soon after the convert-
ing error occurs, it is recommended to perform “Print Current Error Log Window”.
The operation for this, refer to 12–2 “Printing Reports”.

(3) Change the allocated bits and words

If necessary, change the allocated bits and words.

Usually, it is not necessary to change the allocated bits and words since their
settings in the conversion source data are reflected in the converted data.
However, if the data is converted from NT31, NT31C, NT631, or NT631C to a
conventional model in element units, or if the data is converted between differ-
ent direct access types, modification of the allocated bits and words may be-
come necessary since the range of usable channels and word numbers differ .
For details, refer to “Correcting the PC (PLC) addresses” (page 474).

(4) Correct the screen data

If the data is converted from a PT model to another PT model which has small-
er screen than the source PT model, it is necessary to modify the screen data
in accordance with the screen size.

If data is converted between a conventional model and a new model, the data
must be corrected in accordance with the conversion destination because
there are many differences between a conventional model and a new model.

Refer to page 473.

(5) Modify the program.

If the screen data is corrected, the program at the host may have to be modi-
fied.  Modify the program by referring to “Correcting the Screen Data Conver-
sion” (page 473).
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Correcting the Screen Data Conversion
This section describes how the screen data should be corrected after it has been
converted.

If the screen data cannot be converted correctly, an error message is displayed on
conversion of the data (when changing a PT model or PLC Vendor, or registering a
symbol from the symbol manager).  If an error message is displayed, it will be nec-
essary to correct the screen data or the program.

Correcting colors

� Conversion from monochrome display models to color display models

Colors (black and white) remain as they are after the conversion.

If you want to color the converted data, change or color the data as needed.

� Conversion from color display models to monochrome display models

Colors are converted into black or white as shown below.
Colors for objects other than Image

Black, blue, red, magenta: Black

Green, cyan, yellow, white: White

Colors for Image

Black: Black

Blue, red, magenta, green, 
cyan, yellow, white: White

Change the colors as needed.

Correctiong the PLC addresses (On data conversion between direct accesses)
When converting the data between different direct accesses, it may be necessary
to change channels and word numbers of PLC address since corresponding PLC
is changed. In this manual, conversion between OMRON and MEMLINK is de-
scribed.
� Difference

OMRON: Various channels are available such as CIO area (CH)
and data memory area.
Available word numbers differ depending on the PLC
 which is used.

MEMLINK: Only memory link area (PT memory) can be used.
Available word numbers: 0000–9999

� Conversion result, error message and corrective action.

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With “OMRON”
data, area other than
CIO area (CH) is
set.

The PLC address is
reset.

PLC address (XXX)
of YYY is invalid. It
is reset to default.

Reset the area to
memory link area (PT
memory). If this PC
(PLC) address is referred
to from the program, it is
necessary to correct the
program accordingly.
(Refer to 6-1-10)
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Correcting the PC (PLC) addresses (On data conversion between PT models)

When converting the data of the entire screen data file, screen data for use with
new models cannot be converted to screen data for use with conventional models.
However, if the data of a new model is registered for the screen of a conventional
model using the symbol manager, the following points must be taken into consider-
ation due to differences in the usable PC (PLC) address range between a conven-
tional and a new model.

� Difference

New models: Word numbers can be handled up to five digits.

Conventional models: Word numbers can be handled up to four digits.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model,
word numbers are
within four digits.

With a conventional
model, word num-
bers remain as they
were.

–– ––

With a new model,
the word number is
five digits.

The word number is
reset.

Invalid PC (PLC) ad-
dress. It is reset to
default.

Reset the word number
to a number of four or
less digits.  If this PC
(PLC) address is referred
to from the program, it is
necessary to correct the
program accordingly.
(Refer to 6-1-10.)

Correction related to continuous screens

When the data of a conventional model is converted into data for a new model, an
error may occur due to differences in the handling of continuous screens between
conventional models and new models.

� Difference

New models: Continuous screens cannot be used.

Conventional models: Continuous screens can be used.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With conventional
models, continuous
screens are used.

The continuous
screen (parent
screen) is deleted.

The screen no.
XXXX was a Contin-
uous Parent Screen
which is not sup-
ported in this model.
It is discarded.

Use a touch switch to
switch screens.  If the
program is created to
display the parent screen
of continuous screens,
correct the program so
that the first child screen
is displayed.  (Refer to
6-8-2.)
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Correction related to overlapping screens

When an overlapping screen is converted, an error may occur due to differences in
the handling of overlapping screens between conventional models and new mod-
els.

� Difference

New models: A window/keyboard screen cannot be specified as a
child screen.

Conventional models: A window/keyboard screen can be specified as a child
screen.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, a window/
keyboard screen is
specified as a child
screen.

With a new model, a
window/keyboard
screen is removed
from child screens.

The screen no. XXX
of type YYY is not
supported as a child,
so the parent-child
association is dis-
carded.

Copy the contents of the
window/keyboard screen
to a standard screen and
specify that standard
screen as a child screen.
(Refer to 5-3-2.)

Correction related to number of window/keyboard screens to be opened

When a window/keyboard screen is converted, conversion is executed as shown
below due to differences in number of window/keyboard screens which can be dis-
played at the same time.

� Difference

New models (with “-V1”):

Up to three window/keyboard screens can be opened
at the same time.  (1 Global Window and 2 Local Win-
dows) 
With a screen attribute, up to two local windows can be
specified as pop-up windows to be displayed when the
screen is opened.
With a touch switch (cursor move and input key-win-
dow/keyboard function), specification of local window
1 or 2 is possible.

Conventional models, New models (without “-V1”):

Only one window/keyboard screen can be opened.
(Local window 1 (keyboard) only)
With a screen attribute, only one window can be speci-
fied as a pop-up window to be displayed when the
screen is opened. 
With a touch switch (cursor move and input key-win-
dow/keyboard function), specification of only local win-
dow 1 (keyboard) is possible.
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� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model
with “–V1”, local win-
dow 2 is specified
for the attribute of
touch switch. And
the touch switch is
registered to the
symbol manager.

Minimum value is re-
stored for window/
keyboard screen
number.

Input Key-Window/
Keyboard screen
number is not within
the valid range.
Minimum value re-
stored.

Correct the screen data
so that the local window
1 includes all the re-
quired elements.

Correction related to display range of window/keyboard screens

When a window/keyboard screen is converted, conversion is executed as shown
below due to differences in the window/keyboard screen display range between a
conventional and a new model.

� Difference:

New models: A window/keyboard screen can be specified only in the
range that fits the touch switch grids.

Conventional models: A window/keyboard screen can be specified at any 
desired position.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, a range that
does not fit the
touch switch size is
specified as the dis-
play range.

With a new model,
the range is cor-
rected so that it
agrees with the
touch switch posi-
tions.

Some screen ele-
ments exceed frame
size. The elements
will not be down-
loaded to PT Hard-
ware.

If the position and the
range of the window to
be displayed is inconve-
nient for operation, cor-
rect the position and the
range.  (Refer to 5-4.)

Correction related to the system initializing screen (Host Connect screen)

When the system initializing screen is converted, conversion is executed as shown
below due to differences in screen numbers and elements which can be registered
between conventional and new models.

� Difference

New models: Screen No. 9000
Only fixed display elements (excluding image data and 
library data) can be registered.

Conventional models: Screen No. 1999
All kinds of element can be registered.  Some elements 
which need communications with a host may not be 
displayed correctly.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, elements
which cannot be
registered on a new
model are regis-
tered.

With a new model,
the screen No. is
modified to “9000”.
Elements which can-
not be registered for
a new model are re-
moved.

This screen does
not support XXX.  It
is discarded.

Correct the screen so
that the same screen as
before the conversion is
created using fixed dis-
play elements excluding
image/library data.  (Re-
fer to 5-8.)
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Correction related to extended screens

When an extended screen is converted, an error message may be displayed due
to differences in the handling of an extended screen between conventional and
new models.

� Difference

New models: Extended screens are not supported.

Conventional models: Extended screens can be used as standard screens.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, the screen
number of an ex-
tended screen is
used for a standard
screen.

With a new model,
the screen is treated
as a standard
screen.

The screen no. XXX
was an Extended
Screen which is not
supported by this
model, so it is con-
verted to a standard
screen.

––

Correction related to history screens

When a history screen is converted, an error message may be displayed due to
differences in the handling of the screen numbers of the frequency history screen
and the occurrence history screen between conventional and new models.

� Difference:

New models: Screen No. 9001 and No. 9002
History screens (occurrence order, frequency order) 
cannot be edited.

Conventional models: Screen No. 1997 and No. 1998
History screens (occurrence order, frequency order) 
can be edited.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, a history
screen (occurrence
order, frequency or-
der) is edited.

With a new model,
the history screen is
deleted (displaying
the edited history
screen is possible
by specifying it from
a PT).

The screen no. xxx
was a history occur-
rence (frequency)
screen which is not
supported in this
model.  It is dis-
carded.

––



478

Data Conversion Appendix A

Correction related to the number of memory tables

Since the number of memory tables which can be used differs depending on the
PT model, conversion is executed in the manner shown below.

� Difference

NT11S NT20S NT600S
NT30

NT30C

NT620S
NT620C
NT625C

NT31
NT31C
NT631

NT631C

Numeral memory
table 128 128 512

512, or
1000

512, or
1000

512,
1000, or

2000

Character string
memory table
(String table)

128 128 256
256, or
1000

256, or
1000

256,
1000, or

2000

Bit memory table –– –– –– 256 256
256, or
1000

Extended I/O in-
put table –– –– –– 64 –– ––

Extended I/O
output table –– –– –– 64 –– ––

F-key input notify
table 4 –– –– –– –– ––

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

A memory table
number which is out-
side the allowable
range of memory
tables is used for
display or input.

The memory table
number is reset to
“0”.

[Object Name] refers
to invalid numeral
table entry.  The ref-
erenced table entry
is reset to entry “0”.

Correct the memory table
number to the one which
is in the valid range.  If
the memory table num-
ber is specified in a pro-
gram, correct it also.
(Refer to “Dialog Box
Settings in the PT Con-
figuration “ in P52.)

Correction related to contents of numeral memory table

When the data of a conventional model is converted to the data for a new model,
the converted data requires your attention to the fact that the processing that oc-
curs if incorrect data (existence of “A” to “F” other than “F” at the most significant bit
position) is written to an allocated word in the host differs between a conventional
and a new model.

� Difference

New models: The written data is invalid and the existing content is re-
tained.

Conventional models: The incorrect data is stored.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

–– –– –– Note that the display dif-
fers between a conven-
tional and a new model if
incorrect data is written.
(Refer to 7-2.)
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Correction related to bit memory table

If a bit memory table is converted from the conventional model to the new model,
conversion will be executed in the manner shown below due to the difference of the
bit memory table function.

� Difference

New models: Alarm function and switch screen function cannot be
set simultaneously.

Conventional models: Alarm function and switch screen function can be set
simultaneously.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion

Error
Message Corrective Action

[Switch screen]: OFF
[Screen No]: 0

Function: None
[Switch screen]: OFF
[Screen No]: 0

–– Change function to [Alarm], if
you want to display the
alarm.  (Refer to 7-4.)

[Switch screen]: OFF
[Screen No]: As desired

Function: Alarm
[Switch screen]: ON
[Screen No]: As desired

–– Correction is not necessary.

[Switch screen]: OFF
[Screen No]: 0

Function: Alarm
[Switch screen]: ON
[Screen No]: 9999

–– Correction is not necessary.

[Switch screen]: ON
[Screen No]: As desired

Function: Alarm
[Switch screen]: ON
[Screen No]: As desired

–– Change the function to
[Switch screen].  (Refer to
7-4.)

Correction related to extended I/O input/output table

When an extended I/O input/output table is converted, the data is converted in the
manner shown below due to differences in the handling of an extended I/O input/
output table between NT30/NT30C and other models.

� Difference

NT30/NT30C: Extended I/O input/output table can be used.

Other models: Extended I/O input/output table cannot be used.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With an NT30/
NT30C, an extended
I/O input/output table
is set.

With a PT model
other than NT30/
NT30C, the setting
of an extended I/O
input/output table is
discarded.

–– Correct the screen data
and a host program so
that unusable tables can
be replaced with inputs/
outputs of a host, etc.
(Refer to 7-5 and 7-6.)
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Correction of image codes

When an image code is converted between a conventional and a new model, con-
version is executed in the manner shown below due to differences in the image
codes between them.

� Difference

New models: 0001 to 0FFF (hexadecimal)

Conventional models: FE20 to FEFF (hexadecimal)

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

Conventional model
Assume the code is
“X”.

New model
The code is “X –
FE1F”.

[E]
Image Table entry
has been converted.
[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYY.

If the code after conver-
sion differs from the
image code to be used,
change the code to the
correct one.  (Refer to
8-1.)

New model
Assume the code is
“Y”.

Conventional model
The code is “Y +
FE1F” (if the con-
verted code is out-
side the usable
range, the code is
fixed as “FE20”.)

[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYY.

Correction of library codes

When a library code is converted between a conventional and a new model, con-
version is executed in the manner shown below due to differences in the library
codes between them.

� Difference

New models: 1000 to 3FFF (hexadecimal)

Conventional models: FA20 to FAFF, FB20 to FBFF, FC20 to FCFF, FD20 to 
FDFF (hexadecimal)

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

Conventional model
Assume the code is
“X”.

New model
The code is “X –
EA20”.

[E]
Library Table Entry
has been converted.
[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYYY.

If the code after conver-
sion differs from the li-
brary code to be used,
change the code to the
correct one.  (Refer to
8-2.)

New model
Assume the code is
“Y”.

Conventional model
The code is “Y +
EA20” (if the con-
verted code is out-
side the usable
range, the code is
fixed as “FA20”.)

[W]
The code for screen
element [Object
Name] has been
converted from
XXXX to YYYY.
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Correction related to image/library in (character) strings

When an image/library in a (character) string is converted between a conventional
and a new model, conversion is executed in the manner shown below due to differ-
ences in handling of the image/library between them.

� Difference

New models: Insertion of an image/library into a (character) 
string is impossible.

Conventional models: Insertion of an image/library into a (character) 
string is possible.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, the image/li-
brary is used in a
(character) string.

With a new model,
the code is dis-
played like this:
\<!xxxx>”.
(The code after con-
version conforms to
the image/library
code conversion
method.)

[E]
Image Table entry
has been converted.
[E]
String Table: Table
Entry XXXX has in-
valid component
code.  It has been
converted from
XXXX to YYYY.

Delete a code in the
(character) string and
make corrections so that
the (character) string and
image/library (fixed dis-
play or image lamp) are
overlapped for display or
grouped, allowing the
image/library to be dis-
played in the same way
as a (character) string.
(Refer to 6-1-7.)
(In case of lamp/touch
switch label, a fixed dis-
play–image goes behind
the label and the display
will not be as desired.  In
this case, use an image
lamp instead.)

Correction of graphic display attributes

When a graphic is converted between a conventional and a new model, conver-
sion is executed as shown below due to differences in the display attributes.

� Difference

New models: The inverse attribute is not supported for some kinds of 
graphic.

Conventional models: All graphics have inverse attributes.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, the “inverse
attribute” is specified
for a graphic for
which “inverse attrib-
ute” is not supported
by a new model.

With a new model,
the foreground color
and background col-
or are automatically
interchanged.

[Object Name] – 
inverse attribute not
supported. Fore-
ground and back-
ground colours inter-
changed.

Since the foreground col-
or and background color
are automatically inter-
changed, no special
correction is required
(display attribute is set to
default (standard)).
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Correction of smoothing processing for marks

If a mark is converted between a conventional and a new model, conversion is exe-
cuted in the manner shown below due to differences in the handling of mark
smoothing processing between them.

� Difference

New models: Smoothing processing is not possible for marks.

Conventional models: Smoothing processing is possible for marks.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, smoothing
processing is speci-
fied for a mark.

With a new model,
smoothing process-
ing is invalid for a
mark.

[Fixed Display Mark]
–
smoothing not sup-
ported.  It is ignored.

Correction not necessary.

Correction related to the system keypad

If a system keypad is converted between a conventional and a new model, conver-
sion is executed in the manner shown below due to differences in the handling of
the system keypad between them.

� Difference

New models: The system keypad cannot be set.

Conventional models: Numeric keys can be created automatically by setting a
system keypad.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, a system
keypad is automati-
cally created with a
numeral setting input
screen.

With a new model,
the system keypad
is invalid and thus
not displayed.

–– Either copy the regis-
tered keyboard from the
symbol manager (refer to
6-10), or create numeric
keys which are equiva-
lent to a system keypad
using the touch switch
control code input func-
tion (Refer to 6-8-5).



483

Data Conversion Appendix A

Correction of alarm list/history touch switches

If a touch switch for alarm list/history is converted between a conventional and a
new model, conversion is executed in the manner shown below due to differences
in the handling of this kind of touch switch between them.

� Difference

New models: Control touch switches are annexed to alarm lists/his-
tories; correction is possible only with regard to the
position of the touch switches.

Conventional models: Control touch switches can be handled as independent
touch switches (to be associated with alarm lists/histo-
ries).  Their position, size, label, etc. can be edited as
desired.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, an alarm list/
history is registered
for a screen and
touch switches are
associated with it.

With a new model,
the associated touch
switches are deleted
and the control
touch switches (in
the initial state) are
automatically
created.

[E]
Touch Switch func-
tion type is not sup-
ported.  It is dis-
carded.
[W]
The associated
touch switches of
the alarm has been
discarded and com-
ponent touch
switches have been
created.

Adjust the position of
control touch switches if
necessary.  (Refer to
6-3.)

With a conventional
model, an alarm list/
history is registered
for a screen (without
control touch
switches).

With a new model,
control touch
switches (in the ini-
tial state) are auto-
matically created.

[W]
The associated
touch switches of
the alarm has been
discarded and com-
ponent touch
switches have been
created.

If control touch switches
are not necessary, delete
them by setting in the
alarm list/history proper-
ties.  (Refer to 6-3.)

With a new model,
touch switches are
automatically
created by register-
ing alarm list/history
to the symbol man-
ager.

With a conventional
model, all control
touch switches are
deleted.

[W]
The component
Touch Switches of
the Alarm List will be
discarded.

Create the control touch
switches using the touch
switch control code input
function and associate
them with the alarm list/
history.  (Refer to 6-8-5.)

Correction of touch switch position and size

Touch switch size differs between NT20S, NT600S, NT620S and other PT models.
Therefore, when the data of NT20S, NT600S, NT620S is converted to the data for
other PT models, touch switch position and size may change.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

Touch switch position
and size may
change.

–– Correct the touch switch
position and size as
needed.  (Refer to 6-8)
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Correction related to a touch switch for which a pop-up window/keyboard function is set

If a touch switch assigned the pop-up window/keyboard function is converted be-
tween a conventional and a new model, conversion is executed in the manner
shown below due to differences in the range of screen numbers of the touch switch
window/keyboard screen.

� Difference

New models: Screen numbers of window/keyboard screen: 
1 to 3999

Conventional models: Screen numbers of window/keyboard screen: 
1900 to 1979

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model,
the touch switch for
which a pop-up win-
dow/keyboard func-
tion is set is regis-
tered to the symbol
manager.

With a conventional
model, the window/
keyboard screen
number is corrected
to “1900”.

Input Key-Window/
Keyboard screen
number is not within
the valid range.
Minimum value re-
stored.

Create the window/key-
board screen for a
screen number in the
range 1900 to 1979 and
correct the window/key-
board screen number set
for the touch switch ac-
cordingly.  (Refer to 5-4,
6-8-4.)

Correction related to the touch switch for which the copy function is set

If a touch switch assigned the copy function is converted between a conventional
and a new model, conversion is executed in the manner shown below due to differ-
ences in the range of numeric values which can be input.

� Difference

New models: As a constant for the copy setting function, a numeric 
value of up to 10 digits can be input.

Conventional models: As a constant for the copy setting function, a numeric 
value of up to 8 digits can be input.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model, a
touch switch for
which the copy set-
ting function is set
with a numeric value
greater than
100000000 or small-
er than –10000000
specified is regis-
tered to the symbol
manager.

With a conventional
model, a value
greater than
100000000 is cor-
rected to 99999999
or a value smaller
than –10000000 is
corrected to
F0000000.

[W]
Constant Value is
out of limit.  Maxi-
mum value restored.

Correct the screen data
or the program in the
host so that a constant of
up to 8 digits suffices.
(Refer to 6-8-6.)
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Correction related to the lamp label (ON state)

If a lamp’s label is converted between a conventional and a new model, conversion
is executed in the manner shown below due to difference of label color setting.

� Difference

New models: ON state and OFF state can be set independently.
Background color is transparent only.

Conventional models: Only foreground color can be set.  (OFF, ON/Flash has
same color).  Background color can be set as desired.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model;
“Background”: Any
“Foreground”: Any

With a new model;
“Background”:
Transparent
“OFF State”: Same
as “Foreground”
“ON State”: Black

–– This will lead to an invis-
ible label when the lamp
is ON.  Select the lamp
and choose [Edit] – [Edit
Object] and double click
at the label.  Then
change the label ON
state color to different
color.

Correction related to the maximum and minimum limit check function for numeral input

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences in the range of numeral
which can be input.

� Difference

New models: A numeric value of up to 10 digits can be input for the 
maximum/minimum limit.

Conventional models: A numeric value of up to 8 digits can be input for the 
maximum/minimum limit.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model, a
numeral setting input
field for which a nu-
meric value greater
than 100000000 or
smaller than
–10000000 is speci-
fied as a maximum
or minimum limit is
registered to the
symbol manager.

With a conventional
model, maximum
and minimum value
greater than 8 digits
will be reset.

[W]
Numeral Input Maxi-
mum value is out of
limit.  Default values
restored for maxi-
mum and minimum.

Create a new numeral
setting input field.  Cor-
rect the screen data or
the program in the host
so that a constant of up
to 8 digits suffices.  (Re-
fer to 6-4-1, 6-4-3.)
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Correction related the number of digits for numeral input

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences in the range of numeric
values which can be input.

� Difference

New models: A numeric value of up to 10 digits can be input.

Conventional models: A numeric value of up to 8 digits can be input.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model, a
numeral setting input
field (or a thumb-
wheel switch) for
which a numeric val-
ue exceeding 8 dig-
its is input is regis-
tered to the symbol
manager.

With a conventional
model, a numeral
setting input field (or
a thumbwheel
switch) of greater
than 8 digits is dis-
carded.

[E]
[Numeral Input] – 
Total number of inte-
ger and decimal ex-
ceeds limit.  It is dis-
carded.

Create a new numeral
setting input field (thumb-
wheel switch).  Correct
the screen data or the
program in the host so
that a constant of up to 8
digits suffices.  (Refer to
6-4-1, 6-4-3.)

Correction related the reference memory tables for numeral input

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences in the numeral memory
tables which can be referred to.

� Difference

New models: For numeral memory tables No. 247 to No. 253, refer-
ence is not possible for numeral input/thumbwheel
switch.

Conventional models: For numeral memory tables No. 247 to No. 253, refer-
ence is possible for numeral input/thumbwheel switch.
(Display only)

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, a numeral
setting input field (or
a thumbwheel
switch) for which a
numeral memory
table in the range
No. 247 to No. 253
is referred to is reg-
istered to the symbol
manager.

With a new model,
the reference nu-
meral memory table
No. is corrected to
“0”.

Thumbwheel switch
refers to reserved
numeral table entry.
The referenced table
entry is reset to 0.

Make corrections so that
the contents of a numeral
memory table in the
range No. 247 to No. 253
are displayed in a numer-
al display.  (Refer to 6-6.)
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Correction related the number of digits for numeral display

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences in the range of numeric
values which can be displayed.

� Difference

New models: A numeric value of up to 10 digits can be displayed.

Conventional models: A numeric value of up to 8 digits can be displayed.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model, a
numeral display ele-
ment for which a nu-
meric value exceed-
ing 8 digits is dis-
played is registered
to the symbol man-
ager.

With a conventional
model, a numeral
display element of
greater than 8 digits
is discarded.

Numeral Display:
Total number of inte-
ger and decimal ex-
ceeds limit.  It is dis-
carded.

Create a new numeral
display element.  Correct
the screen data or the
program at the host so
that a constant of up to 8
digits suffices.  (Refer to
6-6.)

Correction related to analogue meter

In the conversion of the data between new models (with “-V1”) and other PT mod-
els, conversion is executed in the manner shown below due to presence/absence
of analogue meter.

� Difference

New models (with “-V1”): Analogue meter can be used.

Conventional models, new models (without “-V1”): 
Analogue meter cannot be used.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model
(with “-V1”), an ana-
logue meter is regis-
tered to the symbol
manager.

With a conventional
model and a new
model (without
“-V1”), an analogue
meter is not dis-
played.

Cannot paste ana-
logue meter.  It is
discarded.

Create a bar graph or
other display element
instead of an analogue
meter to display contents
which was displayed by
an analogue meter.
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Correction related to control touch switch of trend graph

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences in the trend graph con-
trol touch switches.

� Difference

New models: Marks with codes FFEF to FFF5 (hexadecimal) are 
used as trend graph control touch switches.

Conventional models: No trend graph control touch switches (codes FFEF to 
FFF5 may be used as desired).

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, the marks
with codes FFEF to
FFF5 are used as
desired.

With a new model,
marks registered
with a conventional
model are used as
trend graph control
touch switches.

–– (1) Copy marks regis-
tered under codes
FFEF to FFF5 to oth-
er codes with the
mark editor.

(2) Reset the marks with
codes FFEF to FFF5
with the mark editor.
(By resetting, the
marks are returned
to the trend graph
control marks.)

(3) For the elements
which use the con-
ventional marks of
codes FFEF to FFF5,
correct the codes to
those assigned after
copying the marks.
(Refer to 8-3.)

With a conventional
model, the marks
with codes FFEF to
FFF5 are not used.

With a new model,
nothing is registered
for codes FFEF to
FFF5 and trend
graph control touch
switches are not dis-
played.

–– Reset the marks with
codes FFEF to FFF5 with
the mark editor.  The
marks of these codes are
recognized as the trend
graph control marks.
(Refer to 8-3.)
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Correction related to sampling cycles of trend graphs

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences of trend graph sampling
cycles.

� Difference

New models: The sampling cycle can be set in the range from 0.5 to 
6553.5s in units of 0.5s.

Conventional models: The sampling cycle can be set in the range from 0.1 to 
6553.5s in units of 0.1s.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a conventional
model, the sampling
cycle is set in units
other than 0.5s.

With a new model,
the sampling cycle is
corrected to 0.5s
unit cycle (corrected
to the nearest val-
ue).

[W]
Sampling cycle less
than minimum value.
Minimum value re-
stored.
[W]
Sampling cycle not
multiple of 5.  Value
rounded off to near-
est multiple of 5.

Since there are no prob-
lems in actual operation,
correction is not neces-
sary.

Correction related to the 100% value, 0% value and –100% value of a graph

In the conversion of the data between a conventional and a new model, conversion
is executed in the manner shown below due to differences in the range of numeral
which can be input.

� Difference

New models: A numeric value of up to 10 digits can be input for a % 
value.

Conventional models: A numeric value of up to 8 digits can be input for a % 
value.

� Conversion result, error message and corrective action

Status before 
Conversion

Status after 
Conversion Error Message Corrective Action

With a new model, a
graph for which a
value greater than
100000000 or small-
er than –10000000
is set for a % value
is registered.

With a conventional
model, if a % value
is outside the allow-
able range, it is re-
placed as shown be-
low: for a 100% val-
ue, the existing val-
ue is corrected to
“100”, for a 0% val-
ue, it is corrected to
“0”, and for a –100%
value, it is corrected
to “–100”.

[W]
[Object Name] – %
value is out of limit.
Default values re-
stored for 100%, 0%
and –100%.

Correct the screen data
or the program at the
host so that a constant of
up to 8 digits suffices.
(Refer to 6-9.)
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APPENDIX  B
System Installer Operation

The Support Tool is provided with the “system installer” which installs the system
program at a PT.

Version up of the PT system program or installation of new communication pro-
grams in a PT are possible by installing the system program.

Reference: Version up (version up to “–V1” type (system program Ver.2.1)) of NT31, NT31C,
NT631, NT631C without “–V1” is possible by installing the system program which
is supplied with the Support Tool (Ver.3.2).
For details of the conversion method, refer to Appendix A “Data Conversion”.
In this case, however, the following function can not be used.

� 32 dot high-definition font (Refer to 6–1“Settings for text display”)

� Font type ISO8859–1(Refer to 3–3 “Font Type” and Appendix J)

� Memory unit system transmission (Refer to operation manual of NT31, NT31C,
NT631, NT631C with “-V1”)

To reuse the existing NT31, NT31C, NT631, NT631C screen data, the screen data
should be converted to the data for system program Ver.2.1 beforehand.

Applicable PT Models
The system installer is used to install the system program in the following PT models.

NT11S, NT30, NT30C, NT31, NT31C, NT620S, NT620C/NT625C, NT631,
NT631C

Note For the individual PC (PLC) models, always install the system program of the spe-
cific PT model.  It is not permissible to install the system program of another PT
model.

Reference: � The Support Tool is provided with the system programs of the following PT models.

NT31, NT31C, NT631, NT631C with “-V1” (system program Ver.2.1),
NT11S (For SYSMAC and multivendor)

The system program must be installed with the system installer when installing
the Support Tool at your personal computer.  For details of installation at the per-
sonal computer, refer to Section 2 “Setting Up the Support Tool”.

� System programs of NT30, NT30C, NT620S, NT620C/NT625C are available
upon request.  To install these system programs, purchase the following system
installer separately.

NT30-ZS3AT-EV1 : For NT30/NT30C
For SYSMAC

NT620-ZS3AT-EV1 : For NT620S/NT620C/NT625C
For SYSMAC

NT620-ZS3AT-EMV1 : For NT620S/NT620C/NT625C
For multivendor

These system programs can be transmitted to a PT using the system installer
supplied with the Support Tool (Ver.3.2).
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Starting and Exiting the System Installer
The system installer is started by pressing the Windows start button, then selecting
[Programs] → [Omron] → [Ntst3.2] → [NT–series System Installer] as shown
below.

e.g.) Windows 95

When the system installer starts, the main window, shown below, is displayed.

Existing the system installer

You can exit the system installer by using any of the following operations:

� Select [Download System] → [Exit].

� Click on the  button in the upper right section of the main window.

� Double click on the system installer icon in the upper left section of the main win-
dow.

� Click on the system installer icon in the upper left section of the main window,
then select [Close] in the control menu box.

� Press the [F4] key while holding down the [Alt] key.

When you exit the system installer, the Windows screen is displayed.
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Functions of the Main Window
The functions provided by the main window of the system installer are described
below.

Drive:

Specify the drive where the system program is stored.  Click on  and select the

drive name from the displayed items.

The drive in the network can be selected only when it is allocated to “My Comput-
er”.

PT Model:

Specify the PT model for which the system program is installed.  Click on  and

select the drive name from the displayed items.

Select NT31, NT31C, NT631 or NT631C to use NT31, NT631C, NT631 or
NT631C with “-V1”.

Com Port:

Specify the port used for communications with the PT.  Click on  and select the

drive name from the displayed items.  Selection is possible from [COM1] and
[COM2].

Look in:

Specify the folder where the system program is stored.  The folder can be
opened or closed by double clicking on the folder line.

Among the folders which are open, the folder at the bottom line is selected.
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System File(s):

The system programs in the specified folder and those for the specified PT mod-
el are displayed.  Specify the system program which is to be installed at the PT
from among the displayed programs.  The extension of a system program file
name represents the PT model.

Extension PT Model

.31 NT31

.31C NT31C

.631 NT631

.63C NT631C

.11S NT11S

:

The system program is installed when this button is clicked.
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Installing the System Program
The procedure for installing the system program is shown below.

(1) Specify the PT model for which the system program is installed for [PT Model]
in the main window.

(2) Specify the system program to be installed by setting the information at 
[Drive], [Look in], and [System File(s)] in the main window.

(3) Specify the RS-232C port used for the communications with the PT for [Com
Port].

(4) Make the PT ready for installation of the system program.

The operation required at the PT varies depending on the PT model.  Basical-
ly, execute the processing for deleting the system program, then that for set-
ting the PT in the state in which it waits for the reception of the system pro-
gram.  For details, refer to the manual for your PT.

(5) Click on  in the main window.

The system program is installed.

While the system program is being installed, the progress of the operation is
displayed in graph form.

(6) At the completion of system program installation, the corresponding message
is displayed.

Read the message and click on .

(7) At the PT, press the touch switch which acknowledges the end of system pro-
gram installation.

The PT re-starts by the installed system program.
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APPENDIX  C
NT Transfer Utility

With the Support Tool on CD–ROM, the “NT Transfer Utility” which can transmit
screen data to a PT easily on site is supplied. 
It can download the screen data file in mmi format to a PT and can save the screen
data uploaded from a PT to a file in mmi format.  
Screen data file in mmi format is less than 1.44 Mbytes. So it is useful when you
save the file in a floppy disk to transfer the data to and from a PT on site.

Reference: � NT Transfer Utility is a software which is exclusively used for downloading/
uploading the screen data without modifying the contents.

� NT Transfer Utility can handle only the file in mmi format. It is not possible to read
or write the file in onw format which is a standard format of the Support Tool.
Therefore, please be sure to save the screen data in mmi format when you use
the NT Transfer Utility. For details of the restriction of the file types and mmi for-
mat, refer to 3–3–3 “Saving the Screen Data (Application) File”

� NT Transfer utility downloads/uploads the screen data in the application unit. It is
not possible to perform individual transmission such as the transmission in the
screen unit.

Equipment necessary for using the NT Transfer Utility
The following indicates the equipment necessary for using the Support Tool.

Hardware

� Recommended CPU

Pentium 100MHz or faster CPU

� Personal Computer

Use an IBM personal computer or 100% compatible.

� Recommended Memory

32 Mbytes minimum

� Free Area in Hard Disk

At least 3.5 Mbytes

Operating System

Microsoft Windows 95/98 and Windows NT (Windows NT is only available with
NT–series Support Tool Ver.3.3 onward.)

Device necessary for transmitting screen data

� RS–232C cable

The cable used for the Support Tool can be used. 
For cable specifications, refer to Appendix I “Connecting Cable Specifications”.
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Installing the NT Transfer Utility
Install the NT Transfer Utility in a personal computer which is to be connected to a
PT on site. NT Transfer utility operates alone. You do not need to pre–install the
Support Tool in the personal computer.

Before installing

To install the NT Transfer Utility in the personal computer without a CD–ROM drive,
make the floppy disks for installation beforehand following the procedure below.

� Equipment to prepare

2 floppy disks (3.5 inch 1.44Mbytes 2HD, formatted)

� Creating installation FD

Copy the contents in the following folder of the Support Tool (CD–ROM) to FDs.

– The contents of [disk1] folder in [Transfer Utility] folder

→ To the first installation disk

– The contents of [disk2] folder in [Transfer Utility] folder

→ To the second installation disk

Reference: If the personal computer has a CD–ROM drive, the install program can be execut-
ed from the CD–ROM of Support Tool directly.

Installation

To install the NT Transfer Utility, execute the install program which has been ready
in your software package.

Reference: The basic operation of the install program is same as the install program of the
Support Tool. Refer to 2–2–1 “Basic Installation Operation”.

� Procedure

(1) Start up Windows 95/98

(2) If your media is FD, set the first FD of the system disks in drive A (or other 3.5
inch FD drive) 
If you are using CD–ROM, set the Support Tool CD–ROM in the CD–ROM
drive while holding down the Shift key to prevent the Support Tool setup pro-
gram from starting up. (Release the Shift key after CD–ROM is recognized
and the access to the CD–ROM is stopped.) If the Support Tool setup program
is automatically started, click on  to abort it.

Reference: You can execute the setup program by double clicking “Setup.exe” for NT Transfer
Utility in the Support Tool system disk by displaying the “Explorer” of Windows
95/98. In this case, steps 3, 4 and 5 bellow can be skipped.
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(3) Click on the Start button of Windows 95/98 and select “Run...”.

(4) Input “a:\setup” in the input field in the specified window. 
Note that drive designation must agree with the name of the drive where you
set the system disk. If you set the disk in drive B, input “b: \ setup”. In case of
CD–ROM, click on  and specify the “SETUP.EXE” in the “disk1” fold-
er in the “Transfer Utility” folder.

(5) Click on . 

The installation started.

(6) When the setup screen of the NT Transfer Utility is displayed, click on
. 

The screen for specifying the destination of program installation is displayed.

(7) Specify the directory for installation. 
In the initial state, the directory shown below is set as the destination directory.
  C: \Program Files\Omron\Ntst3.2\Transfer Utility
If you want to change the directory, click on  and input the drive and
directory. (If a directory that does not exist in the hard disk is specified, the di-
rectory is automatically made.)

After specifying the destination, click on .
The screen for specifying the destination for registering the start menu is dis-
played.
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(8) In the start menu of Windows 95/98, specify the folder where the short–cut to
the Support Tool is created. 
In the initial state, the following folder is selected. 
  Start\Program\Omron\Ntst3.2 
If you want to change the folder, select the desired folder from the “Existing
Folders” or directly input the folder name. (If a folder that does not exist in the
hard disk is specified, the specified folder is automatically made.)

After specifying the folder, click on .
Installation of the specified programs is implemented; files are copied. 
During program installation, the progress of the processing is indicated as a
percentage.

(9) After the completion of installation, the folder specified in step (8) is displayed
along with the installation completion message. 
Click on , then click on  in the setup completion screen.

Installation operation is completed.

Uninstall

An uninstaller (uninstall software) is supplied with the NT Transfer Utility. 
If you want to remove the NT Transfer Utility from your personal computer, run the
uninstaller to delete the NT Transfer Utility program files and installation informa-
tion. (Note that the data saved by the NT Transfer Utility is not deleted.)

� Starting the uninstaller from the Windows 95/98 start menu

Select “Uninstall Transfer Utility” in the same folder where the short–cut to the
Support Tool is stored.

Example:Assuming the short–cut to the Support Tool exists in the Start\Progra-
m\Omron\Ntst3.2\Uninstall Transfer Utility folder
Select the uninstaller by the following operation.
  [Start] → [Program] → [Omron] → [Ntst3.2] → [Uninstall Transfer Utility]

After the start up of the uninstaller, follow the instructions displayed on the
screen.
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How to use the NT Transfer Utility

Reference: For connection method of the NT Transfer Utility and PT, refer to 11–1–1 “Connect-
ing to PT”.

Start up and exiting the NT Transfer Utility

� Starting up the NT Transfer Utility

To start up the NT Transfer Utility, select [Program] – [Omron] – [Ntst3.2] – [NT
Transfer Utility] starting from the Windows Start button. (Items to select vary de-
pending on the [Program Folder] setting specified on installation).

The NT Transfer Utility starts up and displays the main window shown below.

� Exiting the NT Transfer Utility

You can exit the NT Transfer Utility in any of the methods below. 
� Select [File] – [Exit].
� Click on  at the upper right area of the main window.  

� Double click on the NT Transfer Utility icon at the upper left area of the main 
   window. 
� Click on the NT Transfer Utility icon at the upper left area of the main window 
   and select [Close] from the displayed control menu box. 
� Press F4 key while holding down the Alt key.

The screen returns to the Windows screen after the NT Transfer Utility is closed.

Communication Setting at the NT Transfer Utility

Set the baud rate and communication port at the NT Transfer Utility (personal com-
puter).

(1) Select [Configure] (menu bar) → [Comms. Setting].
The communication setting dialog box is displayed.

(2) Set the data for the displayed item
The meanings of the items are described below.
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Item Description

COM Port Specify the RS–232C port to be used.
Specify either “COM1” or “COM2”.

Baud Rate Set the data communication rate. 
If “High” is set, high–speed data communication is pos-
sible.
(Not available for NT11S.)
It is recommended to specify “Standard” to ensure er-
ror–free communication if a communication error occurs
due to an inadequate communication environment.
Data communication at the “Standard” setting will take
about twice the time required in the “High” setting.

(3) After completing the setting for all items, click on .

Sending (Downloading) the Data

The screen data file saved in mmi format is sent (downloaded) to a PT.

Reference: � When data is sent from the NT Transfer Utility to a PT, the existing data in the PT
is lost. Therefore, make sure that the existing data in the PT is backed up by the
Support Tool or by the NT Transfer Utility before executing data transmission
from the NT Transfer Utility to the PT.

� NT Transfer Utility can send only the file in mmi format. 

� Operation Procedure

(1) Select [Download] from [File] menu. 
The dialog box to specify the screen data file (mmi format) to be sent is dis-
played (see below). This dialog box can be called also by pressing the Ctrl key
+ Shift key + D key. 

Click on  and the dialog to confirm the screen data to be trans-
mitted is displayed.

(2) Place the PT in the Transmit mode so that the data sent from the NT Transfer
Utility can be received.
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(3) Click on  after confirming the screen data to be transmitted in the

dialog shown below. Downloading of data is started. 
If you want to change the screen data to be transmitted, click on  at the
right side of the file name and select the file you want to download. 

If the PT is not in the Transmit mode, a “timeout error” occurs in about 10 sec-
onds at the NT Transfer Utility. In this case, set the PT in the Transmit mode
and click on  in the error message dialog box.

(4) While the data is being sent to the PT, the progress of data transmission is
indicated by a bar graph. 
To abort the operation, click on .

(5) After data transmission is completed, click on  in the message box.

Receiving (Uploading) the Data

The NT Transfer Utility receives (uploads) the data stored in a PT and saves it in
mmi file format.

� Operation Procedure

(1) Select [Upload] from [File] menu. 
The dialog box to specify the PT model is displayed (see below). This dialog
box can be called also by pressing the Ctrl key + Shift key + U key. 

(2) Place the PT in the Transmit mode so that the data can be transmitted to the
NT Transfer Utility.

(3) Click on  after selecting the PT model. Uploading of data is started. 

If the PT is not in the Transmit mode, a “timeout error” occurs in about 10 sec-
onds at the NT Transfer Utility. In this case, set the PT in the Transmit mode
and click on  in the error message dialog box.

If the type of PT connected and the PT model setting at the NT Transfer Utility
is different, error message is displayed.

(4) While the data is sent from the PT, the progress of data transmission is indi-
cated by a bar graph. 
To abort the operation, click on .
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(5) After data transmission is completed, click on  in the message box.

(6) The dialog to confirm the screen data is displayed (see below). 

(7) Click on  and the file name setting window is displayed. 

Specify the folder and file name where data is to be stored and click on
. The warning message about the mmi format is displayed. Click on

 and the screen data is saved to the specified file in mmi format. If

you specify the existing file, the overwrite confirmation message is displayed. 
For details of the file name setting dialog, refer to 3–3–3 “Saving the Screen
Data (Application) File”.

Reference: The screen data file received from a PT can be edited using the Support Tool.
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APPENDIX  D
Table of Functions of Each PT Model

The functions which can be set by the Support Tool are summarized below for each
PT model.  Some functions can be set at the PT side even if they cannot be set by
the Support Tool.

PLC Vendor (PT Configuration–PT Type)

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

OMRON � � � � � � � � � � �

Mitsubishi_A � � � � � � � �*1 �*1 �*1 �*1

Mitsubishi_Fx � � � � � � � �*1 �*1 �*1 �*1

Memory Link � � � � � � � �*1 �*1 �*1 �*1

*1: Can be set only with NT31, NT31C, NT631 and NT631C with “-V1”.
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System Setting (PT Configuration)

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Initial Screen 1 – 250
1 – 250
256 –
500

1 –
2000

1 –
2000

1 –
1000

1 –
2000

1 –
2000

1 –
3999

1 –
3999

1 –
3999

1 –
3999

Enable � � � � � � � �  *1 �  *1 �  *1 �  *1

Buzzer Key 
Input � � � � � � � �  *1 �  *1 �  *1 �  *1

Resume Function � � � � � *1 � � �  *1 �  *1 �  *1 �  *1

Backlight OFF � � � � � � � �  *2 �  *2 �  *2 �  *2

Number 128 � � � � � � � � � � �Number
of Table 512 � � � � � � � � � � �
Entries –
Numeral 1000 � � � � � � � � � � �

Table 2000 � � � � � � � � � � �

Number 128 � � � � � � � � � � �Number
of Table 256 � � � � � � � � � � �
Entries –
String 1000 � � � � � � � � � � �

Table 2000 � � � � � � � � � � �

Number
of Table
Entries –

256 � � � � � � � � � � �

Entries –
Bit
Memory
Table

1000 � � � � � � � � � � �

Printer Printer � � � � � � � �  *1 �  *1 �  *1 �  *1Printer
for PT Mode � � � � � � � � � � �

History Alarm � � � � � � � � � � �History
Setting Screen � � � � � � � � � � �

Numeral Display
Type � � � � � � � � � � �

*1: Setting is not possible from the Support Tool.  Set these items at the PT.
*2: For NT31, NT31C, NT631, and NT631C, set the “screen saver function” at PT.  The “Backlight OFF” function is only for turning off the

screen or the backlight.  If the “screen saver function” is used, it is possible to display a string at a desired position in predetermined
intervals in addition to turning off the screen/backlight.
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Report

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Cross-Reference � � � � � � � � � � �

Direct Connection In-
formation � � � � � � � � � � �

History Report � � � � � � � � � � �

Image/Library Report � � � � � � � � � � �

Mark List � � � � � � � � � � �

Screen Image � � � � � � � � � � �

Screen List � � � � � � � � � � �

Table Report � � � � � � � � � � �

Validation Report � � � � � � � � � � �

Data Transmission (Download/Upload)

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Applica-
tion � � � � � � � � � � �

Screen � � � � � � � � � � �

Download/
Upload

Direct
Access
Informa-
tion

� � � � � � � � � � �

System
Memory � � � � � � � � � � �

Table � � � � � � � � � � �

Get Histo-

Screen
History � � � � � � � � � � �

Get Histo-
ry Log Alarm

History � � � � � � � � � � �

Date and Time � � � � � � � � � � �
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Image Data, Library Data, and Marks

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Total No. � � 224 � 224 4095

Code � � FE20 to FEFF � FE20 to FEFF 0001 to 0FFF

Comp. � � � � � �
Image

Mode – 8
Colours � � � � � � � � � � �

Comment � � � � � �

Total No. � � 896 � 896 12288

Library Code � �

FA20 to FAFF
FB20 to FBFF
FC20 to FCFF
FD20 to FDFF

�

FA20 to FAFF
FB20 to FBFF
FC20 to FCFF
FD20 to FDFF

1000 to 3FFF

Comment � � � � � �

Total No. 64 64 224 64 224 224

Mark
Code

FF20
to

FF5F

FF20
to

FF5F
FF20 to FFFF

FF20
to

FF5F
FF20 to FFFF FF20 to FFFF

Memory Tables

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

No. 128 128 512/1000 512 512/1000 512/1000/2000

Value � � � � � �

Initial � � � � � �

Table – Words � � � � � �Table –
Numeral PC

(PLC)
Address

� � � � � �

I/O Com-
ment � � � � � �

No. 128 128 256/1000 *1 256 256/1000 *1 256/1000/2000 *2

Value
�

(20)
�

(32)
�

(40)
�

(40)
�

(40)
�

(40)

Initial � � � � � �

Table – Words � � � � � �
String

PC
(PLC)
Address

� � � � � �

I/O Com-
ment � � � � � �

*1: String Table entry no. from 256 to 999 are the entries which only the initial value can be stored and can not be changed.
*2: String Table entry no. from 500 to 1999 are the entries which only the initial value can be stored and can not be changed.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

No. � � 256 � 256 256/1000

History � � � � � �

String
Table
Entry

� � � � � �

Colour � � � � � � � � � � �

Table –

Image/
Library
Code

� � � � � �

Bit
Memory Switch

Screen � � � � � �

Screen
No. � � � � � �

PC
(PLC)
Address

� � � � � �

I/O Com-
ment � � � � � �

No. � � 64 � � �

Table –
Extended

Cancel
Backlight
Off

� � � � � �

Extended
I/O Input Function � � � � � �

Descrip-
tion � � � � � �

No. � � 64 � � �

Table –
Extended
I/O Out-

PC
(PLC)
Address

� � � � � �

put
I/O Com-
ment � � � � � �

Total No. 3000 3000 3000 3000 3000 3000
Table –
I/O Com-

Address � � � � � �
I/O Com-
ments I/O Com-

ments � � � � � �

Total No. 4 � � � � �

F-key 
Input
Notify

PC
(PLC)
Address

� � � � � �

Table
I/O Com-
ments � � � � � �
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Screens

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Screen Size
(Dots)

160
�

64

256
�

128

320
�

240

640
�

400

640
�

400

640
�

480

320
�

240

640
�

480

Max. No. of
Screen 250 500 2000 1000 2000 3999

Standard Screen 1 to 250
1 to 250
256 to
500

1 to 1899, 2000
1 to
1000 1 to 1899, 2000 1 to 3999

Parent Screen �

1 to 250
256 to
500

1 to 1899, 2000
1 to
1000 1 to 1899, 2000 1 to 3999

Window/Keyboard
Screen � � 1900 to 1979 � 1900 to 1979 1 to 3999

Extended Screen � � 1980 to 1996 � 1980 to 1996 �

Occurrence Histo-
ry Screen � � 1997 � 1997 9001 (Not editable)

Frequency History
Screen � � 1998 � 1998 9002 (Not editable)

Host Connect
Screen � � 1999 � 1999 9000

Password Screen � � � � � �

Menu Screen � � � � � �

Print Format
Screen � � � � � �

Screen Properties

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

None � � � � � �

Contin-
uous � � � � � �

Buzzer Beep � � � � � �

Long � � � � � �

Short � � � � � �

History � � � � � �

System Keypad � � � � � �

Back- Type � � � � � � �Back-
light Colour � � � � � � �

Colour – Back-
ground � � � � � � � � � � �
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Elements

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Alarm Alarm List

Start Bit
Table Entry

� � � � � � � � � � �

Alarm List

No. of Bits
Referenced

� � � � � � � � � � �

Alarm 
History

order of
frequency/
order of 
occurrence

� � � � � � � � � � �

Alarm 
History

History Info

� � � � � � � � � � �

Alarm 
History

Info Type

� � � � � � � � � � �

Message –
Display
Line Qty

� � �(1–12) �(1–12) � �(1–16) �(1–24) �(1–12) �(1–12) �(1–24) �(1–24)

Message –
Length

� � �(1–39) �(1–39) � �(1–40) �(1–40) �(1–39) �(1–39) �(1–40) �(1–40)

Message –
Smoothing

� � � � � � � � � � �

Message –
Scale

� � � � � � � � � � �

Display
ImageLib

� � � � � � � � � � �

Colour –
Frame

� � � � � � � � � � �

Colour –
Back-
ground –
ON

� � � � � � � � � � �

Colour –
Back-
ground –
OFF

� � � � � � � � � � �

Image & 
Library –
Colour –
Foreground

� � � � � � � � � � �
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Alarm Image &
Library –
Colour –
Back-
ground

� � � � � � � � � � �

Line Scroll
Touch
Switch

� � � � � � � � � � �

Page
Scroll
Touch
Switch

� � � � � � � � � � �

Stan-
dard
Lamp

Shape –
Rectangle

� � � � � � � � � � �

Shape –
Circle

� � � � � � � � � � �

Shape –
Polygon

� � � � � � � � � � �

Shape –
Sector

� � � � � � � � � � �

Frame � � � � � � � � � � �

Colour –
Frame

� � � � � � � � � � �

Lamp At-
tribute

� � � � � � � � � � �

Colour –
ON

� � � � � � � � � � �

Colour –
OFF

� � � � � � � � � � �

Label –
Max No. of
characters

� �(32) �(40) �(40) �(80) �(80) �(80) �(40) �(40) �(80) �(80)

Label –
Font Type

� � � � � � � � � � �

Label –
Scale

� � � � � � � � � � �

Label –
Smoothing

� � � � � � � � � � �

Label – At-
tribute

� � � � � � � � � � �

Label –
Colour –
ON

� � � � � � � � � � �

Label –
Colour –
OFF

� � � � � � � � � � �

Label –
Colour –
Back-
ground

� �*2 � � �*2 �*2 � �*1 �*1 �*1 �*1

*1: Fix to transparent *2: Fix to black
With NT31, NT31C, NT631 and NT631C with “-V1”, smoothing is not performed since 32 dot font is used.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Stan-
dard
Lamp

Insert Mark � � � � � � � � � � �

Insert
Image

� � � � � � � � � � �

Image
Lamp

ON State –
Code

� � � � � � � � � � �

OFF State
– Code

� � � � � � � � � � �

Numer-
al Dis-
play

Indirect
Reference

� � � � � � � � � � �

Table Entry � � � � � � � � � � �

Display
Type –
Decimal/
Hexadeci-
mal

�

Decimal
only

� � � � � � � � � �

Format –
Integer/
Decimal

� � � � � � � � � � �

Zero Sup-
pression

� � � � � � � � � � �

Display
Sign

� � � � � � � � � � �

Font Type
�

Standard
only

� � � � � � � � � �

Scale
�

2�1,
1�1

� � � � � � � � � �

Smoothing � � � � � � � � � � �

Attribute � � � � � � � � � � �

Colour –
Fore-
ground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

String
Display

Indirect
Reference

� � � � � � � � � � �

Table Entry � � � � � � � � � � �

Length �(20) �(32) �(40) �(40) �(40) �(40) �(40) �(40) �(40) �(40) �(40)

Font Type
�

Standard
only

� � � � � � � � � �

Scale
�

1�1,
2�1

� � � � � � � � � �

Smoothing � � � � � � � � � � �
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

String
Display

Attribute � � � � � � � � � � �

Colour –
Fore-
ground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

Data Table Entry � � � � � � � � � � �

Input –
Numer-
al

Display
Type –
Decimal/
Hexadeci-
mal

�

Decimal

only

� � � � � � � � � �

Limit –
Maximum

� � � � � � � � � � �

Limit –
Minimum

� � � � � � � � � � �

Format –
Integer/
Decimal

� � � � � � � � � � �

Zero Sup-
pression

� � � � � � � � � � �

Display
Sign

� � � � � � � � � � �

Font Type �

Standard
only

� � � � � � � � � �

Scale �

1�1,
2�1

� � � � � � � � � �

Smoothing � � � � � � � � � � �

Attribute � � � � � � � � � � �

Colour –
Fore-
ground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

Focus
Frame

� � � � � � � � � � �

Focus At-
tribute

� � � � � � � � � � �

Data Table Entry � � � � � � � � � � �

Input –
String

Length �

� �(40) �(40) � �(40) �(40) �(40) �(40) �(40) �(40)

Font Type � � � � � � � � � � �

Scale � � � � � � � � � � �

Smoothing � � � � � � � � � � �
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Data
Input –
String

Attribute
� � � � � � � � � � �

Colour –
Fore-
ground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

Focus
Frame

� � � � � � � � � � �

Focus At-
tribute

� � � � � � � � � � �

Data
Input –

Table
Entry

� � � � � � � � � � �

Thumb-
wheel
Switch

Display
Type –
Decimal/
Hexade-
cimal

� � � � � � � � � � �

Format –
Integer/
Decimal

� � � � � � � � � �

Limit –
Maximum

� � � � � � � � � � �

Limit –
Minimum

� � � � � � � � � � �

Display
Sign

� � � � � � � � � � �

Attribute � � � � � � � � � � �

Size � �  *1 � � �  *2 � � � � � �

End Plate � � � � � � � � � � �

Charac-
ter
Colour –
Fore-
ground

� � � � � � � � � � �

Charac-
ter
Colour –
Back-
ground

� � � � � � � � � � �

Thumb-
wheel
Colour –
Frame

� � � � � � � � � � �

*1: Small & Medium only
*2: Medium only
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Data
Input –
Thumb-
wheel
Switch

Thumb-
wheel
Colour –
Foreground
*1

� � � � � � � � � � �

Thumb-
wheel
Colour –
Back-
ground *2

� � � � � � � � � � �

Graph-
ic

Polyline
� � � � � � � � � � �

(Fixed
Dis-
play)

Rectangle
� � � � � � � � � � �

Polygon � � � � � � � � � � �

Circle � � � � � � � � � � �

Arc � � � � � � � � � � �

Sector � � � � � � � � � � �

Colour –
Foreground

� � � � � � � � � � �

Text
(Fixed

Maximum
Character

20 32 40 40 80 80 80 40 40 80 80

Dis-
play)

Font Type �

Standard
only

� � � � � � � � � �

Scale 1�1,

2�1
� � � � � � � � � �

Smoothing � � � � � � � � � � �

Attribute � � � � � � � � � � �

Colour –
Foreground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

Insert Mark � � � � � � � � � � �

Insert
Image

� � � � � � � � � � �

Tiling Pattern � � � � � � � � � � �

(Fixed
Dis-

Colour –
Foreground

� � � � � � � � � � �

play)
Colour –
Back-
ground

� � � � � � � � � � �

Colour –
Border

� � � � � � � � � � �

*1: Foreground colour for switch
*2: Background colour for switch
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Mark Code � � � � � � � � � � �

(Fixed Scale � � � � � � � � � � �
Display)

Attribute � � � � � � � � � � �

Smooth-
ing

� �  *1 � � �  *1 � � � � � �

Colour –
Fore-
ground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

Image Display (Fixed
Display)

� � � � � � � � � � �

Indirect
Refer-
ence

� � � � � � � �*2 �*2 �*2 �*2

Colour –
Fore-
ground

� � � � � � � � � � �

Colour –
Back-
ground

� � � � � � � � � � �

Library Display
(Fixed Display)

� � � � � � � � � � �

Indirect
Refer-
ence

� � � � � � � �*2 �*2 �*2 �*2

Touch
Switch

Function
– Notify
Bit

� � � � � � � � � � �

Function
– Switch
Screen

� � � � � � � � � � �

Function
– Input
Key –
Control

� � � � � � � � � � �

Function
– Input
Key –
Window/
Keyboard

� � � � � � � � � � �

Function
– Input
Key –
String

� � � � � � � � � � �

Function
– Copy
Setting

� � � � � � � � � � �

*1: For NT20S, NT600S, smoothing is always ON.
*2: Can be used only NT31, NT31C, NT631, NT631C with “(system Ver.2.1)”.
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Touch
Switch

Function
– Cursor
Move

� � � � � � � � � � �

Function
– Screen
Print

� � � � � � � � � � �

Func-
tion– 
Window
Move

� � � � � � � �*1 �*1 �*1 �*1

PC (PLC)
Bit Ad-
dress

� � � � � � � � � � �

Shape –
Standard

� � � � � � � � � � �

Shape –
Shadow

� � � � � � � � � � �

Shape –
3-Dimen-
sion

� � � � � � � � � � �

Shape –
Rectan-
gle

� � � � � � � � � � �

Shape –
Circle

� � � � � � � � � � �

Shape –
Polygon

� � � � � � � � � � �

Shape –
Sector

� � � � � � � � � � �

Frame � � � � � � � � � � �

Colour –
Frame

� � � � � � � � � � �

Show ON
State

� � � � � � � � � � �

Lamp At-
tribute

� � � � � � � � � � �

Colour –
ON

� � � � � � � � � � �

Colour –
OFF

� � � � � � � � � � �

Max No.
of Char-
acters

� 32 40 40 80 80 80 40 40 80 80

Label –
Font
Type

� � � � � � � � � � �

Label –
Scale

� � � � � � � � � � �

Label –
Smooth-
ing

� � � � � � � � � � �

*1: Can be used only for NT31, NT31C, NT631 and NT631C with “-V1”.



517

Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Touch
Switch

Label –
Attribute

� � � � � � � � � � �

Label –
Colour –
ON

� � � � � � � � � � �

Label –
Colour –
OFF

� � � � � � � � � � �

Label –
Colour –
Back-
ground

� � � � � � � � � � �

Label –
Insert
Mark

� � � � � � � � � � �

Label –
Insert
Image

� � � � � � � � � � �

Trend
Graph

Standard/
Pen
Reco

� � � � � � � � � � �

Drawing
Width

� � 1–320 1–320 � 1–640 1–640 2–320 2–320 2–640 2–640

Sampling
Cycle

� � � � � � � � � � �

Table
Entry

� � � � � � � � � � �

100% –
Table
Entry

� � � � � � � � � � �

100% –
Value

� � � � � � � � � � �

0% –
Table
Entry

� � � � � � � � � � �

0% – Val-
ue

� � � � � � � � � � �

–100% –
Table
Entry

� � � � � � � � � � �

–100% –
Value

� � � � � � � � � � �

Line –
Style

� � � � � � � � � � �

Line –
Colour

� � � � � � � � � � �

Direction � � � � � � � � � � �

Display
Sign

� � � � � � � � � � �

Frame � � � � � � � � � � �

Colour –
Frame

� � � � � � � � � � �
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Trend
Graph

Colour –
+ Range

� � � � � � � � � � �

Colour –
– Range

� � � � � � � � � � �

Display
%

� � � � � � � � � � �

Display
% – Font
Type

� � � � � � � � � � �

Display
% –Scale

� � � � � � � � � � �

Display
% –
Smooth-
ing

� � � � � � � � � � �

Display
% –
Colour –
Fore-
ground

� � � � � � � � � � �

Display
% –
Colour –
Back-
ground

� � � � � � � � � � �

Broken-
line
Graph

Start
Table
Entry

� � � � � � � � � � �

No. of
Points

� � 2–320 2–320 � 2–512 2–512 2–320 2–320 2–512 2–512

100% –
Table
Entry

� � � � � � � � � � �

100% –
Value

� � � � � � � � � � �

0% –
Table
Entry

� � � � � � � � � � �

0% – Val-
ue

� � � � � � � � � � �

–100% –
Table
Entry

� � � � � � � � � � �

–100% –
Value

� � � � � � � � � � �

Line –
Style

� � � � � � � � � � �

Line –
Colour

� � � � � � � � � � �

Direction � � � � � � � � � � �

Display
Sign

� � � � � � � � � � �
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Bro- Frame � � � � � � � � � � �

ken-
line

Colour –
Frame

� � � � � � � � � � �

Graph
Colour –
+ Range

� � � � � � � � � � �

Colour –
– Range

� � � � � � � � � � �

Bar
Graph

Table
Entry

� � � � � � � � � � �

100% –
Table
Entry

� � � � � � � � � � �

100% –
Value

� � � � � � � � � � �

0% –
Table
Entry

� � � � � � � � � � �

0% – Val-
ue

� � � � � � � � � � �

–100% –
Table
Entry

� � � � � � � � � � �

–100% –
Value

� � � � � � � � � � �

Direction �

Right
only

� � � � � � � � � �

Display
Sign

� � � � � � � � � � �

Frame � � � � � � � � � � �

Colour –
Frame

� � � � � � � � � � �

Colour –
+ Range

� � � � � � � � � � �

Colour –
– Range

� � � � � � � � � � �

Display
%

� � � � � � � � � � �

Display
% – Font
Type

�

Standard
only

� � � � � � � � � �

Display
% –
Scale

�

1�1,
2�1

� � � � � � � � � �

Display
% –
Smooth-
ing

� � � � � � � � � � �
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Table of Functions of Each PT Model Appendix D

Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Bar
Graph

Display
% –
Colour –
Fore-
ground

� � � � � � � � � � �

Display
% –
Colour –
Back-
ground

� � � � � � � � � � �

Ana- Frame � � � � � � � �*1 �*1 �*1 �*1

logue
Meter

Colour –
Frame

� � � � � � � � �*1 � �*1

Display
Sign

� � � � � � � �*1 �*1 �*1 �*1

Direction � � � � � � � �*1 �*1 �*1 �*1

Metre –
Shape

� � � � � � � �*1 �*1 �*1 �*1

Metre –
Direction

� � � � � � � �*1 �*1 �*1 �*1

Metre –
Type

� � � � � � � �*1 �*1 �*1 �*1

Metre –
Width
Rate

� � � � � � � �*1 �*1 �*1 �*1

Scale � � � � � � � �*1 �*1 �*1 �*1

Distance � � � � � � � �*1 �*1 �*1 �*1

Scale
Length

� � � � � � � �*1 �*1 �*1 �*1

No. of Di-
vision

� � � � � � � �*1 �*1 �*1 �*1

Scale
Colour

� � � � � � � � �*1 � �*1

Colour –
Fore-
ground

� � � � � � � � �*1 � �*1

Colour –
Back-
ground

� � � � � � � � �*1 � �*1

Colour –
+Range

� � � � � � � � �*1 � �*1

Colour –
–Range

� � � � � � � � �*1 � �*1

Value –
Table
Entry

� � � � � � � �*1 �*1 �*1 �*1

*1: Can be used only with NT31, NT31C, NT631 and NT631C with “-V1”.
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Items NT11S
NT20S
Ver. 5

NT30
Ver. 4

NT30C
Ver. 4

NT600S
Ver. 5

NT620S
Ver. 4

NT620C/
NT625C

Ver. 4
NT31 NT31C NT631 NT631C

Ana-
logue

Display
Label

� � � � � � � �*1 �*1 �*1 �*1

Meter 100% –
Table
Entry

� � � � � � � �*1 �*1 �*1 �*1

100% –
Value

� � � � � � � �*1 �*1 �*1 �*1

0% –
Table
Entry

� � � � � � � �*1 �*1 �*1 �*1

0% – 
Value

� � � � � � � �*1 �*1 �*1 �*1

–100% –
Table
Entry

� � � � � � � �*1 �*1 �*1 �*1

–100% –
Value

� � � � � � � �*1 �*1 �*1 �*1

Display
% – Font
Type

� � � � � � � �*1 �*1 �*1 �*1

Display
% –
Scale

� � � � � � � �*1 �*1 �*1 �*1

Display
% –
Smooth-
ing

� � � � � � � �*1 �*1 �*1 �*1

Display
% –
Fore-
ground

� � � � � � � �*1 �*1 �*1 �*1

Display
% –
Back-
ground

� � � � � � � �*1 �*1 �*1 �*1

*1: Can be used only with NT31, NT31C, NT631 and NT631C with “-V1”.
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APPENDIX  E
Limits on Numbers of Elements

Limits with Conventional Models
For NT20S, NT30, NT30C, NT600S, NT620S, NT620C, and NT625C, the limits on
the use of elements are indicated below for each PT model.

Item Limit

Numeral Display 50 entries/screen

String Display NT20S: 32 entries/screen

Other models: 50 entries/screen

Bar Graph 50 entries/screen

Broken-line graph NT20S, NT600S: Not supported

Other models: 1 frame/screen, 256 lines/frame

Trend Graph NT20S, NT600S: Not supported

Other models: 1 frame/screen, 50 lines/screen data file

Lamp NT20S: 128 entries/screen

NT600S: 255 entries/screen

Other models: 256 entries/screen

Touch Switch NT20S: 72 entries/screen

NT600S: 128 entries/screen

Other models: 256 entries/screen

Data Input – Numeral 50 entries/screen
Data Input – String

50 entries/screen
(overlapping screen: registration is possible only on one child screen.)

Alarm List NT20S, NT600S: Not supported

Alarm History
Other models: 4 groups/screen

(max. 32 groups in overlapping screen)



523

Limits on Numbers of Elements Appendix E

New Models

Item Limit

Fixed Display 65535 entries/screen (overlapping screen*1: max. 524280 entries)

Numeral Display 256 entries/screen (overlapping screen*1: max. 1024 entries)

String Display 256 entries/screen (overlapping screen*1: max. 1024 entries)

Image Data 256 entries/screen, including library data
(overlapping screen*1: max. 1024 entries)

Library Data 256 entries/screen, including image data
(overlapping screen*1: max. 1024 entries)

Mark Display (fixed dis-
play)

65535 entries/screen (overlapping screen*1: max. 52480 entries)

Bar Graph 50 entries/screen (overlapping screen*1: max. 400 entries)

Analogue Meter*2 50 entries/screen (overlapping screen*1: max. 400 entries)

Broken-line Graph 1 frame/screen (overlapping screen*1: max. 8 frames)   256 lines/frame

Trend Graph 1 frame/screen (overlapping screen*1: max. 8 frames)

Data logging function not used: 50 lines/screen data

Data logging function used: 8 lines/screen data

Lamp 256 entries/screen (overlapping screen*1: max. 1024 entries)

Touch Switch 256 entries/screen (overlapping screen*1: max. 1024 entries)

Numeral
Input

Numeric
Key Type

256 entries/screen (overlapping screen*3: registration is possible only on
one child screen)

Thumb-
wheel SW
Type

NT31/NT31C: 64 entries/screen (overlapping screen*4: registration is
possible only on one child screen.)

NT631/NT631C: 256 entries/scren (overlapping screen*4: registration is
possible only on one child screen.)

Data Input – String 256 entries/screen
(overlapping screen*3: registration is possible only on one child screen.)

Alarm List 4 groups/screen (max. 32 groups in overlapping screen*1)

Alarm History
(Alarm history: One group each for occurrence order and frequency or-
der in standard/child screen)

*1: Limits on numbers of elements on a window/keyboard screen is same as on a
standard screen.  Limit check is not performed for an overlapping screen at the
Support Tool.

*2: Analogue meter can be used only with NT31, NT31C, NT631 and NT631C with
“-V1”.

*3: Either of numeral input (numeric key type) or string input can be registered on a
window/keyboard screen.

*4: Thumbwheel type numeral input can not be registered on a window/keyboard
screen.
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Limits on display

For elements, limits are also applied to display in addition to the limits on the num-
bers shown above.

� Limits on reading the data

For NT31, NT31C, NT631, and NT631C, the allowable number of data entries
that can be read at the same time is set and read elements exceeding this limit
are not displayed.  If the same data is read from different elements, reading of the
data is counted separately.

The allowable maximum number of data entries that can be read is shown below
for each type of data.

Item Max. Entries

Numeral Memory Table 1024 entries

String Memory Table 1024 entries

Bit Memory Table 1024 entries

Indirect Memory Table Reference 100 entries
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The read data count is indicated below for each element.

Element Read Data Count

Fixed Display
(characters, graphics)

None

Image Data None

Library Data None

Mark None

Touch Switch Host bit: 1

Lamp Host bit: 1

Data Input – Numeral Numeral memory table: 1

Data Input – String Character string memory table (String table): 1

Thumbwheel Switch Numeral memory table: 1

Numeral Display Direct designation Numeral memory table: 1

Indirect designation Numeral memory table: 1

Memory table indirect reference: 1

String Display Direct designation Character string memory table (String table): 1

Indirect designation Character string memory table (String table): 1

Memory table indirect reference: 1

Bar Graph Numeral memory table: 1

Note: If numeral memory tables are specified for 100% value, 0% value
and –100% value, a numeral memory table is read 
for each of them.

Analogue Meter Numeral memory table: 1

Note: If numeral memory tables are specified for 100% value, 0% value
and –100% value, a numeral memory table is read for each of
them.

Broken-line Graph Numeral memory table: “Line No.” x “No. of Points”

Note: If numeral memory tables are specified for 100% value, 0% value
and –100% value for each line, a numeral memory table is read 
for each of them.

Trend Graph Without data logging
function

Numeral memory table: “Line No.”

Note: If numeral memory tables are specified for
100% value, 0% value and –100% value
for each line, a numeral memory table is
read for each of them.

With data logging
function

Background table: “Line No.”

Note: If numeral memory tables are specified for
100% value, 0% value and –100% value
for each line, a numeral memory table is
read for each of them.

Alarm List Bit memory table: “No. of Reference”

Alarm History None
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APPENDIX  F
New Functions of Support Tool Ver.3.2

Here, differences between the Support Tool Ver.3.0 and Ver.3.2 and the new func-
tions added to Ver.3.2 are shown in the table. Various functions are added to
Ver.3.2 to improve operational efficiency.

Items Ver.3.0 Ver.3.2 Page

NT31, NT31C, NT631,
NT631C system pro-
gram Ver.2.1 support

Not supported The following functions are sup-
ported.

� Image/Library indirect reference

� Up to 65535 fixed display objects
can be registered for a library
(With Ver.3.0, up to 64 objects can
be displayed).

� With NT631 and NT631C, up to
40 characters can be displayed for
alarm list/history message regard-
less of the display method.

System is changed so that the
screen switching speed on PT is im-
proved.

6–2–9
6–2–11
6–3

Importing screen or
table data from a differ-
ent screen data file

Not possible (Only one
Support Tool can be
started up).

Possible (Different screen data files
can be opened by starting up two
Support Tools to perform copy op-
eration of screen/table data between
Support Tools. Between the same
PT model only).

3–3–6

Property sheet opens
automatically when
creating objects.

You need to display the
property manually after
registering an object on
the screen.

Automatically displays the property
setting dialog at the same time an
object is registered on the screen.

Object selection using
the Tab key or Shift +
Tab key.

Not possible. Possible (object will be selected one
by one according to the display or-
der. Pressing the Tab key selects
the object according to the higher
display order. Pressing the Shift key
+ Tab key selects the object accord-
ing to the lower display order).

6–1–3

Displaying the property
by pressing the Alt key
+ Enter key

Not possible Possible (only when a single object
is selected).

6–1–10

Direct selection of an
object overlapped by
the other objects.

Not possible Possible (The element with the
smallest area enclosing the point of
selection is selected).

6–1–3

Alignment function None Objects can be aligned by the align-
ment function.  (from menu, toolbar
or short–cut key).

6–1–6
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Items Ver.3.0 Ver.3.2 Page

Filter function None Only the objects of the selected type
is displayed by selecting the object
type using a toolbar (Screen editing
is also possible during the filter func-
tion. This function is cancelled when
the alignment function is used).

5–1–4

Object information dis-
played on the status
bar

None Detailed information of the selected
object is displayed.

3–2–1

Information in the se-
lect object dialog box

Only the object name is
displayed.

Detailed information of the selected
object is displayed.

6–1–3

Display of inverse, flash
and inverse flash attrib-
ute of objects

Can not display on the
Support Tool (They are
displayed as “standard”
attribute on the Support
Tool).

Inverse attribute is always shown. 
Flash attribute can be checked from
a menu or a toolbar.

5–1–3

Display of lamp ON sta-
tus for lamps and touch
switches

Not possible Lamp ON status can be checked
from a menu or a toolbar.

5–1–3

Show tag for a touch
switch with a notify bit
function

Only “notify bit” address
is displayed.

Both “notify bit” address and “lamp
bit” address are shown.

5–1–3

Handles displayed for
objects

Green � handle only An arrow indicating the direction to
which the object can be resized is
displayed inside the green handle (It
helps to distinguish between the
handle and screen grid when
zoomed).

6–1–4

Handle size when
zoomed

Handle size is also
zoomed when using
zoom function. It dis-
turbs the operation with
a small object.

Handle size does not change even
when the zoom function is used
(This enables the smooth edit op-
eration).

5–1–3

Functions of image/li-
brary

� It takes time to dis-
play Image/library
table.

� Copy/paste operation
is not possible on the
image/library editor.

� It is not possible to
select multiple data
on the image/library
table (cannot display
multiple image/library
data collectively).

� Preview function of
image/library data is
not supported.

� Image/library table is displayed
quickly.

� Copy/paste operation is possible
on the image/library editor.

� It is possible to select multiple
data on the image/library table
(multiple image/library data can be
displayed collectively).

� Image/library data can be pre-
viewed.

8–1
8–2
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Items Ver.3.0 Ver.3.2 Page

Multiple displays of
image/library editor

Up to 1 editor can be
displayed at the same
time.

Up to 10 editors can be opened col-
lectively by selecting multiple codes
on the image/library table (The
image/library table closes at the
same time).

8–1
8–2

Modifying the size of an
image data on the
image editor

Not possible Image data size can be modified by
dragging the handle (� mark) of
range specifying frame.

8–1–2

Display method of
property for lamp/touch
switch label

Only the text can be
edited by clicking on
[Edit Label] button in
the lamp/touch switch
property. You need to
select the label using
the Edit Object function
to display a property.

All the properties of label can be dis-
played by clicking on [Edit] button in
the lamp/touch switch property and
the settings such as scale or color
can be changed in it. It is also pos-
sible to select the label directly by
clicking it while pressing the Shift
key and Ctrl key.

6–5
6–8

Copying the I/O com-
ment to lamp/touch
switch label

First, you need to dis-
play the I/O comment
table and then perform
copy operation manual-
ly.

[Copy I/O Comments] button is add-
ed in the property dialog (For notify
bit touch switch, I/O comment of
notify bit is copied and for touch
switch with other functions, I/O com-
ment of lamp bit is copied).

6–5
6–8

Centralization of lamp/
touch switch label

You need to adjust the
label position manually.

Label can be centralized horizontally
by the [Centralize Label] function
(from menu or toolbar). (It is pos-
sible to centralize multiple lamp/
touch switch labels collectively.)

6–1–9

Selecting method of
lamp/touch switch label

Select a lamp or a
touch switch and enter
the Edit Object mode,
then select the label.

Besides the methods mentioned left,
it is possible to select the label di-
rectly by clicking it while pressing
the Shift key and Ctrl key.

6–1–3

Default table entry for
numeral/string input
and thumbwheel.

Fixed to numeral/string
entry “0”.

Default table entry is incremented
automatically so that the numeral/
string table entry does not overlap
with the ones already used for the
numeral/string input or thumbwheel
on the same screen.

6–4

Options for Screen
Image printing (Inverse
printing, screen grid/
dotted line frame print-
ing)

� For monochrome
PTs, the screen is al-
ways inversed for
printing. For color
PTs, the screen is al-
ways printed as it is.

� If you do not want to
print screen grid, you
need to uncheck the
“Display Grid” setting
of each screen’s
property.

For Screen Image printing, options
below are added.

� Inverse Print

� Hide Screen Grid

� Show Dotted Line Frame

12–2–2
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Items Ver.3.0 Ver.3.2 Page

NT Transfer Utility None Supplied with CD–ROM version
(This is software which executes
downloading/uploading of the
screen data in mmi format at site).

App, C

Parts Collection (lamps/
touch switches)

None Supplied with CD–ROM version
(This is a parts collection of graphi-
cal lamps/touch switches combined
with image/library).

3–3–7



530

Error Messages Appendix G

APPENDIX  G
Error Messages

The error message that may be displayed while using the Support Tool, and the
action to take in response to them, are shown below.

The indications [W] and [E], given at the beginning of an error message, classify
the level of errors as indicated below.

[W]: Minor error (permits transmission and execution of screen data)

[E]: Major error (disables transmission of screen data)

Error Message Corrective Action

Sign % display or other element(s) cannot
overlap with the Trend Graph.

A “% display” or other element is overlap-
ping the trend graph.  Move the element
outside the trend graph frame.

A Application version mismatched; Commu-
nication aborted.

Syetem program version installed in a PT
maybe a lower one.  For details of the com-
bination of system program version that can
be transmitted and the PT model setting at
the Suppourt Tool, refer to 11–1–2.
For details of updating the system program,
refer to Appendix B.

C Cannot have more than XXX child
screens.

When creating a new screen, insert a num-
ber of child screens that does not exceed
the maximum limit.

Constant Value is out of limit.  Maximum
value restored.

Correct the screen data or the program in
the host so that a constant of up to 8 digits
set for the copy setting touch switch will
suffice.

Continuous screen does not allow child
screen to have Thumbwheel/Numeral/
String Input elements.

Delete thumbwheel switches, numeral input
elements, and/or (character) string input
elements.

Control/Notify/Window Control area can-
not overlap each other.

Make sure that the PT status control area,
the PT status notify area and the window
control area are not overlapping each other.

Cursor Move Touch Switch does not have
any association link.

Select the cursor moving touch switch on
the screen, choose [Draw] – [Associate],
then specify the element with which the se-
lected touch switch is to be associated.

D Due to length limitation, Input Key – String
Touch Switch is only displaying part of the
label message.

With NT620S, NT620C and NT625C, if
“(character) string input” is selected as the
touch switch function, up to 80 characters
can be set for an input (character) string.

With NT31, NT31C, NT631 and NT631C,
however, although up to 80 characters can
be set for a label, the limit is 40 characters
for an input (character) string (a (character)
string which is input using a touch switch).
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Error Message Corrective Action

F [Fixed Display Mark] – smoothing not sup-
ported.  It is ignored.

The mark is automatically displayed without
smoothing processing.

I Image Table entry has been converted. If the converted image code differs from the
code of the image data that is to be dis-
played, correct the code.

Incompatible PT hardware connected;
communication aborted.

The PT model between the screen data
and the target PT is mismatching on down-
loading/puloading. Check the contents of
PT Configuration.

Input key-window/keyboard screen num-
ber is not within the valid range.  Minimum
value restored.

Create the window/keyboard screen for a
screen number in the range 1900 to 1979
and convert the window/keyboard screen
number set for the touch switch according-
ly.

L Library Table Entry has been converted. If the converted library code differs from the
code of the library data that is to be dis-
played, correct the code.

M Memory access mismatched; communica-
tion aborted.

Target PLC vendor type or PT type is mis-
matching between the Support Tool and PT
hardware.  Confirm the Support Tool and
PT side PLC vendor and PT type is mis-
matching.

Memory utilization has exceeded the XXX
bytes limit by YYY bytes.

Delete several elements.

Memory utilization has exceeded the XXX
bytes limit by YYY bytes.

Delete several elements and screens.

More than one Numeral Input/Thumb-
wheel are referring to Numeral Table entry
0.

Set different numeral memory table num-
bers at the numeral input and thumbwheel
switch properties.

N Notify Area not specified.

Control Area not specified.

Set the PC (PLC) address for the PT status
control area/PT status notify area after se-
lecting [Tools] – [PT Configuration].

Number of [Object name] has exceeded
the XXX limit by YYY.

Delete several elements.

[Numeral Input] – Total number of integer
and decimal exceeds limit.  It is discarded.

Create the numeral input field again.  Cor-
rect the screen data and the program in the
host so that numeric values such as maxi-
mum/minimum check values and an input
value of up to 8 digits will suffice.

O [Object Name] – % value is out of limit.
Default values restored for 100%, 0%,
and –100%.

Correct the screen data or the program at
the host so that a value of up to 8 digits will
be sufficient for the 100% value, 0% value
and –100% value in the bar graph.

[Object Name] has exceeded the maxi-
mum number of characters.

Set the (character) string within the limit.

[Object name] refers to invalid numeral
table entry.  The referenced table entry is
reset to entry 0.

Correct the table number to a number with-
in the valid range.  If the table number is
specified in a program, correct the program
also.
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Error Message Corrective Action

O [Object Name] – Invalid PLC address.  It
is reset to default.

Reset the word number to a number of up
to 4 digits.  If this PC (PLC) address is re-
ferred to from the program, it is necessary
to correct the program accordingly.

[Object Name] – inverse attribute not sup-
ported.  Foreground and Background
colours interchanged.

Since foreground color and background col-
or are automatically interchanged, no spe-
cial correction is required (display attribute
is set to default (standard).).

Overlapping screen has more than 1 child
screen containing Thumbwheel/Numeral/
String Input elements.

An overlapping screen does not allow the
setting of multiple input functions.  Correct
the child screen.

P Please make sure this parent screen have
at least 2 children.

Select the parent screen, then right click
the mouse and select [Modify].  Insert at
least 2 child screens for the parent screen.

S Sampling cycle less than the minimum
value.  Minimum value is restored.

Since there are no problems in actual op-
eration, correction is not necessary.

Sampling cycle not multiple of 5.  Value
rounded off to nearest multiple of 5.

Since there are no problems in actual op-
eration, correction is not necessary.

Screen is empty, downloading may not be
possible.

Create the data in the empty screen or de-
lete the empty screen.

Some objects exceed library size in code
FA20.  The objects will not be downloaded
to PT hardware.

Reduce the size of elements exceeding the
library size using the library editor, or set a
larger library size.

String Table: Table Entry XXX has invalid
component code.  It has been converted
from XXXX to YYYY.

Delete the code from the (character) string
and make corrections so that an equivalent
display can be obtained by displaying and
grouping the (character) string and the fixed
display image/library data.

T The associated touch switches of the
alarm has been discarded and component
touch switches have been created.

Correct the position of the control touch
switches as needed.  If a control touch
switch is not necessary, cancel the check
for the control touch switch in the alarm list/
history properties.  (With alarm touch
switches for NT31, NT31C, NT631, and
NT631, it is not possible to change the size
and label.)

The child screen XXX containing Numer-
al/String Input element(s) does not have
the same key attribute as the overlapping
screen.

In the screen properties, set the same [Key-
pad] attribute both for the parent and child
screens.

The code for screen element [Object
Name] has been converted from XXXX to
YYYY.

If the converted code differs from the code
of the image element that is to be dis-
played, correct the code.

The code for screen element [Object
Name] has been converted from XXXX to
YYYY.

If the converted code differs from the code
of the library data that is to be displayed,
correct the code.

The component Touch Switches of the
Alarm List will be discarded.

Create the control touch switches using the
control code input function as required, and
associate them with the alarm list/history.
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Error Message Corrective Action

T The screen no. XXX of type YYY is not
supported as a child, so the parent-child
association is discarded.

With a new model, it is not permissible to
specify a window/keyboard screen as a
child screen of an overlapping screen.
Copy the contents of the window/keyboard
screen to a standard screen and specify
this screen as the child screen of the over-
lapping screen.

The screen no. XXX was a Continuous
Parent Screen which is not supported in
this model.  It is discarded.

Use a touch switch to switch screens.  If the
program is created to display the parent
screen of the continuous screen, correct
the program so that the first child screen is
displayed.

The screen no. XXX was an Extended
Screen which is not supported in this
model, so it is converted to standard
screen.

Correction not necessary.

The screen number referenced in Touch
Switch, is not a Window/Keyboard screen.

Create the window/keyboard screen after
selecting [New], then use it as the refer-
ence screen.

The total number of Alarm List and History
exceeds the overlapping screen’s limit of
XXX by YYY.

Create the alarm list/history within the limit.

The total number of Bar Graph exceeds
the overlapping screen’s limit of 400 by
YYY.

Create the bar graphs within the limit.

The total number of Broken Line Graphs
exceeds the overlapping screen’s limit of
XXX by YYY.

Create the broken line graphs within the
limit.

The total number of lines in Broken Line
Graphs exceeds the overlapping screen’s
limit of XXX by YYY.

Create the broken line graphs within the
limit.

The total number of XXX exceeds the
overlapping screen’s limit of 256 by ZZZ.

Create the elemetns within the limit.

The total number of Image Display and
Library Display exceeds the overlapping
screen’s limit of 256 by XXX.

Create the image/library data within the lim-
it.

The total number of Numeral Display ex-
ceeds the overlapping screen’s limit of
1024 by XXX.

Create the numeral display fields within the
limit.

The total number of Numeral Table refer-
ences exceeds the overlapping screen’s
limit of XXX by YYY.

Reduce the number of reference elements.

The total number of String Table refer-
ences exceeds the overlapping screen’s
limit of XXX by YYY.

Create the elements within the maximum
limit.

The total number of touch switches ex-
ceeds the overlapping screen’s limit of
XXX by YYY.

Create the touch switches within the limit.
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Error Message Corrective Action

T The total number of Trend graph frame
exceeds the overlapping screen’s limit of
8 by XXX.

Create the trend graphs within the limit.

The total number of Trend Graph line with
Data Logging is ON exceeds the applica-
tion limit of 8 by YYY.

Create the trend graphs within the limit.

The total number of vertices in Broken
Line Graphs exceeds the overlapping
screen’s limit of XXX by YYY.

Create the broken line graphs within the
limit.

This screen does not support XXX.  It is
discarded.

Correct the system initialization screen so
that the same screen as before the conver-
sion is created using fixed display elements
excluding image/library data.

Touch Switch function type is not sup-
ported.  It is discarded.

Correct the position of the control touch
switch as needed.

Touch switch does not have associated
alarm object.

Select the alarm touch switch on the
screen, choose [Draw] – [Associate], then
specify the element with which the selected
touch switch is to be associated.

Y You have already started NT–series Sup-
port Tool.

To import screen data by starting up two
Support Tools, select [Import Component]
from [File] menu.
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APPENDIX  H
Short Cut Keys

The following short cut keys can be used with the Support Tool. Pressing these
short cut keys can perform the functions easily without selecting the items from the
menu.

Menu Function Short cut key

File New Ctrl + N

Open Ctrl + O

Save Ctrl + S

Print Ctrl + P

Edit Undo Ctrl + Z

Redo Ctrl + Y

Cut Ctrl + X

Copy Ctrl + C

Paste Ctrl + V

Align Top Ctrl + Up Arrow

Align Bottom Ctrl + Down Arrow

Align Left Ctrl + Left Arrow

Align Right Ctrl +Right Arrow

Centre in a Column Ctrl +  F9

Centre in a Row Ctrl + Shift + F9

Delete Del

Select All Ctrl + A

View Refresh F9

Draw Group Ctrl + G

Ungroup Ctrl + U

Bring to Front Ctrl + F

Send to Back Ctrl + B

Centralize Label Ctrl + L

Screen New Ctrl + W

Delete Ctrl + E

Tools Table Ctrl + T

Validate F12

Connect Download (Application) Ctrl + Shift + D

Upload (Application) Ctrl + Shift + U

Others Properties Alt + Enter

Objects Selection Higher Display Order Tab

Lower Display Order Shift + Tab

Edit Object Mode ON/OFF Insert

Edit Object Mode ON + Object Selection Ctrl + Shift + Click

The “+” mark in the list indicates that you should press the key after the “+” mark while you press the Ctrl key etc.
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APPENDIX  I
Connecting Cable Specifications

Tool Interface Connector Specifications
The following specifications apply to the connection between the PT and the sup-
port tool (personal computer).

Pin No. Signal Name Meaning

1 FG Frame ground

2 SD Send data

3 RD Receive data

4 RS Request to send

5 CS Clear to send

9 SG Signal ground

Assembly of Connecting Cables
Wiring should be carried out in one of the following ways, depending on the type of
RS-232C connector.

25-pin Connector

Connector for peripheral
devices on PT body

Personal computer

Shielded wire

Use the following recommended products when making the connecting cable.

Name Model Remarks

Connector XM2D-2501 25-pin  Made by OMRON

XM2A-0901 9-pin  Made by OMRON

Connector hood XM2S-2511 25-pin  Made by OMRON

XM2S-0911 9-pin  Made by OMRON

Cable AWG28�5P
IFVV-SB

Multi-core shielded cable  Made by
Fujikura, Ltd.

CO-MA-VV-SB
5P�28AWG

Multi-core shielded cable  Made by
Hitachi, Ltd.
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9-pin Connector

Personal computer

Shielded wire

Connector for peripheral
devices on PT body

Use the following recommended products when making the connecting cable.

Name Model Remarks

Connector XM2D-0901 9-pin  Made by OMRON

XM2A-0901 9-pin  Made by OMRON

Connector hood* XM2S-0911 9-pin, mm-pitch screw  Made by
OMRON

XM2S-0913 9-pin, inch-pitch screw  Made by
OMRON

Cable AWG28�5P
IFVV-SB

Multi-core shielded cable  Made by
Fujikura, Ltd.

CO-MA-VV-SB
5P�28AWG

Multi-core shielded cable  Made by
Hitachi, Ltd.

*: At personal computer side, use the connector hood which conforms to the 
standard of the screw at connector part.
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APPENDIX  J
Keycode Tables and Conversion Rule

ISO 8859/1
Example:Hex code is represented by 30, decimal code by 48, and character by 0.

0
48

30

0

20 30 40 50 60 70 80 90 A0 B0 C0 D0 E0 F0

0
32

0
48

@
64

P
80

’
96

p
112

Space

128

Space

144

NBSP

160

�
176

À
192

�
208

à
224

�
240

1 !
33

1
49

A
65

Q
81

a
97

q
113

Space

129

Space

145

¡
161

�
177

Á
193

Ñ
209

á
225

ñ
241

2 ”
34

2
50

B
66

R
82

b
98

r
114

Space

130

Space

146

¢
162

2

178

Â
194

Ò
210

â
226

ò
242

3 #
35

3
51

C
67

S
83

c
99

s
115

Space

131

Space

147

£
163

3

179

Ã
195

Ó
211

ã
227

ó
243

4 $
36

4
52

D
68

T
84

d
100

t
116

Space

132

Space

148

¤
164

,
180

Ä
196

Ô
212

ä
228

ô
244

5 %
37

5
53

E
69

U
85

e
101

u
117

Space

133

Space

149

¥
165

�
181

Å
197

Õ
213

å
229

õ
245

6 &
38

6
54

F
70

V
86

f
102

v
118

Space

134

Space

150

�
166

¶
182

Æ
198

Ö
214

æ
230

ö
246

7 ’
39

7
55

G
71

W
87

g
103

w
119

Space

135

Space

151

§
167

�
183

Ç
199

�
215

ç
231

�
247

8 (
40

8
56

H
72

X
88

h
104

x
120

Space

136

Space

152

¨
168

’
184

È
200

Ø
216

è
232

ø
248

9 )
41

9
57

I
73

Y
89

i
105

y
121

Space

137

Space

153

�
169

1

185

É
201

Ù
217

é
233

ù
249

A *
42

:
58

J
74

Z
90

j
106

z
122

Space

138

Space

154

ª
170

º
186

Ê
202

Ú
218

ê
234

ú
250

B +
43

;
59

K
75

[
91

k
107

{
123

Space

139

Space

155

«
171

»
187

Ë
203

Û
219

ë
235

û
251

C ,
44

<
60

L
76

\
92

l
108

|
124

Space

140

Space

156

�
172

�
188

Ì
204

Ü
220

ì
236

ü
252

D –
45

=
61

M
77

]
93

m
109

}
125

Space

141

Space

157

SHY

173

	
189

Í
205



221

í
237

�
253

E .
46

>
62

N
78

^
94

n
110

~
126

Space

142

Space

158

�
174

�
190

Î
206


222

î
238

�
254

F /
47

?
63

O
79

_
95

o
111 127

Space

143

Space

159

¯
175

¿
191

Ï
207

�
223

ï
239

NOT
USED

255
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MS–DOS CP437

20 30 40 50 60 70 80 90 A0 B0 C0 D0 E0 F0

0
32

0
48

@
64

P
80

’
96

p
112

Ç
128

É
144

á
160 176 192 208

α
224

≡
240

1 !
33

1
49

A
65

Q
81

a
97

q
113

ü
129

æ
145

Í
161 177 193 209

β
225

±
241

2 ”
34

2
50

B
66

R
82

b
98

r
114

é
130

Æ
146

ó
162 178 194 210

Γ
226

≥
242

3 #
35

3
51

C
67

S
83

c
99

s
115

â
131

ô
147

ú
163 179 195 211

π
227

≤
243

4 $
36

4
52

D
68

T
84

d
100

t
116

ä
132

ö
148

ñ
164 180 196 212

Σ
228

⌠
244

5 %
37

5
53

E
69

U
85

e
101

u
117

à
133

ò
149

Ñ
165 181 197 213

σ
229

⌡
245

6 &
38

6
54

F
70

V
86

f
102

v
118

å
134

û
150

ª
166 182 198 214

µ
230

÷
246

7 ’
39

7
55

G
71

W
87

g
103

w
119

ç
135

ù
151

º
167 183 199 215

τ
231

≈
247

8 (
40

8
56

H
72

X
88

h
104

x
120

ê
136

�
152

¿
168 184 200 216

Φ
232

°
248

9 )
41

9
57

I
73

Y
89

i
105

y
121

ë
137

Ö
153

�

169 185 201 217

Θ
233

•
249

A *
42

:
58

J
74

Z
90

j
106

z
122

è
138

Ü
154

�
170 186 202 218

Ω
234

.
250

B +
43

;
59

K
75

[
91

k
107

{
123

ï
139

¢
155

	
171 187 203 219

δ
235

√
251

C ,
44

<
60

L
76

\
92

l
108

|
124

î
140

£
156

�
172 188 204 220

∞
236

n
252

D –
45

=
61

M
77

]
93

m
109

}
125

ì
141

¥
157

�
173 189 205 221

φ
237

2

253

E .
46

>
62

N
78

^
94

n
110

~
126

Ä
142

Pts
158

«
174 190 206 222

ε
238

�

254

F /
47

?
63

O
79

_
95

o
111 127

Å
143

ƒ
159

»
175 191 207 223

∩
239

NOT
USED

255
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Keycode Conversion Rule
When you are using the European keyboard, please read the following keycode
conversion rules.
Also, PT Hardware NT31–V1/NT31C–V1/NT631–V1/NT631C–V1 are supporting
both Keycodes ISO8859/1 and CP437. This section will describe the rule for Key-
code conversion between ISO8859–1 & Latin–US(CP437) and vice
versa.
Above mentioned will be explained in following order.

(1) When the conversion will be performed.

(2) Basic Policy of the Conversion.

(3) How to Convert.

(4) Conversion Rule from ISO8859/1 to CP437.

(5) Conversion Rule from CP437 to ISO8859/1.

(1) When the conversion will be performed.

The conversion will take place during the following cases.

1. By changing to a different keycode from an existing application. 
    (From <Tools>–<PT Configuration>)
    This is only for NT31–V1/31C–V1/631–V1/631C–V1.

2. Drag/Drop of Symbols with different keycode.

3. Key input (Old & new models from ISO8859/1–CP437).

(2) Basic Policy

Basic Policy : If the Character is not found in the Target keycode, “?” (063) is
chosen.

(3) How to convert. (Only for NT31/631 series with “–V1”.)

The way to convert the Keycode will be as follows.

1. Go <Tools> – <PT Configuration>

2.  Change the “Font Type”.

3. Press [OK] Button.
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(4) Conversion Rule from ISO8859/1 to CP437.

Mapping tables for the conversion.
This conversion will be performed when you try to make the former model
screen data such as,

NT11S, NT20S, N30/30C, NT600S, NT620S/620C, NT31/NT631 series 
(System program ver.1.0) by using European Keyboard.

Also this conversion will take place if you are selecting “CP437” in NT31/631
series with “–V1”.

Note If you have Hardware NT31/631(without V1) and version up the system program of
NT31/631 series to “–V1” system program which is version 2, treat it as NT31/631
series hardware with “–V1”.
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NO

Source Destination

Windows ISO8859/1 MS–DOS CP437

01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

45

46

47

48

49

50

”Space”
128

”Space”
129

[?]
063

[?]
063

”Space”
130

”Space”
131

”Space”
132

”Space”
133

”Space”
134

”Space”
135

[,]
044

[ƒ]
159

[”]
034

[?]
063

[?]
063

[?]
063

”Space”
136

”Space”
137

”Space”
138

”Space”
139

”Space”
140

”Space”
141

”Space”
142

”Space”
143

[^]
094

[?]
063

[S]
083

[<]
060

[?]
063

[?]
063

[?]
063

[?]
063

”Space”
144

”Space”
145

”Space”
146

”Space”
147

”Space”
148

”Space”
149

”Space”
150

”Space”
151

”Space”
152

[?]
063

[’]
039

[’]
039

[”]
034

[”]
034

[• ]
249

[–]
045

[—]
196

[~]
126

”Space”
153

”Space”
154

[?]
063

[s]
115

”Space”
155

”Space”
156

”Space”
157

”Space”
158

”Space”
159

”Space”
160

[>]
062

[?]
063

[?]
063

[?]
063

[�]
089

”Space”
032

[¡]
161

[¢]
162

[£]
163

[�]
164

[¥]
165

[�]
166

[§]
167

[¨]
168

[¡]
173

[¢]
155

[£]
156

[?]
063

[¥]
157

[?]
063

[?]
063

[?]
063

[ ]
169

[a]
170

[«]
171

[¬ ]
172

[–]
173

[ ]
174

[¯]
175

[°]
176

[±]
177

[?]
063

[a]
166

[«]
174

[¬ ]
170

[?]
063

[?]
063

[?]
063

[°]
248

[±]
241

Windows ISO8859/1 MS–DOS CP437
NO

Source Destination
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51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67

68

69

70

71

72

73

74

75

76

77

78

79

80

81

82

83

84

85

86

87

88

89

 90

91

92

93

94

95

96

97

98

99

100

[2]
178

[3]
179

[·]
180

[µ]
181

[¶]
182

[⋅]
183

[,]
184

[1]
185

[2]
253

[?]
063

[”]
034

[µ]
230

[?]
063

[⋅]
250

[,]
044

[?]
063

[º]
186

[»]
187

[�]
188

[�]
189

[�]
190

[¿]
191

[À]
192

[Á]
193

[Â]
194

[º]
167

[»]
175

[�]
172

[�]
171

[?]
063

[¿]
168

[A]
065

[A]
065

[A]
065

[Ã]
195

[Ä]
196

[Å]
197

[Æ]
198

[Ç]
199

[È]
200

[É]
201

[Ê]
202

[A]
065

[Ä]
142

[Å]
143

[Æ]
146

[Ç]
128

[E]
069

[E]
144

[E]
069

[Ë]
203

[Ì]
204

[Í]
205

[Î]
206

[Ï]
207

[�]
208

[Ñ]
209

[Ò]
210

[E]
069

[I]
073

[I]
073

[I]
073

[I]
073

[D]
068

[Ñ]
165

[O]
079

[Ó]
211

[Ô]
212

[Õ]
213

[Ö]
214

[�]
215

[Ø]
216

[Ù]
217

[Ú]
218

[Û]
219

[O]
079

[O]
079

[O]
079

[Ö]
153

[�]
120

[O]
079

[S]
083

[S]
083

[S]
083

[Ü]
220

[�]
221

[�]
222

[�]
223

[à]
224

[á]
225

[â]
226

[ã]
227

[Ü]
154

[Y]
089

[T]
084

[�]
225

[à]
133

[á]
160

[â]
131

[a]
097
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101

102

103

104

105

106

107

108

109

110

111

112

113

114

115

116

117

118

119

120

121

122

123

124

125

126

127

128

[ä]
228

[å]
229

[ä]
132

[å]
134

[æ]
230

[ç]
231

[è]
232

[é]
233

[ê]
234

[ë]
235

[a]
145

[ç]
135

[è]
138

[é]
130

[ê]
136

[ë]
137

[¡]
236

[í]
237

[î]
238

[Ï]
239

[ô]
240

[ñ]
241

[Ò]
242

[Ó]
243

[¡]
141

[í]
161

[î]
140

[Ï]
139

[d]
100

[ñ]
164

[Ò]
149

[Ó]
162

[Ô]
244

[õ]
245

[Ö]
246

[÷]
247

[Ø]
248

[ù]
249

[ú]
250

[û]
251

[ü]
252

[Ô]
147

[O]
111

[Ö]
148

[÷]
246

[Ø]
237

[ù]
151

[ú]
163

[û]
150

[ü]
129

[ÿ]
253

[P]
254

[y]
121

[t]
116

Not Used
255

[ÿ]
152

(5) Conversion Rule from CP437 to ISO8859/1
This conversion will be performed at the time when you try to change the PT
Type to NT31–V1/31C–V1/631–V1/631C–V1  with Font Type ISO8859/1.
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01

02

03

04

05

06

07

08

09

10

11

12

13

14

15

16

17

18

19

20

21

22

23

24

25

26

27

28

29

30

31

32

33

34

35

36

37

38

39

40

41

42

43

44

45

46

47

48

49

50

[Ç]
128

[ü]
129

[Ç]
199

[ü]
252

[é]
130

[â]
131

[ä]
132

[à]
133

[å]
134

[ç]
135

[é]
233

[â]
226

[ä]
228

[à]
224

[å]
229

[ç]
231

[ê]
136

[ë]
137

[è]
138

[Ï]
139

[Î]
140

[Ì]
141

[Ä]
142

[Å]
143

[ê]
234

[ë]
235

[è]
232

[Ï]
239

[Î]
238

[Ì]
236

[Ä]
196

[Å]
197

[É]
144

[æ]
145

[Æ]
146

[ô]
147

[ö]
148

[ò]
149

[û]
150

[ù]
151

[ÿ]
152

[É]
201

[æ]
230

[Æ]
198

[ô]
244

[ö]
246

[ò]
242

[û]
251

[ù]
249

[y]
121

[Ö]
153

[Ü]
154

[Ö]
214

[Ü]
220

[¢]
155

[£]
156

[¥]
157

[Pts]
158

[ƒ]
159

[á]
160

[¢]
162

[£]
163

[¥]
165

[?]
063

[?]
063

[á]
225

[í]
161

[ó]
162

[ú]
163

[ñ]
164

[N]
165

[ª]
166

[º]
167

[¿]
168

[¡]
237

[ó]
243

[ú]
250

[ñ]
241

[N]
209

[ª]
170

[º]
186

[¿]
191

[
169

[¬ ]
170

[�]
171

[�]
172

[¡]
173

[«]
174

[»]
175

176

177

[?]
063

[¬ ]
172

[�]
189

[�]
188

[¡]
161

[«]
171

[»]
187

[?]
063

[?]
063

NO
Source Destination

Windows ISO8859/1MS–DOS CP437 Windows ISO8859/1MS–DOS CP437

Source Destination

NO
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51

52

53

54

55

56

57

58

59

60

61

62

63

64

65

66

67

68

69

70

71

72

73

74

75

76

77

78

79

80

81

82

83

84

85

86

87

88

89

 90

91

92

93

94

95

96

97

98

99

100

178

179

180

181

182

183

184

185

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

186

187

188

189

190

191

192

193

194

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

195

196

197

198

199

200

201

]
202

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

203

204

205

206

207

208

209

210

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

211

212

213

214

215

216

217

218

219

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

220

221

222

223

[α ]
224

[β]
225

[Γ ]
226

[π]
227

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[B]
223

[?]
063

[?]
063
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101

102

103

104

105

106

107

108

109

110

111

112

113

114

115

116

117

118

119

120

121

122

123

124

125

126

127

128

[Σ]
228

[σ]
229

[?]
063

[?]
063

[µ]
230

[τ ]
231

[Φ]
232

[Θ]
233

[Ω]
234

[δ]
235

[µ]
181

[?]
063

[?]
063

[?]
063

[?]
063

[?]
063

[∞]
236

[φ]
237

[ε]
238

[∩]
239

[≡]
240

[±]
241

[≥]
242

[≤]
243

[?]
063

[φ]
248

[?]
063

[?]
063

[?]
063

[±]
177

[?]
063

[?]
063

[⌠]
244

[⌡]
245

[÷]
246

[≈]
247

[°]
248

[• ]
249

[⋅]
250

[�]
251
[n]

252

[?]
063

[?]
063

[÷]
247

[?]
063

[°]
176

[Space]
149

[⋅]
183

[?]
063

[?]
063

[2]
253

[�]
254

[2]
178

[?]
063

Not Used
255

”Space”
160
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INDEX

Numerics

[Help] Menu 85. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Show Window/Keyboard] 96. . . . . . . . . . . . . . . . . . . 

[Window Control Area] 57. . . . . . . . . . . . . . . . . . . . . . 

32 dot font 138. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

A

[About NT–series Support Tool] 86. . . . . . . . . . . . . . 

[Add Node] 150. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Alarm History 181. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

alarm history 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Alarm list 173. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Alarm list/history function 305. . . . . . . . . . . . . . . . . . . 

Applicable PT 28. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Application (in file units) 443, 446. . . . . . . . . . . . . . . 

Application Manager 72. . . . . . . . . . . . . . . . . . . . . . . . 

Application manager screen 44. . . . . . . . . . . . . . . . . . 

[Arc] 151. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Arrange Icons 84. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Associate With...] 132. . . . . . . . . . . . . . . . . . . . . . . . . 

[Attribute] 138. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Available Data Communication Methods 439. . . . . . 

B

[Background function] 265. . . . . . . . . . . . . . . . . . . . . . 

[Backlight] 90. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Backlight OFF] 54. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Bar Graph] 238. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

base screen 105. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Batch selection of multiple elements 122. . . . . . . . . 

Bit Memory Tables 305. . . . . . . . . . . . . . . . . . . . . . . . . 

[Bring to Front] 128. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Broken–line Graph] 243, 251. . . . . . . . . . . . . . . . . . 

[Buzzer] 54. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Buzzer 90. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

C

Cable 438. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Canceling backlight OFF 311. . . . . . . . . . . . . . . . . . . 

Cascade 84. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Channel setting 143. . . . . . . . . . . . . . . . . . . . . . . . . . . 

(Character) String Input 196. . . . . . . . . . . . . . . . . . . . 

(Character) String Input Touch Switch 229. . . . . . . . 

character string memory table (string table) 298. . . 

Check box 48. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

child screen 101, 103. . . . . . . . . . . . . . . . . . . . . . . . . 

[Circle] 153. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Clip] 338. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Close] 62. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Closing a Creation Screen 74. . . . . . . . . . . . . . . . . . . 

Code setting in the image/library code field 309. . . . 

Color Palette Symbol 276. . . . . . . . . . . . . . . . . . . . . . 

Colour 91. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Combo box 49. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Comment] 53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Comment 90. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Comms. Setting] 81. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Comms. Setting 441. . . . . . . . . . . . . . . . . . . . . . . . . . . 

communication method 29. . . . . . . . . . . . . . . . . . . . . . 

Communication method for each PT type 29. . . . . . 

Connecting Cable Specifications 536. . . . . . . . . . . . . 

Connection to PT 438. . . . . . . . . . . . . . . . . . . . . . . . . . 

[Contents] 85. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Continuous Screen 101. . . . . . . . . . . . . . . . . . . . . . . . 

Control code input 310. . . . . . . . . . . . . . . . . . . . . . . . . 
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Control Code Input Touch Switches 231. . . . . . . . . . 

Control Menu Box 44. . . . . . . . . . . . . . . . . . . . . . . . . . 

[Control/Notify Area] 56. . . . . . . . . . . . . . . . . . . . . . . . 

[Copy] 126. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Copy Increment 289. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Copy Increment Setting Operation 289. . . . . . . . . . . 

Copy Setting Touch Switch 233. . . . . . . . . . . . . . . . . 

[Copy to Image] 99. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Copying a Screen 75. . . . . . . . . . . . . . . . . . . . . . . . . . 

Copying and pasting elements 126. . . . . . . . . . . . . . 

Correcting colors 473. . . . . . . . . . . . . . . . . . . . . . . . . . 

Correcting the PC (PLC) addresses 
(On data conversion between PT models) 474. . . . . 

Correction of alarm list/history touch switches 483. 

Correction of graphic display attributes 481. . . . . . . 

Correction of image codes 480. . . . . . . . . . . . . . . . . . 

Correction of library codes 480. . . . . . . . . . . . . . . . . . 

Correction of smoothing processing for marks 482. 

Correction of touch switch position and size 483. . . 

Correction related the number of digits for numeral
display 487. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related the number of digits for numeral
input 486. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related the reference memory tables for
numeral input 486. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to a touch switch for which a 
pop–up keyboard function is set 484. . . . . . . . . . . . . 

Correction related to analogue meter 487. . . . . . . . . 

Correction related to bit memory table 479. . . . . . . . 

Correction related to contents of numeral memory
table 478. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to continuous screens 474. . . . . . 

Correction related to control touch switch of trend
graph 488. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to display range of window/
keyboard screens 476. . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to extended I/O input/output 
table 479. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to extended screens 477. . . . . . . 

Correction related to history screens 477. . . . . . . . . 

Correction related to image/library codes in 
(character) strings 481. . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to keyboard screens 476. . . . . . . 

Correction related to number of window/keyboard
screens to be opened 475. . . . . . . . . . . . . . . . . . . . . . 

Correction related to overlapping screens 475. . . . . 

Correction related to sampling cycles of trend
graphs 489. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to the 100% value . . . . . . . . . . . . 
0% value and –100% value of a graph 489. . . . . . . . 

Correction related to the lamp label (ON state) 485. 

Correction related to the maximum and minimum
limit check function for numeral input 485. . . . . . . . . 

Correction related to the number of 
memory tables 478. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to the system initial screen (Host
Connect screen) 476. . . . . . . . . . . . . . . . . . . . . . . . . . 

Correction related to the system keypad 482. . . . . . 

Correction related to the touch switch for which the
copy function is set 484. . . . . . . . . . . . . . . . . . . . . . . . 

coursor position 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Creating a New Screen 74. . . . . . . . . . . . . . . . . . . . . . 

Creating an Element 119. . . . . . . . . . . . . . . . . . . . . . . 

Cross–Reference 453. . . . . . . . . . . . . . . . . . . . . . . . . . 

Cursor Moving Touch Switch 235. . . . . . . . . . . . . . . . 

Cursor Position 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Cutting and pasting elements 127. . . . . . . . . . . . . . . 

D
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Data Communication Procedure 440. . . . . . . . . . . . . 

data conversion 471. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Data creation screen 44. . . . . . . . . . . . . . . . . . . . . . . . 

Data logging function 265. . . . . . . . . . . . . . . . . . . . . . 

[Date and Time] 449. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Decimal 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Delete] 128. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Delete 76. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Deleting a Screen 76. . . . . . . . . . . . . . . . . . . . . . . . . . 

Deleting an element 127. . . . . . . . . . . . . . . . . . . . . . . 

dialog box 48. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Dialog Box Settings in the PT Configuration 52. . . . 

Direct access (PLC vendor 470. . . . . . . . . . . . . . . . . 

Direct Access Information 443. . . . . . . . . . . . . . . . . . 

Direct Connection Information 454. . . . . . . . . . . . . . . 

direct connection type 53. . . . . . . . . . . . . . . . . . . . . . . 

[Disassociate] 132. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

display history 448. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

display history (Screen History) function 112. . . . . . 

[Display Sign] 142. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Display Type 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Displaying and Setting Screen Properties 76. . . . . . 

Displaying and Setting the PT configuration 76. . . . 

Displaying the Print Image (Preview) 467. . . . . . . . . 

Distance 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Download (NT–Series Support Tool ” PT) 443. . . . . 

Download (NT–series Support Tool ” PT) 82. . . . . . 

E

[Edit Object] 123. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Edit Operation 286. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Editing a Table 77. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Enable] 54. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Error Log 80. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Error Messages 530. . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Exit] 43. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Extended I/O Input table 17. . . . . . . . . . . . . . . . . . . . . 

Extended I/O input table 18. . . . . . . . . . . . . . . . . . . . . 

Extended I/O Input Tables 310. . . . . . . . . . . . . . . . . . 

Extended I/O Output table 17, 18. . . . . . . . . . . . . . . 

Extended Screen 111. . . . . . . . . . . . . . . . . . . . . . . . . . 

F

File types 61. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Fixed Display] 149. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

floating palette 47. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Format] 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Full Screen 95. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Full Tiling 92. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

G

Get History Log 448. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Global window 108. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Graph] 238. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Group] 131. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Grouping Elements 130. . . . . . . . . . . . . . . . . . . . . . . . 

H

Hardware 7. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Hexadecimal 141. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

History 89. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

History Report 455. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[History Setting] 54. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Host Connect Screen 
(System Initializing Screen) 114. . . . . . . . . . . . . . . . . 
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I

I/O Comment Tables 317. . . . . . . . . . . . . . . . . . . . . . . 

[I/O Comments] 58. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Image] 212. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Image data 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Image Display] 163. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Image/Library Report 455. . . . . . . . . . . . . . . . . . . . . . 

[Import] 471. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Import I/O Comments 322. . . . . . . . . . . . . . . . . . . . . . 

Importing I/O Comment from Ladder Program 320. 

[Initial] 293. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Initial Screen] 53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Input Notify Touch Switch 228. . . . . . . . . . . . . . . . . . . 

Inserting Image Data 303. . . . . . . . . . . . . . . . . . . . . . . 

Inserting Library Data 304. . . . . . . . . . . . . . . . . . . . . . 

Inserting Mark Data 302. . . . . . . . . . . . . . . . . . . . . . . . 

Installing the System Program 494. . . . . . . . . . . . . . . 

K

[Key Input] 55. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Keyboard Screens 105. . . . . . . . . . . . . . . . . . . . . . . . . 

L

[Lamp] 209. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Library data 8. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Library Display] 169. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Limits on display 524. . . . . . . . . . . . . . . . . . . . . . . . . . 

Limits on Numbers of Elements 522. . . . . . . . . . . . . . 

Limits on reading the data 524. . . . . . . . . . . . . . . . . . 

limits on the use of elements 522. . . . . . . . . . . . . . . . 

List box 48. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Load Keyboard Screen] 90, 91. . . . . . . . . . . . . . . . . 

Local window 108. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

M

Main Window 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Mark Editor] 348. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Mark List 456. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Marks 9. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

MEMLINK 53, 144. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Menu bar 45. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Menu Chart 23. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

message box 50. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Meter Shape 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Mitsubishi–A 53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Mitsubishi–FX 53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Mitsubishi_A 144. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Mitsubishi_Fx 145. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

mmi format 61. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Modify Parent] 104. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Modifying an Element 124. . . . . . . . . . . . . . . . . . . . . . 

[More windows...] 84. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Moving an overlapped element to the 
front or back 128. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

N

[New] 51, 74. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

New Models 523. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[New Window] 83. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

No. of Division 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Notify bit 310. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[NT–series Support Tool] 42. . . . . . . . . . . . . . . . . . . . 

[Number of Table Entries] 54. . . . . . . . . . . . . . . . . . . . 

[Numeral Display] 215. . . . . . . . . . . . . . . . . . . . . . . . . 

Numeral Input 187. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Numeral Memory Tables 291. . . . . . . . . . . . . . . . . . . . 

[Numeral Storage Type] 56. . . . . . . . . . . . . . . . . . . . . 

O
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object position 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Objects which can be used 9. . . . . . . . . . . . . . . . . . . 

Occurrence History Screen 112. . . . . . . . . . . . . . . . . 

OMRON 53, 144. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

onw format 61. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Open] 59. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Opening a Data Creation Screen 74. . . . . . . . . . . . . 

Opening/Closing and moving a window 108. . . . . . . 

Option button 48. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Output to a File (RTF) 465. . . . . . . . . . . . . . . . . . . . . . 

Output to a Printer 460. . . . . . . . . . . . . . . . . . . . . . . . . 

Outputting the Screen Image 468. . . . . . . . . . . . . . . . 

Overlapping Screens 103. . . . . . . . . . . . . . . . . . . . . . . 

P

parent screen 101, 103. . . . . . . . . . . . . . . . . . . . . . . . 

[Paste] 126, 127. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

PC (PLC) address 143. . . . . . . . . . . . . . . . . . . . . . . . . 

PC (PLC) Address dialog box 57. . . . . . . . . . . . . . . . 

PLC Vender 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Polygon] 155. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Polyline] 149. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

pop–up window function 105. . . . . . . . . . . . . . . . . . . . 

Pop–up Window/Keyboard Touch Switch 229. . . . . 

[Print] 460. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Print Preview] 467. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Print Screen Touch Switch 236, 237. . . . . . . . . . . . . 

[Print Setup] 459. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Printer for PT] 55. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Printing information on errors occurring during data
conversion 463. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Properties] 76, 89, 133. . . . . . . . . . . . . . . . . . . . . . . . 

[PT Configuration] 76. . . . . . . . . . . . . . . . . . . . . . . . . . 

[PT Control Area] 56. . . . . . . . . . . . . . . . . . . . . . . . . . . 

[PT Notify Area] 57. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

PT Type page 52. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

R

Receiving (Uploading) Data 445. . . . . . . . . . . . . . . . . 

Receiving (Uploading) the History Record 448. . . . . 

[Rectangle] 152. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Reference Operation 280. . . . . . . . . . . . . . . . . . . . . . . 

Refresh 95. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Relationships between Elements and Memory
Tables 148. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Remaning memory 44. . . . . . . . . . . . . . . . . . . . . . . . . 

[Remove Node] 150. . . . . . . . . . . . . . . . . . . . . . . . . . . 

replacement 282. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Resume Function] 54. . . . . . . . . . . . . . . . . . . . . . . . . 

rich text format 465. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Right click the mouse 120. . . . . . . . . . . . . . . . . . . . . . 

Rotate or Flip 335. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

S

[Save] 60. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Save 78. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Save As] 60. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Save As 78. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Saving the Screen Image 99. . . . . . . . . . . . . . . . . . . . 

[Scale] 137, 140. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Scale 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Scale Length 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Screen 443, 446. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Screen Image 457. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Screen List 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Screen No. 89. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Screen switching 310. . . . . . . . . . . . . . . . . . . . . . . . . . 

Screen switching function 305. . . . . . . . . . . . . . . . . . . 

Search for Help on 85. . . . . . . . . . . . . . . . . . . . . . . . . . 
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Search Operation 282. . . . . . . . . . . . . . . . . . . . . . . . . 

[Sector] 157. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Select Object] 121. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Selected PT model 44. . . . . . . . . . . . . . . . . . . . . . . . . 

Selecting an Element 120. . . . . . . . . . . . . . . . . . . . . . 

[Selector] 119. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Sending (Downloading) the Data 81, 442. . . . . . . . . 

Setting footer and header 464. . . . . . . . . . . . . . . . . . . 

setting for screen switching 98. . . . . . . . . . . . . . . . . . 

Setting margins 464. . . . . . . . . . . . . . . . . . . . . . . . . . . 

Setting the color for graphics 134. . . . . . . . . . . . . . . . 

Setting the color for lamps and touch switches 135. 

Setting the color for text and numerals 134. . . . . . . . 

Setting the display color 134. . . . . . . . . . . . . . . . . . . . 

Setting the line type 134. . . . . . . . . . . . . . . . . . . . . . . . 

Setting the Screen Attributes 89. . . . . . . . . . . . . . . . . 

Setting the tiling color 135. . . . . . . . . . . . . . . . . . . . . . 

Settings for numeral display 139. . . . . . . . . . . . . . . . . 

Settings for text display 137. . . . . . . . . . . . . . . . . . . . . 

setup 35. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Show Tag] 94. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Size and display position of window 110. . . . . . . . . . 

[Smoothing] 159. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Smoothing 138. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Specifying an element consisting of multiple 
elements 123. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Standard Lamps 209. . . . . . . . . . . . . . . . . . . . . . . . . . 

Standard Screen 100. . . . . . . . . . . . . . . . . . . . . . . . . . 

Start–up Procedure 42. . . . . . . . . . . . . . . . . . . . . . . . . 

Status bar 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Storage Type] 294. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[String Display] 219. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

String table 17. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Switch Screen Touch Switch 228. . . . . . . . . . . . . . . . 

Switching Screen by Extended I/O Input 98. . . . . . . 

Switching Screens by Extended I/O Input at Each
Screen 97. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Symbol Manager] 269. . . . . . . . . . . . . . . . . . . . . . . . . 

System installer 32. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

System Installer Operation 490. . . . . . . . . . . . . . . . . . 

System Keypad 91. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

System Memory 443, 446. . . . . . . . . . . . . . . . . . . . . . 

System page 53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

system program 490. . . . . . . . . . . . . . . . . . . . . . . . . . . 

T

Table 17, 77, 97, 443. . . . . . . . . . . . . . . . . . . . . . . . . . 

Table Display Operation by Specifying the Table
Number 290. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Table of Functions 495, 503. . . . . . . . . . . . . . . . . . . . 

Table Report 458. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Text] 158. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Text box 48. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

the import method of I/O comment 320. . . . . . . . . . . 

The relationships between elements and memory
tables 148. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Thumbwheel Switch] 205. . . . . . . . . . . . . . . . . . . . . . 

Thumbwheel switch 187. . . . . . . . . . . . . . . . . . . . . . . . 

Tile 84. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Tiling] 161. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Title 89. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Title bar 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Tools] 472. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Total memory 44. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Touch Switch] 224. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Trend Graph] 257. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Type 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Types of Screens 19. . . . . . . . . . . . . . . . . . . . . . . . . . . 
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Types of windows 107. . . . . . . . . . . . . . . . . . . . . . . . . 

U

[Ungroup] 131. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Uninstall 40. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[unInstallShield] 40. . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Upload (PT ” NT–series Support Tool) 446. . . . . . . . 

V

Validate 79. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Validation Report 458. . . . . . . . . . . . . . . . . . . . . . . . . . 

[Value] 293. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Variations of Support Tool 4. . . . . . . . . . . . . . . . . . . . . 

[Vendor] 53. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

W

[What’s This?] 86. . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Width Rate 244. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

[Window] 83. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Window Moving Touch Switch 236. . . . . . . . . . . . . . . 

Window/Keyboard Screens 105. . . . . . . . . . . . . . . . . 

[Words] 295. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 

Z

[Zero Suppression] 142. . . . . . . . . . . . . . . . . . . . . . . . 

[Zoom] 96. . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . . 
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Revision History

A manual revision code appears as a suffix to the catalog number on the front cover of the manual.

Cat. No. V053-E1-2

Revision code

The following table outlines the changes made to the manual during each revision.  Page numbers refer to the
previous version.

Revision code Date Revised content

1 March 1999 Original production

2 August 1999 Reflected the changes in NT–series Support Tool Ver.3.2
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